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Chapter 1
INTRODUCTION

WELCOME!

Congratulations on your purchase of an Intellispec system! The Intellispec is a high-speed
machine vision system designed specifically for product and online process monitoring. It is a
very powerful tool that provides inspection much more reliably than the human eye or
sampling methods. The latest PC technology, powerful new inspection algorithms, online
adjustment capability, and inspection data storage allow the Intellispec to automatically
inspect parts with extreme accuracy on high-speed lines.

The Intellispec will help you provide the highest quality of products shipped to your customers.

ABOUT THIS MANUAL
KEEP FOR FUTURE REFERENCE

This book is considered an integral part of the system and should be kept handy for future
reference as long as the system is being used in your plant.
This manual:

e Is considered to be valid as of release 5.2.022 of the Intellispec Series V software. Contents
of this manual are subject to change without notice.

e Is your responsibility to keep in good condition, in a dry place, and ready for consultation
by the authorized users (on page 16) of the system.

e Contains the technology implemented at the time of selling and supplying the system and
shall not be considered inadequate in case of technological enhancements in the machine
or in the manual's illustrations.

Related books include:

e Intellispec Series V Operator's Guide which has Operator-level user instructions, and is a
good place to start if you are new to Intellispec

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Introduction 5
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TYPOGRAPHICAL CONVENTIONS

Following is a list of typographical conventions used in this manual:
e Bold type indicates a topic heading or an important item or statement.
e [talicized type indicates emphasis.

e Names of main components and system control signals have the first letter of each word
capitalized. For example: Processor Cabinet.

e Danger messages appear as shown below:

Danger
Danger messages alert you to specific conditions that can cause serious or fatal personal injury.
Danger messages give you important information which must be observed to prevent injury.
These messages are set off from the body text as shown here.

e Caution messages appear as shown below:

L_—_ Caution

Caution messages indicate important information which must be observed to prevent: loss of

data, poor system performance, or equipment damage. These messages are set off from the
body text as shown here.

e Notes appear as shown below:

¢ Note: Notes contain special information that warrants being set off from the body text as
shown here.

SAFETY CONSIDERATIONS

Observe the following safety warnings when operating the system or working near it:

£L__—_\ Warning
Potential for projectiles to strike persons and cause injury. Keep clear of reject devices.

Warning
Sensitive electronics and High Voltages may be exposed. Keep Processor Cabinet door closed.

6 Introduction System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
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STATIC DISCHARGE PROTECTION

A
M Caution

Electronic components can be damaged by static electricity discharge.

Always observe the following precautions before removing, installing or handling any
electronic components within the Inspection System:

e Wear an anti-static wristband which is grounded to the Inspection System.

e Stand on an anti-static, grounded floor mat, and lay circuit boards on the mat during any
board replacement.

e Keep circuit boards in static shield bags when storing and transporting. Ensure the bag is
sealed.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

Introduction 7
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Chapter 2
SAFETY INFORMATION

This section contains operator safety information that must be read before operating or
servicing the system.

£——_ Warning
Do not, under any circumstances, tamper with sealed machine parts or devices. This could
result in the removal of protections that might create potentially hazardous conditions.

£L__—_\ Warning
This product contains no operator serviceable parts. Refer servicing to qualified personnel. To
prevent electrical shock do not open cabinet doors whilst power is connected.

SYMBOLS

The following symbols are used on or near the Intellispec system. Be aware of potential risk
hazards.

CAUTION

Risk of danger. Refer to accompanying user documentation before use.

WARNING

Risk of electric shock

I On (supply)

O Off (supply)

N Alternating current

™ Protective conductor terminal

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Safety Information 9
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Marking

The following illustration shows an example label that you will find on the Intellispec Series V
system components.

'

n@:L@:@:T:E_ﬁﬂa:-:@z‘z4

-

_ HANUFACTURED 20300«

1

5

6

Name of component. NOTE: Chromapulse model is listed on the front panel

of the module. See example below.

Voltage range in Volts AC

Frequency range in Hertz (Hz)

Maximum rated power in watts (W) with all accessories or plug-in modules

connected

Serial number is listed in this box

Year of manufacture

Component certification

Risk of danger. Refer to accompanying documentation

before use.

10 Safety Information
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An example of a Chromapulse module label with the model number is shown below.

,5

For additional markings, see the System Specifications (on page 19) section.

WARNING DEVICES

The Intellispec Series V system has warning devices that indicate system failure or report
excessive defects or warnings for your production line.

Alarms
User-programmable alarms (on page 93) allow you to set the duration of the lights in the
optional light tree and the horn if certain criteria are met.

In addition to the light tree, an alarm button is displayed on screen when certain criteria are
met. You can click the alarm button to clear the alarm (see "Viewing and Clearing Alarms" on
page 94)(s) and see more detailed information about the alarm condition.

Light Tree

The optional light tree may be mounted on or near an inspection module, or near a cluster box
(if applicable). The optional horn, mounted with the light tree provides an audible warning.
For more information, refer to Light tree status (on page 386).
Light Tree (optional)
Red (Alarm)
Amber (Warning)
Green (Online)

Blue (Power)

[

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Safety Information 11
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RESIDUAL RISK

The Intellispec system has been designed to minimize any danger of personal injury. However,
the system uses rejection devices to remove defective product from the production stream.
Also, the electronics cabinets contain risk of shock if they are opened.

Observe the following safety warnings when operating the system or working near it:

' ¥ Warning
Potential for projectiles to strike persons and cause injury. Keep clear of reject devices.

Warning
Sensitive electronics and High Voltages may be exposed. Keep Processor Cabinet door closed.

INTENDED USE

Type of Process
The Intellispec system is intended to monitor container and other special manufacturing
processes and identify non-conforming product.

Intended Use
The Intellispec system is designed and constructed for use in an indoor industrial environment,
always sheltered from the weather.

Space Required
The Intellispec machine and accompanying sensors must be installed in a place that will enable
safe and easy installation, size changeover, user operation, and maintenance procedures.

12 Safety Information System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
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NON-INTENDED USE

¥ Warning
If this instrument is not used as specified, the protection provided by the equipment could be
impaired. This instrument must only be used in a normal condition (in which all means of
protection are intact).

0 Important
The Intellispec system should NOT be used for any purpose other than specifically indicated in
the section titled Intended Use (on page 12).

The following uses are not intended:
e Use in an explosive environment
e Usein a flammable environment
e Use in a damp, moist, or wet environment, except where specifically indicated

PERSONAL PROTECTIVE EQUIPMENT
0 Important

Always follow the safety requirements of your plant in addition to the recommendations
below.

We recommend, at minimum, use of the following Personal Protective Equipment (PPE):

Protective clothing

Protective gloves

Protective ear plugs or headphones

Protective eye wear

Protective foot wear
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PERSONNEL SAFETY

The following rules are recommended to ensure the safety of personnel in charge of machine
operation and maintenance.

During machine operation:

Only one operator is needed to operate the machine. All others must keep at
a safe distance.

Operators must be familiar with all machinery connected to the Pressco
equipment and know how to use emergency stop devices.

Note: the emergency stop devices may not be connected directly to the
Pressco equipment, but it is important to know how to use them.

Before putting the Pressco system online, the operator must ensure that all
safety devices used with all connected machinery are in place and
operational.

Q
The operator must maintain maximum focus on his work and be alert
throughout his shift. If this is not the case, immediately inform the shift

supervisor.

When carrying out maintenance or repair work:

Disconnect master switch. For switch locations, refer to the Power Up (on
page 375) and Power Down section.

Before starting the machine, ensure that no person is close to the machine.

If maintenance or repair requires the disconnection or removal of safety or
protection systems, this operation must be supervised by authorized
personnel who must ensure the prevention of personal injury or damage to
the machine. All machine movements must be performed with limited speed
and limited movements.

Maintenance or repair work on electrical components must be carried out
exclusively by authorized, trained personnel. When running tests with power
connected, you must strictly comply with the rules provided.

Personnel working on higher parts of a machine must wear a harness and
hook it on to the structure and must always move with extreme caution.
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Never perform lubrication or maintenance procedures on mechanical parts
with the machine running.

A\ For your safety, do not:

e Open safety guards during machine operation

e Perform maintenance and repair while the system is running

e Lean on the machine

e Sit on the machine components

e Use the machine for purposes other than those listed in this manual
e Modify parts of the machine

e Allow unqualified personnel to operate or perform maintenance procedures on the
machine

LIFTING HEAVY OBJECTS

_ ¥ Caution
Some components are heavy. Take proper precautions to prevent personal injury or damage to
equipment. If you are not capable of lifting the object alone, ask a capable person to help lift
the object, or use a mechanical lifting device

The components do not have handles to lift the equipment. Be sure to:

e Lift equipment from the bottom - do not use wires, brackets, nor other protrusions
o Keep fingers away from sensor lenses to keep the equipment clean

e Proceed slowly

» To safely lift equipment:

i ¥ Caution
Do not twist your body when moving the load. Instead take small steps with your feet turning
until you are in the correct position.

1. Stand close to the load and center yourself over it with your feet shoulder width apart.
2. Tighten your abdominal muscles.
3. Keeping your back straight, bend your knees and squat down to the floor.
4. Get agood grasp on the load with both hands.
5. Keeping the load close to your body, use your leg muscles to stand up lifting the load off
the floor.
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= Your back should remain straight throughout lifting, using only the muscles in the legs
to lift the load.

6. To place the load in the appropriate spot, bend at the knees using only your leg muscles
to lower the load.

AUTHORIZED USERS

Trained machine operators, mechanic and electrical maintenance staff, and plant managers are
considered authorized users of the Intellispec system. These users should carefully read the
information contained in this manual. The plant manager must ensure that the safety

recommendations included in this manual are observed.

£——_ Warning
Allowing workers who are unfamiliar with the production process to operate the Intellispec
system could result in hazard risk.

If you are unclear about any part of this manual, contact Pressco Technical Support (see "How
to Contact Pressco" on page 481).

0 Important
No worker should ever operate the system outside of his/ her own area of competence and
responsibility.

Proper Operation:

Only one worker is to operate the system at any given time. The correct position for the
operator is in front of the user interface monitor or control enclosure (if applicable).

Repairs:

Any repair on the system shall be carried out exclusively by Pressco Technology Inc. service
personnel or by other service expressly authorized by Pressco Technology Inc.

SPARE PARTS USAGE

The following restrictions apply to replacing parts:

L __—_\ Warning
Using spare parts that are not designed to Pressco's specifications can compromise the safety
and effectiveness of the Intellispec system.

e The use of parts that are not within Pressco's design specifications is prohibited. This
prohibition applies in particular when the parts involved contain or are connected with
safety devices.

e Before resuming production, make sure all safety devices are in working order.

Pressco Technology Inc. shall not be liable in any way if any of the above-described directions
are not complied with.

To obtain a spare parts list, contact the customer service department at Pressco. How to
Contact Pressco (on page 481).
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Pressco's technicians are available to help customers, in their own plant, to solve any problem
that might arise during use and maintenance of the Intellispec system.
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Chapter 3
SYSTEM SPECIFICATIONS

This instrument has been designed and tested in accordance with Publication EN61010-1:2001
Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use

and has been supplied in a safe condition. The instruction documentation contains information
and warnings which must be followed by the user to ensure safe operation and to maintain the

instrument in a safe condition.

ENVIRONMENTAL CONDITIONS

The Intellispec Series V system is designed to be safe in the following environmental

conditions:

7

+* Note: Please consult Pressco Technology Inc. (see "How to Contact Pressco" on page 481)
if your environmental conditions are outside of those listed.

Condition Specifications

Indoor/ outdoor use Indoor use only

Altitude Up to 2000 meters

Operating Temperature 5°Cto50°C

Storage Temperature 0°Cto70°C

Humidity Maximum relative humidity 80 % for temperatures up to 31 °C

decreasing linearly to 50 % relative humidity at 50 °C

Mains supply

Voltage fluctuations up to + 10 % of the nominal voltage

Overvoltage protection rating

Transient overvoltage typically present on MAINS supply

NOTE: the normal level of transient overvoltages is impulse
withstand (overvoltage) category Il of IEC 60364-4-443.

Rated pollution degree

This instrument is designed for use in Installation Category Il and
Pollution Degree 1 as per EN61010-1 and EN60664 respectively.

Warning

This is a Class A product. In a domestic environment this product may cause radio interference
in which case the user may be required to take adequate measures.

Sound Pressure Level

The horn on the optional light tree (on page 11) has a maximum 105dB level at 1 meter
distance in front of the horn. Use proper hearing protection as specified by your plant safety

instructions.
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SPECIFICATIONS

The following sections contain electrical specifications and measurements for components of
the Intellispec Series V system. Your system contains only the components necessary for your
application.

User Interface
User Interface Electrical Specifications

The following are electrical specifications for different configurations of the User Interface:

Standard User Interface - No UPS included

Voltage Range 100-240VAC
Frequency 50/60Hz
Current 5A @ 120VAC, 100% Load

User Interface with Optional 750VA UPS, 120VAC Nominal

Voltage Range 100-132VAC
Frequency 50/60Hz
Current 6.3A @ 120VAC, 100% Load

User Interface with Optional 1KVA UPS, 230VAC Nominal

Voltage Range 200-240VAC
Frequency 50/60Hz
Current 4.3A @ 230VAC, 100% Load
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User Interface measurements

The following are the weight and dimensions of the Intellispec Series V User Interface (see
illustration below):
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Measurement Value

Weight (total user interface)

79.7 Kg [177 Ib]

Weight (stand with monitor | 31 Kg [68 Ib]
arm and all attached

components)

Weight (computer) 25 Kg [55 Ib]

Weight (Monitor)

11.3 Kg max [25 Ib]

Weight (UPS)

12.7 Kg [28 Ib]

Height 1656 mm [65 in]
Width 504 mm [20 in]
Depth 600 mm [24 in]

Integrated Tunnel Electrical Specifications

The following are electrical specifications for the integrated tunnel (an inspection module that
contains cameras and part tracking in one unit, such as the CP/ EV series tunnels).
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Standard - No UPS

Voltage Range 100-240VAC
Frequency 50/60Hz
Current 6.2A @ 120VAC, 100% Load

Optional 500VA UPS, 120VAC Nominal

Voltage Range 100-132VAC
Frequency 50/60Hz
Current 4.1 @ 120VAC, 100% Load

Optional 500VA UPS, 230VAC Nominal

Voltage Range 200-240VAC
Frequency 50/60Hz
Current 2.2A @ 230VAC, 100% Load

CP/EV module measurements

The following are the weights and dimensions of the CPxx/ EV series inspection modules:

[OHEC)

15 oell e
' ‘ % % ‘ ! e ®
1RcE 1 il
{ | | il

648 1 \ © 2 \ ! 254 \ H H \
40 =k i i
: : il Ib
| IR | e el
1 1] L=
Ei | b 279
L.L_ o o _:J

Measurement Value

Weight 16.4 Kg [36 Ib]

Height 648 mm

Width 254 mm

Depth 279 mm
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R

% Note: measurements do not include connectors
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DECLARATION OF CONFORMITY - INTELLISPEC
SYSTEM

C€

Pressco Technology, Inc. of 29200 Aurora Road, Cleveland, Ohio USA 44139-1847,

hereby declare under our sole responsibility that the following machinery complies with the
essential health and safety standards and protection requirements of the following standards:

Electromagnetic Compatibility Directive 2004/108/EC
Low Voltage Directive 2006/95/EEC

Machine description: AUTOMATED MACHINE VISION INSPECTION SYSTEM
Make: Pressco Technology Inc
Model Number: INTELLISPEC™ Series V

We certify the above product and its components have been designed and manufactured using
the following transposed harmonized European standards:

EN50081-2 Generic Emissions Standards
EN55011 Class A/CISPR 11
EN 50082-2 Generic Immunity Standards
EN61000 4-2 ESD: 4kV CD/8kV AD
EN61000 4-3 RFI: 10V/m
EN61000 4-4 EFT: +/-2kV Power Lines, +/-1kV Signal Lines
EN61000 4-6 Conducted RF
EN60950 Safety of Information Technology Equipment

A technical construction file for this product is retained at the above address.

Signed: Date:
Name: Noel E. Morgan Jr. Title: VP of Operation

Being the person authorized by the manufacturer to sign on their behalf.
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DECLARATION OF CONFORMITY - INTEGRATED
TUNNEL

C€

Number: EMC2932

Declaration: The Pressco Technology, Inc. Intellispec Series V Inspection System is in
conformity with Directive 2004/108/EC of the European Parliament and of the Council of 15
December 2004 on the approximation of the laws of the Member States relating to
electromagnetic compatibility and repealing Directive 89/336/EEC, and with Directive
2006/95/EC of the European Parliament and of the Council of 12 December 2006 on the
harmonization of the laws of Member States relating to electrical equipment designed for use
within certain voltage limits.

Manufacturer: Pressco Technology, Inc.

29200 Aurora Road

Cleveland, Ohio 44139-1847

USA
Product Identification: Product Name: Intellispec Series V Inspection System
Standards Used (only major standards listed):

e EN61326-1:2006: Electrical equipment for measurement, control and laboratory use
—EMC requirements — Part 1: General requirements

e EN61010-1(2001): Safety requirements for electrical equipment for measurement,
control and laboratory use - Part 1: General requirements

Technical File: MS2932

Place: Pressco Technology, Inc. April 30, 2010
29200 Aurora Rd.
Solon, Ohio 44139-1847

USA
Signed: Date:
Name: Noel E. Morgan Jr. Title: VP of Operation

Being the person authorized by the manufacturer to sign on their behalf.
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Chapter 4

INSTALLATION AND WIRING

SHIPPING AND HANDLING

Pressco Technology Inc. ships unassembled components in packing cases designed to protect
the contents during handling and from exposure to weather.

Unless otherwise specified in the contract with the machine order, the Customer shall supply
Pressco Technology Inc. with the means and equipment necessary for the unloading, lifting,
and handling of machine parts. Pressco Technology Inc. deems it important to have one of their
technicians supervise the process of unloading, handling, and lifting the machine. The
technician can give useful advice as to the logical sequence in which the components should be
unpacked and positioned for ease of assembly.

L——_ Warning
Only qualified personnel must be involved in the operation of unloading, handling, and lifting
the machine. Pressco Technology Inc. shall not be liable for damage to components and/or
personal injury resulting from the involvement of unauthorized personnel and/or failure to
comply with the directions provided in this manual in relation to lifting and transport.

0 Important
The site supervisor will be responsible for ensuring that all the various mounting phases are
carried out safely and in compliance with current regulations.

After the machine is delivered, check for any damage that might have occurred during

shipping. In case of damage, contact Pressco Technology Inc (see "How to Contact Pressco" on
page 481).

In handling the machine, always keep it close to the ground.

e \\/e recommend using a forklift truck with adequate capacity and forks to suit the
weight to be lifted (machine plus packaging).
The dimensions and weight of a crate are listed below. Note that this is the maximum size and

weight. The size and weight of the crate may be less depending on your configuration. You may
receive multiple crates depending on your configuration.

Size 152.4 cm x 124.46 cm x 152.4 cm (60 x 49 x 60
inches)
Weight 453.592 kg (1000 Ibs.)
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RECOMMENDATIONS PRIOR TO INSTALLATION

Before the machine is installed, the Pressco installer, together with the Customer (or
representative) shall check the following criteria in the environment where the machine is to
be installed:

e Work required by contract for the installation of the machine has been carried out

e The plant layout drawing that describes where the machine will be installed is the final
drawing agreed to by Pressco Technology Inc.

e The space and height required for installation are actually available

e Only the components included in the installation layout are present in the area where the
machine is to be mounted. Ensure no machines or components have been added at a later
stage that might hinder mounting or make it more difficult. Should this be the case,
immediately contact Pressco's Project Engineering personnel to arrange a suitable solution
to the problem.

We recommend the following prior to machine installation:

e Transport the machine in its packaging to the area where it will be installed to minimize
possibility of damage

e Carefully remove the packaging material and check components for damage

e Check tightness of mechanical components, as they can loosen during transport

e Prepare the compressed air mains line. Before making final connections, ensure that the
pipes are clean and free from any debris.

SYSTEM BLOCK DIAGRAM - INTEGRATED TUNNEL

Below is a basic block diagram for Series V Intellispec. This drawing shows the major
components for the system. Your system will contain only the components required for your
application. The numbered components are listed in the table below.

The drawing below shows a basic block diagram for a system with an integrated tunnel (with
one camera).
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1 User Interface (PC, monitor, and UPS)

PDN (Pressco Data Network) ethernet green cable

Inspection sensor/ camera ethernet blue cable

Light tree (optional)

| b |lw | N

Sensor cables (for part present sensor, encoder, machine part, pocket detect,
reject confirm) For details: I/O connectors (see "Chromapulse module
external connections" on page 400)

6 AC power

7 Integrated tunnel (example: CP/EV inspection module)

ASSEMBLY, LOCATION, AND MOUNTING
REQUIREMENTS

The Intellispec requires the following:

Utilities to be supplied by customer

The following utilities are required to operate the Intellispec Series V system. Before making
connection, make sure the utility matches the technical specifications. More than one
connection of the utilities may be required depending on the number of modules installed.
Refer to specific wiring diagrams.

Utility Requirements

Air supply for rejection | Pipe size must be such that there will be no pressure decrease during
device machine operation. Air must be dry and free of oil.

Electrical supply Provide one each electrical socket to comply with:

User interface electrical specifications (on page 20) (use the
specifications that apply to your system)

Integrated tunnel electrical specifications (on page 21) (if

applicable)

Cluster box electrical specifications (if applicable)
Internet connection Provide a shielded ethernet cable to use Pressco's remote support through
(optional) the Internet.

Protective earthing

This product must be grounded (earthed). If it should malfunction or break down, grounding
provides a path of least resistance for electric current to reduce the risk of electric shock.
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Danger
Improper connection of the equipment grounding conductor can result in a risk of electric
shock. Check with a qualified electrician or service technician if you are in doubt as to whether
the product is properly grounded.

Cord Connected Equipment

The product will be equipped with a supply cord having an equipment grounding conductor
and a grounding plug. The plug must be plugged into an appropriate outlet that is properly
installed and grounded in accordance with local codes and ordinances.

Do not modify the plug provided with the product - if it will not fit the outlet, have a proper
outlet installed by a qualified electrician.

Cable Direct

This product must be connected to a grounded metal, permanent wiring system, or an
equipment grounding conductor must be run with the circuit conductors and be connected to
the equipment rounding terminal.

Electrical connection

Make sure that the power outlet voltage matches the voltage required by the machine. Refer
to the specifications for equipment included with your system:

e User interface electrical specifications (on page 20)

e Integrated tunnel electrical specifications (on page 21) (if applicable)

e Cluster box electrical specifications (if applicable)

£L__—_\ Warning
Power Switch is the power disconnect device. Do not position the equipment such that access
to the disconnect switch is impaired. If not readily accessible (such as within a rack or mounting
out of reach), an additional disconnect device should be installed that can isolate the Live and
Neutral lines of the mains power supply, whilst leaving the protective earth intact.

Installation

Pressco Technology Inc. recommends that the machine be installed and assembled by Pressco's
specialized technicians. This is of vital importance for correct machine operation.

L——_ Warning

Pressco Technology Inc. shall not be liable in case of failures or damage to property and/or
personal injury resulting from or connected with assembly if this has been carried out by
unauthorized personnel, or is not in compliance with the indications given in this manual.
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To carry out production and cleaning/ servicing operations, it is important for the machine to
have a minimum amount of space all around and away from walls.

Ventilation

Place the Intellispec Series V components in a position with adequate ventilation to allow
proper air flow through the air filters.

Component Spacing

User Interface Leave 1 meter [39 inches] clear around machine
Cluster box (not used on all Leave 100 mm clear in front of the fan and vent
systems)

Stability of user interface

Ensure the stability of the user interface. Also refer to the directives in the Personnel Safety
(on page 14) section.

» To make sure the user interface is stable:

1. Make sure that the user interface stabilizer [item 1] is secured properly to the user
interface.

2. Adjust the feet [item 2] to level the user interface. Proper leveling can help ensure proper
operation.
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COMMISSIONING

Before placing the machine into operation, make sure the following checks are completed:

Completed Yes No

Positioning and leveling of the unit

Connection of compressed air line to connection points

Connection of power supply to user interface cabinet

Connection of power supply to cluster box (if applicable)

Connection of power supply to integrated inspection module(s) if
applicable

Proper wiring from user interface cabinet to sensor module(s) and
cluster box (if applicable) using the wiring diagrams
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Chapter 5
NAVIGATING THROUGH THE SYSTEM

This section describes the regions of the user interface and how to navigate through the
software. It also describes how to select items and how to use the user interface buttons.

INTELLISPEC CABINET AND USER INTERFACE

INTZLLISPEC

1 24" Diagonal color LCD with optional touch screen. An on-screen keyboard
(OSK) is displayed when needed.

2 Trackball with two sets (left-handed or right-handed) of buttons: Select

buttons [@] and Information buttons [@¥]

3 Vision processor on/off switch.
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4 Inside the cabinet:

Ethernet switches

Vision processor
Mechanical keyboard (MKB)

5 USB convenience port is mounted on the side of the user interface.

Monitor

The standard monitor is an LCD color monitor mounted on a mechanical arm to allow the user
to tilt or swivel the screen for best viewing. It has an area of 1920 x 1200 pixels and a diagonal
size of about 24 inches.

Touch Screen Monitor (optional)

Some Intellispec systems have a touch screen monitor installed. It has an area of 1920 x 1200
pixels and a diagonal size of about 24 inches. This is used primarily for high level navigation,
obtaining information from the system, and responding to alarms. It is not to be used for
inspection setup or configuration tasks, as those tasks require detailed input.

Use the touch screen to:

e Llogin/out

e Put the system online / offline

e (lear statistics

e Print reports

e Acknowledge or reset Alarms

e Navigate the menus (from System Overview to Lane View to Sensor view, etc.)
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USER INTERFACE INPUT DEVICES

The following devices are available to input information to the Intellispec system:

e Trackball and buttons (see "How to select menu items" on page 36)

e On Screen Keyboard (OSK) (on page 36)

e Touch Screen monitor (optional) (on page 34)

e Temporarily connected conventional Mechanical Keyboard (MKB) (on page 38)

e USB Ports (on page 38)

e Optional Biometric Identification login device (see "Biometric login device" on page 39)

User interface selection devices

The user interface hardware consists of several buttons and selection devices:

1 2

1 (not a button) Grommet for user interface equipment cords.

2 Optional Biometric Identification login device

3and [ Secondary set of buttons, used with track ball. See also items 6 and 7.

4
5 Track Ball
6 Button (left-click) to select and activate objects on screen
7 Button (right-click) to call up a context-sensitive menu about the selected
object on screen
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How to select menu items

Use the track ball to select, interact, and change active objects on the screen. The track ball will
be required for all inspection editing tasks.

Under the track ball are two buttons. Use the left button (the primary button @) to select

and activate objects on the screen. Use the right button Q to call up a context-sensitive
menu related to the area or object clicked. A second set of each button type is located on the
left side of the podium for two-handed operation.

7

** Note: Swapping the button assignments is not supported. The second set of buttons is to
accommodate left-handed users.

The following table shows the actions available for the track ball and buttons, and the results of
those actions.

Action Result

Point (move pointer with the Display Tool Tip when hovered over active object
track ball)

Click (Left-click) @ When the pointer is over an active object, a click

initiates various actions. Nothing happens when
the pointer is clicked on a disabled object.

. When the pointer is over an active object, a
Double-click @ @ .p o . . )
double-click initiates various actions. For example,

edit an inspection.

Right-click e Display a context-sensitive menu when you click on

an enabled object. The context-sensitive menu
often contains functions that are also available in a
menu bar or other screens. For example, add a
point to a polygon.

Drag (hold the left button while | Examples: move a selected Region of Interest (ROI)
moving the track ball) around an image or move an inspection in a Tree
View to change the order of execution.

On Screen Keyboard (OSK)

Different types of on screen keyboards will be displayed depending on what kind of input is
needed. When you want to type text or numbers into a field, right-click or double-click on a
text input field to display the appropriate keyboard.
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e If alphanumerical input is needed, a full alphanumeric keyboard will be displayed
e In numeric input only is needed, a smaller, numeric keypad only will be displayed

Alphanumeric keyboard
( Login
Unsr Mame m___‘l'__l

Passward

112314l s]6] /18] o] o o=
mJo[wle[ [Tl [ole
=Lale[alTolnl [l 1 [
80000008
—
3 4

1 2
1 Shift lock button - capitalizes all letters until you press this button again.
2 Shift button - capitalizes one letter, then returns to uncapitalized letters
automatically.
3 OK button - accepts the typed information and closes the keyboard screen.
4 Cancel button - disregards the typed information and closes the keyboard
screen.

Numeric keyboard
The numeric keypad is displayed when the input field requires a numeric entry. Most of the
buttons are self-explanatory. Additional buttons are described below.

Note: some buttons are not displayed if they are not appropriate for that field.

7
L4

34586

1 Backspace - removes a digit
2 Enter - populates the field in the Intellispec screen without closing the
keyboard. This is useful if you want to test a value and see the results of the
change immediately.
3 [+/-]  makes the number positive or negative
4 [.] available only if a decimal number is valid in the input field
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5 [<=>] cycles to the next limit of the parameter. If the parameter has more
than two limits, then asterisks will surround the selected value in the menu.

Ambient Technigue Dresresity

Ambient Arabkysis Mode hliry & W
Region Extract Mathad Feg Badally

Merminal 128

G accepts your changes and closes the numeric keypad

Mechanical keyboard (MKB)

The system supports the temporary connection of a conventional mechanical keyboard using
one of the available USB ports (on page 38). This keyboard will mostly be used for system level
tasks such as BIOS configuration, Network configuration, and Operating System level setup.

The keyboard:

e Is primarily used by Pressco Field Service Engineers
e |sstored inside the Vision PC chassis

e Requires a stable location when in use

USB Ports

There are USB ports available to back up or transfer data, and also to connect the optional
mechanical keyboard. One is mounted on the side of the user interface pedestal.

Some touch screen monitors have additional USB connectors on the side of the monitor.
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Biometric login device

The Biometric Identification login device (see "Adding a user with the biometric login device"

on page 52) is used to log in and out of the Intellispec system. This device is optional and must
be purchased with the system.

To log in with this device, press your finger to the device. The following are conditions for use:
e You must use the same finger as initially set up by your administrator

e If you do not know how your account was set up (or which finger you used), contact your
administrator

e If, after three tries, the Intellispec does not recognize your finger print, you must log in
using the on screen keyboard (OSK (see "On Screen Keyboard (OSK)" on page 36))

USER INTERFACE DISPLAY - 4 LEVELS

The display on the user interface has four levels for viewing:

System Overview

Look at the tab at the top of the screen to quickly determine which level you are viewing (from
System Overview to Sensor Overview). The tab will read "System Overview" [level 1], "Lane n"
[level 2], or "sensor name" [level 3]. In the Inspection Screen [level 4], the tab also reads
"sensor name," but the inspection graphs and parameters are available to view and edit.

«» Note: when you switch between System Overview and Lane Overview modes, you will see
one screen 'minimize’ to the task bar while your selected screen is displayed. This is normal.

» To view the four viewing levels:

1. Click the Home button E to go to level 1, System Overview.
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= System Overview - Displays information that represents the complete system as well as
a thumbnail line for each Lane that is configured. More information about the System
Overview screen (on page 42).

(o] ! [ /=]~ [e] 2 T e [Drressco mrawsesc

2. Click a Lane button to go to level 2, Lane Overview.

= Lane Overview - Displays information for a particular Lane as well as a thumbnail line for
each sensor used in that Lane. More information about the Lane Overview Screen (on
page 43).

01 PRESSCO INTELLISPSC
D

Wi | Daleel % '| =eries | Lana Talal ) ——
i

3. Click a Sensor button to go to level 3, Sensor Overview.
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Sensor Overview - Displays information for a particular sensor, including an image area,
sensor statistics, a graphics area that displays user-selectable graphs, and a

user-selectable inspection list. More information about Sensor Overview Screen (on
page 44).

001 st @PRESSCO INTELLISPSC

1004 {mace)

-/ % Patt=rn Match
<@ Polygon [1]
& Comtrast [1]
4. Double-click an inspection name ~~#FeWaeniZl iy the Analysis Inspections list to get
to level 4, Inspection Screen.

% Note: Some menu items are only available to advanced level users.

= |nspection Screen - Double-click on any inspection name to see this view, which allows
you to see |nspect|on parameters and make changes if necessary.

& @mﬂsco INTSLLISPEC

RETRO-SPEC in-ﬂon View: Contrast

5. Click the exit button e to go back to level 3 Sensor Overview mode.
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System Overview screen

For a description of the toolbar icons, see Menu Toolbar (on page 45).

123 45 67

10 é&éé&é&. —t

Detects.
V LIL]]

@mﬂsco INTELL | PEC

System Overview

9 e ,
2 ﬂ' Lane 2 =y
Ilduu 3
" __Mam minuten)
13 | o=
B o
- DIME v n::::‘ einnes)
14 —

\
|
Q..@—w

1 Home
2 Alarms
3 System Settings
4 Favorites
5 Wizards
6 Language
7 Help menu (Remote support only at System Overview)
8 Login
9 Walk By Graphic
10 Click to go to Lane Overview
11 Lane Statistics
12 Current Part Program
13 Online/ Offline
14 Heartbeat Image
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Lane Overview Screen

d = T — = 5
2 DOB OO0 g o e
120 (max) TECHNGIOGY 1ML

Wiz Parts ¥ Vs | Defect® ¥ Series- || ane Total v)

[ Trend Graphs

-

r Trend Graphs

r_ Cavity

r Inzpections

r_ Stalistics

VHTF0N 4:21:11 PM

1 Click the sensor button to toggle to detailed Sensor View and back

2 Switch to System Overview

More Lane Information

e = More Lane Information .

Under the Lane Overview screen, click the More Lane Information bar to display additional
graphs, statistics, or an additional Walk By graphic. Buttons on the right side of the screen
provide different viewing options.

Sensor Information

Sansor Informaltion

Under the Lane Overview screen, click the Sensor Information bar (at the bottom of the screen)
to display the default sensor information. Graphs, images, or statistics are displayed depending
which button on the right is selected.

Statistics menu

Use the Statistics menu in the Lane Overview screen to view, reset, or print statistics.

< Note: Some menu items are only available to advanced level users.

» To view the Statistics menu:
1. Goto the Lane Overview screen by clicking a Lane n button.
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2. Click over a statistics box. The Statistics menu is displayed. The items in the menu are
described below.

Total Parts Statistics Menu
2465 Clear Lane Statistics
Defects -, Clear Lane Statistics and Clear Images
264 Clear SPC Statistics Only
Clear Machine Part Statistics Only
Defect % Print Lane Report
14.767 ) _ Statistics Last Reset |

Clear Lane Statistics
Clear the statistics for the lane only.

Clear Lane Statistics and Clear Images
Clear the statistics for the lane and empty the defective image buffer.

Clear SPC Statistics Only
(Only available if you have Retro-Spec inspections enabled to keep SPC data) Clear the
statistics statistical process control. See Statistical Process Control (see "Statistical Process
Control (SPC) Charting" on page 89).

Clear Machine Part Statistics Only
(Only available if machine part correlation is enabled on your system) Clear the statistics for
the machine parts. See Machine Part Correlation (on page 117).

Print Lane Report
Send the lane statistics report to the default configured printer.

Statistics Last Reset
Display the date and time when the lane statistics were last reset.

Sensor Overview Screen

120 ppm PRESSCO INTZLLISPEC
120 (max) TECHNGIOGY INC.

Sedes: (| Total - o
(RN [

([FT———

_rRajar_‘t Images

Defect %
24.101

-/ Inspectons
- @ Registration ROI
- ® Registration
@ Fim RO
* Rim Inapection
1 e — ] Registration ROI
“I13 Drientation Ragistration
- & Btwn Letter RO Jle)
# Btwn Letter Inspection Rim Inspection
- @ Liberty Date ROl Ovienialion ROI

# Liberty Date Inspection = .
L Bitwn Letter RO

Btwn Letter Inspection
# IGWT Inspection
e TR Liberty Date RO
1
.t I'IB?\ o - Liberty Date Inspection
ot Blgrd Inspection \GIAT RN

= @ Collar ROI

® Right Bigrd Inspection Lot Blgrd ROI Statistics

Lett Bkgrd Inspection
# Collar Inspection Right Bkgrd RO!
Right Blkgrd Inspection
Callar ROI

VHIF0N 42539 PM
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1 Double-click to open Inspection View

2 Switch to System Overview

Inspection Overview Screen

2
OB DA00 = e W

0 (max)

™ Lane 1 Lot 00 Rery RETRO-SPEC Population View: Rim Inspection
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B Acceprabie Size 500
Sizing Total it
@ Color RO - 1 Regian Extraction Read Radisly
#* Color Inspaction \ m Advanced Setings
@ Lattering ROI \ i X B Sepment Safings
# Lefterng Inspactian \
& Rim ROl
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# Symbol Inspectic

[Contrast Limits] Determines how strong a gray shade variation
has to be before it is 3 candidate for a defect feature).

GG 1

120612011 5:22:53 Pd

1 Close the Inspection View
2 The inspection window must be closed first to switch to System Overview
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MENU TOOLBAR
1 2 3 . 5 6 7

1 Home

Alarms

Tools

Wizards

Language

2
3
4 Favorites
5
6
7

Help

Home
Click Home to return to the System Overview Screen. If a region or inspection editor menu
is open, you must close it before anything else can be selected. The Home button is
highlighted in the System Overview screen.

Alarms
When this icon is selected, a different pop-up window appears depending on what screen
you are on. For more information, refer to the section about alarms (on page 93).

Tools
When this icon is selected, a different pop-up window appears depending on what screen
you are on. For more information, refer to the section about tools (see "Tools Menus" on
page 105).

Favorites
From the Lane and Sensor Overview screens, you can select between Take Screen Shot and
Defect Database.

Wizards
From the Lane or Sensor Overview screens, select wizards that assist in setting up certain
features. At the present time the only wizard is for setting up the Walk By graphic. This
allows you to select group names, inspections assigned to each group, and values that
determine when areas of the Walk By graphic turn to yellow, red, or back to normal (green).

Language
Select an available language from this menu.

Help
From the Lane or Sensor Overview screens, access the help documents, support package
utility, remote support option, and software version.
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Language

E Click the language button to select a different language. Choose from the available
options.

Language Settings

Q English

Select Language:
svenska \J ]

Select Language for Report Output:

italiano '—]
English

If this box is checked, the names of the available languages are displayed in US English
(example: Swedish instead of svenska).

Select Language
Select the language to display on the user interface.

Select Language for Report Output
Select the language for the reports, such as the Lane Report from the Statistics menu (on
page 43).

Install Language Pack button
When a new language is available, use this option to install the proper files. You will receive
instructions from Pressco to install the language pack.

Help

Click the Help icon to:

e use the help files

e create a support package (see "Creating a Support Package" on page 145)
e access Pressco remote support (see "Help - Remote Support" on page 147)
e open Windows Explorer (administrators only)

e obtain your current software version

Help Menu

Help Documents ’
Create Support Package
Remote Support

Launch Windows Explorer
About
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> To access the user manuals:

1. Click the Help icon .
2. Select Help Documents, then select a manual from the list. The user manual is displayed.

ONLINE / OFFLINE

Q *  The stoplight is the online/offline indicator for each lane. A red light indicates
the lane is offline; a green light indicates the lane is online.

Ir"'_ *  To switch from the online to offline mode, or vice versa, click the stoplight.

Lanes can be put online or offline independently. If multiple lanes are
configured, then one can be offline while another is online.

EXITING THE INTELLISPEC SOFTWARE

You must have proper user permissions to exit the software. This prevents unauthorized
system shutdowns. Contact your system administrator if you need user permissions.
> To exit Intellispec software:

Login.

Click the Home button n

1
2
3. Click the Tools button to display the Tools menu.
4. Click the Exit System option.

5. Adrop-down menu allows you to choose an option:

= Shut down the Intellispec software only

= Shut down the Intellispec software and computer

=  Shut down the Intellispec software and restart the computer

SHUT-DOWN SYSTEM

Intellispec Only v
Intellispec Only J

Shut Down Intellispec and Computer
\Shut Down Intellispec and Restart Computer

00O

6. Choose the desired option from the menu and click the OK a' button. The Intellispec
software and/or computer shuts down (and restarts if applicable).
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Chapter 6

USER ACCOUNTS AND LOGIN
INFORMATION

This section describes how to log in and how to manage user accounts.

LOGGING IN AND LOGGING OUT

Each user account has a list of permissions and restrictions. This is to give administrators more
control over the system, and restrict others from performing tasks like changing lighting, or
adding and editing inspections. When you log in, you can perform the tasks made available to
you.

> Tolog in, follow either of the steps below:

e Click the Log In button MJ to display the login dialog box. Select your user
name from the drop-down list. Enter your password using the On Screen Keyboard by
touch screen or trackball and buttons. The password characters will not be shown for
security reasons.

e [With the optional biometric sensor] Press your finger to the sensor. The system will
automatically determine your identity and log you in. If the system fails to recognize your
identity after three attempts, the log in dialog box will appear, to allow you to log in with
your user name and password.

» Tolog out, follow either of the steps below:

e Click the Log In button that displays your user name. The account drop-down menu
appears. Select the Log Out button. The system logs you out.

e [With the optional biometric sensor] Press your finger to the sensor. The system logs you
out.

¢ Note: When another users logs in, the system automatically logs you out.

LOG IN MENU

To ensure that only authorized users perform certain changes to the system, users are required
to log in*.

¢ Note: Accounts may be shared by a group of people (example: Shift 1).

» To view the Log In menu:

1. Click the Log In button =e0/n 'J and enter your password. The text on the

button changes to indicate who is logged in.
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2. Click the Log In button again (which has your user name displayed on it). The Log In menu
is displayed. Some options in this menu are only available to authorized users.

[

1 —= Logout

2 = Switch User

3 —* Change Password

4 Manage Users

5 —TExpurt Users

5] T Impaort Users

7 —* Manage Permissions

8 —Jt Setup Auto Logout _/

1 Logout - Logs out whoever is logged in

2 Switch user - Allows you to switch from one user to another

3 Change Password (see "Changing your password" on page 51)- Allows you
to change only your password

4 Manage Users (see "Managing user accounts" on page 51) — Used to assign,
remove, or edit users. This is where users are given access to specific tasks
(example: one user is given the access to edit inspections and another is not
given this access). You can also give users access to specific tasks through
Manage Permissions (see "Managing Permissions" on page 56).

5 Export Users (see "Exporting user accounts" on page 54) - Allows you to
export user profiles from one Intellispec to another

6 Import Users (see "Exporting user accounts" on page 54) - Allows you to
import user profiles from one Intellispec to another

7 Manage Permissions (see "Managing Permissions" on page 56) — This is
where the system can be configured to allow pre-defined tasks to be
performed with no log-in

8 Setup Auto Logout (see "Setting up Auto Logout" on page 61)— This feature
will automatically log you out if there is no activity for a defined amount of
time

*Some tasks can be configured so that users do not need to log in. This is done through
Manage Permissions (see "Managing Permissions" on page 56).

«» Note: There is a Pressco Technician account for use only by Pressco Service Engineers. This
gives access to unsupported features (menu items are a different color). If you log into this
account and use those features, do so at your own risk.

SWITCHING USERS

The Switch Users option from the Log In menu logs out the current user, and allows a new user
to login.

> To switch users:

1. Click the Log in button (which has the current user's name displayed).
2. Select Switch Users from the menu.
3. Select the new user name from the drop-down menu.
4. Enter the new user's password. The new user is logged in. The previous user is logged
out.
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>

If you have a biometric sensor:

Press your finger to the biometric sensor device to log in. The previous user will be
automatically logged out by the system.

CHANGING YOUR PASSWORD

The Change Password function is available to all users.

7
°

Note: an Administrator can reset a password if necessary.

» To change your password:

N ousrwnNE

Login.

Click the Log In button with your user name to see the Log In menu.
Select Change Password. The Change Password dialog box is displayed.
Enter your Old Password.

Enter a New Password.

Confirm your New Password.

Click the OK button @ to accept the changes. The dialog box closes and your password
is changed.

MANAGING USER ACCOUNTS

The Manage Users button is only available to those with the Manage Users permission. This
feature provides a wizard that allows you to Add a new user, Edit a current user or Remove any
user. You may create one user account for a group of people and give that group the password
to the account (example: Shift 1).

K/
0’0

Note: the biometric login features are only used when the optional biometric login device is
installed

» To manage a user account:

PwwnNnpRE

Log in as an administrative user.

Click the button with your user name to see the login drop-down menu.

Select Manage Users. The Manage Users dialog box is displayed.

Select Add, Edit, or Remove a user. Follow the information on screen to complete these
actions. The current step is highlighted on the left side of the configuration screen [item 1
in illustration below], and is repeated at the bottom of the screen.
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5. Use the forward arrow button [item 2] to move to the next screen after you have entered
the appropriate information. Use the back arrow button (not shown in first step) to
return to the previous step. You do not need to enter information in each screen to move
from one screen to the next.

Configuration Manage Users

~ Step 1 of 8 : Users -

e v
Fress Mre ADS balhon 1o ol & scw et j

Sedect 4 vt and peeax the Ldi busons o

Uscf Namo . WOdly » user Piras the emove Sumon 4o
Ty s m
Ramove

Steps

Users

Password

Biometric Login
Select Finger

Finished

1 2
1 Current step in the wizard is highlighted.
2 Forward navigation to move to the next step. A back arrow (not shown) is
available in later steps.

Adding a user with the biometric login device

When you have the optional biometric login device installed, you will need the user present.
The biometric login uses finger recognition software to log in rather than selecting a user name
and entering a password. You can always log in (see "Logging in and logging out" on page 49)
using your user name and password, even if you have a biometric login device. The maximum
number of biometric accounts is 40.

‘0

e Note: use of one account by a group of people is not supported with the biometric device.
Each user must have his or her own account.
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2
L X4

Additionally, you cannot create two accounts for the same finger print. You could create

two accounts for one person, but you must use two different fingers.

» To add a user with the biometric login device:

Log in as an administrative user.

Click the button with your user name to see the login drop-down menu.
Select Manage Users. The Manage Users dialog box is displayed.

Click the Add button.

Add the user name when prompted. Click the forward arrow.

Enter a password, then Confirm it. Click the forward arrow.

NoubkwnNpeE

[Biometric login] The next screen gives you the option of creating a biometric login or

skipping over it. If you chose Skip, go to step 10. If you chose Create, go to step 8.

8. [Select Finger] Choose which finger the biometric sensor will read. Select any finger by
using the touch screen or trackball and buttons to choose the circle above the finger.
Only one finger can be used, and you must use this finger every time when logging in.

Click the forward arrow.
Manage Users

«580p 5 of 8 Select Finger

Swnct 8 Anger 1o e o Beomenic o gn J

G C
s

nee

9. [Read Finger] Click the Start Button at the top of the screen. The system will ask you to
place the finger you selected on the biometric sensor. To ensure an accurate biometric
measurement, you are asked for three readings. Instruct the user to place his or her
finger on the biometric sensor three times when prompted. Click the forward arrow.
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10. [Permissions] This is where you can set up what each user can and cannot do within the

system. After you have selected the desired permissions, click the forward arrow. You can

also change permissions later. For more information, see Managing Permissions (on
page 56).

11. [Finished)] Click the OK button G to accept changes and exit.

EXPORTING USER ACCOUNTS

This allows you to export user accounts from one system to another. The user accounts may be

used in other Intellispec Series V systems in your plant. You may also want to back up your user
accounts in the event they are changed in the system.

>
°

What you need:

A USB memory device to export or import data
User access permission to change permissions

» To export a user account:

1. Login as an administrative user.
2. Insert the USB (see "USB Ports" on page 38) device into an available slot on the
Intellispec Series V system.
3. Click the button with your user name to see the login drop-down menu.
4. Inthe user login drop-down menu, click Export Users. The Export Users dialog box is
displayed.
Export Users
CAPresscol208100sers Y | m
Current Users Exported Users
Administrator
Designer
Mechanic
Olps=rator
Select the user account that you want to export.
6. Click the right arrow n to export the user account.
7. Choose the destination to save the user account from the drop-down menu, or click the
Save button m to browse to the USB device.
8. Click OK G to accept changes and exit the screen. The user account is exported.
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IMPORTING USER ACCOUNTS

This allows you to import user accounts from one system to another. The user accounts may be
used from other Intellispec Series V systems in your plant.

S

> What you need:

e A USB memory device with user accounts already saved on it, or a folder on the Intellispec
hard drive with valid user accounts
e Administrative access to user accounts

» Toimport a user account:

1. Login as an administrative user.

2. Insert the USB (see "USB Ports" on page 38) device into an available slot on the
Intellispec Series V system.

3. Click the button with your user name to see the login drop-down menu.

4. Inthe user login drop-down menu, click Import Users. The Import Users dialog box is
displayed.

Import Users

CAPressce 2061 0Wsers Y |

Camrent Lisers Imponatsle Users
Aciniratar Machani

Dasigrer

Wt g

Operatar

20

5. Select the user account that you want to Import from the right column. If you do not see

any users available, click the Save button m to browse to a location where the user
account is saved.

Click the left arrow u to import the user account.

Click OK @ to accept changes and exit the screen. The user account is imported.
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MANAGING PERMISSIONS

The Intellispec has some default permissions that you can use to quickly set up users. To grant
these permissions, click the appropriate button in the Manage Users screen. When you select
these default permissions, you could also add or subtract specific permissions for the user.

1
Cﬂnﬁguratiﬂn Manage Usars (Operator)
$laps — Etap 7 of B : Parmiaaiona —
User Hamo Frrmiasions P
Blomsatric Login
Road Finger E
Finished ol = |
(o | )
20
1 Choose from one of the predefined Roles to use the default permissions
2 Subtract one of the Granted Permissions. First highlight the permission in the
list, then click the left arrow.
3 Choose one of the Denied Permissions to be granted. First highlight the
permission in the list, then click the right arrow.

Notes about roles and permissions:

e Granted permissions have priority over roles. If you change the permissions of a role, or
change the role of a user, the granted permissions persist.

e When you change permissions for a role, all users with that role get the new permissions of
that role. This is useful to change permissions for groups of users.

Standard Role Setups Default Permissions

Not logged in Access Image Tools
Clear statistics

Operator Forced reject sampling
Online

Offline

Open help sessions
Run Mass Recorder

Switch part program
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Standard Role Setups Default Permissions

View system logs

Mechanic Access system configuration
- all Operator permissions, plus: Access system diagnostics
Configure alarms
Configure charts
Configure statistics
Configure walk-by graphic
Edit inspections

Edit lighting

Enable inspection items
Manage part programs
Rollback part program
Run Mass Manager

Setup report schedule
Shut down system

View change logs

Designer Access advanced inspection parameters
- all Mechanic permissions, plus: | Design inspection tree

Enable defect database

Administrator Adjust date and time

- all Designer permissions, plus: Install language pack
Manage user accounts
Setup printer

Switch report language

Pressco Technician All Permissions

The following table provides a brief description of all the available permissions. Note that some
permissions may not be available in your list. The options that have been permitted without
login are removed from the list. For more information, refer to Editing Permissions (on page
60).

Permission Description

Access image tools (see "Image | Gives you access to the Image Analysis Tools.
Analysis" on page 158)

Clear statistics Allows you to reset inspection statistics.

Operator

Forced Reject (on page 125) Allows you to request forced reject sampling.

Sampling

Online (see "Online / Offline" on | Allows you to put a lane online.

page 48)

Offline (see "Online / Offline" on | Allows you to put a lane offline.

page 48)

Open help sessions (see "Help - | Allows you to start a remote help session with Pressco Technical
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Permission

Description

Remote Support" on page 147)

Support.

Run Mass Recorder

Used with mass sensors, this allows you to enter sample data from
cut and weighed bottles.

Switch part program

Allows you to change the part program that the system is currently
running. This also allows you to add a new part program.

View system logs (see "Log
Reader" on page 111)

Allows you to view the system logs.

Mechanic

Access system configuration

Allows you to change system configuration values.

Access system diagnostics

Allows you to perform system functions including 1/0 and
correlation diagnostics.

Configure alarms

Allows you to configure the lane and sensor alarms.

Configure charts

Allows you to configure trend charts and other statistics charts.

Configure walk-by (see "Walk
By Setup" on page 64)

Allows you to name, set up alarms, and set up which inspections will
be used with a particular region on a part. These regions are
displayed in the walk-by graphic.

Edit inspections

Allows you to edit existing inspections.

Edit Lighting (see "Sensor menu"
on page 155)

Allows you to change the lighting settings for each camera.

Enable inspection items (see
"Inspection menu" on page 196)

Allows you to enable or disable individual inspections and the
rejecter for those individual inspections.

Manage part programs (see
"How to Create, Copy, or Import
a Part Program" on page 193)

Allows you to create, import, export, copy, or load part programs.

Rollback part program (see
"Part Program Change Log" on
page 198)

Allows you to roll the current part program back to a previous state.

Run Mass Manager

Used with mass sensors, this allows you to select appropriate
Scaling Recorder sessions to scale the Intellimass readings.

Setup report schedule (see
"Schedule Reports" on page 109)

Allows you to schedule statistics reports to be generated
periodically.

Shut down system (see "Exiting
the Intellispec software" on
page 48)

Allows you to shut down the Intellispec system.

View change logs (see "Part
Program Change Log" on page
198)

Allows you to view the inspection change logs.

Designer

Access advanced inspection
parameters

Allows you to access advanced parameters inside of the inspections,
and access some inspection tree items (such as regions).

Configure statistics (see
"Statistics Configuration" on

Allows you to configure how the statistics graphs are displayed.
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Permission Description

page 87)

Design inspection tree Allows you to add or delete inspections.

Enable defect database Not available as of this printing.

Administrator

Adjust date and time (see Allows you to adjust Intellispec system date and time.
"Adjusting Date and Time" on

page 143)

Install language pack (see Allows you to update the language files for the user interface, if
"Language" on page 47) provided by Pressco.

Manage user accounts (see Allows you to open Manage Users which lets you add, edit and
"Managing user accounts" on remove users.

page 51)

Setup printer (see "Setting up a | Allows you to configure a printer for Intellispec reports.
printer" on page 144)

Switch report language (see Allows you to choose a language for the Intellispec reports.
"Language" on page 47)
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Editing Permissions

This feature allows you to set up permissions that will be available when no one is logged in. It
also gives the selected permissions to all users. Once a permission has been selected, it will no
longer appear in the available or selected columns when adding or editing a user in the
Manage Users option. This feature is only available to Administrators (with Manage Users
permissions).

r

Edit Permissions 1
Mol logged in Y|
Dramied Garadied

ACCEEE IMEns ok
Ancess Sestam canfiguration
Acoess Hpsfam diagnosics
Acfust data ard dme
Clear statistics
Canfigurs @arms
Canfiguna chars
Canfigura siatistcs
Canfiguna walk-by
Dasigninspecion rae
Ecki napsctions

Eckt ighting

Enabli defact ot e
Enable inspection kames
Fangil reject sampling
o off-ire

0 pn-ine

MaEN &8 LS Er BCOLNTS
Open help 8essions
Ralback part progrsm
Sehip printar

Selup report scha ks
Shui-doasm sy atem
Swikch part progran
Wikt change loge

Wikl ByETEM kg

2L Ax)

» To grant permissions to all users:

N ok wWwNE

9.

Log in as Administrator.

Click the Log in button with your name on it to see the Log in menu.
Select Manage Permissions. The Edit Permissions screen is displayed.
Click the Roles button.

From the drop-down menu below Roles, select "Not Logged In."
Highlight the desired permission in the left column.

Click the right arrow n to move the permission to the right column.
Repeat the above two steps for all desired permissions.

Click the OK button @ to accept changes and exit.

You can also remove permissions from all users that are assigned specific roles.
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_ ¥ Caution
Be sure you select the User name from the drop-down menu before you change Roles.

Otherwise, you could change your Administrator permissions (example: from Administrator to

Operator, and not be able to Manage User Permissions afterwards).

A

r

vk wnN e

N

9.

To remove permissions from a role:

Log in as Administrator.

Click the Log in button with your name on it to see the Log in menu.

Select Manage Permissions. The Edit Permissions screen is displayed.

Click the Roles button.

From the drop-down menu below Roles, select the role from which you want to remove
the permissions.

Highlight the desired permission in the right column.

Click the left arrow m to move the permission to the left column.
Repeat the above two steps for all desired permissions.

Click the OK button @ to accept changes and exit.

You can also manage permissions for any user.

> To edit a user's permissions:

PwwnNpRE

Log in as Administrator.

Click the Log in button with your name on it to see the Log in menu.

Select Manage Permissions. The Edit Permissions screen is displayed.

Select a user from the User drop-down menu.
Move the desired permissions between Denied and Granted. Or:
Assign that user a new role. For example, change Jane's permissions from Operator to
Mechanic. The user will acquire all permissions for that role, including any that you have
assigned separately from Pressco's default settings.

Repeat the above step for all desired permissions.

Click the OK button @ to accept changes and exit.

SETTING UP AUTO LOGOUT

This feature will automatically log you out after a set number of minutes of inactivity.

» To set up Auto Logout:

pwNPE

Log in as an administrative user.

Click the button with your user name to see the login drop-down menu.

Select Setup Auto Logout. The setup menu is displayed.

Click the box next to "Auto Logout" to enable the feature. A check mark is displayed in
the box when it is enabled.

Set the Wait time in minutes by clicking the up or down arrows, or by highlighting the
number of minutes and typing a new value (from 1 to 9999 minutes).
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6. Click the OK button Q All users will be logged out automatically after the set number of
minutes of inactivity.

Auto Logout
kg retvronue
Wit {minutns) 680
&
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Chapter 7
GRAPHS AND IMAGE DISPLAYS

Several graphs are available on the user interface to help you view inspection trends. This
section discusses the buttons on the right side of the screen in the Lane Overview and Sensor
Overview modes.

WALK BY GRAPHIC
Walk-by

This feature uses a graphic representation of a part so that you can quickly identify which area
of the part is failing. It is called Walk By because you can quickly walk by the Intellispec and
look at the graphic to determine the status of inspection:

e Green areas indicate that parts are passing inspection.

e Yellow warning areas notify you that the spoilage rate is approaching, but has not yet
reached a critical level. This allows you to make necessary changes to the manufacturing
process before the failure rate gets too high.

e Red areas indicate the spoilage rate has exceeded user defined limits.

The defect percentage rate at which each group reaches warning or failure limits is defined in
Walk By Setup (on page 64).

There are two available Walk By Graphics:

e A small Walk By Graphic is displayed in System Overview, Lane Overview, and Sensor
Overview modes

e Alarge Walk By Graphic can be displayed in Lane Overview mode

» To see the large Walk By Graphic:

1. Click a Lane n button to view the Lane Overview mode.

2. Click the More Lane Information bar in the center of the screen to display more graph
options. 5 More Lane Informalion . & =

3. Click the Walk By button on the right side of the screen. & The Walk By
Graphic is displayed in the center of the screen.
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The large Walk By Graphic displays the group names, pointing to the appropriate areas on the
part. It also displays the current defect percentage for each of those groups, from inspection
results.

Panel (17.143)
Rim (8.571)
Text  (0.000)

Profile (8.571)

Using the Walk By Graphic
You can view inspection information by clicking on the areas of the graphic. The Intellispec will
display the configured inspection group and detail. The example below shows:
e The Panel group was clicked - all the inspections for Panel are displayed in the table

e The Panel area in the Walk By Graphic is red - The average defect % for the group of
inspections exceeds the failure limit from the Walk By setup (on page 64)

[ core i JRRCR

[ nspection [ Total I Detects [ Derect | " LastN %
F T‘::' PAME | & oiygon 312615 26794 B.5T1 78 7,800
D—zu | ot FNIEIE 44668 14.286 120 12000
Palygon MG 26704 28671 T8 T.200
—‘ Conliast aM2Bil6 IET2T 11.428 0% A0 500
2 Palygan 126818 26795 BE5T1 Ta 7.800
____,I]_llnl]
Contrast 312816 44650 14. 286 131 1100
Penny1 ‘I']

Double-click an inspection from the table (example: a Contrast inspection) to open and edit
that inspection. Note: Some menu items are only available to advanced level users.

Walk By Setup

This screen allows you to set up the Walk By Image. Each Lane can be set up differently if
needed.

Each area of the part graphic display is:
e Assigned a group name.
e Assigned the correct inspections for that group.

Configured to turn the area yellow or red when defined defect statistics are achieved.

7
°

Note: you must have correct user permissions to set up the Walk By Graphic. You must also
have a part program loaded.
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> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu >
Lane set up > Walk By Setup.

Walk By Groups
- Step 2 of 5 : Group Name -

Outer Edge Ender or edit the growp name. J

IIIIIII.IE-
[iJo]p
L

.lllll.l
(o zlxfc]v]bfnfm]
A—

(Group Namo i ¢um [

> To set up the Walk By graphic:

1. Follow the instructions on screen, and navigate using the buttons at the bottom of the
screen. Some parameters are explained below.
2. After the last screen, the system takes you back to the first screen so that you can set up

another group. If you are finished, click the OK button 0 at the bottom of the screen
to accept your changes and exit the screen.

Group
Each graphical area on the part is assigned to a group - this is defined in the graphic file.
Assign as many inspections as you wish to a group, preferably those inspecting that area of
the part. Inspections can be from any sensor within the same part program on the lane.
Some drop-down menus on the user interface refer to 'groups' - these represent groups of
inspections that inspect one area of a part.

A group can be a contiguous area, or a group of related areas on a part, as shown in red
below.
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Warning Percent
Set the value at which the group on the Walk By Graphic turns yellow. Yellow warning areas
notify you that the spoilage rate is approaching, but has not yet reached a critical level. This
allows you to make necessary changes to the manufacturing process before the failure rate
gets too high.

*» Note: this warning percentage is not connected to inspection warning limits. Those
limits are set separately. Additionally, this warning percentage does not affect the
Excessive Warnings alarm.

Failure Percent
Set the value at which the group on the Walk By Graphic turns red. Red areas indicate the
spoilage rate has exceeded user defined limits.

*»*» Note: this failure percentage is not connected to inspection limits. Those limits are set
separately. Additionally, this failure percentage does not affect the rejects alarms.

Group Digital Outputs (for Extended 1/0 option)
Select the group number (Group 0 through 15) to trigger an output signal through the
Extended 1/0 board (on page 425). If your system has firmware version lower than F168,
then you will have outputs 0 through 14 available.

Group Digital Outputs

oooaoooa
ooomBaana

The outputs go active when any inspection within the assigned group fails. You can use
these outputs to monitor the process within your plant and make adjustments as necessary.

You can assign multiple groups to one output. The groups can contain inspections from any
sensor within their corresponding lane part program. Each lane may have its own Extended
I/0 board, so you cannot combine inspections from different lanes.

Group Priority Level

This feature allows you to assign a priority to each group within the Walk By graphic. You can
designate which defects are more important and prioritize the reporting structure accordingly.

Group Priority Level ensures that only one defect per part is counted for each of the groups.
This differs from normal group reporting where there can be counts in multiple groups
depending on which inspections fail. If no defects are found in the first priority level group,
then the priority falls to the second priority group, and so forth for all groups configured. See
example below.

Notes about Group Priority Level:
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Group Priority Level must be enabled before use.
e You can assign only one priority level per group.

You do not need to use every group in the Walk By graphic.
» To enable Group Priority Level:

1. From Lane or Sensor Overview mode, click the Tools button > Lane Setup >
Miscellaneous Configuration.
2. Enable Group Priority Level in the Miscellaneous Configuration menu.

Miscellaneous Configuration

Reject Missed Results
Disable Inspection Wamings

Group Priority Level

20

3. Click the OK button to save changes and exit.

Next, set up Group Priority Level in the Walk By Setup. If you need information about setting
up the Walk By Graphic, see Walk By Setup (on page 64).

» To set up Group Priority Level:

1. From Lane or Sensor Overview mode, click the Tools button > Lane Setup > Walk By
Setup. You will see an additional step (six instead of five) in the wizard.

2. Follow the instructions on screen for steps one through four. This is where you assign
inspections to a group.
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3. Instep five of the wizard, choose a priority for the group you have just set up. Level 1 is
the highest priority. In this example, we have five group priority levels available because
that is the total number of groups available on this type of part. The priority number you
assign will become highlighted. If you try to use a priority level that has already been
assigned, the system will prompt you to either delete the previously assigned group, or
allow you to select another priority.

Configuration Walk-By Groups

— Step 5 of 6 : Group Priority Level —
Steps

Groups

level

Use buttons to select group priority
Group Name

Group Inspections

Group Limits

Group Priority Level

Finished

Group Priority Level

(J:Ja0 ]

Group Priority Level

XX

4. After you select a group priority in Step 5, the wizard will return to Step 1 so that you can
set up another group and assign a priority. Repeat Steps 1 through 5 of the wizard for
each group you want to assign.

5. Click the OK button to finish and exit.

Example

Example 1 below shows a normal group reporting with Group Priority Level disabled. Notice
that almost all of the groups show a defect percentage.

— Cap (11.017)
_____———— Tamper Band ( 1.695)
Neckring ( 0.000)
High Neck (1.695)
Fill (1.695)
68 Graphs and Image Displays System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary



Example 2 below shows group reporting with Group Priority enabled, and the inspections were
run similar to the above example. Notice that only one group shows a defect percentage. In
this example, we set the "Cap" group as the highest priority. This means that only one defect
per part was counted, and each failed inspection was part of the "Cap" group. Other defects for
each part are recorded by the system, but not reported in the Walk By Graphic or output
through the Group Digital Outputs.

If the "Fill" group was set at Priority 2, and a part had a defect for one of the inspections in the
Fill group but NOT the Cap group, then you would see a defect percentage for that group.

—Cap (12.838)

_____———— Tamper Band (0.000)

Neckring ( 0.000)
High Neck ( 0.000)
Fill ( 0.000)

SORTING DATA IN GRAPHS (OPTION)

You can change the order of the displayed data in the Machine Part Graphs (on page 80). The
Machine Part graphs are only displayed if your system is configured for machine parts.

‘0

e Note: when you change sorting order, it affects the Machine Part Graphs in the upper and
lower screens. Other graphs are not affected.

» To sort the graph data:

1. Right-click over a Machine Part Graph. The Graph Menu is displayed.
2. From the Graph Menu, select Sort Method, and select an option. The data on the graph is
sorted. The options are explained below.

' Graph Menu

Configuration
Clear Machine Part Statistics Only

( Sort Method ') Sont Ascending Value |
@ Sort Descending Value
Sort Maximum Error
Sort Sequential
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e Sort Ascending Value — Sort from low to high result. In the example below, the machine
part with the highest number of defects is shown on the right side of the graph.

FILLER VALVE 7
FILLERVALVE ¥ Inspection Mean ¥ | Fill Height v]  Totals ¥ D
H-axis: V-axis: Inspection: Series:

Fill Level [pixel]

FILLER VALVE

e Sort Descending Value — Sort from high to low result. In the example below, the machine
part with the highest number of defects is shown on the left side of the graph.

FILLER VALVE y

FILLER VALVE ¥ | Inspection Meaf? | Fill Height ¥ Totals ¥ D
H-axis: V-axis: Inspection: Series:

FILLER VALVE
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e Sort Maximum Error — [Available when Keep Retro-Spec Statistics is enabled for an
inspection, Totals is selected for the graph Series, and Inspection Mean is selected for
V-Axis] Sort the data by machine part where the highest peak shows the furthest value

from nominal, as an absolute value.

FILLER VALVE 2
N ___
FILLER VALVE V¥ | Inspection Mean ¥ | Fill Height v | Totals v| KR
H-axis: V-axis: Inspection: Series:
B9 76—
8920 {—
B8 54 |-
S sgool
=
; BEFEAf— e e e
o BN | BN B
=il L | BN B B
oo B BN BN BN BN BN BN BN BN BN OB
74 18 18 62 a2 136 48 96 140 40 68 36 66 16 116 100 144 24
FILLER VALVE
e Sort Sequential — Display an ordered list of machine parts.
FILLER VALVE 2 5
FILLERVALVE ¥ | Inspection Mean ¥ | Fill Height v Totals v 6
H-axis: V-axis: Inspection: Series:
32288
HOM
G866
= o 3 B B e e e
% MO ko —3 | N N . N e SN A EEEE A EEE—— —] — —— 3 _
g BT | 7 SN R — — L B N B BN N e SEEN NN — _— 3 -
x| 4TI N T 2 2 S S $Ih EE I T 2 2aSE aEa—— 2 - -
Eerz: | I R | B o BN B B BN B B B O
1 E2 3 4 5 1 T a a 10 1 14 15 16 17 18 18 20
FILLER VALVE

CLEARING MACHINE PART GRAPH DATA

This option is only available if machine part correlation is enabled on your system. You can
clear the statistics for the machine parts only, if desired. This does not affect the remaining

system statistics.

> To clear Machine Part statistics:

1. Right-click over one of the trend graphs or machine part graphs.

Graph Menu

Configuration
Clear Machine Part Statistics Only
Sort Method v

2. From the Graph Menu, select Clear Machine Part Statistics Only. The machine part
statistics are cleared. The remaining statistics are unchanged.
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SCROLLING IN GRAPHS
Scrolling in Trend Graphs

When the data falls outside of the current viewing range (example, time) a scroll button
becomes available next to the Series drop-down box.

The data goes back to when the system was powered up, or 2880 data points, whichever is
more recent. The trend data is reset when the system is restarted.

e Inatime-based graph, if the graph time per update is set to one minute, then the data
goes back 48 hours

e Ina part-based graph, if parts per update is set at 1000 parts, then the data goes back
2,880,000 parts

See Trend Chart Configuration - System Overview (on page 74) or Trend Chart Configuration -
Lane Overview (on page 75) to learn more about setting the time per update or number of
parts on a graph.

> To view other data:

1. Click the scroll button . A scroll bar becomes available.

. — 0o

——t s Y e

Vo (il e ]

2. Click and drag the scroll bar to view the desired data.

3. To exit, click the exit button a The graph returns to the current data.

Scrolling in Machine Part Graphs (option)

When there are more machine parts than can be plotted on the graph, a scroll button
becomes available to view other filler machine parts.

> To view other data:

1. Click the scroll button 4 . A scroll bar becomes available.

wr
FILLER VALVE

2. Click and drag the scroll bar to view the desired data.

3. To exit, click the exit button a The graph returns to the current data.
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TREND GRAPHS

Trend Graphs

A

» Toview the Lane trend graphs:

1. Select alane (click a Lane n button).
2. Click a Trend Graphs button on the right side of the screen. The trend graph is displayed.

7

** Note: There are two Trend Graphs buttons available. One is for the lane; the other is for the
sensor. If you are viewing Lane Overview mode, then the trend graph in the upper screen is
where you select the viewing options. The trend graphs in the lower screen follow the
settings from the upper screen. In Sensor Overview mode, you can select viewing options
separately within the upper and lower screens.

Trend graphs are available to view statistics based on specified criteria. These graphs are
available for each lane and each sensor within that lane. You can select criteria for the H-axis,
the V-axis, and Series. There is an adjustable Alarm Level for Defect %. Both the H-axis and
V-axis adjust automatically to higher and lower values. The Alarm Level will adjust as well.
Below is a list of possible combinations for Time and Parts based graphs.

If you have an inspection enabled that collects Retro-Spec Statistics (on page 81), then an
additional column of Inspection* data is available.

*These items are available for Trend Graphs (only in the upper screen) if:

e You have an inspection that collects Retro-Spec Statistics, and that feature is enabled, AND
e You select Inspection Mean, Inspection STD, or Inspection CPK for the V-axis, AND

e You select Lane Total from the Series drop-down menu

For more information about these items, see Retro-Spec Statistics (on page 81)

H-axis V-axis Inspection* Series

Time Defect % Inspection name (the names of *  Lane Total
Defect Count the inspections that have *  All Walk-By Groups
Defect Cost Retro-Spec statistics enabled) Al Sensors
Parts and Defect % * Individual Sensors (list)
Inspection Mean*
Inspection STD*
Inspection STK*

Parts Defect % Inspection name (the names of *  Lane Total
Defect Count the inspections that have *  All Walk-By Groups
Defect Cost Retro-Spec statistics enabled) Al Sensors
Inspection Mean* * Individual Sensors (list)
Inspection STD*
Inspection STK*
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For Trend Graphs, you can select which data to display. Select from the Series drop-down
menu.

| All Sensors ¥,
- Lane Total [
All Walk-By Groups
All Sensors

Lili

Lane Total
Displays the statistics averaged for all sensors within the lane.

All Walk-By Groups
Displays the statistics for inspection groups. These groups are defined in the Walk By
Graphic setup, and pertain to a specific area of a part.

All Sensors
Displays the statistics for each sensor.

Individual Sensors [names vary]
Displays the statistics for only the selected sensor.
Note: A key (to explain color-coding and data point shape) is displayed to the right of the graph
for All Walk-By Groups and All Sensors.
» To change the graph criteria:

1. Click any button (next to H-axis, V-axis, Inspection, or Series) to view the drop-down
menu options.
2. Select the desired criteria. The graph is updated to display based on your chosen criteria.

Trend Chart Configuration - System Overview

This is the setting for the trend chart displayed on System Overview screen.

«»*» Note: the vertical axis setting is automatically scaled to best represent the data on the
chart.

» To change the chart configuration:

1. Click the Home button n to view the System Overview screen.

2. Right-click over the trend chart. The Chart Configuration menu is displayed.

r
Chart Configuration

Trend Graph Typs

Mumber of Points [4 ] =i 0

0090

3. Choose from the available trend chart types, and select the number of points to display
on the chart.

4. Click the OK button a' to accept changes and exit the menu. The selected chart is
displayed in the System Overview screen.
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2

*» Note: these changes affect all trend charts in the System Overview screen

Trend Chart Configuration - Lane Overview

These settings affect the display of all the trend charts in the Lane Overview or Sensor
Overview screens.

«»* Note: the statistics for the lane are reset when you change a configuration setting.

» To change the trend chart display:
1. View the Lane Overview or Sensor Overview screen by clicking either a Lane n button or a
Sensor n button.
2. Click one or all of the Trend Charts buttons on the right side of the screen to display a
trend chart.
Right-click over one of the trend charts. The Graph Menu is displayed.
4. From the Graph menu, select Configuration. The Trend Chart Configuration menu is

w

displayed.
Trend Chart Configuration
Number of Points Currrency Units
(B 133 £ 13 3
¥
iyal
Parts per Update (Trend Point) :y %
4
[« B 1000} 43 1000 c
Time per Update (Trend Point) in minutes J
i 0
Inspection Samples per Point
Q Use Sampling
[ B 10 £ 10

5. Select the desired settings from all the available parameters.

6. Click the OK button to save your changes and exit the screen. All the trend charts for the
selected lane are updated to reflect your changes.

Alarm Percentages in Trend Charts

The alarm level can be adjusted when Defect % is selected for the V-axis. Click and drag on the
red Alarm Level line to adjust it. This also changes the alarm percentage in the Lane Alarm
Configuration (on page 96) menu. The illustration below shows Sensor Overview mode with
Trend Charts displayed for both Lane and Sensor. Changing the alarm percentage in any one of
the Trend Charts or Lane Configuration menu changes the percentage in all the other locations.
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¢ Note: Changing this alarm percentage does not affect the alarm percentage level in the
Walk By Graphic.

120 ppm PRESSCO INT=LLISPEC

120 (max) FECHNDLOGE INT

sefes | Lane Total

F -
Machine Parts

=
Statistica

o,
5 73 T Reject Images

Pt Caunt [z1800)

i Defect% Y] fetes Lane Total ¥ [.rend.Graphs

6 A v I

P
e Machine Parts

Statistics

Part Gaust {x1000)

=
Walk-by

seres laneTotal ¥ | Trend Graphs

=
Machine Paris

Statistics

Part Goust (<000}

Sensor Information

Selected Alarm _ Percent Defects v)

a Alarm Enabled

Minimum Count n 100 3 100

Trigger [%] 4 0 a2

Audible Enabled

Audible Duration [seconds] c m 3600
@@ visualEnabled
Vit Drsntonconcsl €3 gD 550
Alarm Digital Outputs

oD ooDDnDEBEnEBARn ]

XX
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REJECT IMAGES

| Reject Images

Reject Images are images from the last 100 defects from a sensor (or all sensors for Lane
Overview mode). These images are available in the Lane Overview screen and the Sensor

Overview screen.

» To view Reject Images:
1. From the System Overview screen, click a Lane n button to display lane information.
2. Click a Reject Images button on the right side of the screen. Note: there are buttons for
Lane and Sensor levels - these display images for the entire lane or just the sensor.
e Lane Reject Images show a variety of images from different Sensors. Below the image is
the name of the Sensor it came from and what time it was rejected. You can scroll through
the images using the arrows. Clicking on an image will bring you to the Sensor from which

it faed. E

A0 1% 45 Peeep 1 45 Peney X

e Sensor Reject Images show snapshots of failed images from that Sensor only. Below the
snapshot is the time it was rejected.

» To use the images:

e Click an image from the Lane Reject images to display the corresponding Sensor
information in the lower part of the screen.
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e Click any one of the small images to display a larger version of that image.

e Click on the large image to display a magnified portion of the image. This is useful to see
small defects. Click and drag on the magnified portion to navigate around the image. Click
in the magnified area to toggle the magnifier.

Right-click on the image to choose a zoom amount. An enlarged image, the same size as

the Big Live Image (on page 92) is displayed. Use the navigation arrows, or click and drag
the cursor to pan around the image.

From the pop-up menu, you may also choose Image Analysis (on page 158) (when the lane
is offline).

Click the exit button @ to close the zoom window

Image Options I[;
Zoom 6X

Zoom 4X

Zoom 2X

Normal Resolution

Save Image B
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Accessing Inspections from Reject Images

After selecting one of the reject images, you can quickly access the inspections that are related
to the part. This allows you to see which inspections failed.

> To use the images:

e Click an image from the Lane Reject images to display the corresponding Sensor
information in the lower part of the screen.
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e Click an inspection in the list to the right of the large image. This will show defect graphics
for the specific inspection, such as the region and any diagnostics that are associated with
that inspection.

Inspection Results (double click to edit)

Inspection
Measure ROI(s) Good
Support Ring Registration Good
Ribbon Good
Finish Location Not Complete

Polygon Not Complete
Feature Detect Not Complete
Good
Bad
Ambient Good
Distance Bad
Distance Bad

e Double-click the name of any inspection. This will open the inspection editor, so that you
can make adjustments if necessary. In the above example, if you double-click the Fill Height
inspection, then the Fill Height (on page 315) inspection editor opens. For more
information about the inspection editor, see Inspection Editor (on page 205).

«» Note: you must have user permissions to enter the inspection editor. Contact your system
administrator if you need permissions.
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e Click an inspection name in the inspection tree. The set of reject images will change to
those that are associated with that inspection (only if there are defects associated with
that inspection). This is useful if you want to know what types of defects are being caught
by that inspection.

14:24:45

14.24.486 14.37.02

- Inspections

Inspection Results (double clickto edit)

& Finish Location

<j@ Polygon Inspection
Measure ROI(s) Good
@ Centerline
- @ Measure ROI(S) [2] Ribbon Not Complete
* Fill Height Finish Location Not Complete
# Flll Height - Segmented Polygon Not Complete
# Amblent Feature Detect Not Complete
Centerline Not Complete
: Dfs‘a““ it Measure ROI(s) Not Complete
iieree Fill Height Not Complete
Fill Height - Segmented Not Complete
Ambient Not Complete
Distance
Distance

MACHINE PART GRAPHS

Ma rts

Machine Part Graphs are available when you have the Correlation option installed. Machine
Parts Graphs display defect information for each machine part. Below is a list of possible
combinations for the machine part graphs. The name on the button(s) matches your system
configuration. Examples of machine parts include "Cavity," "Filler Valve," or "Capper."

If you have an inspection enabled that collects Retro-Spec Statistics (on page 81), then an
additional column of Inspection data is available.

H-axis V-axis Inspection*® Series
Defect % Inspection name (the names of In the upper screen:
Machine Part - Defect Count | theinspections that have *  Lane Total
i Retro-Spec statistics enabled
(dependmg on *  Inspection P ) *  All Sensors
correlation Mean*

configuration) In the lower screen:

Inspection Latest Defects
STD*

. Totals
Inspection
CPK*

*These items are available for Machine Parts graphs if:
e You have an inspection that collects Retro-Spec Statistics, and that feature is enabled, AND

e You select Lane Total (upper screen) or Total (lower screen) from the Series drop-down
menu

For more information about these items, see Retro-Spec Statistics (on page 81).
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An example graph is displayed below. It shows defects for a machine part type, and the

number of defects correlated to each sensor.

Haxy:  Defect Count  ¥|

vasi:  Machine Part3 v|

Sees: | All Sensors ¥

' 1 | 1 ¥ ¥

L] L] §

The example below shows machine part data for the mean fill height for each machine part, for
one camera. The machine part numbers are displayed at the bottom of the graph. Use the

scroll button to view other filler machine parts. Use the "X" button to close the scroll

bar.

To change the sorting order, right-click on the graph. For more information, see Sorting Data in
Graphs (see "Sorting Data in Graphs (Option)" on page 69).

FILLER VALVE

g

FILLER VALVE ¥ | Inspection Meai¥ |

Fill Height

v Totals v €D

H-axis: V-axis:

Inspection:

Series:

77 133 49 97 21 121 93 109 33 53 [
FILLER VALVE

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
© 2013 Pressco Technology Inc. Proprietary

Graphs and Image Displays 81



Retro-Spec Statistics

Inspections that collect measurement data have the ability to collect Retro-Spec statistics.
These inspections have a check box called "Keep Retro-Spec Statistics." This feature must be
enabled in order for the system to keep this data. The inspections include:

e Ambient (on page 296)

e Fill Height (on page 315)

e Fill Height - Segmented (on page 322)
e Label Skew Extract (on page 345)

e Distance (on page 349)

e Angle (on page 354)

For Fill Height applications

You can use the system graphs to plot fill level over time. First, you must check the box to Keep
Retro-Spec Statistics in the Fill Height (on page 315) inspection menu.

:

Fill Mode Top and Bottom

Part Orienation Closure on Left
Reference Region Region 1

Fill Ratio 53

Correct Fill Position V' Enabled

Fill Correction Deviation 59.0®

Fill Height Limits 50.0® +405.92®/-40.0®
Show Fill Height [V Enabled

Keep RetroSpec Statistics [v Enabled

The statistics that are kept include:
e Defect % (percentage)

Defect Count

Inspection Mean

e Inspection STD (Standard Deviation)

Inspection CPK (statistical value, showing how well-centered the data population is within
the reject specification)

> To view the statistics:

In either the Lane Overview Screen (on page 43) or Sensor Overview Screen (on page 44), click
the Machine Parts button on the right side of the screen. A machine parts correlation graph is
displayed.

I Machine Parts \

There are Machine Parts buttons in both the top and lower portions of the screen. The button
in the upper screen allows you to view machine part data for the entire lane. If you are viewing
the Sensor Overview screen, the Machine Parts button in the lower screen allows you to view
machine part data for one sensor.

From the drop-down menus, select an option for H-axis, V-axis, Inspection (if shown), and
Series. In our example, we have selected Filler Valve as the correlation graph, Inspection Mean
as the type of graph to display, Fill Height as the inspection, and Totals as the series.
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2

«*» Note: to choose an inspection to view (in this example: "Fill Height"), you must select
Inspection Mean, Inspection STD, or Inspection CPK in the V-axis drop-down menu. In
addition, you must select "Lane Total" in the upper screen or "Totals" in the lower screen
from the Series drop-down menu.

FILLER VALVE 2
FILLER VALVE ¥ | Inspection Meai | | Fill Height v| Totals v 6
H-axis: V-axis: Inspection: Series:
288
267 45
262.m
Esam -----
§63$ .....................................................................
=
24931 4o B e R e e R e s R e L. e ... B ... ... o
20470 - ... B . S .o S o oo S - e« L e S e S o S e e S e S e B o e o I e e S - e S - o oo S e o g
20251 - T N - == - - - R = > W BN BN O BN = - - e B m= - B . b
77 133 49 97 i imm a3 109 33 653 5 89 129 &8 61 29 102 14 106 73
FILLER VALVE
The example above shows the mean fill height for each valve, for one camera. The valve
@
numbers are displayed at the bottom of the graph. Use the scroll button | a8 to view other
filler valves. Use the "X" button to close the scroll bar.
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In addition to displaying fill height data in the Machine Parts graphs, you can plot the fill level in
the SPC graphs (see "Statistical Process Control (SPC) Charting" on page 89) to show the data
for the inspection in several different ways.

| SPC Graphs

Source: Fill Height v | Source: Fill Height v |
Type: Correlation ¥ | show: Value ¥ | Type: Sigma ¥ | Series: Sensor v |
URL
SO0 .. . k. k.
R ~ N7 &
' o000
| 110
= I I“ 8 "II 38 l 018 I 76 l llmllﬂﬂﬂlﬂlﬁ |LRL 40 4 L o 12 14 16 18 20
FILLER VALVE Samples
source: _Fill Height v | source: _Fill Height v |

Type:  Distribution '| Series: FILLERVALVE| 5 '  1ype: X-Bar '| Series: Sensor v

8
2
[
N
v
N,
i
{
AW
v
N,
/
[
AW
v
N,
/
[
N\
.
N

LEcL
0 0000 = T T P e e LRL
32 606 7.7 163.028 228.739 293 451 368 662 4B7 .47 & 10 12 14 16 18 20
Value Samples
Avg = 266.791 STD=164.595 Min = 0.000, Max = 478216 Avg=273.341 5TD=29.415 Min = 186.017, Max = 272767
CP=D.452 CPK=0.383 PCI=0.452 CP=2527 CPE=2522

Another way to view fill height data is through the Trend Graphs (on page 72) in the upper
screen.

Measure STD
3
J

6620
0.00
4 : 7 10 11 12 13
Part Count (x1000)
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TIMING TREND

Timing Trend

< Note: this chart is mostly used by Pressco service engineers during installation, or it can be
used when additional inspections or hardware have been added to the system.

This chart displays the time required to run inspections. It is important to view the inspection
timing, especially if you have multiple sensors or multiple lanes, to make sure that the system
is inspecting all parts before they reach the reject station.

The choices for the Series in the Timing Trend chart allow you to choose Sensor Total, which is
all inspections for that sensor, or any individual inspection for that sensor.

Heaxis: Time v & Series: Measurement ¥ |
ET(ms)

1000

9.7

00

9.6

om

Time (minutes)

INSPECTIONS GRAPH

| Inspections
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Click the Inspections button on the right side of the screen to see the Inspections Graph. This
graph displays the Defect Count or Defect % for the selected sensor. It displays the failed
inspections in descending order of failure. The example below is the graph shown in Sensor
Overview mode. In Lane Overview mode, the bars are displayed vertically instead of
horizontally.

H-axis: Defect % v | R

il

Cositried

i

Polygm

Folygon

TAD 10000 17.60 2000
Defect

STATISTICS GRID

I Statistics

The Statistics Grid displays information about each Sensor. There are two different types of
Statistics Grids: Lane and Sensor.

Lane Statistics Grid
The Lane Statistics Grid (in Lane Overview mode) displays general information about each
Sensor. It shows the Total number of parts run, Sensor, Defects, Defect %, Last N, and Last N

%.
S Sensors v Dat=il: All v T;-
Fivet HiT48 LET48 100,000 W43 a5, sk
Fanel 56748 SaT48 100,000 953 a5, I

Sensor Statistics Grid
This grid is available when you display Sensor information. It shows specific information for
each sensor, including Inspection, Total number of parts run, Defects, Defect %, Last N, and

Last N %.
Inspesiion Defects " Lasi % |
Fattarn Match SET4E SET4G 1D 000 53 F5.300
Radial Edge BETAR i} LU} i noan
R SET4E [1] n.O0n 1] oon
Ring BET4R i LERATiTH] 1] LERE ]

¢ Note: you can configure (see "Statistics Grid options" on page 88) the statistics display.
Your system may not display all of the above-mentioned items.
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To display the statistics grid, click the Statistics button on the right side of the screen. There
may be multiple buttons, depending which screen you are viewing.

Sorting order

To sort any column in ascending or descending order, click the button at the top of the column.
Click it again to toggle to the opposite order. Right-click to clear sorting in the statistics grid.

Inspection | Total l* Defects B Delect %
Fattern Match SET4E 56748 100,000 953 95300
Fadial Edge EET4R o 0.0 o 0000
Fiing SET4E o 0, [y o 0.000
Ring BET4R [ 0000 o 0.000

Statistics Configuration
All the statistics grids in the current lane will use these settings.
» To get to this screen:

1. From the Lane or Sensor Overview screen, click the Tools button to see the Tools
menu.
2. Choose Lane Setup, then Statistics Configuration.

Statistics Configuration

LastN (¢ = 1000 |
Parts per Update am
Time per Update n minutes

Ol Ix,

Specify how many parts to include in recent statistics, such as the column "Last N" which
displays the number of defects in the Last N parts, or "Last N %" which displays the
percentages of defects within the Last N parts.

This feature allows you to continue to collect inspection data (Total inspected, total defects,
and defect %) without clearing the statistics to see how the most recent batch of parts has
done.

Parts per Update
Determines the graduations on the horizontal axis for the Trend Chart and Timing Trend if
"Parts" is selected.

Time per Update
Determines the graduations on the horizontal axis on the Trend Chart and Timing Trend if
"Time" is selected.
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Statistics Grid options

To change what is displayed in the statistics grids, use the options menu. These settings are
applied to all statistics grids, whether in the Lane Overview screen, or Sensor Overview screen.
Right-click over any statistics grid to see the options. These are explained below.

Statistice Grid |,

Column Vigibilily +———[d_Show Tolal Parts | |
Display Oplicns +——— W Show Defect Count
Show Dafac! Parcan
Show Last N Count
Sheow Lot N Percant

Change Limis s
Clear Sarting

EELE

L g [d Hide Regions |

W Hide Erhancsmierts

Statistics Grid Configuration

—

i snow Totat Parts i =how Last M Count
i@ sthow Detect Sount (@) showLost N Percant

Show Defect Percant

E Hide Ragions a Hiktli Eila hesaimnants

Q Use Error Limit
Triggeriparcent) ey .00 D

g Use Warnang Lamit

Trigger(parcent) B 4.00 D

20

Column Visibility
Change the number of columns that are displayed in the grid.

Display Options
Change the number of rows that are displayed in the grid. This only affects the statistics grids in
the Sensor Overview level.

Hide Regions
If this is checked, then the inspection regions are not displayed in the grid. This means the
Ring, Polygon, Rectangle, or Adaptive regions that identify the inspection area, but do not
have any reject criteria.

Hide Enhancement
If this is checked, then the inspection enhancements such as Clipping, Stretch Grayshades,
or Power Filter are not displayed in the grid.

Change Limits

This menu allows you to change the number of columns and rows of the grids in the first two
sections of the menu. These are the same as Column Visibility and Display Options.

The lower two sections of this menu allow you to enable and change limits for inspection.
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Use Error Limit
Causes the Defect % and Last N % columns to display in red if the trigger percentage is
exceeded. This allows you to see these statistics from a distance.

Use Warning Limit
Causes the Defect % and Last N % columns to display in yellow if the trigger percentage is
exceeded. This allows you to see these statistics from a distance.

Clear Sorting

Puts the sorting order back to the default setting. To sort any column in ascending or
descending order, click the button at the top of the column. Click it again to toggle to the
opposite order.

STATISTICAL PROCESS CONTROL (SPC) CHARTING

The measured data can be displayed in a number of views. To view more than one graph at
once, select a sensor button (Sensor Overview mode), and then select the SPC graph button on
the right side of the screen.

| SPC Graphs

There are four sections to the SPC graph, each of which can be setup to display a unique view
of the data. Select from the following options for each view:

e Source

o Type

e Show / Series

Source
Select the inspection from which the data is derived.

=  For mass sensors, the only choice under Source is the mass inspection because the
empty pocket inspection does not have appropriate data for these views.

= For camera sensors, the choices for Source depend what inspections are included and
enabled in the part program. Only the inspections that keep Retro-Spec Statistics (on
page 81) have SPC graph data.

= For other sensors (such as X-Ray), the choice for Source depends on the available
inspection(s).
Type
Select the type of chart. The choices are:
=  X-Bar - the history of the average values from this sensor
= Range - the history of the range of values from this sensor
= Sigma - the history of the standard deviation of the values from this sensor

=  Trend - similar to X-Bar, with the addition of a trend line that shows the historical trend
of the data from this sensor

= Distribution - the histogram of the data values. A curve of a standard distribution is
shown in yellow to indicate a normal distribution around the average value.

=  Correlation - the display of the average sensor values by individual cavity
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Series/ Show

On the first five chart types listed above, the Series category selects the source of the data.
The available settings are ‘Sensor,' which is the average value for the sensor, or the name of
a machine part, such as 'Cavity' which selects the data from an individual machine part. You

can choose a machine part from a drop-down menu displayed next to the Series drop-down
menu.

When the Correlation chart is selected, the Show category allows the selection of:
= Value - the average data value
= Sigma - the standard deviation
= Defects - a defect count from when the data was last reset
The picture below shows sample data from mass sensors.

Source: Mass v | Source: Mass v |

Type:  Correlation v| Show: Value 'l Type: X-Bar v| Series: Cavity 5 '|

Value

URL
4.6 LRL
8.0
3445
2.7
1148
uct
0,000 T — —
1 2 3 4 & 8 7 8 9 10 11 12 13 14 16 168 17 18 19 20 2 4 L: 10 12 14 16 18 20
Cavity Samples
Avg = 0.000 STD =0.000 Min = 0.000, Max = 0000
CP=0.000 CPK=0.000
Source: Mass v ] Source: Mass v I

Type:  Distribution '| Series: Sensor '| Type: Trend '| Series: _Sensor '|

Court

URL
-l 6174
e 5.082
PP o S g —* —1
s 1l | 4897
4 806 LRL
4811 4874 4937 5.000 5.062 65126 5230 2 4 B 10 12 14 16 18 20
Value Samples
Avg=5.016 STD=0.076 Min =4 779, Max = 5241
CP=0926 CPK =090 PCI=0.926
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The picture below shows sample data from camera sensors.

Source: Fill Height

hd

Type: Correlation ¥ |

show. Value V)

91 96101081 HAS 21 2HINIG 144

FILLER VALVE

URL

LRL

Source: _Fill Height v ]
Type:  Distribution Y| Series: FILLER VALVE] 5 1
4
22
(4]
1
0 32 606 armr 163028 vl e 293 451 358 662 AGT 34T
Value
Avg = 266791 STD =164 595 Min = 0,000, Max = 478 216
CP=0.452 CPK=0.383 PCI=0.452

Source: Fill Height

ad

Type: Sigma "|

Series: Sensor v

500 k.. .. k. k..
T 2 T <~
LT T
cx
20 [ m 12 14 16 1m 20
Samples

Source: Fill Haig ht

v)

Type: X-Bar v I

Series: Sensor v |

392410
204 307
8 N NN INA
=
a8 102
0.000
4 & 10 12 14 16 18 20
Samples
Avg =233.341 STD=29.415 Miin = 186 017, Max = 272 767
CP=2527 CPE=2522

LCL
LRL

The picture below shows sample data from x-ray sensors.

Source: Compare

v)

Type: X-Bar v I

Series: Sensor v |

12512
507 936
5 603350
m
»
496,784
494 208
C 10 12 14 16 18 20
Samples
Avg = 502610 STD=0.108 Min = 502 260, Max = S02.776
CP=32.032 CPK=29.168

source: Compare

>)

Type: Range v |

Series: Sensor v

232056
18 564
13 )\“ - A {/ .
—

x - N A N
9262
4641

L m 12 14 16 1% 20

Samples

Source: Compare

=

Type: Sigma v |

Series: SenNsor v |

an
—
3"‘\ )v*"/ \»-‘""‘H»—_qr-"\ Y. ,u—-nv/'\;,_
N NV ~
w 20
.
ot 10 12 14 16 18 20
Samples
Source: Compare v |

Type:  Distribution ¥ |

Series: Sensor v

000
750
€
2 so0
o
250
0o
493 560 496 G0 499,000 502 920 506 (40 509160 514,
Value
Avg=502.6515 STD=3.399 Min = 492000, Max = 514 5380
CP=1.020 CPK=0929 PCI=1.020
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BIG LIVE IMAGE

Click the Big Live Image button in Sensor Overview mode to view an enlarged image of the last
part that was inspected.

This image is updated when the lane is online and the camera is snapping images. The image is
outlined in green if the part is passing, yellow if it is in a warning state, or red if the part is
failing. You can view this image from a distance to quickly see how the inspection process is

performing.
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Chapter 8

ALARMS

There are three levels of alarms within the Intellispec system: System, Lane, and Sensor alarms.
Most of these are configurable. The table below lists the alarms, possible causes for triggering
the alarm, the reset mechanism, and color of the indicator on the light tree. Also refer to the
light tree status (on page 386) for more information about the lights.

The information in this section is valid as of software version 5.0.475.

«*» Note: Alarms are recorded in the system log reader (on page 111), even when the alarms
are automatically cleared.

Alarm Name Cause Reset Mechanism Color in light
tree
System Alarms (see "System Alarms Description" on page 96)
Note: If a system alarm occurs, an alarm icon is displayed in the lower right of the screen (in the Windows
system tray)
UPS Battery is dead. Manually [you must Not applicable
T first replace battery] (N/A)
Plant power is lost and the UPS shutdown | If plant power is N/A
time is exceeded. The Intellispec shuts restored before the
down. Intellispec shuts down,
then the alarm
condition is
automatically cleared.
Otherwise, you must
restart the system
manually.
Over temperature CPU temperature exceeds highest Manually N/A
recommended operating temperature.
The Intellispec system shuts down. You
must wait till the processor cools before
resuming operation.
Lost network If the plant network is configured to Restoring plant network | N/A
connection communicate with the Intellispec and the | connection
network connection is lost, a lost network
icon appears in the Windows system tray
Lane Alarms (see "Lane Alarms Description" on page 99)
Percent Defects’ Percentage of defects exceeds the set Manually Red
limit
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Alarm Name Cause Reset Mechanism Color in light
tree
Offline’ Lane goes offline Manually Green when
system is
online
Red when
system goes
offline
Chute Full’ Reject chute is full Manually [you must Red
first clear chute]
Blow Molder Door Blow molder door is open Automatically [by Red
Open’ closing blow molder
door]
Power Status’ Lane AC Power is lost Automatically Off when AC

power is lost

Blue when
power is OK
Good Parts' Used as a part counter. When specified Manually Red
number of parts is reached, then alarm is
triggered.
System Error’ Missed rejects, part tracker, or other Manually Red
internal system errors
Sensor Alarms (see "Sensor Alarms Description" on page 103)
Percent Rejects’ Percentage of rejected parts exceeds the | Manually Red
set limit
Excessive Rejects' Excessive number of rejects Manually Red
Excessive Warnings' Excessive number of warnings Manually Amber
Consecutive Defects' Too many consecutive defects Manually Red
System Error’ Missed part, missed acquisition, missed Manually Red

result, or other internal error

T If you want to connect an external monitoring device such as a PLC, an optional Extended I/0

(on page 425) board is required for each lane.

VIEWING AND CLEARING ALARMS

Use the View/Clear Alarms menu to see which alarms are enabled and disabled. A green light
indicates that the alarm has not been triggered, while a red light indicates the alarm has been

triggered.

> To get to the View/Clear Alarms menu:

e Click an Alarm button m The View/Clear Alarms menu is displayed.

Or:

1. View the Lane Overview or Sensor Overview screen by clicking either a Lane n button or

Sensor button.

2. Click the Alarms button n to view the Alarms menu.
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3. Select View/Clear Alarms from the menu. The menu shown below is displayed.

» To view when an alarm was triggered and who last cleared it:
Click an LED in the View/Clear Alarms screen.

Alarm Details

i Cleared: 5M16/2012 10:56:54 AM
\\) By: Administrator

Alarm raised: 5/16/2012 10:57:04 AM

g

©

e Click the Clear button next to any alarm to clear a single alarm. Or:
e Click the Clear All button at the bottom of the screen to clear all alarms.

> Toclear an alarm:

«» Note: some triggered alarms may be from another sensor - click the red sensor indicator [in
item 1] to see that sensor's alarms

Lane Alarms

[
: . <+
Click on an alarm to see details. @ O O 1
Penny Nickel Dime
(8] —
O Offline o Percent Rejects
A A
. O System Error
O System Error
®
I
1 List of sensors in the selected lane. Click an LED to select a sensor.
2 List of Lane alarms

w

List of Sensor alarms. Use the drop-down menu to select a sensor.

‘0

e Note: The LED with a white circle around it in the list of sensors [item 1] is the selected
sensor. The drop-down menu also indicates the selected sensor.

The indicators in this screen show whether an alarm is enabled, and whether it is triggered.

. Green Off - the alarm is not enabled nor triggered
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O Green On - the alarm is enabled, but has not been triggered

o Red On - the alarm is both enabled and triggered

SYSTEM ALARMS DESCRIPTION

The system alarms are the UPS (uninterruptible power supply) and CPU temperature alarms.
You can configure the UPS shut down time.

N

» To get to this menu:

1. Click the Home button n to view the System Overview screen.

2. Click the Alarms buttonn to view the system alarms. The screen shown below is
displayed.

System Alarms

1 > UPS Shutdown Time (sec) £} m

—~ CPU Temperature Warning Level (°C)

2 ——+——> CPU Temperature Shutdown Level (°C) 96
————— CPU Temperature Current Value (°C) 46
1 UPS Shutdown Time — Set the number of seconds that the UPS will maintain power to the

system if AC power has been lost. The Intellispec system shuts down after this time period.
This allows for a normal Windows shutdown.

2 CPU Temperature — Displays the current, warning, and shutdown temperatures associated
with the computer CPU. If a multiple core computer is used, the highest temperature is
displayed. If the shutdown CPU temperature is reached, the Intellispec system shuts down.

LANE ALARM CONFIGURATION

In the Lane Alarm Configuration menu, you can edit alarms for an entire lane. To see a
description for each type of alarm, see Lane alarms description (on page 99).

¢ Note: Some menu items are only available to advanced level users.

» To get to this menu:
1. Login.
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2. View the Lane Overview screen by clicking a Lane n button.

3. Click the Alarms button n to view the Alarms menu.
4. From the Alarms menu, select Lane Alarm Configuration.

Lane Alarm Configuration

Selected Alarm _/Percent Defects =5 Prborcent Defects h
/Offline

Chute Full
Blow Molder Door n
Slams Sasbled /Power Status °P°
Good Parts
n < System Error

Minimum Count 100

Trigger [%] [« =6 500 | ) |6.900

Audible Enabled po—
Audible Duration [seconds] () 'H
Q Visual Enabled

Visual Duration [seconds] g 3600 | 9

Alarm Digital Outputs

ooagoAooaooooBaAan j

QOO

Select an alarm from the drop-down menu to configure that alarm. You can enable or disable
parameters for each alarm individually. A check mark appears in the box next to the
parameter, and the name of the alarm, when it is enabled. The parameters are described
below.

For numeric values, you can change the numbers with the slider bars or click in the box to the
right of the slider to nudge the number up or down, or bring up a numeric keypad to enter a
new value.

Alarm Enabled
Enables alarm.

Minimum Count
Specify the minimum number of parts that must be inspected before the alarm can be
triggered. This prevents the alarm from being triggered too soon, when only a small number
of parts may make the statistics trigger the alarm.

Minimum Count is used in the Percent Defects alarm.
Trigger [%]

Define the percentage of parts inspected that must fail to trigger the Percent Defects alarm.
This number is selectable between zero and 100. The default value is five percent.

Trigger [%] is used in the Percent Defects alarm.

«»*» Note: you can change this percentage in the Trend Charts (see "Alarm Percentages in
Trend Charts" on page 75) in Lane Overview mode when Defect % is selected for the
V-axis.

Trigger (thousands)
[Good Parts alarm] The number of parts that must pass inspection to trigger the alarm. The
number is expressed in thousands.

Audible Enabled
If this parameter is enabled, the audible alarm will sound when triggered.
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Audible Duration
The number of seconds the audible alarm will sound if triggered. It will remain on until the
alarm is cleared. Use the slider to set values up to 3600 seconds (60 minutes).

Visual Enabled
If this parameter is enabled, this alarm will switch on the appropriate light on the light tree
when triggered.

Visual Duration
The number of seconds the light will remain on when the alarm is triggered. It will remain
on until the alarm is cleared. Use the slider to set values up to 3600 seconds (60 minutes).

Alarm Outputs
Select an output (Inspection Alarm 0-14) to be toggled on the optional Extended 1/0 (see
"Extended 1/0 board" on page 425) kit when the alarm is triggered.

7

«» Note: if your system has firmware version F168 or higher, there are 16 Alarm Digital
Outputs. They are numbered 0-15. Firmware versions below F168 support 15 Alarm
Digital Outputs numbered 0-14.

= There are 15 available Inspection Alarm outputs that correspond to the extended I/0
signals (on page 426). Click one of the output numbers to assign the current alarm to an
output.

. These outputs go active when the alarm is triggered, and go inactive when the alarm is
cleared.

= The outputs can be monitored by your plant equipment, such as a PLC, to notify you
when certain alarms are triggered.

Disable All Alarms
Click this button to disable all the current alarms at once. This disables only the alarms for
the current sensor or lane. This is used in emergencies when you cannot repair a situation
immediately, or when setting up the system. The remaining parameter settings for each
alarm are saved for future use. You must re-enable each alarm individually when you are
ready.

System Error Alarm Details

The System Error Alarm cannot be disabled. However, there is a Details button that shows
whether it is being used as an alarm (to light the red light of the light tree, turn on the horn, or
turn on the audible alarm). Alarms may be added or subtracted from the software without
notice.

System Error Alarm Details

Use as Alarm

Missed Reject @ «
Part Tracker Lost Communication @ 1/.‘
Part Tracker Closed Connection @ (_
UDP zero-Jength message ® -
Internal Error @ F

XX
Use as Alarm

This is the normal setting.
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Count Only
If one or more of the System Error alarms have Count Only selected, then those alarms will
be used as a warning. In the View/Clear Alarms screen, the LED will be yellow if the alarm is
triggered (instead of red). The Count Only alarms will NOT light any light in the light tree,
sound the horn, nor cause the red flashing ALARM button over the Lane button.

«» Note: We do not recommend using Count Only for any of the System Error alarms,
unless the system has a problem where a specific alarm is frequently triggered and thus
overshadows other alarms.

Click the OK button @ to apply changes and exit the menu.

LANE ALARMS DESCRIPTION

The available Lane alarms are as follows:

Percent Defects
This alarm is triggered when the percentage of defective parts from a Lane exceeds the
Percent Trigger. It will remain triggered until you clear the alarm. It uses the red light of the
light tree as a visual indicator.

Offline
This alarm indicates whether the system is online or offline. The green light of the light tree
is on when the system is online. The green light turns off and the red light turns on when
the system goes offline.

Chute Full
This alarm is mainly used in systems that have inspection modules installed within a blow
molder, and use the blow molder’s internal reject chute. It is triggered when the blow
molder’s internal reject chute is full. This alarm may not apply to your system. It uses the
red light of the light tree as a visual indicator.

If this alarm is enabled and triggered, the blow molder’s internal rejector will be disabled,
thus not allowing any more defective parts to be rejected. The rejector will remain disabled
until you clear the chute and then clear the alarm from the alarms tab. If you clear the
alarm without clearing the chute, the alarm will be triggered again.

¢ Note: This alarm is disabled when the Intellispec is offline.

Blow Molder Door Open
This alarm is used for systems that have inspection modules installed within a blow molder.
It is triggered when the blow molder door is opened. It will remain triggered until the door
is closed. It uses the red light of the light tree as a visual indicator. This alarm may not apply
to your system.

¢ Note: In PET Preform applications, this alarm is triggered when the Bypass Gate opens.

Power Status
This alarm is triggered when Lane AC power is lost. It remains triggered until AC power is
restored. If AC power remains off for an extended period of time, the system will shut
down.

The red light of the light tree will switch on when Lane AC power is lost. The blue light
should remain on as long as the Lane power is on.
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Good Parts
This alarm can be used as a part counter. For example, say you are inspecting preforms, and
have a box at the end of the conveyor (after inspection) that holds 5000 preforms. This
alarm will count the number of good inspected parts, and notify you when 5000 good parts
have reached that box. The Alarm Output through the optional Extended I/O can be used to
stop the conveyor from moving parts into the inspection system. You can then install a new
box at the end of the conveyor, reset this alarm, and start counting the next 5000 parts.

This alarm is triggered when a number of good inspected parts [Trigger (thousands)] has
been reached. It will remain triggered until you clear the alarm. It uses the red light of the
light tree as a visual indicator. Note that clearing this alarm also clears the Good Parts
count.

See also information about the optional Extended 1/0 (see "Extended I/0 board" on page
425) module.

System Error
System Error is a group of several internal system alarms. Click the System Error LED on the
Lane Alarms screen to see all the alarms and their statuses. See also Lane Alarm
Configuration (on page 96) to see how this alarm is configured.

System Error Alarms
Lane 1

Missed Reject

Part Tracker Lost Communication
Part Tracker Closed Connection
UDP zero-length message

Internal Error

Q0000

)

These errors are recorded in the Log Reader (on page 111). Some of these are described
below. Other system error alarms may be added and shown on the screen, or removed
without notice.

= Missed Reject - This alarm works in conjunction with Reject Confirm (see "Reject
Confirm Calibration (Optional)" on page 139). It is triggered when a missed reject
occurs. It uses the red light of the light tree as a visual indicator. There will be two
Missed Reject alarms available if two rejectors (see "Rejector Enable/ Disable" on page
123) are enabled and two Reject Confirm rejectors (see "Reject Confirm Calibration
(Optional)" on page 139) are enabled.

=  Part Tracker Lost Communication - You may be able to reset the Part Tracker to
re-establish communication. See Resetting the Part Tracker Board in FHCP 3X

= Internal Error - an internal error was logged. This usually requires Pressco technical
assistance.
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SENSOR ALARM CONFIGURATION

In the Sensor Alarm Configuration pop up window, you can edit alarm settings for an entire
Sensor. To see a description of each type of alarm, see Sensor alarms description (on page
103).

‘0

»  Note: Some menu items are only available to advanced level users.

> To get to this menu:

1. Login.
2. View either the Lane Overview or Sensor Overview screen by clicking a Lane n or Sensor n
button.

3. Click the Alarms button n to view the Alarms menu.
From the Alarms menu, select Sensor Alarm Configuration.
5. Choose a sensor to configure. You must configure each sensor separately.

E

Sensor Alarm Configuration (Neck)

- /Percent Rejects Iy
Selected Alarm /Excessive Rejects TP JE> SR Disable All Alarms
Excessive Warnings
Consecutive Defects
« System Error

Alarm Enabled

Seinele Siee (4] 100 - 0O 100
Trigger [%] [« F 2000 | =3 _2.000
=

@ ~
Audible Enabled { Py - (53
Audible Duration [ sl ) ‘ CE) B 3600

& visualEnabled
Visual Duration [seconds] () sfZTTY D 4.2

Alarm Digital Outputs

o000 000O0000 j

QOO

Select an alarm from the drop-down menu to configure that alarm. You can enable or disable
parameters for each alarm individually. A check mark appears in the box next to the
parameter, and the name of the alarm, when it is enabled. The parameters are described
below.

For numeric values, you can change the numbers with the slider bars or click in the box to the
right of the slider to nudge the number up or down, or bring up a numeric keypad to enter a
new value.

Alarm Enabled
Enables alarm.

Minimum Count
Specify the minimum number of parts that must be inspected before the alarm can be
triggered. This prevents the alarm from being triggered too soon, when only a small number
of parts may make the statistics trigger the alarm.

Minimum Count is used in the Percent Rejects alarm.
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Sample Size
Define the number of parts that must be inspected to determine the excessive warning
percentage. This number is selectable between one and 100,000. The default value is 100.
This is a sliding window: for example assume Sample Size = 1,000 and Percent Trigger = 3. If
three percent of the last 1000 parts have had a warning status, the alarm is triggered.

Sample Size is used in the Excessive Rejects and Excessive Warnings alarms.

Trigger [%]
Define the percentage of parts inspected that must fail to trigger the Percent Defects alarm.
This number is selectable between zero and 100. The default value is five percent.

Trigger [%] is used in the Percent Rejects, Excessive Rejects, and Excessive Warnings
alarms.

«»*» Note: you can change this percentage in the Trend Charts (see "Alarm Percentages in
Trend Charts" on page 75) in Sensor Overview mode when Defect % is selected for the
V-axis.

Consecutive Triggers
Define the number of defects in a row that the system must have to trigger the alarm. This
number is selectable between two and 100. The default value is 25.

Consecutive Triggers is used with the Consecutive Defects alarm.

Audible Enabled
If this parameter is enabled, the audible alarm will sound when triggered.

Audible Duration
The number of seconds the audible alarm will sound if triggered. It will remain on until the
alarm is cleared. Use the slider to set values up to 3600 seconds (60 minutes).

Visual Enabled
If this parameter is enabled, this alarm will switch on the appropriate light on the light tree
when triggered.

Visual Duration
The number of seconds the light will remain on when the alarm is triggered. It will remain
on until the alarm is cleared. Use the slider to set values up to 3600 seconds (60 minutes).

Alarm Outputs
Select an output (Inspection Alarm 0-14) to be toggled on the optional Extended I/0 (see
"Extended 1/0 board" on page 425) kit when the alarm is triggered.

«»* Note: if your system has firmware version F168 or higher, there are 16 Alarm Digital
Outputs. They are numbered 0-15. Firmware versions below F168 support 15 Alarm
Digital Outputs numbered 0-14.

= There are 15 available Inspection Alarm outputs that correspond to the extended I/0
signals (on page 426). Click one of the output numbers to assign the current alarm to an
output.

. These outputs go active when the alarm is triggered, and go inactive when the alarm is
cleared.

= The outputs can be monitored by your plant equipment, such as a PLC, to notify you
when certain alarms are triggered.
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Disable All Alarms
Click this button to disable all the current alarms at once. This disables only the alarms for
the current sensor or lane. This is used in emergencies when you cannot repair a situation
immediately, or when setting up the system. The remaining parameter settings for each
alarm are saved for future use. You must re-enable each alarm individually when you are
ready.

System Error Alarm Details

The System Error Alarm cannot be disabled. However, there is a Details button that shows
whether it is being used as an alarm (to light the red light of the light tree, turn on the horn, or
turn on the audible alarm). Alarms may be added or subtracted from the software without
notice.

System Error Alarm Details
(Penny)

Use as Alarm

Missed Part ® @
Missed Acquisition @ -
Missed Result @ f )

N Ix)
Use as Alarm

This is the normal setting.

Count Only
If one or more of the System Error alarms have Count Only selected, then those alarms will
be used as a warning. In the View/Clear Alarms screen, the LED will be yellow if the alarm is
triggered (instead of red). The Count Only alarms will NOT light any light in the light tree,
sound the horn, nor cause the red flashing ALARM button over the Lane button.

¢ Note: We do not recommend using Count Only for any of the System Error alarms,
unless the system has a problem where a specific alarm is frequently triggered and thus
overshadows other alarms.

Click the OK buttonaI to apply changes and exit the menu.

SENSOR ALARMS DESCRIPTION

The available Sensor alarms are as follows:

¢ Note: parameters, such as Percent Trigger, are adjusted in the Sensor Alarm Configuration
(on page 100).

Percent Rejects
This alarm is triggered when the total percentage of defects for the current sensor exceeds
a defined percentage. This percentage is defined with the Trigger [%] parameter. It will
remain triggered until you clear the alarm. It uses the red light of the light tree as a visual
indicator.
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Excessive Rejects
This alarm is triggered when a percentage of the last n parts have been found defective. It
will remain triggered until you clear the alarm. n = Sample Size. The percentage is defined
with the Trigger [%] parameter. It uses the red light of the light tree as a visual indicator.

Excessive Warnings
This alarm is triggered when a percentage of the last n parts have been found with a
warning status. It will remain triggered until you clear the alarm. n = Sample Size. The
percentage is defined with the Trigger [%] parameter. It uses the amber light of the light
tree as a visual indicator.

Warnings are enabled in the Retro-Spec Options (on page 212) when you are editing an
inspection.

Consecutive Defects
This alarm is triggered when the sensor has had too many consecutive defects. The number
of defects is defined by the Consecutive Triggers parameter. It will remain triggered until
you clear the alarm. It uses the red light of the light tree as a visual indicator.

System Error
System Error is a group of several internal system alarms. Click the System Error LED on the
right side of the View/Clear Alarms screen to see all the alarms and their statuses. See also
Sensor Alarm Configuration (on page 100) to see how this alarm is configured. Alarms may
be added or subtracted from the software without notice.

O Missed Part
O Missed Acquisition
O Missed Result

System Error Alarms
Penny

©

These errors are recorded in the Log Reader (on page 111).

Missed Part - No current function.

Missed Acquisition - This alarm is triggered if the sensor misses acquiring the image of a
part. For example, the inspection time was too high, or the part was too deformed to
properly detect. It will remain triggered until you clear the alarm. It uses the red light of
the light tree as a visual indicator. See also Sequence of Events (see "Sequence of
Events During Inspection" on page 192).

Missed Result - This alarm is triggered if the sensor misses the inspection results of a
part. For example, the inspection time was too high, or the processor was too busy to
process the inspection results before the part reached the reject position. It will remain
triggered until you clear the alarm. It uses the red light of the light tree as a visual
indicator. See also Sequence of Events (see "Sequence of Events During Inspection" on
page 192).

104 Alarms

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
© 2013 Pressco Technology Inc. Proprietary



Chapter 9
TOOLS MENUS

This section covers the tools menus that are available through System Overview or
Lane/Sensor Overview modes.

TOOLS MENU - SYSTEM OVERVIEW SCREEN

» To view the Tools menu:
1. Login. (Some items may be grayed out if you do not have permissions to use the items)
2. Click the Home button a to view the System Overview screen.
3. Click the Tools button to view the Tools menu.

Tools Menu s

1 —> Log Reader
2 —» Clear System Statistics

3 —»

4 —»CPU Temperature

5 —» UPS Information

6 — Chart Configuration

7 » System ’

8 —» Exit System

1 Log Reader (on page 111) — Open the Intellispec log

2 Clear System Statistics — Clear the entire system statistics (all Lanes)

3 Disk Imaging Software — Open Acronis Echo software for backing up system
hard drive

4 CPU Temperature — Displays the current, warning, and shutdown

temperatures associated with the computer CPU. If a multiple core computer
is used, the highest temperature is displayed. If the shutdown CPU
temperature is reached, the Intellispec system shuts down.

5 UPS Information — Display Uninterruptible Power Supply (UPS) information
and settings

6 Chart Configuration — Choose the Trend Graph Type and the number of
divisions for the horizontal axis for the chart displayed in the System
Overview Screen

7 System - Set system date and time or set up a printer
8 Exit System — Shut down Intellispec software
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TOOLS MENU - LANE OVERVIEW AND SENSOR
OVERVIEWS SCREENS

The Tools menu is the same in both Lane Overview and Sensor Overview screens.

A

» To view the Tools menu:

1. Login. (Some items may be grayed out if you do not have permissions to use the items)
2. Click a Lane n button to view the Lane Overview screen.

3. Click the Tools button to view the Tools menu.

Tools Menu l

Reporting v

Part Setup v

Lane Setup v

Hardware Setup > |
Reporting

The Intellispec generates many different reports to provide inspection detail. Many of these
reports can be transferred outside of the Intellispec.

* Note: Some menu items are only available to advanced level users.

> To view reports:
1. View the Lane Overview screen by clicking a Lane n button.
2. Click the Tools button to view the Tools menu.
3. From the Tools menu select Reporting, then select your desired option. These are
described below.

Tools Menu [ Lane Summary Report < 1
Reporting ' , Lane De-_lall Report <« 2
Correlation Report +«— 3
Part Setup B
Schedule Reports «— 4
Lane Setup B
Hardware Setup 8 — Read:er o 5
— ’ Sensor Missed Statistics«— G
Defect Data Viewer <«— 7
Defect Database <« 8
1 Lane Summary Report (on page 107) - Generate a summary of the statistics for the current
lane.
2 Lane Detail Report (on page 108) - Generate a report with the lane and sensor defect statistics

broken down to inspection-by-inspection data.

3 Correlation Report (on page 109) - (Only available if correlation is enabled on your system)
Generate a report with the percentage of defects by machine part

4 Schedule Reports (on page 109) - Define the frequency and destination for automatic statistics
reporting.
5 Log Reader (on page 111) — Open the Intellispec log
6 Sensor Missed Statistics (on page 112) - Display the number of missed parts for the lane.
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7 Defect Data Viewer (see "Defect Data (Images) Viewer" on page 452) - [Only shown if this
option is enabled] View the images in the defect database

8 Defect Database (see "Defect Database Viewer" on page 453) - [Only shown if this option is
enabled] View the inspection data and reports from the defect database

Lane Summary Report

This report lists the statistics summary for the lane, including:
e Number of parts inspected

e Number of defects

e Defect percentage

The above numbers are reported per sensor, and as an overall number for the lane. An
example from a one lane system is shown below.

B myReport.txt - Notepad R
File Edit Format View Help

Lane Summary,

Machine Mame: INTELLISPEC 1234
Fart Program: My Part Program
Current Time: 12/23/2010 3:53:45 FM
Last Reset; 12/23/2010 3:53:.02 PM

Sensor Parts  Defects Defect %
Sensor 1 149 147  90.658
Sensor 2 149 146 97 987
Sensor 3 149 0 |o.ooo

Ciwerall 149 147 98658
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Lane Detail Report

This report contains all the information in the Lane Summary Report (on page 107), plus
inspection detail for each sensor with the number of defects found by each inspection. An
example is shown below.

Lane Swuimary:

Machine MName: INTELLISPEC 1234

Part Program: MyPartProgram

Current Time: 12/23/2010 3:54:39 PHM
Last Reset: 1272372010 3:53:02 PHM

Jensor Farts Defects Defect %

ZJensor 1 149 147 o3.6538

Jensor 2 149 146 o7.987
rrerall 149 147 o3.6538

Machine MNeme: INTELLISPEC 1254

Part Programm: MyPartProgram

Current Tiwe: 12/23/2010 3:54:39 PHM
Last Reset: 12/23/2010 3:53:02 PHM

Sensor 1
Inspection Parts Defects Defect %
Ring 149 o 0.000
Measurement 1449 147 o98.658
Arbhient 149 o 0.000
Contrast 1449 147 o98.658
Polygon 149 o 0.000
Centerline 1449 147 o98.658
Adaptive 149 147 o8, 658
Ring 149 o 0.000
Arbbient 149 o 0.000
Measure Extract 1449 57 a8.255
Distance 149 147 o8, 658
rrerall 149 147 o8, 658
Sensor 2
Inspection Parts Defects Defect %
Polygon 149 o 0.000
Centerline 1449 146 97.987
rrerall 149 146 o7.98%7
108 Tools Menus System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary



Correlation Report

This report contains the percentage of defects by machine part, sorted from highest to lowest

percentage of failure. An example is shown below.

j Report - Notepad

TT3400

FHCP3X Master
6/18/2013 1:28:37 PM
6/18/2013 9:42:47 AM

File Edit Format View Help
Machine Name:
Part Program:
current Time:
Last Reset:
"FILLER VALVE'
# Percent
28 0.18
112 0.18
136 0.18
16 0.18
76 0.18
88 0.18
100 0.18
52 0.18
40 0.18
64 0.18
124 0.17

Il 4 0.17
144 0.16
60 0.16
24 0.16
36 0.16
96 0.16
84 0.16

| 108 0.16
120 0.16

Schedule Reports

"CAPPER HEAD'
Percent

28 0.71
16 0.71
4 0.71
24 0.64
36 0.64
12 0.63
20 0.51
22 0.51
8 0.5
34 0.5
10 0.5
32 0.5
18 0.45
30 0.45
6 0.44
13 0.42
19 0.42
25 0.42
1 0.41
7 0.41
31 0.41
15 0.34
= ]

Set up a schedule where the Intellispec generates reports automatically. This is a Lane-level
setting. To schedule reports for more than one lane, you must repeat the process for each lane.

» To schedule reports:

1.

2.
3.

Go to the Lane Overview screen by clicking a Lane n button.
Click the Tools button . to view the Tools menu.

From the Tools menu, select Reporting, then select Schedule Reports. The screen shown
below is displayed.

Change the settings as desired. These are described below.
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5. Click the OK button @ to save changes and exit the screen.

Schedule Reports

Lane Detail Report VJ

Enable Scheduled Report

Printon Change-Over

Q Keep File Name

O Clear Statistics

Next Scheduled Report [535667
Time Between Reports 8 hours
IO ' minutes

20

Report drop-down menu

Select which report to schedule, then change the settings in the menu. Each report must be set
up separately.

See also Lane Summary Report (on page 107) and Lane Detail Report (on page 108).
Report settings

Enable Scheduled Report
Choose whether to schedule the selected report. When this box is checked, the settings
below are active.

Destination drop-down menu
Choose whether to send the report to the default printer or a file. When Text File is
selected, you can enter a file name by clicking the File Name button.

If you do not name the file, then the file is named "PresscoReportnn.txt" where nn is the
number of the next generated report. It is saved at the hard disk location "c:\Pressco."
Subsequently saved reports overwrite the file.

Print on Change-Over
Schedule the system to generate a report if someone changes a part program. This contains
defect statistics from the time of the last statistics reset until the time that the part
change-over occurred. See Change-over Report Example (on page 111).
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Keep File Name
When a report is printed to file and this feature is enabled, the system will write the
inspection statistics to the same file name each time, rather than creating new files with
unique names. The system overwrites the file each time. You will need to click the File
Name button, browse to the location where you want to save it, and create a name for your
report.

An example of where this feature might be used is a plant where the Intellispec is
networked. Say the office computer is programmed to poll the Intellispec at regular
intervals to get the latest statistics report. With the same file name, the office computer just
needs to request the same file name each time, regardless of the date and time the report
was saved.

Reset Statistics
The Lane statistics are cleared after each print.

Next Scheduled Report
Using a 24 hour clock, set the time when the Intellispec should save or print the next report.

Time Between Reports
Set the time interval when the Intellispec should save or print the following reports. This
interval is used after the Next Scheduled Report, and is repeated the set number of hours
and/or minutes thereafter.

Change-over Report Example

This report contains defect information for the most recent parts. It specifies the time of the
last statistics reset, and displays information through the time that the part change-over
occurred.

| Line 5 Detail Report_2013-06-18_13-31-32.txt - Notepag

File Edit Format View Help

Machine Name: TT3400

Part Program: FHCP3X Master

current Time: 6/18/2013 1:31:32 PM

Last Reset: 6/18/2013 9:42:47 AM

Inspection Parts pDefects Defect % Last N Last N %

Lane 1 97703 14606 14.949 135 13.500

Main 97703 3908 4.000 36 3.600
Neckring Reg ROI 97703 0 0.000 0 0.000
Neckring Req 97703 0 0.000 0 0.000

color 1 97703 6772 6.931 63 6.300
Neckring Reg ROI 97703 0 0.000 0 0.000
Neckring Req 97703 0 0.000 0 0.000

color 2 97703 4652 4.761 42 4.200
Neckr“ing Reg ROI 97703 0 0.000 0 0. 000
E&clﬂ‘in& Re_g o a7703 0 0.000 0 0.000

Log Reader

The log reader displays the Intellispec event history including:
e User login and log out information
e Part program changes

‘0

e Note: detailed part program changes are found in the Part Program Change Log (on
page 198)
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Alarms, when triggered and cleared

System errors

System starting information

Lane online/ offline history

Lighting changes

Text files of the logs are stored at: C:\Pressco\Logs.

Date

Tue |2011-11-22

Tirme

Lane

(2} Nickle

Log Reader

Message

System went offline

User

Administrator

Online

Offline

Fart Frogram Al
Micke R

Tus |2011-11-2
Tue (2011
Tue 2011
Tue 2011
Tue 2011
Tue 2011

-11-29
-11-28
-11-28
-11-29
-11-28

(%) Cuarter
(&) Quarter
(4) Cuarter
(&) Quarter
(&) Quarter
(4) Cluarter

Lane process starts.,

Versior: 5.0.467 (XP, 32 bit)

Bulle 11/28/2011 3:29:07 PM

Built by: dpaunescu

Built on machine: DPOP75%

Built on aparating system: Microsoft Windows NT 51,2600 Service ...

Administrator
Administrator
Acministrator
Administrator
Administrater
Acministrator

Measurement_test
Measurement_test
Measurameant_test
Measurement_test
Measurement_test
[ easuremeant_test

Tue |2011-

Tue | 2011
Tue | 2011
Tue | 2011
Tue | 2011
Tue | 2011
Tue | 2011
Tue 2011
Tue 2011
2 TN 2011

[ o)

11

-29
-11-
-11-
11-
-11-
11
-11-2
11-
11-
11-

08:28:31
08:30:20
08:30:20
08:30:20
08:30:20
09:30:22
08:30:41

Navigate

All Columns Y I

Enter Search Te:

(2) Nickle
(2) Nickle
(2) Nickle
(2) Nickle
(2) Nickle
(0 System
() System
(2) Nickle
(13 Penny
(1) Penny

Lane process stars.

Sensor "Neck' with Id 2 in the part program 1L squat blue was not fo...
Sensor "Seal' with id 3 In the part program 1L squat blue was not fou...
Sensor "Neck' with I1d 2 In the part program 5L Snapple Clear was n...
Sensor "Seal' with Id 3 In the part program .5L Snapple Clear was no...

Was not able to connectto a UPS
Uszer '‘Administrator has logaed In,
System went offline.
System went onling.
System went offline.

Administrater
Adrministrator
Adrinistrator
Adrinkstrator
Adrminkstrator
Adrministrator
Adrinistrator
Adrministrator
Adrministrator
Adrministrator

Offfine
Offline
Offline
Offline
Offline
Offline
Offline
Offine
Online
Offline

Micke R
Mickel
Mickel
Mickel
Mickel
default
default
Mickel
Fenny
Fenny

Sensor Missed Statistics

Displays the number of missed parts and missed part tracking for the sensor.

Missed Parts / Results

Missed Result

Mo Missed Results

Missed Part
No Missed Parts

Lost Part Tracking: 0
Part Tracking Closed: 0

Clear All?

This information is recorded in the Log Reader (on page 111).

112 Tools Menus

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
© 2013 Pressco Technology Inc. Proprietary




Missed Results
This can occur if you set the Reject Delay Calibration (on page 133) incorrectly. Another
cause could be kinks or intermittent connections to cables, or the inspection time for the
lane is too long.

Error messages

Part Tracker Exception
If you see an error "Part Tracker Exception" on the Intellispec screen, this means that power
was lost to the Cluster Box or Part Tracker.
> To reset the part tracker board:
Push the Reset button on the part tracker board. This is found inside the inspection module or
Cluster Box.

Lost Part Tracking
If you see a "Lost Part Tracking" message, possibly the power was lost to the Cluster Box or
Part Tracker inside an inspection module. Reset the Part Tracker board as described above.

Part Setup

The Part Setup menu provides access to lighting, part display options in charts, and part width
calibration.
» To view the Part Setup menu:

1. View the Lane Overview screen by clicking a Lane n button.

2. Click the Tools button to view the Tools menu.
3. From the Tools menu select Part Setup >> then your desired option. These are described
below.

Some menu items are only available to advanced level users.

Advanced Adjust Lightin e— 1
Tools Menu | - c Aqus: ~Igning d
—— | Basic Adjust Lighting <|— 2
eporing | Clear All Defect Images <«— 3
Part Setup . > |
Lane Selup R Change Part Type <—| 4
Hardware Setup v | Set Cost Per Part < | 5
' Image Analysis <|— 6
Part Width Calibration < | 7
Select Inspections for Charts «— 8
Part Notes <4«— 9
1 Advanced Adjust Lighting (on page 165)
2 Basic Adjust Lighting (on page 163)
3 Clear All Defect Images - Remove all images from the Reject Images buffer.
4 Change Part Type - Select the type of part to be displayed on the Walk By Graphic for the

current lane.

5 Set Cost Per Part - Set the cost of each product, to be used with the "Defect Cost" trend chart.
6 Image Analysis (on page 158) - Determine the gray shade value for any pixel or group of pixels
in your image.
7 Part Width Calibration (on page 114) - Set the number of encoder pulses that the part detect
sensor "sees" the part.
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8 Select Inspections For Charts - Select which inspections (up to 8) to display on the Trend Chart
and Timing Trend.

9 Part Notes - Add setup and programming information about the part. This is especially helpful
if you or someone else need to modify the part program later.

Part Width Calibration

Part Width is the number of encoder pulses that the part detect sensor "sees" the part. To
perform the calibration you must be running parts past the part detect sensor.

» To get to the Part Width menu:

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu
(on page 155).
2. Select Part Tracking, then select Part Width Calibration.

Part-Width Calibration

In Use New Value

Part Width 0 72 (Encoder Ticks)

Part-Present Disable Time 0 3 (Encoder Ticks)
Calibration Results (Part Width)

Parts Avg. o Min  Max
127 71.46 14.89 45 94

20

Confirm changes

9' Do youwantto apply the following changes to the
system?

Partwidth changes from 0 to 72 encoderticks.
Part presentdisable time changes from0to 3

encoderticks.
> To calibrate the Part Width:

1. With parts running under the camera or sensor, click Start Calibration. As each part goes
by its part width will be displayed in Part Width field.

2. After a sufficient number of parts have gone by (we recommend about 10 parts), click
Stop Calibration (same button as Start Calibration). This will display the calibration results
in the lower part of the screen.
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3. Examine the results; look for the minimum and maximum values to be within

approximately 10 encoder pulses of each other. If the results are acceptable click OK Q
to save the data. If the results are skewed, recalibrate the part width. To exit without
saving the changes, click the exit @ button.

4. The system will prompt you to confirm your changes. If the results are acceptable click OK

Q to save the data. If the results are skewed, click the cancel ® button and
recalibrate.

Part Rate
In Intellispec systems with software version 5.0.440 and later, the part rate is displayed in Lane
Overview and Sensor Overview modes.
You can reset the part rate by right-clicking over the part rate tab and clicking Reset Part Rate.
The part rate displays:

a) ppm (parts per minute) - The average rate over the last five seconds. It is updated once per
second.

b) max- The maximum rate found for all individual parts in the last five seconds determined
in [a]. The displayed value is the largest value found in the last five minutes.

Administrator V|

f C1A Haxis:  Defect Count ¥

991 ppm
992 (max)

Total Parts

(\ 33071 8
Defects

O 496
Defect % | | | i ! | |

Cavity

N2 \ 4
Lane Setup
Some menu items are only available to advanced level users.
Tools Menu | :[ Change Lane Name 4—J| 1
e N Change Sensor Name <—| 2
Part Setup v Image Display Configuration <—| 3
Lane Setup ————————» Machine Part Correlation <—| 4
Hardware Setup D Manage Part Programs <—| 5
Miscellaneous Configuration <—| 6
Defect Recording Configuration <—| 7
Rejector Enable/Disable <—| 8
Image Source <—| 9
Start Forced Reject <—I 10
Stop Forced Reject +— 11
Chart Configuration ‘—i 12
Statistics Configuration <—| 13
Statistics Grid Configuration <—| 14
,  Walk-By Setup +«— 15
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Change Lane Name - Change the name of the current lane.

Change Sensor Name - Change the name of the selected sensor.

Image Display Configuration (on page 116) - Set the frequency, rotation, and other display
options for the sensor images.

Machine Part Correlation (on page 117) - Configure up to four different machine parts for
correlation. [This option only appears when Correlation is configured] (This is usually done by
the Pressco installer)

Manage Part Programs (on page 119) - Create, delete, or edit part programs.

Miscellaneous Configuration (on page 123) - Change settings for Missed Results, Inspection
Warnings, and Defect Database (not currently available).

Defect Recording Configuration (see "Preparing the Database" on page 447) - [only shown if
this option is enabled] Enable defect recording

Rejector Enable/ Disable (on page 123) - Enable or disable the rejector for lane or sensors.

Image Source (on page 168) - Select images to display on the lane.

10
and
11

Start Forced Reject (on page 125) - Force parts to be rejected based on correlation to a specific
machine part.

Stop Forced Reject - Stop the Forced Reject process.

12

Chart Configuration — Set the number of columns in the Trend Chart and the currency type to
be used in the "Cost per Part" trend chart.

13

Statistics Configuration (on page 87) - Change the display settings for the charts displayed by
the Statistics buttons.

14

Statistics Grid Configuration (on page 127) - Change the amount of information for the charts
displayed by the Statistics buttons.

15

Walk By Setup (on page 64) - Set up the group names, inspections assigned to each group, and
the criteria determining when the areas of the graphic turn green, yellow, or red.

Image Display Configuration

Adjust the display settings for images.
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> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu,
then select Lane Setup, then select Image Display Configuration.

Image Display Configuration

All Sensors
Heartbeat Interval (parts)
1 — O D
Defect Refresh Rate (seconds)
2 — Ok 0
3 E Show Correlation Values in Images
Main 'l'l
Image Rotation
@ pisabted
(" @0°
4 —»
(" 180°
( 270°
~
1 Set the frequency to update the image in the sensor view window.
2 Set the frequency to update the defective images when the system is online
3 If correlation is used, check this box to display correlation information in the Big Live Image
view.
4 Rotate the defect images, sensor display images (heartbeat), and the Big Live Images by
selecting rotation in degrees with respect to camera position, or rotation with respect to the
orientation (if an orientation is being used).

Machine Part Correlation

Configure up to four different machine parts for correlation. Each machine part can be named
and assigned the correct number of stations. The offset bar is used for calibrating the displayed
part with the actual machine part.

¢ Note: This screen is usually set up by the Pressco installer.
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> To get to this screen:
From the Lane or Sensor overview screen, click the Tools button to see the Tools menu,
then select Lane Setup, then select Machine Part Correlation.

Machine Part Correlation (8-Channel Part Tracker)

Number of Machine Parts: ‘ 4

Name Cavity (MP1) Name InFeed (MP3)
Source Hardware " Source Hardware Vl
Number (K1) EZEE D | vumber (3N D
oot (DI 0| or O 0
Name Spindle (MP2) Name OutFeed (MP4)
Source Herdware V) Source Hadware V)

b T D | vumber I 0
onset ([ ICHE 0 | omet CHIECEE 0

Qr" d Transfer S tial (MP4) 1

= G Outfeed Linked to Infeed (MP4 to MP3)
ir Goumcavnysmem
fj(rk | E—
_ (v Xx)

Number Of Machine Parts
Select the number of correlation sensors in your system (1-4).

7
°o

Note: If you only see two Machine Parts available, you probably have a two channel Part
Tracker board. This is the default configuration.

If your system has an eight channel part tracker board, you must run the Discovery
software and configure the lane for an eight channel part tracker board. Use the Edit
Existing Lane function. This will provide the capacity for four Machine Parts to be
configured.

7
L4

Name
Rename each machine part to something more recognizable to you (examples: Cavity,
Spindle, or Liner Gun #1). This name will be displayed on the Intellispec screens and
throughout correlation reports.

Source
Select between Hardware and Part Program to provide correlation. Some applications have
inspections from which you can derive correlation information.

Number
Set the number of components in each machine part (example, number of pockets in a
starwheel).
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Offset
This allows you to change the mapping between what the inspection system considers part
#1 (or pocket #1) and the actual parts. For example, if you try to reject a part from cavity #1,
and the system rejects the part from cavity #2, then you would set offset at 1. This
information is required to be correct for the inspection system to track components
properly.

Outfeed Transfer Sequential
(only available when four sensors are used, and only applicable to blow molder
installations) Specify whether the infeed and outfeed transfer arms are numbered
Independently or Sequentially. For example, say your machine has 10 infeed transfer arms
and 10 outfeed transfer arms. If they are numbered Independently, the infeed transfer arms
would be numbered 1 - 10, and the outfeed transfer arms would be numbered 1 - 10 as
well. If they are numbered Sequentially, the infeed transfer arms would be numbered 1 -
10, and the outfeed transfer arms would be numbered 11 - 20.

Outfeed Linked to Infeed (MP4 to MP3)
(applicable to blow molder installations) Enable this to derive the outfeed correlation count
(MP4) from the infeed correlation count (MP3). This is typical of most blow molders. For
example, in an SBO20 machine, the infeed count will be from 1 - 10. The outfeed count will
be from 11 - 20. Infeed count 1 will correspond to outfeed 11, and so forth.

7

% Note: When this feature is enabled, the number of components is forced to be equal
(number of components in MP3 = number of components in MP4 ).

7

** Note: There is no index sensor for MP4 in the hardware configuration.

Dual Cavity System
(only available when four sensors are used, and only applicable to blow molder
installations) Enable this if your system is a dual cavity machine.

Show correlation values in images
Displays the correlation value in the images. These values are saved as part of the image file
(if you save images).

Manage Part Programs

Create new part programs or delete, edit, rename, import or export existing part programs for
all the different products inspected with the system.
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> To get to this screen:

e From the Lane or Sensor Overview screen, click the Tools button to see the Tools
menu, then select Lane Setup, then select Manage Part Programs. Or:

e Right-click the Part Program drop-down menu.

Manage Part Programs

Part Programs

Penny (g
NICKEL

New

Currently Running Part <NICKEL>

©

For information on using this screen see:

e How to Create, Copy, or Import a Part Program (on page 193)
e Export a part program (on page 121)
e Load a Part Program (on page 121)

Delete a part program
You can delete a part program to prevent other users from running it.

» Todelete a part program:

1. Goto alane Overview or Sensor Overview screen [from Home: Lane button > Sensor
button].

2. Load a known good part program, one that you will not delete. You cannot delete the
currently running part program.

3. Right-click over the part program drop-down menu. The Manage Part Programs menu is
displayed.

4. Highlight the program name in the Manage Part Programs menu, then click the Delete
button.

5. A warning box will ask you if you are sure you want to delete the program. Click the OK

button @ to delete the program. The program is deleted from memory.
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Lane 1 Manage Part Programs
O Tnli:"ﬂ‘ll Part Proarams

Penny
NICKEL

=
n |
-4
(]
]

Defect % E—

o o

~ "Rename
G D T

Right-click _:

Currently Running Part <NICKEL>

Load a part program
You can switch part programs by loading a different part program from disk.

» Toload a part program:

1. Goto aLane Overview or Sensor Overview screen [from Home: Lane button > Sensor
button].

2. Right-click over the part program drop-down menu. The Manage Part Programs menu is
displayed.

3. Highlight the program name in the Manage Part Programs menu, then click the Load
button. The program name will appear in the Part Program drop-down menu on the Lane
Overview or Sensor Overview screen.

4. Click the OK button 9 to exit the Manage Part Programs menu. The new part program
is loaded into the Intellispec memory.

Lane 1 Manage Part Programs
o T“:“ Part Programs
— Pen (@
(ﬂ« D':"“ NICKEL Now
- ey
_om _
@ D =
Right-click _l
Currently Running Part <NICKEL>
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Export a part program
You can export a part program to use it on another sensor, lane, or Intellispec.

Lane 1 Manage Part Programs

0 LI o Part Programs
a

Penny T
Dietects NICKEL

Right-click

(B
Import/Export

Gurrently Running Part <NICKEL>

o Qi

» To export a part program:
1. Goto aLane Overview or Sensor Overview screen [from Home: Lane button > Sensor
button].
2. Right-click over the part program drop-down menu. The Manage Part Programs menu is
displayed.
3. Click the Import/Export button. The Import or Export Part Programs menu is displayed.

Import or Export Part Programs

Caurrant Part Programs Denke

© Papsso Do bt rm

Panny

Faniny1

My new parl program
(1) Penry 1

<C:hPressocoiDataExpo> Q

4. Click the disk icon M to browse to the folder or USB destination to export the part
program.
5. Highlight the part program that you want to export in the Current Part Programs column.

6. Click the right arrow button n to export the part program.

Click the OK button 9 to exit the Import or Export Part Programs menu. The part
program is exported.

8. Click the OK buttona to exit the Manage Part Programs menu.
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Miscellaneous Configuration
Enable or disable additional lane options.

> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu >
Lane Setup > Miscellaneous Configuration.

Miscellaneous Configuration

Reject Missed Results
Disable Inspection Wamings

Group Priority Level

Reject Missed Results

A missed result occurs if the system misses the inspection results of a part. This can happen
if the inspection time is too long or if the system is too busy to process all the data before
the part reaches the reject station.

Check this box if you want the system to reject parts from any missed results in the current
Lane.

Disable Inspection Warnings
Inspections can have reject and/or warning limits. A warning allows you to perform
maintenance or adjustments before the system starts rejecting parts.

The warning limits are represented by the yellow adjustable slider bar on the Retro-Spec
graphs. If you do not wish to use warning limits, check the Disable Inspection Warnings box.

Group Priority Level
This feature allows you to assign a priority to each group within the Walk By graphic. You
can designate which defects are more important and prioritize the reporting structure
accordingly. See Group Priority Level (on page 66)
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Rejector Enable/ Disable

Enable or disable the rejector at the Sensor level or at the Lane level.

e If one or more Sensors are checked, the reject device for all inspections performed by
those Sensors is disabled.

\ T
0
.

Defects
0
Defect %
% 0.000 J

v

e If all Sensors are checked, the reject device is disabled at the Lane level. Anicon is
displayed in the Lane window to indicate that the rejector is disabled.

‘0

s Note: the trash can symbol is only displayed if ALL sensors within the lane are disabled.

> To enable or disable the rejector for one sensor only:

1. Go to Sensor Overview mode.

2. Right-click over the desired sensor button to see the Sensor menu.

3. Click "Reject Enabled" to toggle it to "Reject Disabled" or vice versa. If Reject Enabled is
displayed, the rejector is enabled.

If you put the system online when the Sensor rejector is disabled, you will see a message
stating "Sensor Rejector Disabled - Do you want to go online?"

> To enable or disable the rejector for one or more sensors within a lane:

1. From Lane Overview or Sensor Overview mode, click the Tools button to go to the
Tools menu.

2. From the Tools menu, click Lane Setup, then select Rejector Enable/ Disable.

3. Check or un-check the box next to the sensor(s) to enable or disable the rejector.
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4. Click the OK button to apply the changes and exit the menu. The new setting is applied. If
the rejector for all sensors within the lane is disabled, you will see the trash can icon near
the statistics for that lane.

Enable Reject
Base

Neck

Sidewall

Seal

Base Mass

E All

X

If you put the system online when the lane rejectors are disabled, you will see a message
stating "Lane Rejector Disabled - Do you want to go online?"

LANE REJECTOR DISABLED

I
The rejector is disabled for this lane.

l.;

Do you want to go on-lina? [

The Forced Reject feature allows you to force any part to be rejected. The system will reject all
parts associated with the checked components, regardless of the pass/fail condition of those
parts. This provides a means of handling an emergency situation until repairs on a blow-molder
or other machine can be made. If you know there is a serious problem with a particular
component, you can use this method to ensure that no part from the defective machine
component passes the inspection process.

Forced Reject

«*» Note: the correlation check boxes and machine parts are only displayed if your machine is
using correlation.
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» To get to this menu:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu,
then select Lane Setup, then select Start Forced Reject. The Forced Reject screen is displayed.

Forced Reject

Combined Machine Parts v |
Reject N Parts Y] [14  Parts
Q Sample Interval 0— Revolutions
Cavity 14 (129
Q Spindle ‘o (1.300)
(@) ImFeed D
OutFeed e (.24

Note: All machine parts must match to reject the part.

Start Forced Reject

Forced reject won't start until the system is on-line.

-

f

Stalus

Forced reject started.

Correlation(Cavity, Spindle, InFeed, OutFeed)

Reject 001 of 014, Comelation(14, 26, 14, 14) Bad Part
Reject 002 of 014, Correlation{14, 50, 14, 14) Bad Part
Reject 003 of 014 Correlation(14, 74, 14, 14) Bad Parnt
Reject 004 of 014, Cormrelation(14, 98, 14, 14) Bad Part
Reject 005 of 014, Corralation(14, 122, 14, 14) Bad Part
Forced reject completed or stopped.

b @

The different parts of the menu are as follows:

‘0

s Note: The lane must be online to force rejects.

Any Part/ Single Machine Part/ Combined Machine Parts (drop-down menu)
Any Part - The system will reject any part, regardless of correlation to a machine part.

Single Machine Part - Reject a part correlated to one type of machine part (example: cavity,
or fill valve). The system displays a drop-down menu to select the desired machine part. Use
the numeric keypad to enter the machine part number or series of machine part numbers.

Combined Machine Parts - All correlated machine parts are displayed (as in the example
above). Check the boxes next to the desired machine parts. Use the numeric keypad to

enter the desired machine part number.

¢ Note: Combined Machine Parts is an AND function. The part must be correlated to each
machine part and number entered. If there are no such parts, then no part will be
rejected. In our example, if we typed Cavity 14 and Outfeed 17, no such part exists;

therefore none would be rejected.

Reject One Part/ Reject N Parts/ Continuous Reject (drop-down menu)
Reject one part, ‘N’ parts, or continuously reject from a specific machine part. To begin

rejecting, click the Start Forced Reject button.

Reject One Part - rejects the next part that reaches the reject station, regardless of its
inspection status. If you select Single or Combined Machine Parts in the above drop-down

menu, the part must meet that criterion.

Reject N Parts - the numeric field next to this drop-down menu becomes active. Enter a
number of parts you want to reject, regardless of their inspection status. If you select Single
or Combined Machine Parts in the above drop-down menu, the part(s) must meet that

criterion.
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Continuous Reject - rejects all parts regardless of their inspection status, until you click the
Stop Forced Reject button. If you select Single or Combined Machine Parts in the above
drop-down menu, the part(s) must meet that criterion.

Sample Interval
Instead of rejecting every part specified with the Reject N Parts and Correlation menus, this
option only rejects parts every n number of intervals. If you enter 3 Revolutions, then the
system will reject parts on every third revolution. If you select Single or Combined Machine
Parts in the first drop-down menu, the part(s) must meet that criterion.

Cavity /spindle/ infeed/ outfeed
The names displayed in this section will correspond to the names of your machine part
components. These are only shown if you select Single or Combined Machine Parts in the
first drop-down menu.

Rejector
(Not shown in the above screen) Specify which rejector to force rejection of part. If you only
have one rejector, then this button is not applicable.

Numeric Keypad
This is used to type values for numbers or series of rejected parts or correlation to machine
parts.

Start Forced Reject/ Stop Forced Reject
When you click Start Forced Reject, the criteria specified in the menu are applied and the
parts are rejected. Click the Stop Forced Reject button to stop the reject process. Note that
if you only reject one part, or specify a number of parts, the button toggles back to Start
Forced Reject automatically.

Status Box
Displays information about the rejection process.
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Statistics Grid Configuration
Choose how the statistics grids are displayed.
» To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu,
then select Lane Setup, then select Statistics Grid Configuration.

Statistics Grid Configuration
Show Total Parts Show Last N Count
Show Defect Count Show Last N Percent
Show Defect Percent
Hide Regions Hide Enhancements
Q Use Error Limit
Trigger(percent) ﬂ m ﬂ
G Use Warning Limit
Trigger(percent) ﬂ_m D
1 Checking these boxes determines what information is shown on the Statistics Grid screen.
2 These two slidebars allow you to enable/disable and determine the setting for warning and
error limits applied to the Statistics Grid screen.
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Hardware Setup

Some menu items are only available to advanced level users.

Tools Menu | 110 Diagnostics < 1
Reporting N Extended I/O Configuration <4— 2
Part Setup R Correlation Diagnostics < 3
Lane Setup 5 Offline Imaging +«— 4
Hardware Setup —————» Part Present Delay Calibration <— 5
Reject Delay Calibration <« B
Part Tracker Simulation <« 7
PDX Configuration <« 8
Missed Packets Exception +«—— 9
1 1/0 Diagnostics (on page 129) - Verify the presence of input and output signals.
2 Extended I/0 Configuration (on page 432) - Configure the optional Extended 1/0 board.
3 Correlation Diagnostics (on page 130) - Verify correlation signals.
4 Offline Imaging (on page 158) - Choose how the Intellispec acquires images when the lane is
offline.
5 Part Present Delay Calibration (on page 131) - Calibrate the distance (in encoder pulses) from
the part detect sensor to the camera centerline.
6 Reject Delay Calibration (on page 133) - Calibrate the distance (in encoder pulses) from the
part detect sensor to the rejector.
7 Use part tracker simulation (on page 136) for troubleshooting or if a part detect sensor is bad.
A simulated part rate would allow inspection to continue.
8 PDX Configuration (on page 137) - Set up the part detect generator. Only used in some
applications.
9 Missed Packets Exception (on page 139) - Set the number of missed packets to trigger the part
tracker to send a Lost Part Tracking message to the Intellispec.
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I/0 Diagnostics
> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu >
Hardware Setup > |/0 Diagnostics.

This screen can be used to verify the presence of input and output signals. Part rate and
encoder rate are also displayed.

e Green lights are input signals (signals that originate outside the Intellispec and are
communicated to the system). When an input is received the light is on.

e Red lights are output signals (signals that originate inside the Intellispec and are
transmitted out of the system). When an output is generated the light is on. You can test
an output signal by clicking on the appropriate light.

1/0 Diagnostics
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The outputs correspond to the hard-wired input and output signals throughout the Intellispec
system.
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Correlation Diagnostics

This is a troubleshooting tool to verify that correlation sensor information is being received by
the Intellispec.

> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu,
then select Hardware Setup, then select Correlation Diagnostics.

Correlation Diagnostics

MP1
MP2
MP3

o ©o o o

MP4

@ Asynchronous Correlation

LastRead Count: 0

Calibrated Count: 0
Percent Offset: 5

Adjusted Count: o

. 09O

For systems that have correlation sensors, this screen is used to verify that the correlation
sensor information is being received by the system. It is a troubleshooting tool.

As the production unit is operating, if the correlation sensor is transmitting pulses, it will come
up in the appropriate window. For example, if you have a cavity sensor attached to machine
part one (MP1) and are running an 8-cavity blow molder, you will see MP1 increment from 1-8
repeatedly.

Make sure that each machine part (MP) increments according to the number of components in
your system.

MP = Machine Part. MP1 through MP4 correspond to the correlation sensors that you have
configured in the Machine Part Correlation (on page 117) screen.

Asynchronous Correlation is used in certain applications. For a description of how to use this
feature and to set the parameters in the FHCP application, see:

Asynchronous Correlation FHCP 3X, and Asynchronous Correlation Software Setup FHCP 3X.

Part Present Delay Calibration

Part Present Delay is the distance (in encoder pulses) from the part detect sensor to the
camera centerline. Two independent signals are generated: 1) light strobe and 2) camera snap.

¢ Note: if your system is using a PDX, set up PDX Configuration (on page 137) before Part
Present Delay.

The Part Present Delay ensures that your part is in the center of the image when the camera
snaps its picture. Depending on the orientation of your camera, your part could be moving
from left to right, right to left, top to bottom or bottom to top as it travels through the
camera’s field of view. You need to be aware of the part flow direction in order to set up the
Part Present Delay Calibration.
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For an illustration of Part Present Delay within the inspection process, refer to the Sequence of
Events During Inspection (on page 192).

Even if you are unsure what the Part Present Delay value should be, you can view the strobing
of the lights to gauge whether the delay has been set too long or too short. When the Part
Present Delay value has been set too short, the lights will strobe before the part reaches the
camera; likewise when the delay is set too long, the lights will strobe after the part has passed
the camera. When the part is close enough to be in the actual image that the camera acquires,
you can use the image itself to center the part. A Part Present Delay calibration needs to be
done for each camera in the system.

Calibration

When you calibrate the Part Present Delay, it is ideal to only use one part at a time. Otherwise,
it will not be easy to determine if the part detected is actually the same part in the image or
the part rejected (for Reject Delay) since all the parts look alike. If it is not possible to use only
one part, an alternative is to use a different color part. You will most likely use a few parts to
test the calibration, or run the same part through several times.

(Penny) Part Present Delay

" {Encoder Ticks)

_ Stroba Delay (10us

| " Trigger Delay {10us

@QU

» To calibrate the Part Present Delay:

L)

% Note: you must be logged in with proper user access to calibrate the Part Present Delay.

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu
(on page 155).

2. Select Part Tracking, then select Part Present Delay Calibration.

Click the Start Calibration button.

4. Place a part onto the conveyor or into the part stream. The part will trigger the part
detect sensor, then the system will count the number of encoder pulses and take a
picture.

w
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5. Manually adjust the part present delay (encoder ticks) value until the image is centered

every time a part is run through the system.

6. When completed, click the Stop Calibration button. The Part Present Delay calibration

value is saved and stored in a Lane configuration file.

Advanced settings

«* Note: Advanced settings are normally set at the Pressco factory. You should not need to

adjust them. Normal settings are listed below.

Set a Base/Neck configuration as follows:

Camera Strobe Delay Trigger Delay Part Present Delay
Base 5 0 same as Neck
Neck 5 30 same as Base

Also check Advanced adjust lighting - set delay (on page 167) to make sure that the Neck

lighting delays are set correctly.

Reject Delay Calibration

Reject Delay is the distance (in encoder pulses) from the part detect sensor to the rejector. This

signal ensures that the correct part is rejected.

During Reject Delay calibration, the reject device will activate for each part that flows through
the system. Ensure that the rejector is activated properly and that each part is rejected
properly. After calibration, ensure that adjacent parts are not being rejected (example, from
too long a reject dwell time), nor being knocked off by the rejected part.
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For an illustration of the Reject Time Delay within the inspection process, refer to the Sequence
of Events During Inspection (on page 192).

Reject Delay Calibration

Reject Delay [encoder ticks] 6 5 0

@ Rejector 1 I ( Encoder Based Dwell
@ Time Based Dwell

Reject Dwell [ms] 1 50

Q Use Adaptive Reject

Turn-on Time [ms] | ()

Diff. from Calibration [%] | ()
P —
Start Calibration

eIl Y~

> To calibrate the Reject Delay:

7
0.0

Note: you must be logged in with proper user access to calibrate the Reject Delay.

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu
(on page 155).

2. Select Part Tracking, then select Reject Delay Calibration.

3. Click the Start Calibration button.

4. Place a part on the running conveyor or into the part stream. After the number of
encoder pulses shown in the Reject Delay box, the rejector will be activated.

5. Make sure the correct part was rejected.

6. Continue to insert parts into the part stream.

7. Manually adjust the reject delay (encoder ticks) until the correct part is rejected every
time.

8. Adjust the Reject Dwell so that it is long enough to completely reject the part, and short
enough that only one part is rejected for each reject pulse.

9. When completed, click the Stop Calibration button. The Reject values are saved and
stored in a Lane configuration file.

Reject Dwell
The duration of the reject signal. Dwell can be set by encoder ticks or by milliseconds. Select
the correct button for your application. This signal must be long enough to ensure the part
is efficiently rejected, and short enough to ensure that only one part is rejected for each
reject pulse.
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Adaptive Reject
Adaptive Reject (optional) (on page 135)

Adaptive Reject (optional)

This feature is used to compensate for the reject device’s turn-on time delay with varying
speeds of machine operation. An example where this is used is on a Belvac machine. The
turn-on time of the reject device might be over one-half of a can width at high machine speeds.
The Adaptive Reject will delay the activation of the reject device as a function of encoder
speed. As the belt (or production line) slows down, more delay is added.

If you do not know the fastest conveyor or production speed when you are setting Reject
Delay, you could calibrate the Reject Delay again when you run a different part at a different
production speed. Adaptive Reject allows for different speeds without having to recalibrate
between part types.

> For best results when using Adaptive Reject:

e C(Calibrate the Reject Delay and Reject Dwell at the fastest possible conveyor or production
line speed prior to enabling the Adaptive Reject function. Then use a value of 0 - 10 for
Diff. from Calibration (%) (see more information about Diff. from Calibration % below)

e (Calibrate the Reject Delay when the conveyor or production line is running at a constant
speed -- not during a startup or stopping

+ Note: Adaptive Reject will not function properly if the reject device delay is greater than the
spacing between parts.

> Before calibrating Adaptive Reject:

1. If you have not done so already, calibrate Reject Delay and Dwell. See Reject Delay
Calibration (on page 133) for more information.

2. Write down or make note of the Reject Dwell value after Reject Delay calibration. You will
need to temporarily change this during Adaptive Reject calibration.

> To calibrate Adaptive Reject:

1. Click the check box next to Use Adaptive Reject in the Reject Delay Calibration (on page
133) menu to enable the feature.

2. Set Reject Dwell to zero during the Adaptive Reject calibration process.

3. Run the conveyor or production line at the fastest speed that you will use, and click the
Start Calibration button.

4. Let the conveyor or production line run for about 20 seconds. The part tracker will record
the maximum encoder frequency. It will use this number to determine the amount of
delay to be applied to the rejector at all other encoder frequencies.

5. Click the Stop Calibration button.

6. Setthe Reject Dwell back to the value originally calibrated during Reject Delay calibration
(the number you noted before calibrating Adaptive Reject).

7. Enter the Turn On time of the reject device installed in your system.

8. Enter a value for Diff. from Calibration %, if applicable. See more information below.
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9. Click the OK button @ to save changes and exit the Reject Delay Calibration menu.

Reject Delay Calibration

Reject Delay [encoder ticks] | 6 5 0

@ Rejector 1 I ( Encoder Based Dwell
@ Time Based Dwell

Reject Dwell [ms] 1 50

Q Use Adaptive Reject

Turn-on Time [ms] | ()

Diff. from Calibration [%] | ()
P —
Start Calibration

DEBO

The settings for Adaptive Reject are as follows.

Turn On Time
Latency of the rejector mechanism in milliseconds.

Diff(erence) from Calibration (%)
This number is used if the maximum speed of the conveyor or production line is greater
than the speed at which the Reject Delay was calibrated. For example, if you calibrated the
conveyor for one part where the conveyor runs at a slower speed, and know that you will
run the conveyor 20% faster for another part, then enter 20 for Diff. from Calibration.

The ideal setting is zero. However, a value of approximately 10 is acceptable, to allow for
speed fluctuations due to power surges.

<+ Note: this value only applies to potential speeds greater than calibration speeds, not
slower speeds.
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Part Tracker Simulation

Use part tracker simulation (on page 136) for troubleshooting or if a part detect sensor is bad.
A simulated part rate would allow inspection to continue.

> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu,
then select Hardware Setup, then select Part Tracker Simulation.

Part Tracker Signal Simulation

230 Part Rate [PPM]
5000 Encoder Rate [Hz]

8192 ‘Encoder Resolution [PPR]

_"‘-\-\_\_\_\_\_\
Simulate Part Present | r - — f‘
Simulate Encoder

To enable the simulated part tracker, click the check box and then enter the desired part rate
in the window.

Part Rate - Enter a simulated part rate in parts per minute (PPM).
Encoder Rate and Resolution - Enter the simulated encoder properties.

«»*» Note: the system cannot run in both PDX (see "PDX Configuration" on page 137) mode and
Part Tracker Simulation (on page 136) mode at the same time. If one mode is already
running and you enable the other mode, the system displays a warning that the latest
setting will override the previous mode.
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PDX Configuration

The Part Detect Generator (PDX) is used in some applications where the Intellispec system
inspects directly on a machine, rather than on a conveyor. The PDX is a circuit built into the

Part Tracker board.

«*» Note: the system cannot run in both PDX (see "PDX Configuration" on page 137) mode and
Part Tracker Simulation (on page 136) mode at the same time. If one mode is already
running and you enable the other mode, the system displays a warning that the latest

setting will override the previous mode.

PDX Configuration

Enable PDX

Enable PDX-Generated Pocket
Transfer Arm (MP3) derived from Z-index of Encoder

G Reverse Encoder

Encoder Resolution (Pulses PerRev) | 256
Number of Parts Per Rev ' 1

Correction Factor 0

oXel Ix,

» To get to this screen:

1. From the Lane Overview or Sensor Overview screen, click the Tools button to see

the Tools menu.
2. Select Hardware Setup, then select PDX configuration. The parameters are described

below:

Enable PDX
Enables the PDX circuit.

Enable PDX-Generated Pocket
= |f your system is using a physical pocket disk with an index pin, leave this box
un-checked.
= [f your system is not using a pocket disk, and you need the Z-index signal of the
encoder, check this box. This eliminates the need for a pocket disk. The index signal is
handled on the Part Tracker board.

Reverse Encoder
Reverses the direction of the encoder pulses. Instead of the normal A, B sequence of pulses,

the pulses switch to B, A.

Encoder Resolution (Pulses Per Rev)
Enter the resolution of the encoder installed on your machine.
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Number of Parts Per Revolution
Enter the number of machine parts (example, number of Transfer Arms) to which the
encoder is attached.

» To configure the PDX:

1. Click the Enable PDX check box.

2. Enter the encoder resolution used on your system (example, 8192 pulses per revolution).

3. If your system is NOT using a pocket disk to generate the index signal, check the Enable
PDX-Generated Pocket box.

4. Click the OK buttonaI to accept changes and exit.

Missed Packets Exception

For each part and for each camera, two packets of information are communicated:

e The part tracker sends the host PC a signal stating the camera has been triggered
(correlation signal)

e The host PC then sends a pass/fail signal back to the tracker (results signal) when the
inspections are done

A missed packet exception occurs when the part tracker has sent out X number of correlation
signals without receiving any results signals back from the PC. The default is set at 6.

When this number has been met a Lost Part Tracking input is received on the Sensor Missed
Statistics (on page 112) screen.

> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools menu,
then select Hardware Setup, then select Missed Packets Exception.

Missed Packets Exception

Exception Threshold (missed packets)

]ﬁ
Eb@

Set the number of missed packets to trigger the part tracker to send a Lost Part Tracking
message to the Intellispec.

Reject Confirm Calibration (Optional)

Reject Confirm can detect missed rejects. Coupled with the Missed Reject Alarm (see "Lane
Alarms Description" on page 99), Reject Confirm will reliably detect and notify you of any
missed reject condition.

¢ Note: Reject Confirm is an optional feature, and an additional sensor must be installed at
your site.
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Reject Confirm uses a part detect sensor positioned at a calibrated and defined distance (Reject
Confirm Delay) past the normal reject mechanism to determine whether the defective part was
actually rejected. Reject Confirm Delay must be a value of 1024 or less.

After the rejector fires (meaning the reject delay for a part has passed), the Reject Confirm
Delay starts. Once the Reject Confirm Delay has passed, the system examines the reject
confirm sensor for a period of time equal to the Part Width. If the reject confirm sensor “sees”
a part within that time, it means that the reject was missed. If the reject confirm sensor does
not see a part, it means the part was rejected successfully.

If the reject was missed, the Missed Reject Alarm will be triggered. However, the Missed Reject
Alarm (see "Lane Alarms Description" on page 99) must first be enabled and configured.

Below is a timing diagram of the Reject Confirm process.

AN A A I/'F""-,I
- Reject Confirm p
. Reject Delay | Reject | Delay | Part
« ”| Dwell [* "l Width‘
Part Enters System Image Acguired Rejecter Station Reject Confirm
(PD = Part Detect) N\ AN
I'\__S_ 4 I'\@ /J ', zl_e’l \%II
1 Reject Delay (see "Reject Delay Calibration" on page 133)
2 Reject Dwell (see "Reject Delay Calibration" on page 133)
3 Reject Confirm Delay, set by Reject Confirm Calibration
4 Part Width (see "Part Width Calibration" on page 114)
5 Part Detect (PD) - where the part is first detected by the sensor
6 Image Acquired - image is taken, inspection is performed
7 Rejector Station - standard rejection point
8 Reject Confirm - second part sensor to determine whether a defective part was rejected

> To set up Reject Confirm Calibration:

1 - Enable the Missed Reject alarm
Go to the Lane Alarm Configuration (on page 96) to enable the alarm.

2 - Calibrate Standard Reject Delay

Calibrate the standard reject delay (see "Reject Delay Calibration" on page 133) using normal
procedures.

3 - Set up Reject Confirm

Mount the Reject Confirm sensor at “X” distance beyond the rejector where “X” is distance in
encoder ticks. For example, if there are 70 encoder pulses per inch, and the sensor is mounted
five inches beyond the rejector, the Reject Confirm Delay would be set to 350.

¢ Note: The maximum setting for Reject Confirm Delay is 1024. Mount the Reject Confirm
sensor within that range of encoder ticks.
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When the Reject Confirm sensor sees a part that is not supposed to be there, it triggers the
Missed Reject alarm.

Reject Confirm Calibration

Ruject Confirm Daley (encodar ticks) b3 ]
@ Reject 1 () Enavse Contim Start Calibeation
Hepnct cConfrm
-
) Enadiel

t4 Enadde Contrm
-

90

1. From the Sensor Overview mode, right-click on a sensor button to view the sensor menu
(on page 155).

Select Part Tracking, then select Reject Confirm Calibration.

Enable Reject Confirm.

Click the Start Calibration button.

Run a part through the system.

» To calibrate Reject Confirm:

vk wnN

7

«» Tip: for best results, run about 10 parts through the system.

6. When completed, click the Stop Calibration button. The system will determine the
number of encoder pulses from the part detect sensor to the reject confirm sensor.

Reject Confirm Delay is computed. Reject Confirm Delay = (number of pulses from Part Detect
to Reject Confirm Sensor) minus Reject Delay.
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Chapter 10
SOFTWARE UTILITIES

This section includes various software utilities that assist with Windows settings, help and
support from Pressco, and sensor configuration.

GO ONLINE AT STARTUP

Use this option to have the Intellispec system go online to inspect when you start the software
(or reboot the computer). This saves the extra step of putting each lane online, and it
automatically puts the system into inspection mode if power is lost and the computer reboots
as a result.
> To use this option:

1. Click the Home button to go to System Overview mode.

2. Click the Tools button to see the tools menu, then select System > Go Online at Startup. A

check mark is displayed next to the menu item when this is enabled.

» Todisable this option:

1. Click the Home button to go to System Overview mode.
2. Click the Tools button to see the tools menu, then select System > Go Online at Startup.
The check mark is removed when this option is disabled.

ADJUSTING DATE AND TIME

Adjust the date and time for the Intellispec system. The Windows operating system time is also
changed.

> To adjust date and time:

1. Go to System Overview mode by clicking the Home button U
2. Click the Tools button . to see the Tools menu.
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3. Select System > Set Date and Time. The System Date and Time menu is displayed.

System Date and Time

Current Time and Date

New Time and Date
|Wedne*sday', December 15, 2010 | 16:42:117

(GMT +02:00) Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius W I

@ Automatically adjust for daylight savings.

20

4. Choose your time zone from the drop-down menu.
5. Enable the check box to automatically adjust for daylight savings time if applicable.

6. Click the OK button @ to save changes and exit.

SETTING UP A PRINTER

Configure a USB or networked printer to print Intellispec reports. The driver for the printer
must be set up by an Administrator that has access to Windows.

» To set up a printer:

1. Go to System Overview mode by clicking the Home button a

2. Click the Tools button . to see the Tools menu.
3. Select System, then select Setup Printer. The printer configuration screen is displayed.

Printer Setup

Default Printer

Wip KON _BACK_Color - Konica G152 PGL - _I

4. Select the printer to configure from the drop-down menu. The Intellispec system
recognizes printers through the Windows drivers.

5. To test the printer, click the Print Test Page button. A basic "Intellispec Test Page"
message is printed.

6. Click the OK button @ to save changes and exit. The printer will be ready to use.
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CREATING A SUPPORT PACKAGE

A support package is a set of files that is gathered by the Intellispec system to help determine
system problems. You will send this package to Pressco service specialists so that they can
troubleshoot your system.

7

% Note: A Support Package does NOT contain images. You may be asked to send images with
the support package for the most effective troubleshooting. At least one image per camera
is desired. See How to Save Images (on page 173).

What you need:
e  Mechanical keyboard (MKB) (on page 38) to enter problem description
e USB flash drive (128MB or larger)

e If a Pressco Support representative sent you a ".pcf" file to acquire additional system
information, then copy that file to the USB drive prior to connecting it to the Intellispec
system

> To set up for the support package procedure:

Connect the mechanical keyboard (MKB) to the convenience USB port (see "USB Ports" on
page 38) on the side of the user interface.

> To create the support package:

1. Click the Help button at the top of the screen. The help menu is displayed.

Help Menu

Help Documents ’

Create Support Package

Remote Support

Launch Windows Explorer
_About

-

2. Select the Create Support Package option. The support package wizard is displayed.

3. Follow the instructions on screen.

4. Use the forward arrows n to move to the next screens.

5. When asked to describe the problem, use the mechanical keyboard to enter information.
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6. Optional: At Step 3: Configure, check the Custom Configuration box. A .pcf file is custom
Pressco configuration file that gathers additional information (beyond the standard
Support Package) from your system. A Pressco Support representative will send you a .pcf
file to load before you run the Support Package option.

Support Packaging
Steps - Step 3 of 5 : Configure —
Contact Info
Describe Issue O Load custom configuration.
Configure CAProssen v| @

Gather Information

20

) If a Pressco Support representative sent you a .pcf file to acquire additional system
information, then connect the USB device that contains the .pcf file.

Q

b) Click the disk icon and browse to the location (usually your USB drive) where the
.pcf file is stored. The system locates the .pcf file.

7. When the steps are completed, verify that the Step 5: Export screen is displayed.

Support Packaging
Steps — Step 5 of 5 : Export —

Contact Info

Describe Issue

Package stored In:

Configure Support. TSPAYERT3400.5,1,021,2012-08-24T11-20-41.2p
3 Copy To:
Gather Information Ci\Pressco\DataExport
-
CiPresscolDamExport v

=

8. Select the USB Flash Drive in the "Copy to:" location. You may need to remove the
mechanical keyboard and then insert a USB flash drive into the USB port.

9. Click the Copy button. The support package files are copied to the USB flash drive, then a
"Copy Succeeded" message is displayed.

Copy Succeeded

a
Fils

\-y 'Support TESTESS00. 201 0-04-03T00-21-28 xig”
wars seccessigly copmd fo direciony "HEY

kb
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10.

11.
12.
13.
14.

Click the OK button G to continue.

Click the OK button G at the bottom of the Support Packaging screen to exit.
Remove the USB flash drive.

Remove the mechanical keyboard (MKB).

Send the support package files to Pressco.

» To send the files to Pressco:

1.
2.

Copy the files that were saved, including images, from the USB drive to your computer.
Send an e-mail to service@pressco.com (mailto:dispatch@pressco.com) and attach the
support package files. Pressco service/ tech support will respond within one business day,
if possible.

HELP - REMOTE SUPPORT

Remote Support is used to allow remote access to the Intellispec software. iTivity software is
the method used by Pressco to provide remote system support if a Maintenance Agreement is
purchased for that Intellispec system. With this software Pressco can log in and operate the
Intellispec remotely.

> You will need:

A functioning Intellispec (systems without power, or systems that are not capable of
running Intellispec software, cannot be remotely accessed)

An internet connection to your Intellispec. This can be established through your network,
and is usually set up during installation. You may use DSL, Cable, Mobile Broadband, or
plant network connections to connect to the internet. Contact your network administrator

for help.

» To use Remote Support:

1. Notify a Technical Support (see "How to Contact Pressco" on page 481) representative
that you require remote support. You will need to identify yourself, your location, and the
Intellispec to which he should connect. )

2. Inthe Intellispec software, Click the Help button . From the Help menu, select
Remote Support.

r ~
Remote Support

Please select the remote-support application that

you want to use.
Help Menu

GoTo Meeti
Help Documents »
Create Support Package
Remote Support
Launch Windows Explorer @
About
[ -
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mailto:dispatch@pressco.com

3. Select the iTivity button. If the system has a valid internet connection, the iTivity agent
will attach to the server at Pressco. A connection status screen will appear indicating that
the session has been established, as shown below. Intellispec systems are identified by
computer name, which, in most cases, is the serial number.

ITivity Live Support Agent Connection Status

support.pressco.com Connection Status

Connected from agent: ISPEC-39<78/Mycomputers123.456.789

Connected to iServer:  support. pressco.com: Senver

Session Established to support.pressco.com.

The Session Id is 13df5de.

4. When the Pressco Tech Support representative is connected, you will be asked to give
him control of your Intellispec system. Check Allow remote user MOUSE and KEYBOARD
control and click Accept. The Tech Support representative will now perform the necessary
troubleshooting of your system.

A& new remote control session is being requested,
from user: user12 on iTivity iServer

on system: support. pressco.com

" allow remote user VIEW ONLY access
* Allow remote user MOUSE and KEYBOARD control

NOTICE: automatically REJECT in 18 seconds.

Ao |

5. When the Tech Support representative is finished, he will disconnect your Intellispec
from the remote session.

If you need to disconnect your Intellispec from the remote session yourself, follow the steps
below.

» To disconnect from remote support:

1. Click the X in the upper right corner of the 'iTivity Live Support Agent Connection Status'
box.

2. When the system asks "Do you really wish to exit the iTivity Live Support Agent?" click
OK. The system will be disconnected.

= Note: if you click the button, the session will be disconnected, but this does
not close the remote support program.
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= [fthe session is disconnected and you want to allow Tech Support to be able to access

your system again, click the button.

support.pressco.com Connection Status

Agent disconnected:  |SPEC-39¢78/Mycomputer123.456.789

Disconnected from iServer. support. pressco.com: Server %
MNat Connected. g,
The Session Id is 1ab1b?7. o

DISCOVERY SOFTWARE - WHAT IS DISCOVERY?

Discovery is software installed on the Intellispec hard drive that automatically looks for and
identifies certain components installed on each lane. Specifically, the software identifies any
sensors, cameras, lighting drivers, part trackers, and if used, Intellimass drivers that are
attached to the system. Each one of these devices communicates with the Intellispec software
via Cat -6 cabling and is assigned a unique MAC address.

¢ Note: You should rarely need to use this software. However, if a new component (for
example, camera) is installed on the system the software would be used to configure the

new camera.

Additionally, during system startup, if a previously configured component fails to communicate
with the Intellispec software, the discovery software screen will automatically appear on the
user interface, alerting you to the problem.
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Discovery software screen

Discovery PRESSCO INTZLLISPEC

TECHNOIOGT INC

4 Fart Tracker- D0:00:00:00:00:00
B CP-TS0E (one camera, ring)

5] Cammera - D0; 040 D000 0000

i Lighting Comtrolier - 00:00:00:00:00:00 Wocome to Discovery. The tree at the left shows the system
iLana 2 ion. U i i are shown in red.
=+ Part Tracker - 00:00:00:00:00:00 Missing harvare devices are shown in orange. Use the buttons
W GP-750E (ene camers, ring) below or right ek on items in the tree to configure the system.

] Garmera - 00:00:00:00:00:00 When you > done click on the OK button below.
) Lighting Gontraller - D0-00:00:00:00:00

ILane
< Part Tracker - D0:0G:00;00:00;00
B CP-TS0E (one camera, ring)

5l Canmera - D0:00-00 00:00

o Light Controller [ 0:00;00:00; 0000
o
tLane 4

== Part Tracker - D000 | G00:00:00
B CF-TS0E (one camel || ring)

f5 Camers - DOUOGC0D: | 10000

o Lighting Controllar | i:00:00:00:00:00
t Unassigned Devices

1 The tree on the left side of the screen shows the system configuration including the lanes in
the name and MAC address of each component in that lane.

*  Unassigned hardware devices are shown in red

*  Missing hardware devices are shown in orange

2 This menu allows you to perform specific actions, such as add or edit lanes or sensors, by
clicking on the designated button.

3 The Discovery menu toolbar (on page 150) allows you to perform additional actions.

Discovery Menu Toolbar
Tools Menu N 1

Rediscover New Hardware
Add Simulated Devices for Testing
Inspection Module Preset Editor

Tools Menu

150
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e Rediscover New Hardware - when this command is initiated this software will perform
another search of all hardware communicating with the Intellispec and displayed in the
tree on the left side of the screen.

e Add Simulated Devices for Testing - this is software used by Pressco engineers to assign
devices on an Intellitrainer.*

e Inspection Module Preset Editor - this is software used by Pressco engineers to assign new
components as they become available.

Wizard Menu - lists the same choices as those listed in the green buttons in the center of
the screen.

E Language Menu - displays language choices that can be displayed.

Help - provides software and systems for users.

*Intellitrainer = portable Intellispec training computer.

Discovery - access and use

e The initial configuration of all hardware devices will be performed by the Pressco installer,
and it is not anticipated that plant personnel will normally need to use Discovery software.

e The Discovery screen is automatically displayed during system startup anytime a hardware
device that was previously configured is not communicating with the Intellispec software.

e If you need to run the Discovery screen manually, you must log in as an Administrator, shut
down the Intellispec software, and run the Discovery program from Windows

e An example of a situation where plant personnel may use the Discovery software and
actions to be taken is described next:

= During system startup camera does not communicate with the Intellispec software

= The Discovery screen sees this as a missing piece of hardware and automatically
displays the Discovery screen. The configuration tree shows the camera in the expected
location but displayed in orange, indicating that hardware device is missing.

= As afirst step you should open the tools menu icon and select "Rediscover New
Hardware." This will trigger the software to search for the missing camera.

= [f the camera re-establishes communication, as seen by the camera name changing to
black, you can close the discovery software and resume normal operation.

= |f the camera does not re-establish communication this indicates a hardware problem
and the camera will most likely need to be replaced.

FAVORITES MENU

Access the Favorites menu from System Overview, Lane Overview, or Sensor Overview menu.
Click the Favorites button E from the toolbar to see the menu.

Favorites Menu ‘

Take Screen Shot
No Background Task Active

This menu allows you to access the following utilities:
Take Screen Shot (on page 152)
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Manage Background Tasks (on page 152)

Take Screen Shot

This utility allows you to capture an Intellispec screen image. This is different from saving
individual part images through the Save Image (see "Saving Images Through the Sensor
Menu" on page 174) function. A screen shot is useful to illustrate a problem to technical

support, or to capture settings for future setup.

» To capture the current full Intellispec screen:

1. Click the Favorites button to access the Favorites menu.

2. Select the Take Screen Shot option. An onscreen keyboard is displayed with a default
image name.

3. Re-name the screen shot if desired.

4. Click OK to save the image. The image is saved as a Portable Network Graphic (.png) file
to C:\Pressco\DataExport\ScreenShots.

Background Tasks

You can control the Intellispec system's background tasks. If you are saving or copying several
images, especially to a USB device, this process is slow. Therefore the Intellispec considers it a
background task. The system will continue to inspect and perform regular tasks in the
foreground. You may stop or remove certain background tasks if desired.

Background task management is found under the Favorites icon (except in System Overview
mode). You may see different icons depending on whether the system is performing
background tasks.

1 . Normal. No background tasks in use.

2 . One or more background task is running. None is complete.

3 f ) One or more background task is running. At least one is complete.
|

4 All background tasks are complete. This icon will appear on screen until you "Remove All"
@ tasks from the system using the Manage Background Tasks menu.

When at least one background task is active, the Manage Background Tasks menu item
becomes active in the Favorites menu. Click either icon [item 2 or 3 above] to access the menu.

Favorites Menu

Take Screen Shot
Manage Background Tasks
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Select the Manage Background Tasks option from the Favorites menu to cancel or remove one
or more tasks. Removing a task gets rid of all information about the task.

Manage Background Tasks

Save Last 100 Images 10:05:26 AM  Finished  10:06:01 AM
L cancel
Jtest\Defects

Save Defectlmages for '‘Base”’ 10:07:03 AM Running

:
iEn Cancel

Jtest\Defects

Remove All

Notes:

e Each lane maintains its own list of background tasks. If you start a task on Lane 1, you must
manage the task from Lane 1.

e You will not be able to close the dialog box until the task is complete or canceled. This
prevents errors from occurring in the system.

Saving images to USB using the Retro-Spec interface

When you are editing an inspection, you might save image sets to a USB device. This is not a
background task, and you will not be able to perform other tasks while saving the images.
However, you can cancel the task if necessary (see menu shown below). You will not be able to
close the dialog box until the task is complete. This prevents errors from occurring in the
system.
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The sequence to save the images is (see illustration below): 1 - click the Save button. 2 - Choose
the USB device. 3 - Save a data set (A or B). For more information about this menu see Saving
Images through the Retro-Spec interface (on page 176).

RETRO-SPEC Population View: Neckring Registration R — ) 1

M1

Save Image Files

Save what? Where to save?
(\ Save selected parts. ERmITRET v ] E’ 2
@ S‘P_ne set A(left side).
Di ed parts will be 5
(\ Save setB (right side). I(o;t?gn ) paris wi saveatomis 3
File names start with || i
I save type

Image File: 1000.bmp

@ Save Image Only.

( Save Image with Graphics.

( Save Both.

1]
<
o

You may cancel the task if necessary.

Save Image Files

Save Image Files 4:12:05 PM  Running

-
Cancel

G:test images\000.bmp

r
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Chapter 11
LIGHTING AND IMAGING

This section includes how to adjust lighting, how to save and load images, how to use Offline
imaging, and how to use Image Analysis.

SENSOR MENU

The Sensor Menu provides access to part tracking, lighting, and image options. Right-click the
Sensor button to view the Sensor menu from the Lane Overview or Sensor Overview mode.
The items at the bottom of the menu are only available in Sensor Overview mode.

7

** Note: the lane must be offline to access the items in the Sensor menu.

[@ Reject Enabled J

|

Part Tracking a
Offline Imaging |
Image Analysis

Camera Gain and Offset

Lighting »
Review Camera Calibration

Save Images ’
Image Source ’
Options ’

Part Program Change Log
The items in the Sensor menu are as follows:

Reject Enabled
(Toggles to Reject Disabled) This option enables or disables the rejecter for the Sensor only.
If you disable a sensor and put the system online, you will see a message that a rejecter is
disabled.

See also Rejector Enable/ Disable (on page 123).

Camera Focus and Aperture (on page 156)
Calibrate the focus and aperture of some cameras. This menu item will be grayed out if your
system does not have cameras that can be adjusted through the software.

Camera Gain and Offset

¢ Note: This menu normally should not be adjusted. It is usually set by the Pressco installer.
Improper adjustment of these parameters can cause a distortion of the image.
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e Camera gain is the amplification of the video signal
e Offset adjusts the grayscale reference values

Part Tracking
Opens Part Tracking options for:

=  Part Present Delay Calibration (on page 131)

= Reject Delay Calibration (on page 133)

= Reject Confirm Calibration (see "Reject Confirm Calibration (Optional)" on page 139)
=  Part Width Calibration (on page 114)

Offline Imaging (on page 158)
Choose how the Intellispec acquires images when the lane is offline.

Image Analysis (on page 158)
This tool displays the gray shade value for any pixel or group of pixels in your image. This is
useful in programming part programs or setting up lighting. You can measure grayscale
values of pixels in horizontal or vertical lines, or over a circle. Image Analysis also allows you
to calibrate the pixel scale for the sensor.

Lighting
Opens lighting options: Basic Adjust Lighting (on page 163) and Advanced Adjust Lighting
(on page 165).

Review Camera Calibration (on page 167)
This tool shows how the current camera is calibrated - the number of image pixels to an
actual measurement on your part. Calibration is used in measurement inspections.

Save Images (see "Saving Images Through the Sensor Menu" on page 174)
Allows you to save captured images to disk.

Image Source (on page 168)
Allows you to choose which images to display, and select between live sensor images or
saved images.

The two following options are available from Sensor Overview mode.

Options (see "Options (sensor menu)" on page 202)
Provides different inspection tree views.

Part Program Change Log (on page 198)
Display the Part Program Change Log. This lists the inspections and the edit history for each.
You can view all inspections from one sensor, other sensors, or other part programs.
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Camera Focus and Aperture

This menu allows you to adjust the focus and aperture of some cameras. It is only available
when the lane is offline.

< Note: only some cameras support this feature. They contain built-in motors to make these
adjustments. The Camera Focus and Aperture menu item will be grayed out in the Sensor
menu if your system does not support this feature.

» To get to this screen:

From the Lane or Sensor Overview screen, right-click the Sensor button to see the Sensor
menu, then select Camera Focus and Aperture from the menu.

Focus and Aperture
Focus
[ 252 e »
Aperture
(B 182 0

3
Rocfenfeos
e alibeate Ageetne

Camera R : 640 x 480 M Q Q

Make adjustments as necessary.

Focus slider
Sets the focus position of the lens.

Aperture slider
Sets the aperture position of the lens.

Recalibrate/ Calibrate Focus
Determines and sets the usable range of focus positions for the lens.

Recalibrate/ Calibrate Aperture
Determines and sets the usable range of aperture positions for the lens.

Auto Focus
Automatically determines and sets the best focus position for the image.
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Offline Imaging

Choose how the Intellispec acquires images when the lane is offline.

Offline Imaging

Triggered Mode

Singla Images

Immediate Mode

Triggered Mode

e Single Image — using the part detect sensor, an individual picture is taken every time the
button is clicked.

e Run-—using input from the part detect sensor, pictures are taken continuously at the rate
set in "Image Update Interval."

Immediate Mode

e Single Image — NOT using the part detect sensor, an individual picture is taken every time
the button is clicked.

e Run-—the camera takes a continuous picture, the light array is on, and you instantly see
whatever is under the camera.
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Image Analysis

This tool displays the gray shade value for any pixel or group of pixels in your image. This is
useful in programming part programs or setting up lighting. You can measure grayscale values
of pixels in horizontal or vertical lines, or over a circle. Image Analysis also allows you to
calibrate the pixel scale for the sensor.

» To get to Image Analysis:

e Make sure the lane is offline. Image Analysis is not available in online mode.

e Right-click an image in the Sensor Overview screen to display the zoom and image options.
Choose Image Analysis from the menu.

Image Options ]

Zoom 6X
Zoom 4X
Zoom 2X |

Normal Resolution

Image Analysis J
-OR-

e Right-click the Sensor menu (on page 155) and choose Image Analysis from the menu.

7

«» Note: you must have proper user access (see "Managing Permissions"” on page 56) to use
Image Analysis; otherwise, the option will be grayed out

The Image Analysis screen is displayed. The components of this screen are described below.

To quickly center the line or circle, right-click over the image to display the Options menu. Then
click Center Drawing Tool. The line or circle is centered on the image.

Options

[ Center Drawing Tool |\ |
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The Image Analysis screen shown below is from a high resolution camera. The regular 640 x 480 camera
Image Analysis screen has the same controls, but is laid out differently. See the example below the table.

1 2 3 4
[~ Image Analysis for Sensor ‘Main’ \ & + A

Measured Leng? 7
Calibration Units  millimeters [mm] !ﬂ 8
Calibration Scale 0.0817 millimeters / pixel |

12.2326 pixels/mm ——F 1 9

olo|
oeoRg| = | "

= Camera Raselution: 1228 x 824 [ Computa Scale Save Scale |
N (Y

17 16 15 14 13 12 1

** Note: use the square and circle markers [items 3 and 4] to make measurements. You can
make your circle or line [items 15 and 14] any size you want, but the markers will give you a
more accurate measurement. Use the histogram graph to place the markers, using gray
level transitions as marker locations.

Under the histogram graph, the information displayed is as follows:

Marker Positions
The distance in pixels that the square or circle markers are from the beginning of the
reference (red) line. If you are using a circle, then the markers measure the length in pixels
from the yellow square.

Marker Value Difference
The difference in gray shade between the values of the two markers.

Marker Values
Gray shades of markers.

1 Click and drag an end square to change the length or location of the line. If you are using a
circle for image analysis, use the middle square to re-position the circle on the image.

2 The highest and lowest gray shade values along the line or circle are displayed on the left of
the graph
3 Square marker - click and drag the square to any point on the line or circle (either in the image

or in the graph)

4 Circle marker - click and drag the circle to any point on the line or circle (either in the image or
in the graph)
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5 The gray shade values of the pixels at the markers are displayed, along with the differences
between the markers. See below the table for more information.

6 Values for each image are displayed so that you can see the difference between images

7 Measure your actual part with a ruler or calipers and enter the measured value in this box.
Place a line or circle on the image, covering the same area you measured.

If using a line: place the markers [items 3 and 4] on the same area on the image that you used
to measure the part. This will measure length.

If using a circle: place the circle on the image over the same location you used to measure your
part. This will measure the part's diameter.

8 Choose your calibration units that you used to measure your part

9 This is a computed number that is updated after you click the Compute Scale button. It
computes the units of measure per pixel, and shows the number of pixels measured by the line
or circle.

10 The keypad with the four arrows allows you to re-position the line or circle with buttons. The
drop-down menu allows you to choose the point or feature to move.

11 Use this keypad to enter the measured value of your part.

12 Save Scale - (available after you Compute the scale) Click this button to save the number of
pixels per unit of measure to the sensor file. This calibration unit can then be used in
inspections such as Measurement or Distance.

13 Compute Scale - Click this button after you have entered your measured valued [item 4] and
set up your line or circle. The system computes the units of measure per pixel.

14 Click the line button to view gray shades along a line

15 Click the circle button to view gray shades along a circle

16 Click Snap to acquire one new image. This option is only available if you accessed Image
Analysis by right-clicking the Sensor button.

17 Click Run to continually snap new images. Different images are only displayed if your
production line is running. This option is only available if you accessed Image Analysis by
right-clicking the Sensor button.
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The Image Analysis screen shown below is from a standard resolution camera.

./
Image Analysis for Sensor '‘Penny’

' 255

1 - " [l s = - i [T [ LT ]
o
Marker Positions: 0= 563; O = 160; Distance = 393 Marker Value Difference: (0-0) =179 Marker Values: 0 = 28; 0 = 207

- Area=GEIN7 Circle iamotor=272, Avg =18, Rango=23.766, STD-41.154, Anghe=168.0857, Conter-(3zl, zg)

G Area=BEAN7 Gircle Diameter=272, Avg =184, Fange-23.206, STD-41.184, Anghe=168.802", Conter-(a20, 28)

G Ases=SBINT Circle Diameter=272, Avg =183, Range=23._256, STD=41.194, Angle=187.571%, Conler={320, 218)

© Ama=ERINT Circl Diamatar=272, Avg =183, Range=23 265, STD=41194, Anghe=166 A0, Canter=(170, 208)

© Auga=HEINT Circle Diamatar=272, Avg =183, Fange=73 765, STD=41134, Anghe=166 304", Canter=(320, 738)

C- Area=EE107 Circle Dlamator=272, Avg =183, Rango=23. 266, STD=41.134, Anghe=186.908", Conter=(320, 208) Measured Diameter

- Arma=GEIN7 Circle Diamotor=272, Avg =18, Rango=23.766, STD-41.134, Anghe=166.B0%", Conter-{azll, z3g) .

©: Area=88107 Circle (Mameter=272, Avg =183, Range=23.206, STD=41.184, Angle=185 472%, Center={320, 238) 0.0 pixel

Calibration Units  pixels [@] Y

Calibration Scale 1.0
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Calibrating the Image Pixel Scale
Using Image Analysis

Image Analysis can be used to enter your actual measured values of your part and compute the
units of measure per pixel. This is called Pixel Scale. This calibration can be used for any
inspection on that sensor.

» To compute the pixel scale (refer to the illustration for Image Analysis (on page 158)):

1. Using a known good part, measure the length or diameter of an area on your part.

Enter that value into the Measured box [item 4].

3. Place a line or circle on the part image in Image Analysis over the same location used to
measure your part. Place the markers of the line, or a circle at the edges where you want
the system to measure your part.

4. Click the Compute Scale button [item 9]. The system computes the pixel scale and
displays the values [item 6].

5. To save the scale to the Sensor file, click the Save Scale button. The pixel scale is saved
with the sensor and can be used for any inspection on that sensor.

N
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Using an inspection

Pixel scale can be calibrated for an individual inspection or sensor. When Save Calibration is
used in these inspections, you can use the calibrated information in other inspections for that
sensor. The inspections that use pixel scale calibration are:

e Measurement (on page 307)

e Fill Height (on page 315)

e Fill Height - Segmented (on page 322)

e Support Ring Registration or Neckring Registration (on page 278)

e Distance (on page 349)

See the descriptions for the individual inspections using the links provided.
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Basic Adjust Lighting

The Basic lighting provides most of the lighting adjustments you will use.

7

** Note: lighting must be adjusted while the lane is offline.

> To get to this screen:

1. From the Lane Overview or Sensor Overview screen, right-click over the desired sensor

2. g:r(:StnLighting, then select Basic Adjust Lighting. The Basic Lighting screen is displayed.
1
f White Near IR ®
°
2 —» [
@ Froveromaizin 5

., 90O

1 Upper right corner displays each zone. Click a zone to adjust it. You can select a single zone or
multiple zones at any one time. As lighting is changed, the zone and the button next to it
change color.

2 Separate slider bars for each color (red, green, blue, and infrared) allow individual adjustment.

3 Incremental mode

Proportional % - Moving the slider bar adjusts all colors but maintains the current percentage
of each color.

Equal % lighting - Each color is adjusted by the same amount.

4 Click any image (if applicable to your system) to select the camera to adjust its lighting.

5 Enable Normalization - (in some systems, Disable Normalization). For most applications leave
normalization disabled. If you are modifying a part program that has normalization enabled,
then leave it enabled. This function was previously used to limit the brightness of certain LEDs.
It is no longer required.
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Advanced Adjust Lighting

This screen provides additional lighting setup. This is mostly used by Pressco engineers, or for
making infrequently performed specialized settings.

< Note: lighting must be adjusted while the lane is offline.

> To get to this screen:

1. From the Lane Overview or Sensor Overview screen, right-click over the desired sensor
button.

2. Select Lighting, then select Advanced Adjust Lighting. The Advanced Lighting screen is
displayed.

1
1 = =] L
@ @

r " By Section ‘ 

2
2

'n—a-lml

1 Opens a color palette and allows you to choose preselected colors.

2 If your inspection module has different lighting arrays, click one of the array buttons to adjust
lighting by zone.

3 By Section - Allows you to change lighting by each individual section.

By Color - Allows you to change lighting for multiple sections at once.

4 Enable Normalization - (in some systems, Disable Normalization). For most applications leave
normalization disabled. If you are modifying a part program that has normalization enabled,
then leave it enabled. This function was previously used to limit the brightness of certain LEDs.
It is no longer required.

5 Pixel Smear - The Intellispec computes the amount of pixel smear based on lighting, image
size, and part rate. It should be kept below one.

6 On-screen keypad (OSK) - enter the percentage of color. Type the number in the empty box
(using the onscreen keypad). This also moves the percentage slider.

7 A/B buttons - Allows you to set up two different lighting settings for the same part so you can
view each and compare.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Lighting and Imaging 165
© 2013 Pressco Technology Inc. Proprietary




Advanced adjust lighting - zones

When you select one of the array buttons from the Advanced Lighting screen, you can adjust
each zone independently.

8

P R VO T o S U0 S 0 S SO I Y
o — 9
i Add 8 to Group

Remaove All From Group

Resat Al

8 Adjust any zone within the light array. Options:
Adjust any zone with the slider or arrows

Select several zones by checking their gray box to adjust those zones as a group
(intensity will be the same for the whole group)

Right-click over any zone for options to add all zones to the group, remove all zones
from the group, or reset all zones to zero

9 Click another array button to adjust lighting zones for that array

10 Enable Normalization - (in some systems, Disable Normalization). For most applications leave
normalization disabled. If you are modifying a part program that has normalization enabled,
then leave it enabled. This function was previously used to limit the brightness of certain LEDs.
It is no longer required.

11 Set Delay (see "Advanced adjust lighting - set delay" on page 167) is only available in a BNS
application.

12 Click the Back to Camera Lighting button to go back to the main Advanced Adjust lighting
screen

13 1X - 2X is an intensity multiplier. 1X is the normal setting. 2X doubles the intensity without

having to adjust the intensity through the sliders. Maximum intensity is 100% - if a slider is
already at 100%, then the intensity will not be doubled.
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Advanced adjust lighting - set delay

Setting the zone delay is only available in a BNS application. It provides a strobe delay on the
light control board for the Neck camera, so that the Neck lighting fires after the Base camera
(and not at the same time). Since the Base and Neck part present signal occurs at the same
time, a lighting delay is required so that the Base is lit separately from the Neck.

7

** Note: this setting is normally done in the Pressco factory. You should not need to adjust it.

» To get to this screen:

1. From a Lane Overview or Sensor Overview screen, right-click over a Sensor button to see
the sensor menu.

2. Select Lighting > Advanced Adjust Lighting.

3. Inthe upper right corner of the lighting screen, click one of the array buttons to go to the
zone adjustment screen.

4. Click the Set Delays button. The Zone Delays menu is displayed.

Zone Delays )
10 microseconds
R
microseconds [
;E micmsswn:s ==
» e @O0
o e

mom o~ @M ot AW M =

00O

1. Enter the number of microseconds for each zone with the OSK. The normal setting for the
Neck camera is 350 microseconds on each zone.

2. Click the OK button ﬁ to save changes and exit the menu.

e

> To adjust zone delay:

¢ Note: this delay is separate from the Strobe Delay set in Part Present Delay Calibration (on
page 131).

Review Camera Calibration

This menu allows you to switch between inches and millimeters, select a custom scale, or go
back to pixels. If you switch between inches and millimeters, the pixel scale is automatically
converted. Calibration to pixel scale is performed in Image Analysis (on page 158) or some
inspections such as Measurement or Fill Height. Calibration is used to compute measurements
on a part.

The unit you select in this menu is displayed in the Inspection menus: & for pixels, mm for
millimeters, " for inches, or [ ] blank for custom units.
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To see this menu, right-click over the Sensor button in Lane Overview or Sensor Overview

modes > select Review Camera Calibration.
~
Calibration for Camera 'Penny’

Calibration Units

millimeters [mm] TI

Calibration Scale
0.625 millimeters / pixel

R
QD
§

Notes:

e If you switch from mm to inches, or inches to mm, the scale is converted for you. However,
if you switch to custom or pixels between mm and inches, then the scale is not adjusted for
you.

e If you switch to pixels, the scale is set to 1.0. The scale will revert back to your calibrated
value if you switch from pixels to another unit.

e The Reset Scale button sets the scale to 1.0 for any unit you have selected.

Image Source

This tool allows you to choose which images to display for the lane or sensor. You can load
images to simulate inspection if your production line is not running, or choose live images from
the sensor.

To see this menu, right-click the Sensor button from Lane Overview or Sensor Overview mode,
then select Image Source.

«»*» Note: you can also see most of the items from this menu by clicking the Tools button in Lane
Overview mode, selecting Lane Setup, then selecting Image Source.

[@ From Sensor N
Simulated

Select Simulated Lane Images
Manage Simulated Lane Images
Select Sensor Images

-

From Sensor
The system displays the live images from the current sensor.

Simulated
The system displays images you have previously saved to disk. You must specify images
through one of the following options: Select Simulated Lane Images, Manage Simulated
Lane Images, or Select Sensor Images.

Select Simulated Lane Images

Load a PDL file (on page 170)
Manage Simulated Lane Images (see "Manage Simulated Lane Images (PDL)" on page 169)
Select Sensor Images (on page 172)
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Manage Simulated Lane Images (PDL)

Create a Pressco Data List file [.PDL] that lists the images to load. This way, you can easily load
the same images another time. It allows you to save and load images for all sensors within the
lane.

First, you must save a set of images; choose from one of the options: How to Save Images (on
page 173)

To see this menu, right-click on a Sensor button in Lane or Sensor Overview mode to see the
Sensor menu (on page 155), then choose Image Source (on page 168), then choose Manage
Simulated Image Files from the menu.

Manage Simulation Image Files

Image Set

~
— Nothing Selected — !] H Make Active

J

Base —MNothing Selected — w J 'Repeal Sequentially 'J .
Neck Nothing Selected w I 'Repeat Sequentially 'l .
Seal —Nothing Selected— w ] ‘Repeat Sequentially 'I .

20

¢ Note: this process creates one file where you can load images from all sensors within the
lane.

» To create a new PDL file:

1. Click the disk icon under Image Set.
2. Inthe Select Lane Simulation File screen, click the New button. An on-screen keyboard is

presented.
Select Lane Simulation File
C:\PresscolLane 1\mages v | :"'_I‘
jui9765.PDL
My part set 091812_PDL
*.PDL

X
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3. Type a name for the image file and click the OK button from the on-screen keyboard to
save the file. A file is created and saved in the default directory for the sensor (example:
C:\Pressco\Lane 1\Images). The file path will be displayed in the Image Set drop-down
menu.

4. To add images to the set, highlight the file name in the Select Lane Simulation File
screen. The Edit button becomes active.

5. Click the Edit button. The Select Lane Simulation File screen closes, and the selected file
name is displayed in the Manage Simulation Image Files screen.

6. Check the Enable Modification box, then click the disk icon l}] next to the 'Repeat
Sequentially' drop-down menu. The Select Sensor Images screen is displayed.

7. Select images for the set using the instructions under the Select Sensor Images (on page
172) section, and click the OK button to save.

8. Choose how to display the images using the drop-down menu on the right of the screen.

= Repeat Sequentially - displays the images in order by file name, starting from the first
image file, repeating as long as the lane is online.

= Repeat Randomly - displays the images in a random order, repeating as long as the lane
is online.

= Run Once - not currently supported.

9. Click the Make Active button. A check mark is displayed next to the PDL file name, and
the file is activated.
10. Exit from the Manage Simulation Image Files screen.

Next, display the list of images.
> Todisplay the simulation images:

1. Make sure Simulated is selected in the sensor menu: Right-click over a sensor button >
choose Image Source > Simulated. A check mark next to Simulated indicates the system
will display images from disk, and not the camera.

2. To clear the previous images from the lane, right-click over the Statistics menu (on page

43), and select Clear Lane Statistics and Clear Images.
3. The next time you put the lane online, the selected PDL images will be displayed.

Load a PDL file

This topic assumes that your system already has PDL files on the hard disk. If not, create a new
PDL file: Manage Simulated Lane Images (see "Manage Simulated Lane Images (PDL)" on
page 169).

» Toload a previously created PDL file:

1. Take the lane offline (if necessary).

2. In Lane Overview or Sensor Overview mode, right-click a sensor button to see the Sensor
menu (on page 155).

3. Make sure Simulated is selected in the sensor menu: Choose Image Source > Simulated.
A check mark next to Simulated indicates the system will display images from disk, and
not the camera.
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4. Right-click over the sensor button to view the sensor menu again. Choose Image Source >

Select Simulated Lane Images. The Select Lane Simulation File screen is displayed.

Select Lane Simulation File
Device or Location Lane Images File Time !
Ci\PresscolLane 1\images Y | MylmageSet Lane1 0911912 PDL  9/19/2(

S \yimecese091ei2P0L oo

Sensor 1

Selected Lane Images Folder
C:\Pressco\Lane T\Images
¢l ] a

F .
[ Create Directory Selected Lane Images File
MylmageSet2 091912 FDL

20

In the right side of the screen, select the PDL file to display. Browse to a different

directory if necessary. Click the OK button @ to save the selection and exit the screen.
To clear the previous images from the lane, right-click over the Statistics menu (on page
43), and select Clear Lane Statistics and Clear Images.

The next time you put the lane online, the selected PDL images will be displayed.

Edit a PDL file

You can edit an existing PDL file by adding or deleting images. If your system does not already
have a PDL file, create one: Manage Simulated Lane Images (see "Manage Simulated Lane

Images (PDL)" on page 169).

> To edit an existing PDL file:

1.

Go to the Manage Simulation Image Files screen: Right-click a sensor button > choose
Image Source > Manage Simulated Lane Images.

In the Manage Simulation Image Files screen, click the drop-down menu under Image
Set, and select the PDL file to edit. The PDL file name is displayed in the Image Set box.
Check the Enable Modification box. The list of images in the PDL file is displayed in the
drop down menu next to the sensor name. You can add or delete images as desired.

> To delete images:

1.
2.

4.

Follow the instructions "To edit an existing PDL file" above.
Click the drop-down menu next to the sensor name to display the list of images in the
PDL file, and select an image name to delete. Release the trackball buttons or click

outside of the menu to collapse the drop-down menu.
Right-click over the drop-down menu next to the sensor name to see the Selected List

Options menu.

Selected List Options Lg‘!

Delete Current Selection
Delete All

From the menu, choose to delete the currently selected image or all the images in the
PDL file. The image(s) is deleted.
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5. Click the OK buttono to save the changes and exit.

> To add images:
1. Follow the instructions "To edit an existing PDL file" above.

2. Click the disk icon next to the 'Repeat Sequentially' drop-down menu. The Select
Sensor Images (on page 172) screen is displayed.

3. Add or remove images by browsing through the directories, using the Add or Remove
buttons.

4. Exit from the Select Sensor Images screen. The modified list of images is displayed in the
drop-down menu next to the sensor name in the Manage Simulation Image Files screen.

5. Click the OK buttono to save the changes and exit.

Select Sensor Images

Select individual images or a group of images to display on the sensor. (To select images for all
sensors within a lane, use Select Simulated Lane Images (see "Image Source" on page 168)) To
see this menu, right-click on a Sensor button to see the sensor menu, then choose Image
Source, then choose Select Sensor Images from the menu. (It is also displayed when you check
the Enable Modification box in the Manage Simulated Lane Images screen.)

Select Sensor Images

Device or Location
ca v I
+ PerfLogs o]
-l Pressco
+ bin
+ DataExport
Discovery

Discovery CE -no PPP

Discovery copled 92112
“ Help Image File Time Stamp
Images
InspectionModule Presets
+ Lane 0
-l Lane 1
Configuration
=l Images
Cosensrr
Sensor 2
Sensor 3
Sensor 4
Sensnr & [~}

Selected Image Folder
C:\Pressco\Lane 1\images\Sensor 1
- ) (.
| Filter | Add Remove
[ r
| All None

-
Create Directory
Selected Images
StandardBase9.bmp 'J
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> To select images:

1. Browse through the directories using the drop-down menu at the top of the screen. The
list of images in the selected directory is displayed on the right side of the screen.

2. Select an image name from the right side of the screen. Click the All button to select all
images in the directory, or click None to de-select all the images.

= To select a subset of common images, click the Filter button. This allows you to specify
a portion of the file name.

o A wild card (asterisk [*]) is required in the filter name

o Anexample is using "*good*" as a filter. Since many images are saved as either good
or bad parts, this allows you to select the set of images you want.

o Another example is using "*.bmp" as a filter. The Intellispec system can only load
bitmap (.bmp) images. If your directory has different image types, you can use the
filter to select only the .bmp files.

3. The Selected Images drop-down menu contains the set of images you have chosen. Use
the Remove button to remove an image from the set.

=  You can add images from more than one directory. After adding selected images from
one directory, browse to another directory in the left panel and add more images. The
drop-down menu below Selected Images shows all the image files you have selected.

4. Click the OK button @ to save the set of images. The next time you put the lane online,
it displays the set of images you have selected.

HOW TO SAVE IMAGES

There are a number of ways to save an image within the Intellispec system. Through most of
these options, you can save images to create a PDL (see "Manage Simulated Lane Images
(PDL)" on page 169) file to load at any time, to create or troubleshoot part programs. Images
can be saved whether the lane is online or offline, except the option: "Saving Images
Automatically" - that option allows you to save information while the lane is online.

Save any image: In most parts of the system, right-click over any image to save it (except the
Big Live Image). A Save Image menu item will be displayed. Select the desired type of image,
and save it. When the system asks you where to save it, use the disk icon to browse to a
location. If you are using a USB device, insert the device and browse to it. This useful to save
images to include with a Support Package.

More information about how to save images from different locations can be found through the
links below:

Saving Images Through the Sensor Menu (on page 174)

Saving Images Automatically (on page 175)

Saving Images through the Retro-Spec interface (on page 176)
Saving Individual Images While Editing an Inspection (on page 181)
Saving Reject Images (on page 182)

Saving a Region of Interest (Unwrapped) Image (on page 186)
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Saving Images Through the Sensor Menu

This tool allows you to quickly save a set of images from one sensor (up to 100 images). You
can use these images to set up and test part programs. You can save images whether the lane
is online or offline.

» To save images:

1. Right-click over the Sensor button in Lane Overview or Sensor Overview mode to see the
Sensor menu.

[@ Reject Enabled J

Camera Gain and Offset
Part Tracking &
Offline Imaging |
Image Analysis

Lighting 8
Review Camera Calibration

Save Images ’
Image Source ’
Options ’

Part Program Change Log

2. From the Sensor menu, select Save Images, then choose whether to save the last 100
images, the latest sensor defect images, or auto-save images. (See Saving Images
Automatically (on page 175)).

| Save Last 100 Images
Save Latest Sensor Defects
Auto-Save Images

r
Save Image
Where to save?

C:\Pressco\l ane 1\Images\Sensor 1\desrt v J
File Name Defects

Image File: Defects### bmp

3. Forthe last 100 images or latest sensor defects, a dialog box prompts you to change

directories. Click the disk button m to browse to a different folder if desired.
4. Type a prefix for the set of image files, if desired. The default "Defects" prefix is provided
for you.

5. Click the OK button @ to save the images.

Save Last 100 Images
Save the last 100 images captured by the current sensor.
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Save Latest Sensor Defects
Save the latest defect images shown in the Reject Images thumbnails, up to 100 images.

Saving Images Automatically

This feature automatically saves images from one sensor when the lane is online. You can set
up this feature to save up to 1000 images, and specify which images to save. The images can be
related to an inspection in the current part program, and they can be images from parts that
pass, fail, or both.

<+ Note: to save images, Save Online must be enabled, and the Start Auto-Save button must
be clicked.

» To get to this menu:

1. Right-click a sensor button. The sensor menu is displayed.
2. Select Save Images > Auto-Save Images. The Image Auto-Save menu is displayed. The
menu items are described below.

Image Auto-Save

1 P Selected Sensor Main (_
— :

2 P Save Location G \Lane Timag 1 v (2
3 —» FileName [Auto = —
4 P Quantity |71 (1..1000 Parts) ‘

5 —» Save Online

6 —p Q Skip N Parts Between Saves |0

. c E
7 — . By Inspection -- Any Inspection -- v I :ums . »
to-Save started.
8 p-Part Status  Passing orFailing ¥ Correlation(FILLER VALVF/CAPPER HEAD)
Saved 001 of 576.,Correl Juon( 1, 1) (Good Part)
9 » Regi i Not Registered "J Saved 002 of 576.,Corr/ation{ 1, 1) (Good Part)
Saved 003 of 576..Co/slation( 1, 1) (Bad Part)

Saved 004 of 576.,C / relation( 1, 1) (Bad Part)
1 0 —» Use Correlation

1M1 —>

(42 FILLER VALVE [1 (1. 144)
Q CAPPER HEAD 1 (1..36) J

12 T scr siosoe

13 14
1 Selected Sensor - Select the sensor in the current lane from which to save images
2 Save Location - Select the location to save the images. A default image path is provided. To

change the location, click the disk icon m and browse to the desired location.
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File Name - Create a file name, preferably something descriptive of the part you are inspecting.
When you click in the file name box, an on-screen keyboard is provided. The system
automatically appends and increases a number in the name, and indicates whether the part
passed [P] or failed [F]. An example name is "Auto0001_S1_P.bmp." This name indicates the
first image saved [0001], from sensor 1 [S1] and it passed inspection [P].

Quantity - Select how many images to auto-save, between 1 and 1000. Use the numeric
keypad [item 11] to enter a number.

Save Online - Check the box to enable auto-save. Images will only be saved when the lane is
online.

Skip N Parts Between Saves - Check the box if you do not want to save consecutive images.
Place the cursor in the number box and use the numeric keypad [item 11] to enter the number
[N] of parts to skip between saved images.

By Inspection - This is only available when you have one sensor selected [in item 1]. Check the
box to enable saving images related to a specific inspection. Use the drop-down menu to select
the inspection from the current part program.

Part Status - Select whether to save images that pass or fail inspection, or both. When images
are saved, the file name contains [P] for passing or [F] for failing.

Registration - Select whether to save images that failed registration [Not Registered], had a
found center [Centered], or had a found center and orientation [Centered and Oriented].

10

Use Correlation - [available if the correlation option is installed] Check this box to enable
saving images correlated to specific machine parts.

11

Machine parts - if Use Correlation is enabled, select the machine part(s) to which the saved
images are correlated. Also enter a machine part number in the box provided.

12

Start Auto-Save - Click the Start Auto-Save button to begin automatically saving images. Note
that images are only saved when the lane is online. To stop the automatic saving of images
before the process is complete, click the button when it reads Stop Auto-Save. If all the
specified images have been saved, the button returns to the default Start Auto-Save state.

13

Numeric keypad - Use the numeric keypad to enter values for quantity of images to save [item
4], or to skip a number of images between saves [item 6].

14

Status - This area displays the status of the auto-save process.

Saving Images through the Retro-Spec interface

This topic covers how to save images through the Retro-Spec interface. You may want to save
images to reference later, to send to Pressco for troubleshooting help, or to set up a part
program. Saving images is done through the Retro-Spec interface from Registrations,
Orientations, or Analyses. You must first have at least a temporary Part Program (see "How to
Create, Copy, or Import a Part Program" on page 193) loaded. You must have user access to
edit part programs.

Images can be saved whether the lane is online or offline. Images are saved as grayscale

bitmap i

X\

mages, at 302 KB in size. No graphics are saved with the images.

» To save one or more images:

1. Go to Sensor Overview mode [from Home, click Lane button, then Sensor button].
2. Putthe lane online for a while to acquire several part images.
3. Take the lane offline to stop acquiring images (if desired).
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4. Double-click the name of any Registration, Orientation, or Analysis in the inspection tree
to view the Retro-Spec interface. Note: you cannot save images through a Region of
Interest (ROI).

5. Right-click the Retro-Spec graph to see the Retro-Spec options (on page 212) menu.

RETRO-SPEC Options

@ Population View

Symmetric Limits
Auto Select Limits
Enable Warnings

Graph Scale Mode ’
Select Data Set A A Mothing Selected
Select Data Set B @ Last 100 Parts
L3

elect Lata e Latest Defects

Select Parameter * Image Files
6. Select an option for Data Set A and/or Data Set B (from Select Data Set A and Select Data
Set B).

7. Inthe Retro-Spec graph, click the bar corresponding to the image you want to save.

1
ol

7
0.0

Note: You can save a whole data set from the Save Image Files menu.
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8. Click the disk icon l]] on the Retro-Spec graph. The Save Image Files menu is displayed.
r b ™\
Save Image Files
Save what? Where to save?

@ Save selected parts. C:\P \Lane 1\images\S 1 v ]

( Save sel A (left side).

(Dragged parts will be saved to this

F Save setB (rightside). location.)

a
File names start with | |ﬁ

Image File: 1000.bmp

' Save Image with Graphics.

F Save Both.

20

L J

9. Choose which images to save under the "Save What?" column. Save only the selected
part image, or all the images from Data Set A or Data Set B.

10. Choose the type of image to save under the "Save Type" column. Save the image only,
the image with the graphics overlaid, or two separate images (both).

11. To name the image files, enter a prefix in the "File names start with" box. The default
prefix is "I" for "image." This step is important if you already have saved images and you
do not wish to overwrite them.

12. Use the disk icon m under "Where to Save?" to browse to the location where you want

to save images. Use the Select Location menu to save images to the Intellispec hard drive
or to a USB device. Create a new directory, if desired, to your images.

Select Location

C:\Pressco\Lane 2\Images\Sensor 1 v ]

Image File Timestamp o
Mickel27 bmp B/A/20105:24:21 PM
Micks{23 bmp S/A/20105:24:21 PM
Mickel3 bong 8/4/2010 5:24:20 PM
Nickeld bong 8/4/2010 5:24:20 PM
MickelS-Cortamination. binp 8/4/2010 5:24:20 PM
Hickel bmg 8/4/2010 5:24:20 PM
Mickel? beng 8/4/2010 5:24:20 PM
MickelB beng 08/4/2010 5:24:20 PM
Mickel3-Color defect bmp B/4/2010 5:24:20 P ]

Selected Image Folder C:\Presscoilane 2\images\Sensor 1

A Create Directory @ @

13. Click the OK buttonaI twice to save the image(s).
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«* Note: all images in a data set will be named with unique file names. However, if you
save another data set to the same folder at a later time using the same prefix, the
original images will be overwritten. See Recommendations for Image File Management
(on page 179).

14. To save subsequent single images to the same location, click the bar for another part and
then click the disk icon on the graph. The part image will be saved.

You can load (see "Loading Images" on page 187) saved images at a later time for reference,
setting up a part program, or testing.

‘0

®  Note: Part images can be dragged to the disk icon II] and saved if the Lock/Move Parts

button is unlocked: @

«» See more information about the Lock/Move Parts button in the Retro-Spec Population
View Graph (on page 210).

Recommendations for Image File Management

When you save the images for data sets to a folder, each image is given a unique name.
However, if you save another data set to the same folder, those original images are
overwritten. Therefore we recommend that you create new folders when you save data sets.
Our recommendations are:

e Make new folders and give them meaningful names

e Add the word Defects to the folder name to indicate that you are storing defects for that
inspection

When you are saving images (see "Saving Images through the Retro-Spec interface" on page
176), you can create new folders (directories).

> To create a new folder while saving images:

1. Click the disk icon m on the Retro-Spec graph. The Save Image Files menu is displayed.

r N ™
Save Image Files
Save what? Where to save?
@ e b te e C:\Pressco\lLane 1\Images\Sensor 1 v ]
(\ Save sel A (left side).
(‘ Save setB (rightside). (Dragged parts will be saved to this
location.)
File names start with |
Save type
Image File: 1000.bmp
@ Save Image Only.
(‘ Save Image with Graphics.
(k Save Both.
A A
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2. Click the disk icon m to browse folders. The Select Location menu is displayed.

Select Location

C:\Pressco\Lane 2\Images\Sensor 1 v ]

Image Fila Timestamp a
Mickal27 brrp 842010 5:24:21 PM
Nick2l23.brg 842010 5:24:21 PM
Nickel2 bong /472010 5:24:20 P
Mickel. beng: 8/4/20105:24:20 P
NickelS-Cortamnation binp 8/4/20105:24:20 P
NickelE: bengs 8/4/20105:24:20 P
Nickel7 beng /472010 5:24:20 P
MickelB beg B8/4/2010 5:24:20 P
HNickelS-Calor defect brp 8472010 5:24:20 Fi ]

Selected Image Folder C:\Presscollane 2\images\Sensor 1

i Create Directory @ @

3. Click the button at the top of the menu to browse to the location that makes sense to the
sensor (example, "C:\Pressco\Lane 1\Images\Sensor 1\"). Note that you can also save
images to a USB device.

4. Click the Create Directory button to create a new folder. Rename the folder something
meaningful, such as the area of inspection (example, Countersink). If you are saving
images of defects, use Defects in the folder name.

5. Click the OK @ button to complete browsing and return to the Save Image Files
menu.

6. Click the OK @ button to save the images. Depending where the images are being
stored, it may take up to a minute to complete, especially if a USB device is used.
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Saving Individual Images While Editing an Inspection

You can save one image while editing an inspection. To save the image, right-click over the
image to see the Image Options menu. Select Save Image from the menu, then choose the
desired option. The image can be saved whether the lane is online or offline.

Las 108 Bt RETRO-SPEC Population View: Contrast —

um |
O 4
18000 4

o GG

. tdnim 1
Bz |

i oo 1
Eﬂ:w-

& i 1
L
mwm

L]

Comra Linis 47138 Gt FALED

II.“Ew ﬂﬂtiﬂﬂﬂ- tra Elinr 10D . 1300 Total Sitee: ILOE (-0.008)
I B Aapludvie Sine LEC ]

Zoom BX - e

Zoom 4X

Fagen Exracion Paad Facialy
A, ] SN

Foom 2X

Hide Region Shading

Show Dalecls

W Enable Region Editor
Display Large Region Editor

u Edil Moda

The options are shown below.

Fanirast Lissies| Detemmines how sirang a gray shade variaion
s o e Defore s @ candkiate for a delect feanme)

n DE@ 6-

[ Image Only —
Image with Graphics
Both

Image Only
Saves a bitmap (.bmp) image with no graphics.

7
0.0

Note: only bitmap images can be loaded back into the Intellispec

Image with Graphics
Saves the current image with inspection graphics on the image. It is saved as a Portable
Network Graphic (.png) file.

Both
Saves both files - (.bmp) with no graphics, and (.png) with graphics.
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When you save an image, a dialog box, as shown below, provides options for saving the image.
The image is saved to the default location shown in the box, unless you click the disk icon and
specify a different location. A default file name including Lane name, date, and time is provided

for you. You can rename the image by clicking on the keyboard icon and typing a new name
using the on screen keyboard.

Save Image
Where to save? I

cap \Lane 3\Umages\Sensor 1 v | l".._l.‘

File Name Dime Aug 16 2011 16.59.35.14

i

Image File: Dime Aug 16 2011 16.59.35.14 bmp

! <Xx)

Saving Reject Images

You can save images from parts that were considered defective, either from Lane Overview or
Sensor Overview mode. This can be done when the Reject Images button on the right side of
the screen is selected. Up to 100 images can be saved at a time. These images can be loaded at
a later time as simulated images to assist in programming inspections or training.

Images can be saved whether the lane is online or offline.

it Inages

» To save reject images:

1. Right-click over any image displayed in the reject image area on the screen (Images in
Sensor Overview mode shown below). The Defect Image Options menu is displayed.

cisece ek

P, 13 7R dd P T ] RG] TR 107 4B

x

e 73 W0 Hk 1339 18 RE ke 133018

Defect Image Options l}]

_Save DefectImages |

2. Select Save Defect Images from the menu. The Save Image menu allows you to change
the directory or name of the images to be saved. A default name and directory are
provided for you.

3. Change the directory or file name if desired and click the OK button to exit. The images
are saved as bitmap (.bmp) images. Each image is given a unique name.

Saving Reject Images by Inspection

You can save images that failed a specific inspection in Sensor Overview mode [from System
Overview mode, select a lane, then click a Sensor button [item 1] to go to Sensor Overview
mode]. There are two ways to save inspection-specific images. Refer to the illustration below.
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2

% Note: If you select an inspection that did not fail any parts, all reject images from that
sensor, up to 100 images, are saved.

» If the Reject Images button [item 4] is selected on the right side of the screen:

1. Click the name of an inspection [item 3] in the inspection tree. The images associated
with that inspection are displayed in the thumbnail image area.

2. Right-click over the set of images to see the Defect Image Options menu [item 2].

3. Select Save Defect Images from the menu. The Save Image menu allows you to change
the directory or name of the images to be saved. A default name and directory are
provided for you.

4. Change the directory or file name if desired and click the OK button to exit. The images
are saved as bitmap (.bmp) images. Each image is given a unique name.

0 ppm PRESSCO INTZLLISPEC
0 (max) FECHWOLOGT INC.
_—— . - = ,- Trend Graphs
1 T |

=
Machine Parts
@
Statistics
; @
Reject Images

Defect %
32222

& Ring [2]

a
- 43 Pattern Match l
T Gaad
-1@ Py n 1
* nc::rs:t:‘] Measurement Mat Complete =
Measure Extract Mot Complets r Timing Trend
r Ring
3 - Pattern Match
Polygon
* Contrast [3] F s | r— Inspections
=@ Pobygon [4]
Pol
# Amitilerit tygon
@ Polygon [5] Folygon Gaoad =
e Gonrast oot | [ statistics
Pulygon Good
Amiblent Good
4 Polygon Good l -
Distance Hat Complets rEIQ Live Image
Py P — a

EMER012 10:51:52 AM

1 Sensor button

2 Right-click over image thumbnails to see Defect Image Options menu

3 Select one inspection to view defect images associated with that inspection

4 Select the Reject Images button to view thumbnails of images from defective parts

> If the Statistics button [item 4a] is selected on the right side of the screen (refer to the
illustration below):

1. Click the name of an inspection [item 3a] in the inspection table. The images associated
with that inspection are displayed in the thumbnail image area.

2. Right-click over the set of images to see the Defect Image Options menu [item 2].

3. Select Save Defect Images from the menu. The Save Image menu allows you to change
the directory or name of the images to be saved. A default name and directory are
provided for you.
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4. Change the directory or file name if desired and click the OK button to exit. The images
are saved as bitmap (.bmp) images. Each image is given a unique name.

En B a Administrator v| 0 ppm PRESSCO INTELLISPEC
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0 0 0,000 0 0,000
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10928 0 0,000 0 0,000 -rT'""'"U Trond
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10928 1667 14247 £ 6.600 d
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otygn [5]

10928

4a

1 Sensor button

2 Right-click over image thumbnails to see Defect Image Options menu

3a Select one inspection to view defect images associated with that inspection
4a Select the Statistics button to view detailed inspection statistics

Saving Reject Images by Machine Part
You can save images that failed inspection and are associated with specific machine parts.

» To save images associated with a machine part (refer to the illustration below):

1. Go to Sensor Overview mode: from System Overview mode, select a lane, then click a
Sensor button [item 1] to go to Sensor Overview mode.

2. Click the Machine Parts button [item 4b] on the right side of the screen. The images
associated with machine parts are displayed in the thumbnail area.

3. Select a different machine part from the drop-down menu [item 3b], if desired.

4. Select a specific machine part from the graph [item 5]. The name of the machine part is
displayed in the button above the V-axis selection.

5. Right-click over the set of images to see the Defect Image Options menu [item 2].

6. Select Save Defect Images from the menu. The Save Image menu allows you to change
the directory or name of the images to be saved. A default name and directory are
provided for you.

7. Change the directory or file name if desired and click the OK button to exit. The images
associated with that machine part are saved as bitmap (.bmp) images. Each image is
given a unique name.
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1 Sensor button

2 Right-click over image thumbnails to see Defect Image Options menu

3b Select a machine part type

4b Select the Machine Parts button to view thumbnails of defective parts associated with specific
machine parts

5 Select a specific machine part from the graph

Saving Individual Reject Images
You can select any thumbnail image in Sensor Overview mode and save it.

> To save an image (refer to the illustration below):

1. Go to Sensor Overview mode: from System Overview mode, select a lane, then click a
Sensor button [item 1] to go to Sensor Overview mode.

2. Click any thumbnail image [item 3c] (available when Reject Images or Statistics button is
selected). The Reject Images button becomes selected after you select the thumbnail
image.

3. Right-click over the large image at the bottom of the screen to see the Image Options
menu [item 2c].
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4. Select Save Image from the menu. Choose to save the Image Only, Image with Graphics,
or Both. For information about these options, refer to Saving Individual Images While
Editing an Inspection (on page 181). The image is saved.
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Right-click over the image to see Image Options menu

3c

Select a thumbnail image

4c

When you select a thumbnail image, the Reject Images button becomes selected for you

Saving a Region of Interest (Unwrapped) Image

You can save the unwrapped region display while you are editing an inspection. The image will
be saved as a Portable Network Graphic (.png) file. An example unwrapped image is shown
below. The image will be the same dimensions as the defined region of interest. Note that the
Intellispec stretches some images to fit the region of interest window.

The image can be saved whether the lane is online or offline.

¢ Note: whether regions, edges, or other graphics are saved depends on the settings when
you save the image. If diagnostics are on, or if Show Graphics is enabled, those items are
saved with the image.
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> To save the unwrapped image while editing an inspection:

1. Right-click in the unwrapped image area to view the ROl Options menu.

" ROl Options . |

Save Image i

@ Show Graphics
~ Region Display Mode »

2. Choose Save Image from the menu. The Save Image menu allows you to change the
directory or name of the image to be saved.

3. Change the directory or file name as desired and click the OK button to exit. The image is
saved as a .png file.

LOADING IMAGES

This topic covers how to load images through the Retro-Spec interface. You can also choose an
Image Source (on page 168) through the Sensor menu.

You can load images previously saved (see "Saving Images through the Retro-Spec interface"
on page 176) on the Intellispec to use as reference, test part sets, or to set up a part program
without the production line running. You must have user access to edit part programs.

» Toload images:

1. Go to Sensor Overview mode [from Home, click Lane button, then Sensor button].
2. Double-click the name of any Registration, Orientation, or Analysis in the inspection tree
to view the Retro-Spec interface graph. A partial graph is shown below.

L 100 RetroSpec Population View: Ambient

250 P
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I T T
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3. Click one of the left or right arrow buttons n to view the Select Data Sets menu.
r -~

Select Data Sets

Set A (left side) Set B (right side)

Irﬁ Mothing Selecied (H— Hathing Seleckes]

Ir— Mo Changes (ketp current pars) r‘_ Mo Changes (ke e cment pans)
Irﬂ Las1 100 @ Last 100

Ir_ Latest Defects |(_ Latest Defecis

@ Image Flles [H_ Image Files
CPresscoilane TimagesiSemso 1 v |

XX

5. Click the disk icon m to browse to the folder where the images were saved. The Select
Location menu is displayed.

4. Click the Image Files button for either Set A or Set B.

Select Location

ca v |

+ Defect Database
Discovery
+ Discovery and Lanes Backup
+ Help
+ Images

InspectionModuleFresets

+ Lane 0

* Lane 1 Image File Timestamp a

S Lane 2 Bady Damaged Nickel bp /47201052420 PM

Mickell.bmp /47201052420 PM

Change Logs_bak Nickell1 brrp B/4/20105:24:20 P

Configuration Hickell 2 bmp B/4/20105:24:20 PM

Nuckell 3bmp B/4/2010 5:24:20 P

DbBackup Hickell4.brmp 0/4/20105:24:20 PM

- Images Hickel1 50wt Smear bmp 8/4/20105:24:20 PM

Hickel16.bmp 8/4/20105:24:21 PM

L e TR AZDI052421 P

- T

B my directory Hicksl18bmp BA2010524:21 PM

Sensor 2 ] Nickel22 Chpped Edge bmp AA4/2010 5:24:21 P V]

Selected Image Folder C:\Fresscollane 2\images\Sensor 1

- . . .
Create Directory @ @

6. Browse to and select the folder that contains the images you want to load.

= To preview the images in the folder, browse through the file names in the window on
the right of the Select Location menu.

7. Click the OK button @' twice. The Intellispec loads all the bitmap images that were
previously saved in the selected folder.
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IMAGE OPTIONS

While viewing an inspection screen, right-click in the part image to see the Image Options
menu. A small check indicates that the option is currently active. Click an option to make it
active or toggle it to inactive. The default Image Options menu is shown below.

«*» Note: some menu items are not shown when you are viewing a registration or orientation.
r 1

Image Options N
Zoom 6X

Zoom 4X

Zoom 2X

Normal Resolution

Save Image B

@ Show Graphics
Show Regions
Hide Region Shading
Show Defects

@ Enable Region Editor
Display Large Region Editor

Enable Moving Region

Enable Region Resizing

Enable Set Region Direction
[\ Close Menu J

There are options for certain regions. Options are grayed out if they do not apply to the current
inspection.
Zoom - 6X, 4X, 2X

Magnify the image by the specified amount.

Normal Resolution
Return the image to normal size.

Save Image
Save an individual image. Refer to Saving Individual Images While Editing an Inspection (on
page 181).
Image Analysis
Not available from this menu as of this printing.
Image Analysis (on page 158)
Show Graphics
Display the region and graphics for the current inspection.

Show Regions
Display the region(s) from other inspections in the same part program.

Hide Region Shading
Remove the shaded graphics from the screen so that you can see more of the part image.

Show Defects
Not available from this menu as of this printing.

Enable Region Editor
Change the shape and placement of the region directly on the image.
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Display Large Region Editor
Display a large part image on which you can change the shape and placement of the region.
Check Enable Region Editor to make the changes to the region. Un-check this option to
return the image to normal size.

Enable Moving Center
[Available when you are editing a region] Change the center of the region when you are
using Region Editor directly on the image.

Enable Region Resizing
Resize the region directly on the image.

Enable Set Region Direction
[Available in certain inspections such as Measure ROI] When this feature is enabled, click on
the region in the image. The region box will be displayed in yellow with diamonds around
the box. Click on one of the diamonds to make the inspection search in the direction of the
selected diamond. The selected diamond is filled in solid yellow.

Center Ring
[Available when you are using Region Editor directly on the image and Enable Moving
Center is checked.] Click Center Ring to re-center the region on the image using the current
parameters. This is a command; there will be no check mark next to this option.

Edit Mode
A Polygon inspection has the option to “Complete Build Mode” to add points to the
polygon. Edit Mode becomes available after a Build Mode is complete. Options below are
only active if a check mark appears next to the option in the menu.

Delete - Click all polygon points that you want to delete. To stop deleting points, right-click
to see Image Options menu. Select Edit Mode > and un-check Delete.

Add - Click anywhere between two points to add another point. To stop adding points,
right-click to see Image Options menu. Select Edit Mode > and un-check Add.

Move - move one point in the polygon. Move the cursor over the point you want to move,
then click and drag the point.

Enable Moving Region - [only available when Move is enabled] Move the entire region at
once. To move the polygon, click anywhere on the image except on one of the yellow
polygon points. Click and drag the polygon to move it.

Enable Rotate Around Center - [only available when Move is enabled] Rotate the entire
polygon with respect to the center. To rotate the polygon, click anywhere on the image
except on one of the yellow polygon points. Click and drag the polygon to rotate it.
[.. Delete ]

Add
& Move

Enable Moving Region
jahla Rotate Around Center
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Chapter

12

INSPECTION OVERVIEW

This section includes basic information about part programs, part tracking, and Retro-Spec
graphs. For detailed information about adding or adjusting inspections, see the section about
Inspections (on page 215).

INSPECTION TERMINOLOGY

The following terms are used throughout this manual and the software. A basic understanding
of this terminology will help you understand how the system operates.

Term

Description

Analyses (on page 296)

An analysis usually analyzes the pixel shade information within a region and
compares it to programmed reference values. The inspection passes or fails
based on these comparisons. There are also several analyses that make
measurements. You may have many analyses for each inspection region.

Dimensions (on page 349)

The dimension inspection type is special in that it connects the results of two
other inspections to do the analysis. For example, a distance inspection can
connect two registrations to measure the distance between centers of two
features.

Enhancements (on page
229)

Enhancements are used to alter images for the purpose of better defect
detection, or for making certain features stand out.

Inspection Module

The housing, camera, cables, and associated electronics that are installed on or
over the production line to acquire an image of your products. Sometimes
referred to as a tunnel. The inspection module can consist of a different sensor
than a camera to make measurements of your product.

Lane

A lane usually refers to one production line, and can contain multiple sensors.

Orientations (on page 288)

An orientation compensates for part rotation by finding a grayscale pattern. An
analysis which must rotate with the part must follow an orientation.

Part Program

The list of regions, analyses, registrations, etc. programmed specifically for your
part to detect defects or make measurements.

Part Tracking (on page 192)

Part Tracking refers to the monitoring of parts from the part detect sensor to
reject station. This ensures that the correct parts are rejected at the correct time,
and that good parts remain in the part stream.

Region (see "Regions of
Interest (ROI)" on page 216)

The Region indicates where on the part the analyses will take place. You may
have as many analyses, enhancements, registrations, or orientations as you like in
one region.

Registrations (on page 249)

A registration compensates for part movement by calculating the reference point
on the part. All analyses follow a registration.

Reject A part that failed one or more inspections from any sensor. The part can be
physically rejected, or simply counted in the statistics.
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Retro-Spec

The graphical interface used in inspections that allows you to make quick changes
to a part program. It also allows you to experiment with different parameter
settings to see how changes would have affected the most recent inspection
population, without unnecessarily rejecting parts.

Sensor

A camera, Intellimass, or other sensor that acquires images, measurements, or
other data from your product.

SEQUENCE OF EVENTS DURING INSPECTION

The following illustration demonstrates a typical inspection sequence of events. Note that your
system configuration may involve more components, and may be different than pictured here.
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Re]ect Time Delay

Reject
Position

PART TRACKING

Part Tracking refers to the monitoring of parts from the part detect sensor to reject station.

i

This ensures that the correct parts are rejected at the correct time, and that good parts remain
in the part stream.

Part Tracking includes:

Part Present Delay Calibration (on page 131)

Reject Delay Calibration (on page 133)
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Reject Confirm Calibration (see "Reject Confirm Calibration (Optional)" on page 139)
Part Width Calibration (on page 114)

HOW TO CREATE, COPY, OR IMPORT A PART
PROGRAM

A new Part Program can be created from scratch, imported or exported to/from disk, or copied
from an existing part program. A Part Program is created in the Lane Overview or Sensor
Overview screen.

> You will need:

e User access to create part programs

» To create a Part Program:

1. Goto aLane Overview or Sensor Overview screen [from Home: Lane button > Sensor
button].

2. Right-click over the part program drop-down menu. The Manage Part Programs menu is
displayed. Choose from the available options described below.

Lane 1 Manage Part Programs

Tedal Fans.
a Part Programs

: Defects Penny | =
I.” NICKEL
1] —
Defect % ey

——d Rename ]
ST =
Right-click E

|'—Irnp‘:u't.i' Export

Currently Running Part <NICKEL>

©

1. Click the New button. An on-screen keyboard is presented.
2. Name the new part program. We recommend that you use your part's name and size in
the part program name.

» To create a new program:

3. Click the OK button @ to save the new part program. The new part program is
automatically loaded and displayed in the drop-down menu below the traffic light. No
inspections are created yet.

4. Click the OK button again to close the Manage Part Programs menu.

5. Add inspections as appropriate for your part. Use inspections recommended by Pressco
technicians to best inspect your part.

» To copy a program:

You can use a copy of a part program to modify it to inspect a slightly different part, or modify
the copied part program without changing the original program.

1. Right-click over the part program drop-down menu (under the traffic light). The Manage
Part Programs menu is displayed
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2. Select one of the available part programs, then click the Copy button. A copy of that part
program is saved under a default name such as "(1) Penny."

3. Select the new part program, and use the Rename button to rename the program to
something more meaningful to you.

» Toimport an existing program:

You may have used a part program in another Intellispec system, or Pressco may have sent you
a part program to use. Import that program to use it on your current system.

1. Right-click over the part program drop-down menu (under the traffic light). The Manage
Part Programs menu is displayed

2. Click the Import/Export button. An "Import or Export Part Programs" menu allows you to
choose a part program from disk.

Import ar Export Part Programs

Curranl Pard Programs Deake

© Papssos D bt rm

Panny

Fanny1

My new part program
i1} Panny 1

<ChWPresscoiDataExport> Q

3. To browse to another location on the computer, click the disk icon li"]

4. Locate the desired folder and click OK in the menu. The Intellispec will only choose part
program names with a ".PPP" extension. You will not be able to see the names nor
extensions when choosing through this menu.

= |nthis example, we clicked the Part Programs folder, then clicked OK to view the
available part programs.

# | Lane 0

# ) Lane 1

=l ) Lane 2
) Change Logs

) Configuration .
% | Images Disk

) InspectionTemplates C:APressco\Lane Z\Parle{.‘H
Sl ]t Prograns |

+ | ) Archives

(2 Parameters Nickel ______________

2 Statistics
5. To import the part program, highlight the name in the right side of the menu under
"Disk."
6. Click the left arrow. The part program is imported into the "Current Part Programs" list.
7. Click the OK button to exit the menu.

194 Inspection Overview System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
© 2013 Pressco Technology Inc. Proprietary



» To load the new program:

1. Highlight the program name in the Manage Part Programs menu, then click the Load
button. The program name will appear in the Part Program drop-down menu on the Lane
Overview or Sensor Overview screen.

2. Click the OK button @ to exit the Manage Part Programs menu.
See also Export a part program (on page 121)

PART CHANGEOVER

When you change your production line from one part type to another, you can quickly change
the part program.

«*» Note: Some menu items are only available to advanced level users.

> What you need:
e User permission to Switch Part Program

» To change parts:
1. Login (see "Logging in and logging out" on page 49).
2. Click the part drop-down menu.

'ﬂ

~

Meas: ci_test

Test_oricntation
Measure_extracl_iest

My new part program
(1) Penny1

3. Click the name of the new part to inspect. The new part program is loaded on the

Intellispec.
4. Put the system online to begin inspecting new parts.

Lane-specific information is contained in each Part Program. Everything you set up have
previously set up is stored: camera information, lighting information, calibration information,
regions, enhancements, and analyses.

Lane Specific Information Definition

Cameras (or other sensor) All information for each camera or other sensor is contained in the Part
Program.

Lighting Each camera has different lighting settings for each part. When you load your

Part Program after a Part Changeover, the lighting will be specific for that
part and save any changes you make.

Calibration Calibration setup for Part Present Delay and Reject Delay is saved for each
part you will run. Part Present and Reject Delay will only need to be set up
once.

Regions, Registrations, All Inspections will be contained in your Part Program. Also, parameter

Orientations, Enhancements, changes are saved for each Part Program.

Analyses, Dimensions

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspection Overview 195
© 2013 Pressco Technology Inc. Proprietary



INSPECTION MENU

The Inspection menu is used to create and edit part programs. Right-click over any analysis,
region, orientation, or registration name to see the Inspection menu. A menu similar to the one
shown below is displayed.

7
°

Note: For simplicity, we use the term 'inspection' to include analyses, regions,
enhancements, registrations, etc.

*

Note: some items may be grayed out if you do not have user access to those items, or if
they do not apply to the current menu.

rInspection Menu [ |

Info

Edit Registration

Is Inspection Enabled? Yes No

Is Inspection Reject Enabled? Yes v No
Is Empty Pocket Check? Yes No v

Rename

Insert »
Add

Replace B

Delete Registration
Part Program Change Log
Copy »

The items in the Inspection menu are as follows:

Info
Display general information about the inspection.

Inspection Information

1 %ﬁ-ﬂamﬂ: Find Part

2 ——; P*General Type: Region

3 » Specific Type: Ring

1 Name - the name you have given the inspection

2 General type - Analysis, Region, Orientation, etc.

3 Specific type - sub-category (example, Ring, Polygon, or Measurement Region)

Edit Analysis/ Region/ Orientation/ Registration
Open the Inspection Editor - performs the same action as double clicking.

For the items below, the name of the inspection becomes color-coded. See the illustration
below.

Is Inspection Enabled?
You can temporarily turn off the inspection by clicking this option. If "Yes" is checked, then
inspection is enabled.
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Click the menu item to disable the inspection; "No" becomes checked in the menu. If an
inspection is disabled, all of its dependent inspections will be disabled as well. The
inspection name is grayed out in the inspection tree when it is disabled [item d in the
illustration below].

Is Inspection Reject Enabled?
You can temporarily pass all parts regardless of whether they pass or fail the current
inspection (if Reject is disabled). If "Yes" is checked, then inspection reject is enabled.

Click the menu item to disable the inspection reject; "No" becomes checked in the menu.
The inspection name is displayed in red when the inspection reject is disabled [item c in the
illustration below].

Is Empty Pocket (on page 215) Check?
Is the current inspection used as an Empty Pocket check? If "Yes" is checked, then
inspection is being used as an empty pocket check.

When the Empty Pocket Check is enabled, the inspection is highlighted in blue in the menu
as shown below [item b].

- Inspections

1@ Ring [1] <+— a

@ Radial Edge <4— |
% Measurement 4—— (C
# Measure Extract off—— d

| eRngll & €

- U Pattern Match

a Inspection in normal state

b Inspection is an empty pocket check

C Inspection reject is disabled

d Inspection is disabled

e Inspection is currently selected by the cursor
Rename

Rename the inspection to something that makes sense to you. This name will appear in the
inspection tree, graphs, and anywhere else the inspection name occurs.

Insert
Choose from the available list to add one item above the currently selected item.

Add
Add an item from the available list. The list varies, depending on the current item.

Replace
Replace the current item with a similar item. Regions can be replaced with other regions,
registrations replaced with other registrations, etc.

Delete Analysis/ Region/ Orientation/ Registration
Delete the current item from the inspection tree list. If the item has other items below it (at
a lower hierarchy), those items are deleted as well.

Delete All Inspections
[only shown when you right-click on "Inspections" at the top of the inspection tree] Delete
all inspections from the current part program.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspection Overview 197
© 2013 Pressco Technology Inc. Proprietary



Part Program Change Log (on page 198)
Display the Part Program Change Log. This lists the inspections and the edit history for each.
You can view all inspections from one sensor, other sensors, or other part programs.

Copy
Copy the current item and descendants (if applicable). The items are copied to the

clipboard. Use Paste to place them in the inspection list. You may copy a part program to
the same sensor, a different sensor, or different lane.

To copy the part program to another Intellispec system, use the Export function. See Export
a part program (on page 121).

Paste
Paste the contents of the clipboard into the inspection list. The contents are pasted below
the currently selected item.

Collapse All
[only shown when you right-click on "Inspections" at the top of the inspection tree] Collapse
the inspection tree to the top level inspection. This does not affect inspection.

Part Program Change Log

The part program change log lists the inspections and the edit history for each. You can view all
inspections from one sensor, other sensors, or other part programs. This is helpful if you want
to see the previous settings for an inspection.

Part Program Change Log Q | Roll Back |
i ndefin ) Fry:

Inspection Undefined |-._J Show nspect
Part Program  Measurement_fest Q Show Other Pan Programs
Senszor Undefined ] 7

Type  Time Stamp User Comera/Sensor  Inspaction Parametar Before Aller

Create | 2011-02-15 18:12:18 | Administratar |Plicke! Ring.

Edit 2011-02-15 16.12.48 | Administrator |Nicked Firg Inner Radius 25 193

Edit 201 1-02-15 18:12:48 | Administratar | Micke! Fing Thicknass 50 53

Create | 2011-02-15 18:12:57 | Administratar |blicke! Radial Edge

Edit 2011-02-15 16.13:36 | Administratr |Nicked Facisl Edge Target Size 100 230

Edit 2011-02-15 18:13:38 | Administrator | Micke! Fadial Edga Qualifying Parcant Limits |26 00 W60 06 E:32.TIW WA 315

Create | 2011-02-15 18:13:56 | Administratar |blicke! Measurement

Edit 2011-02-15 17.17:21 | Administratr |Nicked Maasurement Feature Type Light Featurs Borders: Both Light

Edit 2011-02-15 171721 | Administrabar | Micked Massurament Inner Diameter Enablad | Mo Yas

Edit 2011-02-15 17:17:21 | Administrabar | Mickel Measurement Width. Enabled Mo es

Edit 2011-02-15 17.17:21 | Administratar | Nickel Measurement Width. Units pisel Custom urit

Edit 20010215 171721 | Administrator | Macked Massurament Width Naminal Value 530 265

Edit 20110215 17:17:21 | Administrabar | Mickel Measurament Width. Min/Max E:S0L0:W Woel 000G [S5555.0) GrO.OW WOIE | E-25 42W W25 17-G [26 5] GDLOW WO T7E

Edit 2011-02-15 17.17:21 | Administratar | Nicksl Measurement Width Average E-50.0W W-10 0LG [S5555.0) G.0.0W WODE |E-26 5WW.-26.5.5 [26 5] G DL0W W0 DE

Edit 2011-02-18 17:17:21 | Administrator | Macked Maasurament Width, Cantinuity E-50.0W W-10 06 G:10.0W W80 0 E E-10 TEW W5 656 G:3 B3 W WA BZE

Edit 20110215 17:17:21 | Administratar | Micke! Measurament Width Range 53 0E Gi11.65E

Create | 2011-03-01 18:03:37 |Administratar |Plicks! Clipping

Edit 2011-03-01 16:05:17 | Administratar |Micked Clipping Use Clipging (3 Yas

Create | 20110301 18:05:26 | Administratar |bicks! Stretch Grayshades

b

» To view the part change log:

1. Click a sensor button to go to Sensor Overview mode.
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2. Right-click over a sensor button or inspection name and select Part Program Change Log
from the Inspection menu. If you right-clicked over an inspection name, and the current
inspection has never been changed since it was set up, no data is displayed.

3. Click any of the available check boxes to view other inspections, inspections from other
part programs, or inspections from other sensors. Some boxes are dependent on others;
for example, you must click a dark gray check box before a light gray check box becomes

active.

To view a full column width, click and drag the column title to re-size that column.

L4 Create 2010-08-20 08: 2b: 29

Trcia Penny1

Part Program

Click the Details button to see more information about the highlighted item. A pop-up window
displays more information, including the number of times the inspection was modified.

Change Log Details
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Click the Filter button to choose the items to display in the log. As soon as you select any
option, the Change Log is updated. Some options are dependent on others; for example, if you
want to see the Historic Names for the Sensor, you must choose Historic Names for Inspection

first.
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> To see inspection differences:

1. Click the Difference button to see a list of differences in inspections. A Mark Start/ Mark
Stop menu is displayed, and the inspections in the list are highlighted in magenta
(depending where your cursor is).

| Tema Tare Biamp Lhgr o al ooy

:\5 Crewie ELETETET L RTINS
[ Cremss | BOIDB41E1BAZI |Tris
| Mark Start e —
e 200 0-34-31 13 3040 | Tricis

,,-
Mﬂﬂ( Stn L) E 20108058 18 30 14
Ecn 2010-34-31 1328 21

£ AL 1R | Trms

d

Tricis

- HHHHHBE

2. Click the Mark Start button.

3. Click on the first item in the list where you want to begin viewing inspection differences.
(this is similar to holding the Shift key and selecting multiple items in a list)

4. Click the Mark Stop button.

5. Click on the last item in the list where you want to view inspection differences. Your
selected items are highlighted in magenta.

6. Click the OK button 9 in the Mark Start/ Mark Stop menu. A Differences table is
displayed. This allows you to view a shorter list of items, only those of which have been
changed. Only edited (not created) inspections are included.

Differences
LT CamadalSandaarn Past Pragram Irnepaciian Fai ametar Heidarn Advar
Triia Parssl Dema Comsertad End | Cligping Enabla Clipping Trua Falea
Tricis Parel Cemo Comverted End | Clipping Filack amd 'White Lewval | 50(225) a0 225
Tricis Pare| Cemo Comverted End | Radel Edge: Rejector Disabled Trus Falws
Trices Parel Cremo Comeeried End | Rang D Inspection Dizabled Falze True
£ *

i v

by |
Rollback

This feature allows you to restore the part program to a previous state, allowing you to undo
several changes at once.

» To use the Rollback feature:

1. Check the box next to the Rollback button at the top of the Part Change Log Viewer
screen.

2. Scroll down towards the bottom of the inspection list. The latest changes are at the
bottom of the list.

3. Choose a line where you want to delete the latest changes, including the selected line.
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4. Click the Rollback button near the top of the screen. A Rollback Preview is displayed so
that you can see what will be deleted.

Rollback Preview

Taper T s Hlamp [ R —— B A Fraamelnr Hatee Al

. 9o

5. If desired, click the Details button to see the inspection change details of each line.

6. If you are ready to delete the displayed lines, click the OK button 9 The lines are
deleted, and the part program is changed back to a previous state.

Inspection type icons

In the Inspection tree, you may see icons or symbols that indicate the General Type of
inspection for each item. These allow you to quickly identify these inspections, without the
need to view more information through the menus.

% Note: these are options. To enable icons or symbols, right-click on a Sensor button in the
Sensor Overview mode and select Options >> check Show Icons or Show Symbols.

= [‘D Ring [1] =@ Radial Edge
- @ Ring [2
= 0 Radial Edge -z
J Pattern Match [1]
=1
1+ = Ring[2] U Pattern Match [2]
= '; Polygon [1] # Contrast [1]
Contrast [2] .
# Contrast [2]
E ciipping # Clipping
E stretch Grayshades ¥ Stretch Grayshades
Symbol General Inspection Type

Region - location of inspection

Registration - to find part center or point of reference

Analysis - inspection

Orientation - to place an inspection on the same location on each part,
regardless of part rotation

Enhancement - to add image processing to make defects or part features stand
out better

Intellispec Mass inspection

1 %G| *| @] ©

@ m | Be| = @008
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Options (sensor menu)

The Sensor Options menu allows you to display the inspection tree the best way for you. Some
options hide objects from the inspection tree which makes it easier for adjustments. Other
options display icons or symbols to help you quickly identify inspection types.

7
0’0

Note: these settings apply to the current sensor view only.

» To enable an option:

1. From the Sensor Overview mode, right-click a Sensor button.
2. Select Options >> then select one of the options described below. An option is enabled
when a check mark is displayed next to the option.
[ Show |cons _]
& Show Symbols
Show Standard Names

Show Icons

Displays icons that reflect the different inspection types (see "Inspection type icons" on
page 201).

-2 Ring[1]

= ¢ Radial Edge

<= Ring [2]
= IZ,:; Polygon [1]
Contrast [2]
E Clipping

E stretch Grayshades

Show Symbols

Displays symbols that reflect the different inspection types (see "Inspection type icons" on
page 201).

Clnspections
-l@ Ring [1]
- @ Radial Edge

- @ Ring [2]
O Pattern Match [1]
O Pattern Match [2]
#% Contrast [1]

- @ Polygon [1]
# Contrast [2]
¥ Clipping
¥ Stretch Grayshades

Show Standard Names

Displays the default Intellispec inspection names. You may have other inspection names
that make sense to the inspection of your part. Showing Standard Names is useful to

Pressco engineers or to someone troubleshooting your machine, so that they quickly know
the exact inspection type.
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INSPECTION TREE RELATIONSHIPS

The inspection tree shows the relationship of each inspection. Indented objects are dependent
on the object above it. Indented objects are created when you "Add" an item from the
Inspection menu.
-l@ Ring [1]
- @ Radial Edge
- @ Ring [2]
J Pattern Match [1]
U Pattern Match [2]
# Contrast[1]
- @& Polygon [1]
# Contrast [2]
¥ Clipping
¥ Stretch Grayshades

Some items in the menu may be turned off. The ability to access some items depends on your
user access.

Inspection tree items may be highlighted in different colors. Below is a key.
- Inspections
-1@ Ring [1] <4+— a
@ Radial Edge <4— |
#* Measurement —— (G
# Measure Extract <f4—— d
| eRingl2l 4 €

-/ Pattern Match

a Inspection in normal state

b Inspection is an empty pocket check

C Inspection reject is disabled

d Inspection is disabled

e Inspection is currently selected by the cursor

Design Mode Icon

The Design Mode icon provides additional part program restrictions. Click the icon to see the

options.
==
Edit Only
‘. Y N
# Design and Edit
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e If you select Edit Only, then users are allowed to edit, but not add, the inspections. This
also restricts access to regions.

e If you select Design and Edit, then users are allowed to edit and add inspections, as well as
add and edit regions.

7
°

Note: some users (for example, Operators) cannot edit or add inspections regardless of this
setting. To add and edit inspections in Design and Edit mode, users must also have proper
permissions. See Managing Permissions (on page 56).

See also how to create a part program (see "How to Create, Copy, or Import a Part Program"
on page 193)

ADDING REGIONS AND INSPECTIONS

To add an Analysis, Enhancement, etc., you must first add a Region. The Region indicates
where on the part Analyses or Enhancements are applied. Right-click over the inspection tree,
select Add, then choose an item to add. You may add as many inspections underneath the
region as you wish.

REGION EDITOR

This view is available when you are editing a region. If you have proper user access, you can
edit a region by double-clicking the region name, or right-clicking the region name, then
selecting Edit Region from the pop-up menu.

A T T N EARE T

2
X 0
X 0
Inner Radius 190

3 e " s
[Regions]

2 2 .20
4 5 6 7 4 8 9 10
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% Note: In Region editor, you will not see anything happen if you click numbers 5, 6, or 7. The

data set is changed, but you will not see the data set until you view the Inspection Editor

(on page 205).

1 Unwrapped Region of Displays a linear view of the region from the edited inspection.
Interest

2 Part Image Displays a view of the part with the editable region on the part.

3 Editable Region This is the region on the image that can be edited. When the lines are yellow,
they can be edited. To enable region editing, right-click on the region and
check "Enable Region Editor." The region can be sized and moved using the
track ball and buttons or by using the optional touch screen.

4 Previous and Next Allows you to select the next or previous image.

Image

5 Get 100 images Takes up to 100 images with the current sensor and replaces Data Set A.

6 Refresh Data Set Takes up to 100 images with the current sensor and replaces Data Set A.
When you click this button, the images are refreshed. They will continue to
be refreshed until you click the button again.

7 Snap Image Takes one image with the sensor and adds it to the end of Data Set A.

8 Editable Parameters Adjust different parameters associated with the current region.

9 Parameter Description Gives a brief description of the selected parameter.

Window
10 Undo, Redo, Accept, Allows you to undo, redo, accept or cancel any changes made throughout the

and Cancel

process of editing.
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INSPECTION EDITOR

The following illustration shows the various parts of the screen displayed when you edit an

inspection.

+* Note: the Retro-Spec graph (see "Retro-Spec Population View Graph' on page 210) at the
top of the screen is described separately.

Last 100 Parts.

14000 1

RETRO-SPEC Population View: Liberty Date Inspection Latest Dilocs

12000 1+

100.00

80.00

6000

4000

Conltrast [gray shades]

2000

3 4 5

Libesrty Date Inspection PASSED
3¢e Fiter Total Size: 0.06 (0.060)

& Acceptable Size
Sizing

Region Extracson
B Advanced Setings
B Segment Settings

P /its] Determines how strong a gray shade variation
has to be I/ fore it is a candidate for a defect (feature).

el ]

6 3 7 8 9

Unwrapped Region of
Interest

Displays a linear view of the region from the edited inspection. This region is
marked with two directions: "S" for "Slow direction" and "F" for "Fast
direction." These designations are used in some inspection descriptions to
help you understand how they work.

Part Image

Displays a view of the part with the editable region on the part.

Previous and Next
Images

Allows you to select the next or previous image.

Get 100 images

Takes up to 100 images with the current sensor and replaces Data Set A.

Refresh Data Set

Takes up to 100 images with the current sensor and replaces Data Set A.
When you click this button, the images are refreshed. They will continue to
be refreshed until you click the button again.

Snap Image

Takes one image with the sensor and adds it to the end of Data Set A.

Inspection Parameters

Displays the available parameters for the selected inspection. Note: there
can be multiple tabs; the parameters will vary per inspection.

Parameter Description
Window

Gives a brief description of the selected parameter.

Inspection Overview
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9 Results Box

Shows the results from the current inspection with the option to see results
from other inspections and timing information.

Right-click over the various areas of the menu to see image options, editor options, result
options, and region of interest options.

Editing Parameters

You can change values, display settings, and options that will alter the outcome of an
inspection. For the purpose of this discussion, we refer to inspections, but the information
applies to regions, registrations, orientations, enhancements, measurements, and correlations

as well.

«»* Note: you must have appropriate user permissions to edit parameters

» To edit parameters:

Open the inspection from the Sensor Overview screen:

=  Double-click the inspection name in the inspection tree. Or:

= Right-click the inspection and select Edit Inspection from the pop-up menu.

(Fing JIRROIBIEORR =gt |

Edge Location [ sl

Search Vector Count |

Search Direction

Radial Tolerance |
B Diagnostics
Show Edges |
8 Feject Limits

105 44— 2
[+ {EE?_EU
T3
[*] Enabled

1 Select a tab to adjust parameters. The orange tab contains the parameters that can be
adjusted with the bars on the Retro-Spec graph. The tabs displayed depend on the inspection
itself, and its relationship within the inspection tree.

2 Numeric value can be adjusted by Large Slider or Numeric Text Entry [described below]
3 Check box to enable or disable the feature
4 Backwards R indicates the current parameter that can be adjusted in the Retro-Spec graph

(example: the red and yellow limits bars). Note that you can also adjust parameter limits by
right-clicking over the Retro-Spec graph.

both).

5 Column division for parameter settings (this line is not actually displayed in the Intellispec).
You can see Large Slider AND numeric entry pad if you click in the left column, or just the
numeric entry pad if you click in the right column (this only applies if Numeric Input setting =

There are several ways to change parameters:
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e Numeric values

e Check boxes

e Drop-down menus

e Buttons

e Adjusting the bars on the Retro-Spec graph

7

** Note: Drop-down menus and buttons are discussed separately in the inspections where they
are used

Editing numeric values

There are a few ways in which to change values and settings which include large slider, numeric
text entry, or drop down. The method available depends on Editor Options as described below.

Large Slider
Allows you to make changes using a sliding bar. It displays the value in the menu as you
slide the bar. Changes made on the Large Slider are reflected in the Numeric Text Entry as
well if both are open. Changes are also applied to the red and yellow sensitivity bars in the
Retro-Spec graph.
If the parameter has an upper and lower limit, portions of the bar are displayed in different
colors, as shown below:

(i L~
0.0 -46.38 .ﬁS.Bﬂ 100.0 @

=  Red = failure limit. Any part whose parameter value falls in the red zone fails inspection.

= Yellow = warning limit. Any part whose parameter value falls in the yellow zone is
tagged as a warning level part.

= Green = passing. Any part whose parameter value falls in the green zone passes (at least
this parameter).

Numeric Text Entry
Allows you to type in a specific number. You can use the +1 and -1 feature to make minor
adjustments. Changes made on the Numeric Text Entry are reflected in the Large Slider as
well if both are open.

For more information about the numeric keyboard, see On Screen Keyboard (OSK) (on page
36)
Editor Options

The information displayed when you are editing parameters depends on the Editor Options
settings. Right-click over the parameters menu to see the Editor Options.

[ Normal ]
. . @ Advanced
Editor Options |/‘u Show Generc Text
Editor Access |
@ Enable Region Editor ‘ (@ __slider ]
Numeric Input Text En
- Both "

@ Text Entry on Click on Value Side |

Editor Access
Choose how menus are displayed:

= Normal - display the normal menus (for most users)
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Advanced - display the advanced parameters (for power users)

7
°

Note: you must have the appropriate permissions (see "Managing Permissions" on
page 56) to see the advanced parameters: "Access advanced inspection parameters"

Show Generic Text - default Intellispec names. Some parameter names were changed in
templates to make more sense for a particular application.

Enable Region Editor
Available when the inspection has an associated region that can be modified.

Numeric Input

Slider = Large Slider as described above

Text Entry = Numeric Text Entry as described above

Both = both Large Slider and Numeric Text entry. After you make changes to either
input, you must click the OK button @ on both to close them.

Text entry on click on value side = if you click an item the right column of the menu, you
will see only the Numeric Text Entry box, even if you have Both checked

Result Options

There is additional display information for the Results Box. Right-click to see the menu. To stop
displaying the other inspections, right-click the menu again, then un-check the option.

Result Options

Show Other Inapections

Display Timing Information

Show Other Inspections
Displays whether a part has passed or failed other inspections on the current sensor.
Right-click the menu again to see the option to hide good inspections. If that option is
checked, then only the failed inspections are displayed.

Contrast FAILED ~

Total Size: 0.0 (-1.0@)

1 v

Ring

Fadial Edge Good

Good [~

Measurement Mot Com... )

Measure Extract Mot Com...

Ring

Pattern Match

Good

Folygon

Contrast

Palygon
Contrast

Folygon

Contrast

Polygon

B e B i
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Display Timing Information
Displays timing information for each inspection on the current sensor and the total time in
milliseconds.

Unwrapped Region of Interest Options

Right-click in the Unwrapped Region of Interest to display the region of interest (ROI) options
menu. To stop displaying either option, right-click the menu again and un-check the option.
ROI Options

Save Image
View Full Resolution

@ Show Graphics
Region Display Mode Original Region

Region Selected » [@_Enhanced Region |

Save Image (see "Saving a Region of Interest (Unwrapped) Image" on page 186)
Save the Region of Interest image.

Show Graphics
Displays any graphics that are selected, like vectors or edges, on the Unwrapped Region of
Interest.

Region Display Mode
Gives you the option to show the original region, or the enhanced region, if it has an
enhancement.

Region Selected
(Only available if the inspection has more than one region; example: Fill Height) Select
which region to display.

RETRO-SPEC POPULATION VIEW GRAPH

The Retro-Spec graph is displayed when you edit a Registration, Orientation, or Inspection.

The Retro-Spec Graph can display up to 200 parts at a time, 100 in each set. Each bar on the
graph represents a different part. A green bar means that the part has passed. A yellow bar
means that the part has exceeded the warning limit but not the reject limit. A red bar means
that the part has exceeded the reject limit. A lighter shade of green, red or yellow will be
displayed when a part is selected. To select a part, simply click on a bar in the graph. When you
click a bar, the part's unique Part Image, Unwrapped Region of Interest, and Results will be
displayed.

Population View
Displays details for up to the last 200 parts. The parts can be the last 100 run, the latest 100
defects for the inspection, or a set of parts previously saved to the hard drive.

Graphs with One Reject Bar
Some inspections have one reject bar on the Retro-Spec Graph. The Warning/Reject Bar can
be a minimum requirement where the part Retro-Spec value must be higher than the reject
bar in order to pass. The Warning/Reject Bar can also be a maximum requirement where
the part Retro-spec value cannot exceed the reject bar in order to pass.
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Graphs with Two Reject Bars
Some inspections have two reject bars. The part’s value must be between the two reject
limits to be considered a good part. The example below shows an ambient inspection with
two reject bars (red) and two warning bars (yellow).

Lk 100 RetroSpec Population View: Ambient

250

I 101

. I . - N S S R R S o

The components of the Retro-Spec graph are as follows:
1 P

— RetroSpec Population View: Contrast Lt
mm
180U ¢
weoag |
13003 ¢
10009 +

[

| = A " "
mJ-"‘-b:l (T (i

I|l||l|l|||l|ll|l|
IiNiNimA I
S s B b & b e

12

1 Selected View Shows which Retro-Spec graph view is being displayed.

2 Selected Inspection Shows the type of inspection.

3 Reject Bar (red) Shows the inspection limits. Parts that fall outside the reject limits are
considered defective.

4 Warning Bar (yellow) Shows the inspection warning limits. Parts that fall outside the warning limits
are not considered defective, but are approaching reject status.

5 Reject Part Reject Parts are displayed in Red.

Warning Part Warning Parts are displayed in Yellow. [not shown in this example]

6 Passing Part Passing Parts are displayed in Green.

7 Other Results Indicator | Indicates whether a part has failed or had a warning on a different
inspection. A small red box will appear under a part that has failed a different
inspection. A small yellow box will appear under a part that has had a
warning from a different inspection.
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Save Parts Allows you to save a set of parts which can be reloaded later. You can save
the Selected Parts, Set A, or Set B. You can also choose where to save them
by clicking the Save Parts button under "Where to save?"

Select Parts Allows you to select a set of parts, set A or Set B, to be displayed in the
Retro-spec Graph. Clicking on either the left or right arrow will bring up the
Select Parts Menu below. You can choose from Last 100, Latest Defects, or
Custom Set.

10

Delete Part [Trash can Gives you the ability to delete a single part. Can only be used when the lock
icon] [item 11] is unlocked. To delete a part: highlight the part, then click the trash
can icon, or highlight the part then drag it to the trash can icon and release
the trackball button. A message appears above the icon stating that the part
has been deleted.

11

Lock/ Move Parts When the graph is locked, parts cannot be moved or deleted. When the
Toggles to: graph is unlocked, part sets can be modified. Parts can be saved, moved
within the same set, moved to the set on the other side of the divider, or
EIE] deleted. Dragging the part to the Select Parts arrows [item 9] will move the
S part into the corresponding side. Dragging the part to the Save Parts button
will allow you to save the part. Dragging the part to the Delete Parts button
will delete the part.

12

Data Set B The parts on the right side of the divider make up data Set B.

Once a part has been deleted or moved, the term **Scratch Parts** is displayed at the top of
the data set. To save the data set with your changes, click the Save Parts icon [item 8]. This will
allow you to save the data set on either side of the divider, or just the selected parts.

Retro-Spec Options
Right-click the Retro-Spec graph to see the Retro-Spec options menu.

*» Note: some options are not displayed if they are not applicable to the current inspection.

N

RETRO-SPEC Options |

@ Population View

Symmetric Limits

Auto Select Limits

Enable Warnings

Graph Scale Mode ’

Select Data Set A N
Select Data Set B ’

Select Parameter 8 J

Population View
When this is checked, the Retro-Spec population view graph (on page 210) is displayed.

Part View
When this is checked, the Retro-Spec part view graph is displayed.
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Symmetric Limits
When the Retro-Spec graph has upper and lower limits (two red bars and two yellow bars),
this option keeps the upper and lower limits the same distance from nominal.

Lock Warnings to Errors
Locks the yellow warning bar to the red reject bar in the Retro-Spec graph, keeping them

the same distance apart.

Auto Select Limits
Automatically adjusts warning and reject levels to make all parts in the data set pass.

Enable Warnings
Provides a warning level (yellow) sensitivity bar. A warning level does not reject parts, but
indicates that the process is approaching the reject status. When you enable warnings, they
are enabled for all inspections for the current sensor.

Graph Scale Mode
Change the height scale of the graph.
Limits Only displays part parameter values up to and including the current inspection limits.
This is useful when you want to zoom in on data without extra lines on the graph. Note that
the limit lines may not be displayed on the graph. As soon as you change the parameter
limits from the menu, the limit lines are displayed again on the graph.

Limits and Data is the default mode that displays all the inspection data plus the limit lines.

Select Data Set A or B

For each Data Set, you can select what you want to display. You can choose to display
Nothing, Last 100 Parts, Latest Defects or a set of Image Files that have been previously
saved to the computer.
See information about Saving Images (see "Saving Images through the Retro-Spec
interface" on page 176).

Mothing Selected
@ Last 100 Parts

Latest Defects

Image Files

Select Parameter
Choose a graph to display. This is available for some inspections where you have a choice to
display different graphs. An example is Measurement Analysis, where there are several
different measurement graphs available, as shown below.

(. Inner Diameter.Min/Max |
| Inner Diameter.Average

Inner Diameter.Range

@ Outer Diameter.Min/Max
QOuter Diameter.Average
Width.Min/Max |
Width._Average '
Contrast Limits

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspection Overview 213
© 2013 Pressco Technology Inc. Proprietary




RETRO-SPEC PART VIEW GRAPH

The Part View shows specific information unique to each part. To display the Part View, right
click on a part and choose Population View, or double-click a part from the Population View.
There are different types of Part Views that vary by inspection.

*»* Note: not all inspections have a Part View graph available.

Shown below is the Part View of a Contrast inspection. It has a reject bar and an Unwrapped
Region of Interest. Any type of damage to the surface of the part, which can be seen in the
Unwrapped Region of Interest, will have a corresponding value on the graph. If any part of the
graph exceeds the Reject Bar, the whole part will be considered a defective image. The Reject
Bar can be dragged, changing the actual reject threshold.

Part View: Contrast

Shown below is a Part View of an Ambient inspection. This Part View does not have a reject bar
but does have an Unwrapped Region of Interest. The graph does not correspond to Gray
Shades on the Unwrapped Region of Interest. The graph represents how many pixels of each
Gray Shade are found on the part.

Part View: Ambient

214
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Chapter 13
INSPECTIONS

This section covers regions of interest, registrations, orientations, enhancements, analyses, and
measurements. We use the term inspections to include all of these items, for simplicity.

The information in this section is valid as of software version 5.2.019.

EMPTY POCKET

The Empty Pocket feature checks to see whether a part is present or not. This is used for
applications where you must determine whether a part is present before proceeding with
inspection. A common use for this test is in Starwheel applications where the encoder is used,
based on pocket position, rather than a part present signal. Locating an empty pocket is
important for production numbers to be accurate. If an empty pocket is found, no inspection
takes place for that pocket. Otherwise, an empty pocket would be recorded as a defect.

Notes:

You may run the Empty Pocket check on any inspection. We recommend that you use it
with an inspection that has pass/fail criteria. Ambient and Contrast inspections are most

commonly used.

You may add as many empty pocket checks to the part program as desired.

» To add an Empty Pocket check to an existing part program:

1.

In the inspection tree, right-click over the name of the inspection to which you want to

add the Empty Pocket check.

From the Inspection menu, select the "Is Empty Pocket Check?" menu item. The "Yes"
item will be checked. That inspection is highlighted in blue, and will remain highlighted
unless you disable the Empty Pocket check. The item toggles between Yes and No to

enable or disable the feature.

Enable the Empty Pocket check

Inspection with Empty Pocket check
is highlighted in cyan

- Inspections
- @ Ring [1]

Elrlnspection Menu

¥ Mfasuren

Info
Edit Registration
Is Inspection Enabled? Yes No

Is Inspection Reject Enabled? Yes v No

Is Empty Pocket Check? Yes No v

N

Rename

Insert

Add

Replace

Delete Registration

Part Program Change Log
Copy

-l Inspections
- ® Ring
# Measurement

¥ Clipping
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Statistics updates using Empty Pocket

To make sure that the statistics totals do not count empty pockets as defects, you must set up
an Empty Pocket check for all sensors in each lane. For example, if you have three sensors in
Lane 1, all three sensor part programs must contain an Empty Pocket check.

The statistics are counted as an OR function. If any of the sensors within a lane detects an
empty pocket, then that part ID is not counted in the defect statistics.

REGIONS OF INTEREST (ROI)

Regions of Interest (ROI) are the locations where the registrations, enhancements, analyses,
orientations, and correlation inspections take place. There is no inspection done in a Region of
Interest. However, there is no limit to the number of inspections that can be placed in one
Region of Interest.

There are six region types available to set up the region of interest on a part. All regions can be
edited directly on the image (after adding them to the inspection list).

7

** Note: Your system (and this book) may show only those items that apply to your
application.

e Ring Region (on page 217)

e Polygon Region (on page 218)
e Ribbon Region (on page 220)

e Measure ROI (on page 223)

e Adaptive Region (on page 225)

< Note: Cylindrical Region is not used in 5.2.xxx software.

Region of Interest Compatibility Chart

The following chart shows whether each inspection depends on a certain region type.

Inspection Compatible with this Region Type
Enhancements
All Enhancement types All

Registrations

Feature All except Ribbon and Loop
Center of Mass All

Hough Ring

Radial Edge Ring

Centerline Ribbon - mirrored only

Finish Location Ribbon

Template Registration

All except Ribbon and Loop

Neckring Registration

Measure ROI

Measure Registration

Measure ROI

Orientations

216 Inspections
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Pattern Match

Ring

Template Orientation

All except Ribbon and Loop

Analyses

Ambient All

Shape Check Adaptive

Contrast All

Measurement All except Polygon or Measure ROI
Light Meter All

Fill Height - Segmented Measure ROI

Measure Extract Measure ROI

Distribution All

Label Skew Extract Measure ROI

Feature Detect

Ring or Polygon

Dimensions

Distance These do not use regions; they get data
from other inspections.

Angle

Correlations

Body-Maker ID

Ring

Color Dot

Ring

Ring Region

The Ring region is circular or donut-shaped. You can create arcs or multiple arc segments in the
region. The inner and outer radii are adjustable, and the region's position is adjustable.

> Toadd a Ring Region:

1. If you plan to use Arcs for the Ring Region, place an Orientation (see "Orientations" on
page 288) in the inspection tree. If you want the region to be circular or donut-shaped,

w

skip the Orientation.

Highlight the Orientation name in the inspection tree (if applicable).

Right-click on the item you just added.

From the Inspection menu, select Add > Region > Ring. Re-name it to something more
meaningful to you.

The Ring Menu is displayed and the ring is shown on the image. (The menu is described
below) Adjust the placement of the ring and parameters as necessary.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

Inspections 217

© 2013 Pressco Technology Inc. Proprietary



Ring menu

X 0

Y 0
Inner Radius 179
Thickness 92
Start Angle 0.0°
Stop Angle 0.0°
Arc Count 1

Arc Alignment Align to boundary

The following parameters can be set graphically (on the image), or through a slider bar or
numeric keypad, which pop up when you click on a numeric value. Also refer to more
information about Editing Parameters (on page 207).

X and Y position
Horizontal and vertical position of the center of the ring on the image.

Inner Radius
Size of the inner ring.

Thickness
The thickness of the ring; outer radius minus inner radius.

Use Arcs
Allows you to inspect an arc instead of the whole region. The system will inspect a segment
of the region between the Start and Stop angles. Make sure you have an Orientation in the
job prior to using arcs. This will ensure that the inspection region is placed on the same
location of the part regardless of the part’s orientation.

The following parameters are available when Use Arcs is enabled.

Start Angle
The start angle of the region.

Stop Angle
The stop angle of the region

Arc Count
Set the number of segments you want to create in the region.

Arc Alignment
Not currently used.
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Polygon Region

Similar to the Ribbon Region (on page 220), the Polygon Region is a customizable region that is
used for:

free-form inspection areas on a part
areas that do not fit a circle or other standard inspection region

Note: we recommend that you place a Registration and Orientation (if applicable) prior to
adding a polygon region. This will ensure that the polygon is placed correctly on the part,
regardless of the part's placement or rotation.

» To add a Polygon Region:

1. Make sure that the part program has a registration and/or orientation in place to ensure
proper placement of the polygon on all inspected parts.

2. Highlight the Registration or Orientation name in the inspection tree.

3. Right-click on the item you just added.

4. From the Inspection menu, select Add > Region > Polygon. Re-name it to something more
meaningful to you.

5. A"NEW POLYGON: Click to add points" message is displayed in the large image area, and
the Polygon Menu is displayed. (The menu is described below) Click anywhere in the
image to start the polygon.

6. Continue clicking with the yellow boxes (polygon points) to create a polygon region. You
may create as many points as you like.
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7. When you want to close the region, click on the first box that you placed. The region
closes and is filled in for you.

8. Make any necessary adjustments from the menu (described below). You can make
adjustments to the region, duplicate it, or rotate it from the menu.

> To edit the polygon region:

Right-click the image to view the Image Options (on page 189) menu. Use Edit Mode to Delete,
Add, or Move any polygon point or the entire region.

Polygon menu

Repeat Polygons
Repeat Count 1
Rotate Folygon 0.0°
Expand or Contract 0

Repeat Polygons
Create duplicate copies of the original polygon. Allows from 1 to 10 polygons that are
centered and rotated around the registered position.

Repeat Count
(Available when using multiple polygons) Choose the number of duplicate polygons to place
on the image. The system automatically distributes these polygons around the image. A
common use for this feature is for the feet of a PET bottle.

Rotate Polygon
Rotate the polygon around the center of the polygon. If you have duplicate polygons, they
are also rotated.

Expand or Contract
Resize the region. A negative number contracts the region, and a positive number expands
the region.

¢ Note: be careful not to contract the region too much. This will distort the original shape.
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Ribbon Region

Similar to the Polygon Region (on page 218), the Ribbon Region is a customizable region and
can come in two different forms: ribbon, and loop. This type of region is used for:

o free-form inspection areas on a part
e areas that do not fit a circle or other standard inspection region

** Note: we recommend that you place a Registration and Orientation (if applicable) prior to
adding a Ribbon region. This will ensure that the ribbon is placed correctly on the part,
regardless of the part's placement or rotation.

1 2

1 Ribbon - a customizable region that does not close, similar to a rubber band
that has been cut. Thickness remains the same throughout the region.

2 Loop - a closed version of the ribbon region, similar to a rubber band.
Thickness remains the same throughout the region.

> Toadd a Ribbon Region:

1. Make sure that the part program has a registration and/or orientation in place to ensure
proper placement of the region on all inspected parts.

2. Highlight the Registration or Orientation name in the inspection tree.

3. Right-click on the item you just added.

4. From the Inspection menu, select Add > Region > Ribbon. Re-name it to something more
meaningful to you.

5. A"NEW RIBBON: Click to add points" message is displayed in the large image area, and
the Ribbon Menu is displayed. (The menu is described below) If you want to change the
ribbon type to Loop, use the Ribbon Style drop-down item in the menu.

6. Click anywhere in the image to start the ribbon.

7. Continue clicking with the yellow boxes (ribbon points) to create a ribbon region. You
may create as many points as you like.

8. When you want to close the region, right-click on the image to view the Image Options
menu and select Complete New Ribbon. The region closes and is filled in for you.

9. Make any necessary adjustments from the menu (described below). You can make
adjustments to the region, duplicate it, or rotate it from the menu.

» To edit the ribbon region:

Right-click the image to view the Image Options (on page 189) menu. Use Edit Mode to Delete,

Add, or Move any ribbon point or the entire region.
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Ribbon menu

Ribbon

Ribbon Style Loop

Ribbon Width 20

Repeat Ribbons a

Mirror Ribbon [J Enabled

Rotate Ribbon 0.0°

Expand or Contract 0
Ribbon Style

Choose between Ribbon and Loop as described above.

Ribbon Width

Set the width of the region.

Repeat Ribbons
Create duplicate copies of the original ribbon. Allows from 1 to 10 ribbons that are centered
and rotated around the registered position.

Mirror Ribbon
(Only used when Repeat Ribbons is disabled) Create a flipped duplicate of the region. This is
typically used for the Centerline (on page 259) Registration where two sides are being
searched for.

Mirror Angle
(Only used with Mirror Ribbon) Flip the mirrored region horizontally (90 degrees), vertically
(zero degrees), or any angle in between.

Mirror Offset
(Only used with Mirror Ribbon) Move the mirrored region further or closer together.

Repeat Count
(Available when using multiple ribbons) Choose the number of duplicate ribbons to place on
the image. The system automatically distributes these ribbons around the image. A
common use for this feature is for the feet of a PET bottle.

Rotate Ribbon
Rotate the ribbon around the center of the ribbon. If you have duplicate ribbons, they are
also rotated.

Expand or Contract
Resize the region. A negative number contracts the region, and a positive number expands
the region.

7
0‘0

Note: be careful not to contract the region too much. This will distort the original shape.
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Measure ROI

Measure ROI(s) is a region that is intended to be used in measurement type operations (such
as Label Skew Extract (on page 345), Measure Extract (on page 334), Fill Height (on page 315),
and Support Ring Registration or Neckring Registration (on page 278)).

» To add a Measure ROI Region:

«» Tip: We recommend that you first add a standard region of interest and registration to
locate a reference point on the part. The Measure ROI region will then follow the correct
location on the part.

1. Highlight the Registration name (if one is available) in the inspection tree.

Right-click on the item you just added.

3. From the Inspection menu, select Add > Region > Measure ROI. The Measure ROl region
is added to the inspection tree. Re-name it to something more meaningful to you.

4. The Measure ROI menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

N

Measure ROI menu

;

Region Count Two Regions
Vertical Lock Mode Independent Movement
Horizontal Lock Mode Independent Movement
Sizing Lock Mode Independent Sizing
B Region 1
Center Offset X -100
Center Offset Y -25
Region Width 100
Region Height 50
Region Angle 90.0
ion 2

Region Count
Leave this set at One Region unless you have a Fill Height application. Most measurements
require one region. Fill Height applications require two regions: one for reference, and one
for fill level.

Region 1 or 2
Contains the settings for each region.

Center Offset X and Y
Set the region offset value relative to the registered center. If your region is off the screen,
you may need to change these values.
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Region Width, Height, and Angle
Adjust the size and rotation of the region. You can also click on the image and adjust the
region graphically (if Enable Region Editor is checked in the Image Options menu). To adjust,
click and drag one of the empty yellow squares.

The Region Angle allows you to ensure that the region is a rectangle. After resizing and
moving the region, it can become non-rectangular. Use the Region Angle parameter to
quickly set to 0, 90, 180, or 270 degrees, to make the region a rectangle.

The Measure ROl is a two point polygon ribbon region. Refer to the illustration below. The end
points [1] adjust the length of the ribbon. The point on the side of the region [2] adjusts the
width of the ribbon. The diamond [3] indicates the direction towards which the vectors are
searching.

‘0

e Note: for the image below, both Enable Region Editor and Enable Region Size are checked in
the Image Options menu. You view the yellow boxes and points when you click on the
image to adjust the region size and/or position.

1
3
1
1 End points of the ribbon region
2 Point to adjust the width of the region
3 Indicates the direction towards which the vectors are searching

Additional menu items for Two Regions

Vertical Lock Mode, Horizontal Lock Mode, and Sizing Lock Mode
Choose whether to move the two regions independently, or to lock the regions (move the
regions together). When you choose to mirror the regions, the regions move in opposite
directions.
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Image options Measure ROI
When you right-click the image you will see a slightly different image options menu for
Measure ROI. Most of the menu items are the same as in the default image options (on page

189) menu. The last three items are different.

g Image Options N

@ Show Graphics
Show Regions
Hide Region Shading
Show Defects

@ Enable Region Editor

Enable Moving Region

@ Enable Region Resizing
Enable Set Region Direction
Close Menu

To avoid confusion, we recommend that you make each adjustment one at a time. For
example, Enable Moving Region to move the region, then disable it. Then Enable Region Size to
adjust the size, then disable it. Then Enable Region Direction to set the direction.

Enable Moving Region
Enable Region Editor must be enabled before you can move the region. Click and drag the

entire region.

Enable Region Resizing
Adjust the region size by clicking on the image and moving the yellow points.

Enable Set Region Direction
Click a diamond on any side of the ribbon to change the search direction for the Measure
Extract (on page 334) inspection.

Close Menu
Until you use Close Menu or click on the image, the Image Options menu stays open.
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Adaptive Region

This is a region that is built from the edge points found in registrations (except from Template
Registration). The region adapts to whatever edge points are found. It can follow the shape of
your part.

Series IV users: this is similar to Tracker or Shape Adapt registrations.

+» Note: Adaptive Region can be added only after one or more Registrations (on page 249).

» To add an Adaptive Region:

1. Make sure at least one Registration (see "Registrations" on page 249) has been added to
the inspection tree.

2. Highlight the Registration name in the inspection tree.

Right-click on the item you just added.

4. From the Inspection menu, select Add > Region > Adaptive. The Adaptive region is added
to the inspection tree. Re-name to something more meaningful to you.

5. The Adaptive Menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

w

Adaptive menu

Creation Mode

Region Style Polygon

Edge Offset -12

Correction Mode No Correction
2 Diagnostics

Show Found Edges [0 Enabled

Show Corrected Edges [J Enabled

Show Region Edges [l Enabled

Creation Mode
Choose whether to have the region adapt to each part as it is inspected [Adapting Region],
or to find a region once and use it for all parts [Fixed Region]. Different menu parameters
are available. Fixed Region is described below.
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Region Style
Choose the type of region you want to create from the registration results. Use the one best
suited to the area you are inspecting. The options are described below.

Fit to Circle - A donut-shaped region is created.

+* Note: For descriptions of shapes, also refer to Polygon Region (on page 218) and Ribbon
Region (on page 220). The difference in the Adaptive Region is that the shape is created
using found registration points, rather than manually placed points, as is done in the
standard Polygon or Ribbon Regions.

Polygon - a free-form shape is created and filled in.

Ribbon - a free-form ribbon shape is created. The ends are open. You specify the width of
the region.

Loop - a free-form shape is created. The ends are connected. You specify the width of the
region.

Custom 2 Sided Polygon - a free-form shape is created and filled in. This shape should only
be used after a Centerline registration. You have the option of creating separate offsets for
each side. A common use for this is Preform sidewall inspections, where there is a dark area
on either side of the preform in cameras one and three. With Custom 2 Sided Polygon, you
could create the region to ignore that dark area.

Edge Offset
Specify how many pixels away from the found registration points the Adaptive Region
should be.

Region Offset Side 2
(Used with Custom 2 Sided Polygon) Create a different offset for one side of the part. This is
normally used for Preform sidewall inspections.

Correction Mode
Correct the edge positions from one of the available techniques:
No Correction - uses the original registration positions.
Simple Smoothing - smooths the edges of the region.
Circular Smoothing - smooths the edges to form a circle.

Dual Edge Correction - (applies additional Correction Settings) this mode should only be
used after a Centerline registration. It corrects missing and bad points in the two sets of
edge locations (the two sides of the part).

Bad Point Removal - uses an additional Correction Sensitivity parameter. Removes bad
points from the found edge positions. If an edge point does not fall within the specified
sensitivity, it is removed from the Adaptive region.

Correction Sensitivity
(used with Bad Point Removal) Adjust the sensitivity of the edge positions between 10 and
500. A smaller number means greater sensitivity.

Diagnostics

Show Found Edges
Display the found edges on the image.

Show Corrected Edges
Show the edges that were corrected using Correction Mode.
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Show Region Edges
Show the location of the edges after using Region Offset.

Correction Settings (Used with Dual Edge Correction)

Maximum Deviation
Specify how many pixels an edge can be away from the found edge before applying edge
correction.

Learn Cross Section
Click the Learn Distances button to determine normal edge locations for that part.

Fixed Region Adaptive menu
Adaptive
Creation Mode
Set Region
Region Style Polygon
Edge Offset -12

When you choose Fixed Region, the Intellispec will find the shape of the part once, then use
that shape region for all remaining parts.

> To set a Fixed Region:

1. Select a Region Style.
2. Set the remaining parameters below Region Style as appropriate for your part.
3. Click the Get Region button to set the region based on the current part.

Set Region
Click the Get Region button (after setting the Region Style and other parameters) to set the
region based on the current part. The Intellispec finds the region edges for the current part
and creates a polygon or other region style. That region is then used for inspection of all
subsequent parts.

Region Style
Choose the type of region you want to create from the registration results. Use the one best
suited to the area you are inspecting. The options are described below.

Fit to Circle - A donut-shaped region is created.

7
L4

Note: For descriptions of shapes, also refer to Polygon Region (on page 218) and Ribbon
Region (on page 220). The difference in the Adaptive Region is that the shape is created
using found registration points, rather than manually placed points, as is done in the
standard Polygon or Ribbon Regions.

Polygon - a free-form shape is created and filled in.

Ribbon - a free-form ribbon shape is created. The ends are open. You specify the width of
the region.

Loop - a free-form shape is created. The ends are connected. You specify the width of the
region.

Custom 2 Sided Polygon - a free-form shape is created and filled in. This shape should only
be used after a Centerline registration. You have the option of creating separate offsets for
each side. A common use for this is Preform sidewall inspections, where there is a dark area
on either side of the preform in cameras one and three. With Custom 2 Sided Polygon, you
could create the region to ignore that dark area.
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Region Width
(Used with Fit to Circle, Ribbon, and Loop) Specify how many pixels wide the region should
be.

Edge Offset
Specify how many pixels away from the found registration points the Adaptive Region
should be.

Region Offset Side 2
(Used with Custom 2 Sided Polygon) Create a different offset for one side of the part. This is
normally used for Preform sidewall inspections.

Ribbon/Loop Offset Style
(Used with Ribbon and Loop) Distance Offset works best with small offsets. Proportional
Scaling works better with large offsets and keeps the shape nicely.

ENHANCEMENTS

Enhancements are used to alter images for the purpose of better defect detection, or for
making certain features stand out. They are applied to any region type and you can add as
many as needed to a region.

Notes:

e The unwrapped image (displayed while you are editing an inspection) shows the effect of
the enhancement. You will not see any difference in the main image.

e Enhancements are added prior to inspections

e The order in which you place enhancements is important. The effect of most
enhancements is cumulative, except for Color Distance and Color Extraction. Color Distance
and Color Extraction work independently of other enhancements.

e To determine the best enhancement for your inspection, it may take some
experimentation. Use the enhancement that brings out the defects or features best for
your part.

e You can add inspections between enhancements and have the enhancements affect
inspections differently. Example: suppose you have 1) Region 2) Clipping 3) Contrast 4)
Stretch and 5) Ambient. The Contrast inspection works only with the Clipping results, but
the Ambient inspection works with the combined effects of Clipping and Stretch
enhancements.

» To add an enhancement:

1. Make sure at least one region (see "Regions of Interest (ROI)" on page 216) is placed on
the image.

Right-click on the item you just added.

Select Insert or Add > Enhancement.

Choose the desired enhancement from the menu.

Add an inspection after the enhancement.

Adjust the parameters in both the enhancement and inspection to see the effects of the
enhancement.

ouhkwnN

The available enhancements are:
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e Subtract Bias (on page 230)

e (lipping (on page 231)

e Stretch Grayshades (on page 232)
e Binary (on page 233)

e Gamma Correction (on page 235)
e Grow Dark Areas (on page 236)

e Grow Light Areas (on page 236)

e Absolute Difference (on page 237)
e Color Distance (on page 238)

e Color Replacement (on page 241)
e Color Extraction (on page 244)

e Color LAB (on page 246)
Template (on page 247)

72
L4

Note: Your system (and this book) may show only those items that apply to your
application.

Subtract Bias

Subtract Bias is a simple value subtraction across the entire region. Subtract the given value
from all pixels in the region. The example below shows the result (bottom image) of

subtracting a gray level of 80 from the top image.
- -‘

> To add a Subtract Bias enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Subtract Bias. The enhancement
is added to the inspection tree. Re-name the inspection to something more meaningful to
you.

4. The Subtract Bias menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the parameters as necessary.

Subtract Bias menu

Use Bias Enabled
Black Level i85
Use Bias

Enable the enhancement.
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Black Level

Set the gray level value to subtract from the original value of each pixel in the region of
interest.

Clipping

Clipping is used to change gray shades to a specified value. It allows the system to ignore light
reflections or normal grain in a part, to provide easier defect detection.

» To add a Clipping enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Clipping. The enhancement is
added to the inspection tree. Re-name it to something more meaningful to you.

4. The Clipping menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the parameters as necessary.

Clipping menu

Bz

Clipping

Clipping Mode Clipping Disabled
Black Level Clip EBlack Level
Clip White Level

Clip Black and White Levels

Clipping mode
The available modes are as follows - also refer to the illustration below:
Disabled [item 1] — no clipping.

Clip Black Level [item 2] —set a dark gray shade value. A dark clipping value of 100 would
take all pixels with gray levels of 0-99 and make them a gray level of 100.

Clip White Level [item 3] —set a light gray shade value. A light clipping value of 150 would
take all pixels with gray levels of 151-255 and make them 150.

Clip Black and White Levels [item 4] — set both dark and light levels.
Below are grayscale plots of the area to illustrate the effects of clipping.

255 255

Pt
0 0
255 255 @
100
0

0
1 Original grayscale plot- Clipping Disabled
2 Clip Black Level - example uses 100 as black level
3 Clip White Level - example uses 150 as white level
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4 Clip Black and White Levels - example uses 100 as black level and 150 as white level

You will see the effects of clipping in the Unwrapped Region of Interest, as shown below.

1 Region
2 Clipping Disabled
3 Clip Black and White Levels applied

Stretch Grayshades

Stretch Grayshades is used when you want to make one feature stand out from the rest of the
part. This technique works essentially how it sounds: it allows you to zoom in on a specific
range of gray shades and stretch them to the full 0 - 255 range. You will see the effects of
stretching gray shades in the Unwrapped Region of Interest.

» To add a Stretch Grayshades enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Stretch Grayshades. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Stretch Grayshades Menu is displayed and the region is shown on the image. (The
menu is described below) Adjust the parameters as necessary.

Stretch Gmyshatk#
Stretch Grayshades

tch Technique yshade Percentiles

Shades of Interest 10.0.. 90.0

Stretch Grayshades
Enable the enhancement.

Stretch Technique
Zoom in on any range of gray shades.
Use Min/Max of Region - the system uses the lowest gray shade found and the highest gray
shade found, and stretches that range from 0 to 255.
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Use Grayshade Percentiles - Specify lower and upper values in the Shades of Interest box in
terms of percentage of pixels. The system counts the number of pixels of each gray shade
and puts them into bins. An example is when 29-65 is used for Shades of Interest. The
system determines (a) the gray shade where 29% of the pixels fall, and (b) the gray shade
where 65% of the pixels fall. The system then takes the pixels at gray shades (a) and (b) and
sets them to 0 and 255. The gray shades in between (a) and (b) are stretched from 1-254.

Use Absolute Grayshades - Specify lower and upper values in the Shades of Interest box.
The system sets all pixels at or below the lower specified value to black, pixels at or above
the higher specified value to white, and the values in between are stretched from
grayshades 1 to 254.

Shades of Interest
Define the gray shade range that you want to stretch. Adjust so that the desired feature
stands out in the image.

Stretch Grayshades example

In the example below, we use the mold line as a reference point. We want that mold line to
stand out, so we use Stretch Grayshades.

2
3
4

1 Original image

2 Unwrapped region of interest with no enhancement

3 Unwrapped region of interest with Use Min/Max of Region applied

4 Unwrapped region of interest with Use Grayshade Percentiles and Shades of Interest applied
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Binary

This enhancement makes all pixels at or above a threshold white, and makes all pixels at or
below the threshold black. This can help certain features to stand out. An example of a Binary
enhancement is shown below.

1 Unwrapped region of interest with no enhancement

2 Unwrapped region of interest with Binary Enhancement applied

» To add a Binary Enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Binary. The enhancement is
added to the inspection tree. Re-name it to something more meaningful to you.

4. The Enhancements menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the parameters as necessary.

Binary enhancement menu

=] Binary
Binary Technigue Use Fixed Grayshade
Fixed Threshold 127

Use the technique and threshold that best suits your application.

Binary Technique
Choose between Fixed Grayshade and Adaptive Grayshade. Set the related threshold as

described below.

Adaptive Threshold
The system computes the ambient level for the region. Set Adaptive Threshold to the
percentage of pixels to use in the region. This is similar to the Peak Percentile technique
used in the Ambient (on page 296) inspection.

2) Pixels M'

0 0% 255
1) Gray Level
1 Gray level - choose a percentage
2 Pixels in the histogram of the image
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Fixed Threshold
The system uses the number you enter. All pixels at or below the threshold will be turned

black. All pixels at or above the threshold will be turned white.

Gamma Correction

Gamma Correction lets you reveal detail in a low-contrast image without significantly affecting
the shadows or highlights. The example below shows the results of the Gamma Correction

enhancement applied.

g ' 1
2
3

1 Original image

2 Decreased contrast - Gamma value less than one

3 Increased contrast - Gamma value greater than one

» To add a Gamma Correction enhancement:

1. Make sure at least one region is placed in the inspection tree.

Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Gamma Correction. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Gamma Correction menu is displayed and the region is shown on the image. (The
menu is described below) Adjust the parameters as necessary.

N

Gamma Correction menu

Gamma Correctio

Gamma Correction
Gamma 1.5

Gamma Correction
Enable the enhancement.

Gamma
Change the contrast of the image. Values less than one decrease contrast, and values

greater than one increase contrast.
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Grow Dark Areas

This enhancement will grow the dark areas of the region. This can be used to remove
reflections, or shrink bright spots on the image. The example below shows how Grow Dark

Areas enhances the image.

1 Normal image

2 Image with Grow Dark Areas applied

> To add a Grow Dark Areas enhancement:

1. Make sure at least one region is placed in the inspection tree.

Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Grow Dark Areas. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Grow Dark Areas menu is displayed and the region is shown on the image. (The menu
is described below). Adjust the parameters as necessary.

N

Enhancements menu

=) Grow Dark Areas'

Growth Rate
Max, Shade Delta 0

Grow Dark Areas
Enable the enhancement.

Growth Rate
Increase this value to grow the areas more.

Max. Shade Delta
Specify the largest gray shade difference that can be applied to a pixel during area growth. If
this value is set to zero, then the resulting pixel can be set to any value.
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Grow Light Areas

Grow Light Areas is the opposite of the Grow Dark Areas enhancement. Small dark defects can
be blurred out and therefore ignored. The example below shows how Grow Light Areas
enhances the image

1 Normal image

2 Image with Grow Light Areas enhancement applied

> To add a Grow Light Areas enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Grow Light Areas. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Grow Light Areas menu is displayed and the region is shown on the image. (The
menu is described below) Adjust the parameters as necessary.

Enhancements menu

= Grow Light Areas
Growth Rate
Max. Shade Delta 0

Grow Light Areas
Enable the enhancement.

Growth Rate
Increase this value to grow the areas more.

Max. Shade Delta
Specify the largest gray shade difference that can be applied to a pixel during area growth. If
this value is set to zero, then the resulting pixel can be set to any value.
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Absolute Difference

Absolute Difference will subtract a value from all of the gray shades in an image. The resulting
gray shade value is an absolute value, so that value is always positive. For example, assume
Absolute Difference is set at 100, and two original pixel values are 175 and 25. When the
system subtracts 100 from each, the resulting values are both 75 [175 - 100 = 75, and 25 - 100
= 75] (using the absolute value).

The example below shows an Absolute Difference of 100 applied.

IS s AW
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1 Normal image

2 Image with Absolute Difference enhancement applied

» To add an Absolute Difference enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Absolute Difference. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Enhancements menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the parameters as necessary. Experiment with values to enhance
features you want to see more clearly on your part.

Enhancements menu

= Absolute Difference

Absolute Difference
Enable the enhancement.

Gray Level
The resulting pixel gray shade is the absolute difference between this value and the original
pixel gray shade.
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Color Distance

Color Distance is used to provide more contrast between similar colors on an image to make
certain defects or features stand out. This enhancement only applies to images produced by
color cameras. It is similar to the Absolute Difference (on page 237) enhancement that is used
for grayscale images.

«»*» Note: Color Distance works oppositely from Color Extraction. Experiment between the two
enhancements to see which one works better for your application.

Color Distance evaluates all pixels in the search region against the selected color and translates
that value to a gray level. The closer a color is to the selected color, the darker the pixel. The
further away a color is from the selected color, the lighter the pixel. This difference in pixel
appearance is only displayed in the unwrapped region - not the full part image.

The example below shows a purple part against a blue belt. The region of interest is highlighted
in the image for illustration purposes. Notice that, in the unwrapped region [item 1], the purple
and blue colors are very similar when translated to grayscale, making it difficult to detect the
part edges. We can apply a Color Distance enhancement to this image to make purple and blue
stand out from each other, as shown in the unwrapped image [item 2].

1 Normal image

2 Image with Color Distance enhancement applied

> To add a Color Distance enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Color Distance. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Color Distance menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the parameters as necessary. Experiment with values to enhance
features you want to see more clearly on your part.
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Color Distance menu

Color Distance

v Color Distance
Distance Technique RGB
Proximity Distance from Color

Color Picker [ Color Picker
Color |:|

Color Distance
Enable the enhancement.

Distance Technique
Select how to determine the distance between two colors.
RGB - Uses the red, green, and blue components of a color.

Delta E - Uses L*a*b* color space instead of RGB. This is only used if your plant uses L*a*b*
as your color standard. It computes the distance between the selected color and current
image's color.

7

** Note: Using Delta E uses a significant amount of inspection time. Use only if necessary.

Proximity
Choose how the system determines what grayscale value will be applied to pixels with
respect to their proximity to the selected color.

Distance from Color - the closer the pixel is to the selected color, the darker the pixel will
appear after the enhancement. This is the default.

Closeness to Color - the closer the pixel is to the selected color, the lighter the resulting
pixel will be after the enhancement.

Color Closeness
This is only displayed if Closeness to Color is selected for Proximity. Choose how large a
range of pixel values can be considered close to the selected color. For example, if the
setting is 6.0, then pixels within six grayscale values of the selected color have the
enhancement applied. Those pixels that do not fall within the range of six grayscale values
have a value of zero (black) applied.

Color Picker
Choose the desired reference color.

» To use Color Picker:

1. Click the Color Picker button to begin selecting a color from the image. Click in the image
again until the cursor becomes a cross-hair with an eye dropper.

2. Using the center of the cross-hair, click in the image over the color you want to compare.
The box next to Color in the menu displays your selected color.
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3. When you have selected the desired color, click the Color Picker button again to
complete the selection.

Color
The box displays the selected color.

Click on this menu line to display a drop-down menu array of colors from which to choose.
This can be used instead of using the Color Picker.
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Color Replacement

Color Replacement is used to replace a color in an image with either a different single color or
a background color. This enhancement can be used with a registration, orientation, or analysis.

¢ Note: this enhancement only works with images produced by a color camera.

7

** Note: the color replacement is only visible in the unwrapped image area. The part image
does not change.

» To add a Color Replacement enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Color Replacement. The
enhancement is added to the inspection tree. Re-name it to something more meaningful
to you.

4. The Color Replacement menu is displayed and the region is shown on the image. (The
menu is described after the procedure) Adjust the parameters as necessary. Experiment
with values to enhance features you want to see more clearly on your part.

» To adjust the Color Replacement enhancement:
The parameters are described below this procedure.

1. Choose the Color Replace Technique. RGB is the default and used most often.

2. Choose the Replacement Mode to determine whether to replace the color with another
color or with the background average color.

3. Choose the color to replace by using the Target Color Picker, or by selecting a Target
Color from the drop-down menu.

4. Look at the unwrapped image area to see the results. If the replaced color is not what
you expected, then try another Target Color, or change Replacement Mode, or change
Color Replace Technique.

= To improve color replacement around the edges of color transitions, adjust Edge
Softness.

= To expand the range of colors to replace, adjust Target Color Closeness.
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5. Adjust remaining parameters as necessary until you achieve the desired results.

Color Replacement menu

ColorReplacm;{

[v' Color Replacement

Color Replace Technique RGB

Replacement Mode Second Color
Conditional Replacement [ Enabled

Edge Softness 3

Target Color Closeness 6.0

Target Color Picker
Target Color B s6. 57, 62

R Replacement Color Picker
Replacement Color 9,98

Color Replacement
Enable the enhancement.

Color Replace Technique
Select how to replace the color.

RGB - Uses the red, green, and blue components of a color. This is the default technique
and used most often.

Delta E - Uses the color L*a*b definition of a color. See also Delta E in Retro-Spec
Distribution inspection (on page 341) for more information.

Color Extract - Uses the same technique used in Color Extraction (on page 244) during the
color replacement

Replacement Mode
Select how the replacement color is chosen.

Background Average - replaces the chosen color with the background color in the search
region. This color is the average of all colors except the chosen color.

Second Color - replaces the chosen color with a second unique color by using either a
Replacement Color Picker or the Replacement Color parameters. These items are displayed
when Second Color is selected.

Conditional Replacement
This option requires a Template Registration (on page 269) to have already been
performed in the inspection list. If enabled, this option uses the information from the
Template Registration to restrict where the color replacement can be done.

Conditional Threshold
Set the threshold to determine whether the color will be replaced.

Conditional Edge Softness
This is used to reduce the noise impact around the color transitions.

Edge Softness
This is used to reduce the noise impact around the color transitions. In some areas on a
part, the transition from one color to another is very sharp. A higher number gradually
blends the transition from one color to another, thus improving the replacement of colors
in these areas.
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Target Color Closeness
The target color is the color to replace. A larger value allows the system to use a wider
range of target colors to be replaced. For example, if you pick a white pixel and use a larger
Target Color Closeness value, the system will use the white pixels as well as almost-white
pixels that are close to the color you picked.

Target Color Picker
Click the Target Color Picker button, pick a color on the image that you want to replace,
then click the button again to complete the process.

Target Color
This is the color you want to replace. You can use the Target Color Picker (above), or select
the drop-down arrow to choose from a palate.

Replacement Color Picker
[Available if Second Color is selected for Replacement Mode] Click the Replacement Color
Picker button, pick a color on the image that the original color should be replaced with,
then click the button again to complete the process.

Replacement Color
This is the new color that the target color should be replaced with. You can use the
Replacement Color Picker (above), or select the drop-down arrow to choose from a palate.

Color Replacement Example

An example: The images below show a closure with a scratch and contamination that are
difficult to detect because of the printing. Color Replacement was used to replace the white
printing with the red background. In the lower image, the defects stand out.
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2

** Note: if the defect you are looking for is the same as the color you are replacing, then this
technique would not work, as it would hide the defects. We suggest trying a Template (on
page 247) enhancement instead.

ROI Full Resolution

ROI Full Resolution

Color Extraction

Color Extraction allows you to choose a color and then the system lightens all pixels with that
color. This makes certain defects or features stand out. This enhancement only applies to
images produced by color cameras.

7

** Note: Color Distance works oppositely from Color Extraction. Experiment between the two
enhancements to see which one works better for your application.

When the Intellispec enhances the image, pixels containing the selected color will appear
brighter. This difference in pixel appearance is only displayed in the unwrapped region - not the
full part image. The color pixels are translated to grayscale values and then inspected. This is
what you see in the unwrapped image.

244 Inspections System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
© 2013 Pressco Technology Inc. Proprietary



The example below shows a purple part against a blue belt. The region of interest is highlighted
in the image for illustration purposes. Notice that, in the unwrapped region [item 1], the purple
and blue colors are very similar when translated to grayscale, making it difficult to detect the
part edges. We can apply a Color Extraction enhancement to this image to make purple and
blue stand out from each other, as shown in the unwrapped image [item 2].

1 Normal image

2 Image with Color Extraction enhancement applied

> To add a Color Extraction enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Color Extraction. The
enhancement is added to the inspection tree. Re-name it to something more meaningful

to you.

4. The Color Extraction menu is displayed and the region is shown on the image. (The menu
is described below) Adjust the parameters as necessary. Experiment with values to
enhance features you want to see more clearly on your part.

Color Extraction menu

Color Extractiorn

[v' Color Extraction
Color Extract Technique Red
Gain 1.0

Technique Picker Technique Picker

Color Extraction
Enable the enhancement. Use one of the following selections to choose the color you want

to enhance.
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Color Extraction Technique
From the drop-down menu, select the color closest to the color you want to enhance. If you
select a Raw color such as red, then the Intellispec enhances only the red pixels and ignores
the green and blue elements of the image.

Gain
The default is 1.0 and is typically used. If you increase gain, you increase the result values to
make analysis and display easier to see. This is especially helpful on darker color extractions.

Technique Picker
Choose a reference color from the image. The system will determine the closest color to the
choices available. Note that the system has a limited set of color filters.

» To use Color Picker:

1. Click the Technique Picker button to begin selecting a color from the image. Click in the
image again until the cursor becomes a cross-hair with an eye dropper.

2. Using the center of the cross-hair, click in the image over the color you want to enhance.
The menu item next to Color Extract Technique is updated to reflect the selected color.

3. When you have selected the desired color, click the Technique Picker button again to
complete the selection.

Color LAB

Color LAB is used to convert RGB color to L*a*b* color. This is used when your plant uses
L*a*b* color as a standard, and you want the inspection to use the same color space and
terminology. This enhancement can be used with a registration, orientation, or analysis.

/7

% Note: this enhancement only works with images produced by a color camera.

/7

% Note: this enhancement uses a significant amount of inspection time, and should only be
used when needed.

7

7

X\

» To add a Color LAB enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Color LAB. The enhancement is
added to the inspection tree. Re-name it to something more meaningful to you. The Color
LAB menu is displayed and the region is shown on the image.

This enhancement has no parameters associated with it. You enable it or disable it. When it is
enabled, this enhancement converts the image colors from RGB to L*a*b* format.

[v Color LAB
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Template

Template Enhancement creates a difference image between the learned population and the
current part. The resulting image shows defects in the region of interest - those pixels that
appear different from the learned template. This enhancement works with all inspections on all
types
The example below shows the unwrapped region of interest after the enhancement is applied.
It makes the defects stand out, making it easier to detect defects.

> To

of regions.

add a Template enhancement:

1. Make sure at least one region is placed in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Enhancement > Template. The enhancement is
added to the inspection tree. Re-name it to something more meaningful to you.

4. The Template menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the parameters as necessary. Experiment with values to enhance
features you want to see more clearly on your part.
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Template menu

Set the parameters as recommended by a Pressco engineer, or use what works best for your
application. As you change the parameters, look at the Unwrapped Region of Interest Display
to see the results of the enhancement.

Terrw!aae
Template Source Use Internal Template
Deviation Type Standard Deviation
Enhancement Mode Absolute Difference
Edge Softness 3
Deviation Power 1.0
Deviation Floor 1.0
Deviation Scale 50.0

Template Source
Choose the source of the template to which to compare the current image. Internal - the
Template Enhancement creates its own template. External - the Template Enhancement
uses a template from a previous Template Registration or Template Orientation, whichever
is the closest one to the current Template Enhancement.

After you add an inspection, the template learns the data from Set A in the Retro-Spec
interface.

Deviation Type
Choose the source of the data to which to compare the current image.

Standard Deviation - the differences used in the template are from the standard deviation
of the learned set of images.

Range - the differences used in the template are from a min-max range of data.

Enhancement Mode
Choose the mode that works best for your application. The enhancement creates a
difference image based on the selection.

Absolute Difference - shows white or gray pixels as the differences in the image. Defects
will appear light in the resulting image, their intensity based on how different from the
template that the defects are. If you are using a Feature Detect inspection, Absolute
Difference may work better.

Signed Difference - creates a gray background with black, white, or gray pixels shown as the
difference in the image. In this mode, light defects will appear light, and dark defects will
appear dark. If you are using a Contrast inspection, Signed Difference may work better.

Signed Zero Level
This is only used if Enhancement Mode = Signed Difference. This is the grayshade level used
for a perfect match. If this is zero, then all dark defects are clipped to zero and will be
ignored. If this is 255, then all light defects are clipped to 255 and are ignored.

Edge Softness
This applies to the standard deviation template image. If Edge Softness is increased, it
reduces sensitivity to areas like edges and color transition areas.

Deviation Power
This raises or lowers the impact of the standard deviation value on the mismatch
calculation. Leave this value at one (1) unless instructed to do otherwise by Pressco
engineers.
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Deviation Floor
The minimum standard deviation value that a pixel can have. Adjusting this value can
reduce mismatches. We recommend leaving this value at or around six (6), and not much
lower.

Deviation Scale
This is a multiplier. The enhancement multiplies the original difference by this amount so
that defects stand out better.

REGISTRATIONS

A registration compensates for part movement by calculating the reference point on the part.
All analyses follow a registration.

‘0

e Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page
216) where you want the Registration to take place.

Available registrations include:

e Feature (on page 250)

e Center of Mass (on page 251)

e Hough (on page 254)

e Radial Edge (on page 257)

e Centerline (on page 259)

e Finish Location (on page 264)

e Template Registration (on page 269)
e Neckring Registration (on page 278)

Measure Registration (on page 285)

3

%

Note: Your system (and this book) may show only those items that apply to your
application.

Hough vs. Radial Edge

This topic is intended to help you decide whether to use a Hough or Radial Edge registration for
your round parts.

Use the registration that best fits your needs.

Hough (on page 254) Radial Edge (on page 257)
Finds edges on not quite round parts Finds edges on round parts
Works on incomplete circular features Works on complete circular features
Takes slightly more processing time Faster
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Feature

This registration searches for the center of a specific feature that may not fall into a standard
inspection shape. It looks for all the pixels within a specified gray shade range. Then you can
choose whether to select the center from all the found features or just the largest feature.
Alternately, you may restrict a feature size to determine the center; the found feature does not
need to be the largest feature. It also allows you to count all the found features and reject the
part if there are too many or too few. This can work on any region type.

Series IV users: this is similar to Blob Registration.

The example below shows a Feature registration to find the largest feature. The center of the
largest feature is used as the registration point.

> To add a Feature Registration:

1. Make sure at least one region of interest has been added to the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Registration > Feature. The Feature registration
is added to the inspection tree. Re-name it to something more meaningful to you.

4. The Feature Menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

Feature menu

Center Detection Use All Features
Feature Gray Scale 30..100
Feature Size 5.. 307200
Show Features Fl

= Check Feature Area
B A Allowed Area
Nominal 1000

Learn Nominal Area [ Learn

O Check Feature Count

Center Detection
Choose whether to use the largest feature found, or all features.

Feature Gray Scale
Set the range of gray shades of the feature you want to locate.

Feature Size
Set the allowable size of the feature you want to locate.
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Show Features
Highlight the found features on the image.

Check Feature Area
Check the area of the feature to see that it is within the specified tolerance.

Allowed Area
[only available if Check Feature Area is enabled] The tolerance (in pixel area) of the feature
you want to locate.

Nominal
The expected area size. This number is populated when you press the Learn button.

Learn Nominal Area
Click the Learn button to automatically learn the area.

Check Feature Count
Check to see that the correct number of features is found.

Center of Mass

Center of Mass is a simple edge center routine that will take the average of all found edges and
use that as the center position. This can work on any region type.

7

« Tip: Center of Mass can be used to find edges before an Adaptive Region (on page 225) to
assist in locating the adapted region.

An example of a Center of Mass registration is shown below. This registration works with
almost any shape. The center of the part is marked with a large magenta "X."

«» Note: the center is computed from all found edges. If bad edges are found from a defective
part, those edges would be used in the center computation.

» To add a Center of Mass registration:

1. Make sure a Region of Interest has been added to the inspection tree. This inspection will
work with any region type.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Registration > Center of Mass. The registration is
added to the inspection tree. Re-name it to something more meaningful to you.

4. The Center of Mass menu is displayed and the region is shown on the image. (The menu
is described below) Adjust the placement of the region and parameters as necessary.

> To set up the Center of Mass registration:

1. Make sure the region surrounds the feature that you want to locate.
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2. Go to the Edge Location menu and select an Edge Polarity. If you are searching for a light
edge against a dark background, choose Dark to Light.

3. Go back to the Center of Mass menu and select a Center Technique.

4. If necessary, change the Search Direction (check the Flipped box) to make the search
vectors go in the opposite direction.

5. Adjust other parameters as necessary. The menu is described below.

Center of Mass menu

Center Technique Center of Mass
Search Vector Count 36
Search Direction Flipped
Region Extraction Read Radially
B Diagnostics
Show Edges Enabled
B Reject Limits
Qualifying Percent Limits 25.0..50.0

[0 Area Settings

Center Technique
Choose the best technique to find the center.

Center of Mass - Find the center of mass of the total area enclosed by all edges. In most
cases, this is the more accurate technique, but it may fail if the part is shaped irregularly, or
if you are trying to find edges on a linear feature.

Average of Edges - Use for linear features or if the Center of Mass technique does not work

for your part. This technique finds the average location of all individual edges. Average of
Edges works better for ribbon types of regions.

Search Vector Count
Set the number of search vectors to locate the feature on the container. More vectors
provide a more accurate search, but also take more processing time.

Search Direction
Change the search to the opposite direction.

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region. In this inspection, only Read Radially is used. The data
is extracted in a radial direction as shown in the illustration below.

N4

Y

Show Edges
Show the found edges on the image.
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Qualifying Percent Limits
The percentage of edges that must be part of the target circle. If there are not enough
found edges on the target circle, this registration will fail. This can be set lower if you expect
large changes in sample size (less sensitive). It can be set higher if the size of your product
should not vary (more sensitive).

Area Settings
Click the Learn button to determine the nominal area (in pixels) for your part.

Area Range
Define the acceptable deviation (in pixels) from the normal area of the region. You may also
adjust the values on the Retro-Spec graph.

Nominal
The expected area size. This number is populated when you press the Learn button.

Learn Nominal Area
Click the Learn button to automatically learn the area.

Edge Location menu

This menu determines what kind of edges the system should look for.

Edge Polarity Either

Edge Gradient 15.. 30
Edge Delta 2

Edge Size 2

Use Subpixel [ Enabled

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Edge Size
Indicates how many pixels in a row to compare (1to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.
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Hough

This registration locates a circular feature within an image and computes the center point of
that feature. It also works with features that are not quite round. An important strength of this
registration is that the feature you wish to find does not need to fit completely within the
camera image. As long as a good portion of the feature can be found within the image, the
computed center point is accurate. It also works well if the feature you wish to find is not
clearly defined for 360 degrees.

«*» Note: Hough registration only works with a Ring region (on page 217).

Hough registration locates edges on the desired feature and computes the best center position
based on these edges.

-

1 Feature (white circle) that we are searching for. This feature is partially outside of the camera
view.

2 Found center of the feature

3 Bounding rectangle. The center must be found within the rectangle.

» To add a Hough registration:

1. Make sure a Ring Region (on page 217) of Interest has been added to the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Registration > Hough. The registration is added
to the inspection tree. Re-name it to something more meaningful to you.

4. The Hough menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

> To set up the Hough registration:

1. Make sure the Ring region surrounds the feature that you want to locate. Adjust the ring
with the parameters in the Ring menu (or the Region Editor on the image) if necessary.

2. Inthe Hough menu select a Search Direction. Flipped means that the vectors search from
an outer to inner direction. If Flipped is unchecked, then the vectors search from an inner
to outer direction.

3. Go tothe Edge Location menu and select an Edge Polarity. If searching for a light edge
against a dark background, choose Dark to Light.

4. Go to the Target Circle menu and click Learn. If the Edge Location parameters are set
correctly, the system will automatically detect the proper target radius size. The system
uses this radius to compute the center. You may need to adjust the parameters in the
Hough, Target Circle, and Edge Location menus to find the desired feature accurately.
These menus are discussed next.
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Hough menu

Search Vector Count 203
Search Direction Flipped
Bounding Rectangle 128W x 128H @(256,176)
Search Resolution 3
Region Extraction Read Radially
= Diagnostics
Show Edges a
B Reject Limits
Minimum Center Strength 19
Show Hough Graphics

Search Vector Count
Set the number of search vectors to locate the feature on the container. More vectors
provide a more accurate search, but also take more processing time.

Search Direction
Change the search to the opposite direction.

7

% Tip: if you flip the search direction, go back to the Target Circle menu and press Learn to
re-learn the target radius size.

Bounding Rectangle
Adjust the size of the area where you would expect the center of the feature to be found,
even with slight movement of parts in the camera’s field of view. The system uses only this
area to compute the center. If the computed center falls outside of this bounding area, the
registration fails.

Use Height and Width to adjust the number of pixels to create the size of the rectangle.

¢ Note: larger sized Bounding Rectangles take more processing time.

Search Resolution
The area (in pixels) within the bounding rectangle where the center should be computed. A
larger resolution allows a larger area. This allows the system to more accurately locate the
center on parts that are not perfectly round.

Region Extraction

Choose how the Intellispec should read the information from the region. This usually

depends on the shape of your region. In this inspection, only Read Radially is used. The data
is extracted in a radial direction as shown in the illustration below.

N
N

Show the found edges on the image.

Minimum Center Strength

The minimum strength, or quality, you require for the circle fit. When the quality of the fit is
less than this value, the registration fails.
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Show Hough Graphics
Display the bounding rectangle and search graphics on the image.

Target Circle menu

Target Circle

Target Radius 252

Learn
Adapting Target Radius Enabled
Adaptation Range 3

7

% Tip: to quickly set the Target Circle, click the Learn button. You could adjust the other
parameters as necessary.

Target Radius
The size of the feature you want to find. This is automatically computed by using the Learn
process.

Learn button
Using the Edge Location settings, the system automatically sets the Target Radius size.

Adapting Target Radius
When this is enabled, the system automatically figures out the best fit for the target radius,
within the inner and outer radius of the region.

‘0

» Note: Increasing Adaptation Range increases accuracy, but it also increases inspection
time.

Adaptation Range
When Adapting Target Radius is used, this range limits the number of pixels that the target
radius can move in either direction.

Edge Location menu

Edge { ocation

Edge Folarity Light-to-Dark
Edge Gradient 0. 25

Edge Delta 3

Edge Size 1

Use Subpixel O

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.
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Edge Size
Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.

Radial Edge

Radial Edge registration is good for circular parts that have a distinct edge either on the inside
or outside of the part. This only works with a Ring region. Place the Ring region where you
would expect the edges of the part to fall. The system searches for edges from the inner to the
outer radius (or outer to inner radius), searching for a transition from light to dark or dark to
light pixels. Each search vector tries to detect an edge, using the Edge Location parameters.
Found edges are marked with a cyan or red '+' for pass or fail status.

» To add a Radial Edge registration:

1. Make sure a Ring Region (on page 217) has been added to the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Registration > Radial Edge. The Radial Edge
registration is added to the inspection tree. Re-name it to something more meaningful to
you.

4. The Radial Edge Menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

» To set up the Radial Edge registration:

1. Make sure the Ring region surrounds the feature that you want to locate. Adjust with the
parameters in the Ring menu (or the Region Editor on the image) if necessary.

2. Inthe Radial Edge menu select a Search Direction. Flipped means that the vectors search
from an outer to inner direction. If Flipped is unchecked, then the vectors search from an
inner to outer direction.

3. Go tothe Edge Location menu and select an Edge Polarity. If searching for a light edge
against a dark background, choose Dark to Light.

4. Go to the Target Circle menu and click Learn. If the Edge parameters are set correctly, the
system will automatically detect the proper target radius size. The system uses this radius
to compute the center. You may need to adjust the parameters in the Radial Edge, Target
Circle, and Edge Location menus to find the desired feature accurately. These menus are
discussed next.
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Radial Edge menu

Search Vector Cou 36
Search Direction Flipped
Radial Tolerance S
= Diagnostics
Show Edges Enabled
B Reject Limits
Qualifying Percent Limits 25.0..50.0

Search Vector Count
Set the number of search vectors to locate the feature on the container. More vectors
provide a more accurate search, but also take more processing time.

Search Direction
Change the search to the opposite direction.

Radial Tolerance
The number of pixels in either direction of the target circle that the system will consider an
edge (that is, the size range allowed for the part). A radial tolerance of two allows a four
pixel wide area in which the edge of the part may fall.

Show Edges
Show the found edges on the image.

Qualifying Percent Limits
The percentage of edges that must be part of the target circle. If there are not enough
found edges on the target circle, this registration will fail. This can be set lower if you expect
large changes in sample size (less sensitive). It can be set higher if the size of your product
should not vary (more sensitive).

Target Circle menu

Target Circie

Target Radius 100
Learn
Adapting Target Radius [J Enabled

Target Radius

The size of the feature you want to find. This is automatically computed by using the Learn
process.

Learn button
Using the Edge Location settings, the system automatically sets the Target Radius size.

Adapting Target Radius
When this is enabled, the system automatically figures out the best fit for the target radius,
within the inner and outer radius of the region.
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Edge Location menu

Edge !t ocaﬂm

Edge Polarity Light-to-Dark
Edge Gradient 0.25

Edge Delta 3

Edge Size 1

Use Subpixel a

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Edge Size
Indicates how many pixels in a row to compare (1to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.

Centerline

Centerline Registration finds the sides of a container and determines the center line between
them. It also computes an orientation of the container. This registration uses the mirrored
polygon ribbon region. With Centerline registration, you can determine the orientation of a
feature and compare it to the orientation of the entire part. You can also check the slope of the
sides of the container, or check the overall shape of the container.

FHCP applications: Centerline is used in place of Support Ring Registration in cases where bottles have
caps that cover the support ring. In these cases, the system cannot register on the support ring, so a
refined centerline is used instead. Centerline also tracks the vertical position of the part in version
5.1.021 and higher.

Series IV users: this replaces Midline Orientation, and is similar to Shape Adapt Registration.

¢ Note: this registration requires a Ribbon Region (on page 220) using settings: Ribbon Style
= Ribbon, and Mirror Ribbon = Enabled.
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¢ Tip: you can use Centerline to determine Registration plus Orientation, or just Orientation.

» To add a Centerline Registration:

1. Place a Ribbon Region (on page 220), using a mirrored ribbon.

Right-click on the item you just added.

3. From the Inspection menu, select Add > Registration > Centerline. The Centerline
registration is added to the inspection tree. Re-name it to something more meaningful to
you.

4. The Centerline Menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

N

Centerline menu

Applied Results Center and Orientation
Setup Mode Common Setup
Search Vector Count 36

Refine Centerline ¥V Enabled

Max lterations A

Region Extraction Read Radially

@ Diagnostics
Blv Shape Check

@ 1 Shape Limits 0.0° +360.0°/ -360.0°
Shape Sensitivity 90

[ AreaCheck

[ Angle Check

Applied Results
This determines whether the found center and/or orientation are reported to inspections
that follow the Centerline. Use Center and Orientation to report both to following
inspections. Use Orientation to report only the orientation, but use a previously found
center.

Setup Mode
Use the same parameters to find both sides of the container (Common Setup), or set up the
parameters differently for each side of the container (Individual Setup).

Search Vector Count
Set the number of search vectors to locate the feature on the container. More vectors
provide a more accurate search, but also take more processing time.
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Refine Centerline
This re-computes the centerline. It allows the inspection to get a better alighment of the
two sides to produce a more accurate centerline angle. Note that this adds inspection time.
Set the number of times this is performed through Max Iterations.

Max Iterations
Set the number of times the inspection will re-compute the centerline angle. Note that the

more iterations you use, the more inspection time is used. The edges are displayed as

follows:

Number of Iterations Color of edges displayed
1 Cyan

2 Magenta

3 Dark Blue

4 Dark Gray

5 Yellow

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region. In this inspection, only Read Radially is used. The data
is extracted in a radial direction as shown in the illustration below.

AN

Diagnostics

Show Vectors
Show the search lines on the image.

Show Edges
Show the found edges on the image.

Show Alignment
Display the alignment of the current part with respect to the previous alignment.

Shape Check
Check the angle of the sides of the container.

Shape Limits
Set the angle limits for the container.

Nominal
The ideal value for the shape of the container.

Shape Sensitivity
Set the sensitivity for the straightness of the center line. 100 indicates that points must fall
on a perfectly straight line (most sensitive). A setting of one indicates that points can fall
anywhere (least sensitive). A value of 90 is good sensitivity in most cases.
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Area Check

Check the area of the points found. It is good for determining underblown and overblown
bottles.

Area Range
Define the acceptable deviation (in pixels) from the normal area of the region. You may also
adjust the values on the Retro-Spec graph.

Nominal
The expected area size. This number is populated when you press the Learn button.

Learn Nominal Area
Click the Learn button to automatically learn the area.

Angle Check

Check the orientation of a feature against the previous orientation. If an orientation inspection
was not added to the part program, zero degrees is used. For example, this could be used to
detect turned tabs on a converted end.

Angle Limits
Set the angle tolerance for the feature.

Nominal
The ideal orientation of the feature.

Centerline Sensitivity
Set the orientation sensitivity. The range is from one to 100 with one being the least
sensitive and 100 being the most sensitive. The value of 90 is good sensitivity in almost all
cases.

Search Settings menu

Search Settings

or Direction

Inwards
Edge Polarity Light-to-Dark
Edge Gradient 15.. 96
Edge Delta 2
Edge Size 1
Use Subpixel [J Enabled

This menu specifies settings for the search vectors.

Vector Direction
Specify which direction the vectors should search, with respect to the center.

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Delta

The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.
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Edge Size
Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.

Enhance Center menu

Use this menu to track the vertical position of the part; not just the side to side angle position.
The inspection performs a pattern match, between matching points in the two regions. If it
does not find similar features on both sides of the part, then the registration fails.

< Tip: when placing the ribbon region, place it on an area of the part that is unique from
other areas of the part. Place the ribbon where the system can see edges across from each
other. See the example under Pattern Size below.

¢ This technique works best when the ribbon is set up parallel with the centerline of the part
and NOT set up to follow the profile of the sidewall.

7
L4

Note: This feature will only work with a symmetrical part. If the part looks different from
side to side as it rotates, then this feature may not work.

Enhance Cam:r‘

Enhanced Center Enabled vV Enabled

Learn Features
Start Pattern 0

Pattern Size 15

Show Pattern Match 'V Enabled

Enhanced Center Enabled
Enable the search for the vertical position of the part.

Learn Features
Click the Learn Features button to allow the system to learn the features of the part. You
will need to re-learn the part if you:
= Change the number of search vectors,
= Move or resize the region,
=  Adjust the edge search criteria, or
= Change anything that makes the edge positions change.

Start Pattern
Specify how many vectors down from the top of the ribbon that the pattern area should
start. Check the Show Pattern Area box to view it. Note that if you move your pattern too
far towards the bottom of the search region, then the pattern will be clipped. That is, it will
have fewer vectors than you specify. If you move it outside of the range of the search
region, then the pattern wraps back to the top of the region.
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Pattern Size
Specify how large the pattern should be, in search vectors. The pattern should only take a
portion of the search area, and should be large enough to accommodate the unique section
of the part. In the example below, our pattern area covers just the shoulder area of the
bottle.

7
°

Note: The pattern works best when it is set up to follow a unique pattern, such as the
shoulder of this bottle. It will not work well on an area with no width variation. If you have
a part with multiple features that are all similar, it is best to include all of the similar
features in the pattern.

1
AN

2

1 Pattern Area. Pattern Size in this example = 10.

2 Ribbon search region

Show Pattern Area
Show the vectors in the pattern area. The pattern is shown in magenta.

Show Pattern Match
Show the edges that best match the learned pattern. The pattern in shown in dark green.
When you also show the pattern area, it will overwrite the pattern area. This shows how
much from the original pattern that the part has moved.

A light green line is also displayed at the top of the pattern between search vectors. The line
is drawn with a cross on each side and the center position. This center position will be the
part placement position.
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Finish Location

Finish Location is used to locate the top corners of a bottle. It uses a ribbon region (on page
220). Finish Location also determines part orientation, and passes on the orientation to
subsequent inspections.

Series IV users: Finish Location is similar to Finish Registration in Series IV

» To add a Finish Location registration:

1. Make sure a Ribbon Region (on page 220) of Interest has been added to the inspection
tree. An example of region placement is shown below.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Registration > Finish Location. The registration is
added to the inspection tree. Re-name it to something more meaningful to you.

4. The Finish Location menus are displayed and the region is shown on the image. (The
menus are described below) Adjust the placement of the region and parameters as
necessary.
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Finish Location menu

Search Vector Count

Search Direction Flipped
B Finish Settings
=] Tilt Limits 0.0* +10.0°% -10.0°
Nominal 0.0°

Region Extraction

Search Vector Count
Set the number of search vectors to locate the feature on the container. More vectors
provide a more accurate search, but also take more processing time.

Search Direction
Change the search to the opposite direction.

Finish Settings

Tilt Limits
Set the allowed range of tilt of the part within the image.

Nominal
The expected degree of tilt. This is usually set to the target tilt value with the Tilt Limits
being around this nominal. On most vertical parts the nominal would be 0, with the Tilt
Limits + and — some amount.

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region. In this inspection, only Read Radially is used. The data
is extracted in a radial direction as shown in the illustration below.

Edge Polarity Either

Edge Gradient 15.. 30
Edge Delta 2

Edge Size 2

Use Subpixel (] Enabled

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.
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Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Edge Size
Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size,

the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel

Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.

Corner menu

Adjust these settings to best find the corner on your part.

7

** Note: Enable the Show Corners option in the Diagnostics menu to see the position of the

vectors.
Comer Desensitization !ﬂ
Top Search: Side Shift 30
Top Search: Vector Count 60
Top Search: Edges Percentage 20
Side Search: Down Shift 25
Side Search: Side Shift -8
Side Search: Vector Count 30
Side Search: Vector Length 70
Side Search: Edges Percentage &0

Corner Desensitization

Larger values are used to detect more rounded corners. This is used to prevent detection of
false corners.

The illustration below shows the top and side vectors that search for the part. Note that your
image may be rotated depending on application. Regardless of orientation, the top vectors
search for the top of your part, and the side vectors search for the sides of your part.

1 Top vector (perpendicular to the ribbon)

2 Side vector (parallel to the ribbon)

Top Search: Side Shift
Move the top vectors closer or further away from the corner.
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Top Search: Vector Count
Set the number of vectors to search for the top of the cap. If your parts have water
droplets, use a higher number of vectors to minimize errors in locating the corner of the
cap.

Top Search: Edges Percentage
Set the percentage of vectors that will determine the top of the cap. For example, if 100
vectors are used, and this parameter is set at 15, then the 15 vectors that found the lowest
edges would be used (and colored green). Vectors that find higher edges may be from
water droplets. The other 85 vectors are colored blue and are ignored.

Side Search: Down Shift
Move the side vectors closer or further away from the corner.

Side Search: Side Shift
Move the side vectors closer to or further away from the midpoint of the cap or part.

Side Search: Vector Count
Set the number of vectors to search for the sides of the cap.

Side Search: Vector Length
Increase or decrease the length of the side search vectors.

Side Search: Edges Percentage
Set the percentage of vectors that will determine the sides of the cap. This helps ignore
water droplets.

Diagnostics menu

Diagnosﬁ:s‘
Show Vectors [J Enabled
Show Search Direction Enabled
Show Edges Enabled
Show Cormners Enabled
Show Cormer Search [J Enabled
Show Framing [J Enabled

Show Vectors
Show the search lines on the image.

Show Search Direction
Show the search direction of the vectors with an arrow.

Show Edges
Show the found edges on the image.

Show Corners
Display the location of the finish corners.

Show Corner Search
Display the search used to find the corners. You must also enable 'Show Graphics' in the
Image Options (on page 189) menu.

Show Framing
Display the lines that show where the finish is located based on the projected corners.
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Template Registration

Template Registration is used to locate the center of a feature that is either irregularly shaped,
or is located in a region with a lot of gray scale variation. Examples include rivets from

converted ends, EZO ends, and rectangular bottles. It can work with any region type except
Ribbon and Loop.

«»*» Notes: this registration may not perform well if the visual features are not consistent from
part to part.

<+ If an orientation is needed, use a separate Template Orientation (on page 290) instead of
the orientation built into this inspection, to save processing time.

e For best results, use software version 5.0.455 or higher.

Series IV users: This is similar to Series IV Template Registration

> Before adding the Template Registration:

1. Add a Measure ROI (on page 223) region of interest to the part program. This can be
placed at the highest level in the inspection tree.

-l Inspections

2. Leave Region Count at One Region.
3. Inthe Measure ROl menu, set the Center Offset X and Y to zero.

Measure ROI(s)

Region Count One Region
8 Region 1

Center Offset X 0

Center Offset Y 0

Region Width 630

Region Height 470

Region Angle 90.0

4. Place the inspection region over almost the entire region:

= |f you have a 640 x 480 image, then set Region Width and Region Height to 630 and 470,
respectively. This allows a five pixel margin around the inspection window.

= |fyou have a 1360 x 1024 image, then set Region Width and Region Height to 1350 x
1014, respectively. This allows a five pixel margin around the inspection window.

5. Click the OK button @ to save changes and exit the menu.
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The example below shows a Measure ROl region placement over an image.

Next, add the Template Registration. Use the steps below for quick setup of the registration.
Depending on your part and application, you may need to make other adjustments after these
steps. The parameters for each of the menus are described below.

» To add a Template Registration:

1. Make sure a Measure ROI region has been added to the inspection tree, as described
above.
2. Acquire about 100 images to get a good sample population of part images:
=  Put the lane online, long enough to acquire about 100 images. Take the lane offline.
= OR: Use Offline Imaging (on page 158). Right-click the Sensor button to see the Sensor
menu > select Offline Imaging > Immediate Mode Run button. Exit the Offline Imaging
screen after acquiring about 100 images.

3. Right-click on the item you just added.

4. From the Inspection menu, select Add > Registration > Template Registration. The
registration is added to the inspection tree. Re-name it to something more meaningful to
you. The Template Registration menus are displayed and the region is shown on the
image. (The menus are described below)

5. Inthe Template Registration menu, un-check the Perform Orientation box.

Next, choose an image and save it as a template.

» To save a template image:

1. Inthe Retro-Spec inspection screen, find an image that represents a regular part - not the
best image, not the worst image, but a typical part image. Use the forward/ backward
arrows to scroll through the acquired images.

2. If the current camera is a color camera, go to the Settings menu, and make sure the Color
to Grayscale box is checked.

3. Go to the Template menu and click the Save Template button. An on screen keyboard is
displayed.
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4. Name the template image and click the OK buttonaI to save. A Saved Template dialog
box is displayed with the name and location of the saved template image.

Saved Template

. Saved to: C:\Pressco\Lane 1
\InspectionTemplates\EZ0O My Template.bmp

@

5. Click the OK button to close the message. You can set the remaining parameters of the
Template menu at a later time.

Next, refine the template region to locate the desired feature in each image. The system will
look at the entire Measure ROI region, then locate a similar pattern of pixels that you select in
the refined region (in our example, we want to find just the rivet in the image).

> To refine the region:

1. Inthe Template Region menu, select either Ring Region or Polygon Region for Template
Region Type, depending on the feature you want to locate. In our example, we want to
find a round rivet, so we choose Ring region.

2. Click the View Editor button. The Template Image Viewer is displayed with the template
image.

3. Click inside the region in the Template Image Viewer image to adjust its size and position.
Use the yellow boxes as points to adjust the region. Moving one yellow box adjusts all
four boxes, making the ring either larger or smaller. Wait while the system updates the
image. An example is shown below.

= Right-click in the Template Image Viewer to view the Image Options menu. Turn on or
off options to change the region and use as needed.

= If using a Polygon Region, the system will prompt you to click anywhere in the image to
begin placing points. Keep clicking points in image to create the polygon. To close the
polygon, click the first point again.

= Remember that the center point is also a ring (if using a Ring Region). It can be adjusted
to create a donut shaped region.

4. Click the OK button in the Template Image Viewer to save changes and exit.
Next, test the registration and adjust settings so that it will work on almost all part images.
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» To adjust the registration:

1. Inthe Retro-Spec graph, or using the forward and backward arrows below the image,
view all the images in Data Set A. You want a range of part images that represent your
production line. They do not have to be perfect images, but you should remove images of
parts that should obviously be rejected.

2. Delete images of any parts that should not be part of the sample population:

a) Click the Lock/ Move Parts button to unlock the data set. @

b) Click the bar on the graph for any part you want to delete, then click the trash can icon
to delete the part from the set.

c) Forinformation about how to use the graph, see Retro-Spec Population View Graph
(on page 210).

d) Click the Lock/ Move Parts button again to lock it.

3. Inthe Settings menu, set Radial Samples and Angular Samples at 1024 and 1024. This will
allow the highest resolution inspection.

4. Inthe Template menu, click the Create Aggregate button. This creates a template using
all the data set images combined instead of using one image.

5. (Optional) In the Settings menu, set Downsize Level at Level 2 (16 to 1). This will speed
inspection time.

7

+* Note: Downsizing creates a slight pixel error. The more Downsizing used, the more pixel
error is produced. We use Downsizing when Template Registration is being used as a
coarse registration to locate a feature. We then add an additional registration such as
Radial Edge or Hough to accurately find the center of the feature.

6. Inthe Template Registration menu, adjust Registration Strength. This can be adjusted by
the horizontal bar in the Retro-Spec graph. This will set pass/ fail limits for the
registration.

7. Test the registration: put the lane online to acquire several images, then click the

r f
O
or | buttons to update the Retro-Spec graph. Make sure that bad

parts are failing, as indicated in the Retro-Spec graph (red bars). Take the lane offline. If

you used the & to update the images, then click it again to stop updating the
Retro-Spec graph.

8. Make adjustments to the registration as instructed by Pressco for your application. The
menus are described below.

9. In applications such as our example, Template Registration is used as a coarse
registration. Add another registration after the Template Registration, such as Radial
Edge, to accurately locate the center of the feature.

Template menu

Tempiate
Selected Template T.bmp
Save Template Image

=
View Template Image
Create Aggregate [Create Aggregate
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Selected Template
Select any saved template from the drop-down menu. If no templates have been created,
no drop-down menu is available.

Save Template Image
Save the current image as a template.

View Template Image
To verify that you have selected the correct template image, click the View Template

button. A pop-up window displays the saved template image. An example is shown below.
1

Template Image Viewer

¢ Note: displaying the template image does not display it in the Intellispec image area.

Create Aggregate
Create a template using all the images in Data Set A. This creates a template using all the
data set images combined instead of using one image. When the aggregate is created, the
new template is saved and is selectable through the Selected Template drop-down menu.
The new template uses the same name you created when using Save Template Image, with
the addition of "_Mean" to indicate an aggregated template.

/7

** Note: it is important the all the images in Data Set A are good quality images to create
an accurate aggregated template.

Template Region menu

Choose whether to use a single region for both the search region and the template region.
Using multiple regions can speed up inspection time.

Tempiate Regio

Template Region Type Use Ring Region
View Template Editor " View Editor

X 0

Y 0

Inner Radius 1

Thickness 127

Use Arcs | Enabled

Template Region Type
Select the region to use for the template region.

= Use Inspection Region - Use the region of interest already set up prior to this
inspection.
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= Use Ring Region - Create a region smaller than the search region, to speed up
inspection time.

= Use Polygon Region - Create a polygon region to use for the template instead of the
search region, to speed up inspection time. When you choose this option, click the View
Editor button to create the polygon. In the Template Image Viewer, create a polygon by
clicking several points in the image. To complete the polygon, click the first point again.

‘0

e Note: The following parameters are used only if Use Ring Region is selected for Template
Region Type. View Template Editor is also used when Use Polygon Region is selected.

View Template Editor
To move the region, click the View Editor button. A pop-up window displays the saved
template image with a region. Click in the image to move the region. Right-click in the

viewer for more options. An example is shown below.
-

Template Image Viewer

.

** Note: the content in the image viewer does not display in the Retro-Spec image area.

XandY
Enter the X and Y offset coordinates for the center of the region you want to establish as
your template region. These values are set as a number of pixels away from the center of
the search region.

Inner Radius
Size of the inner ring.

Thickness
The thickness of the ring; outer radius minus inner radius.

Use Arcs
This is normally NOT used in this inspection. If enabled, it divides the ring region into arc
segments.
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Template Registration menu

Registration Strength I«\S 3.0.50
Registration Mormalization Component Magnitude
Registration Normalization Gain 0.0
5| Perform Orientation
Orientation Strength 1.5. 30
Orientation Normalization Component Power
Orientation Normalization Gain 0.0
= Check Scale
Image Scale Limits 1.0 +0.51/-0.51

Registration Strength
Set the minimum strength, or quality, you require for registration between the inspected
image and the template image. This sets the pass/ fail limits. You can set this using the
horizontal bar on the Retro-Spec graph (after you select this parameter in the menu).

Registration Normalization
Normalization uses template data as a reference and compares it to current part data.
Normally this does not need to be changed from Component Magnitude. If you are getting
inconsistent results, try another technique. Use the technique that works best for your
parts. We recommend trying the techniques in this order:

= Component Magnitude - default, used in most applications.
= Component Power - try this as a second option.

=  Global Power - try only if Component Magnitude or Component Power do not work for
your part.

=  Phase Only - not used.

Registration Normalization Gain
Leave this set at zero.

Perform Orientation
Select whether an orientation is performed as part of the inspection. This is normally not
used. We recommend that if you need to perform an orientation, use a separate Template
Orientation (on page 290) to save inspection time.

The following parameters are only used if Perform Orientation is enabled.

Orientation Strength
Set the minimum strength, or quality, you require for orientation between the inspected
image and the template image. If the current part falls below this value, the part fails.

Orientation Normalization
Normalization uses template data as a reference and compares it to current part data.
Normally this does not need to be changed from Component Power. If you are getting
inconsistent results, try another technique. Use the technique that works best for your
parts. We recommend trying the techniques in this order:
= Component Power- default, used in most applications.
=  Component Magnitude - try this as a second option.
= Global Power - try only if Component Magnitude or Component Power do not work for

your part.

=  Phase Only - not used.
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Orientation Normalization Gain
Leave this set at zero.

Check Scale
We recommend that you leave this box un-checked. Scale refers to a magnification factor in
the event of a change in optics or part movement. It can be used as a reject limit for part
size.

Image Scale Units
[Only used when Check Scale is enabled] Restrict how much the size of the inspected image
is allowed to be adjusted to match the template image. A value of one (1) indicates that the
size matches exactly. A value less than one means that the image needed to be reduced to
match the template. A value greater than one means that the image needed to be enlarged
to match the template. If you use this parameter, be aware that it adds time to the
inspection. Also know that a setting of 0.9 to 1.1 means that there could be 10% variation in
either direction from an ideal part.

Settings menu

Use the suggested rules, described below, for optimum inspection.

Standard Settings 'Standard Setting

Radial Samples 1024

Angular Samples 1024

Downsize Level Level 2 (16to 1)

Grain Reduction Technique Disabled

Contrast Compression Technique Disabled

Advanced Orientation [ Enabled

View Filtered Region
Offset Center X 0

Offset Center Y 0

Select Center Offset
Color to Grayscale | Enabled

Standard Settings
Not used.

Radial Samples
This number divides the region into a number of rings. See example under Angular Samples
below.

To set this manually, set this to the approximate outer radius of the template region,
rounded up. For example, if you have a Ring region, go to the Ring menu, and add Inner
Radius plus Thickness to get Outer Radius. In the Settings menu, use the next highest value
from the radius.

Angular Samples
This number divides the region into a number of arcs. See example below.
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Example: This example shows a region with three (3) radial samples and eight (8) angular
samples. (Note: these values are not available in the inspection. These examples and
shading are for illustration purposes only.)

-;_.II.- v './__.‘ ".I

Downsize Level
Using this option depends on the image. For example, if your part image has grain, then use
a Downsize Level of 4 to 1 - this will blur the image enough to almost ignore the grain.

Enabling this option looks at the region differently by grouping pixels. The system will look
at pixels in groups of 4 (Level 1), 16 (Level 2), or 64 (Level 3). Larger values reduce the image
further, speeding up the inspection at the cost of resolution.

Grain Reduction Technique
This is an optional filter. Enable this feature only if your part has grain and is causing
inspection problems. This filter will help block grain from the image. Use the technique that
works best on your part.

Contrast Compression Technique
This is an optional filter. Enable this feature only if your part has low-frequency changes
such as shadows that are causing inspection problems. Use the technique that works best
on your part.

Advanced Orientation
[Only applicable if Perform Orientation is checked in the Template Registration menu] If this
is enabled, it provides an enhanced technique to perform the orientation. Note that this
increases inspection time.

View Filtered Region
[Only applicable if the Grain Reduction or Contrast Compression techniques are being used]
This displays the image area using the filters.

Offset Center Xand Y
We recommend that you leave these values set at zero.

Select Center Offset
Click the Select Center button to initiate the selection. Then click in the image where the
center should be. Wait while the system computes the new center values and populates the
Offset Center X and Y parameters. Then click the Select Center button to complete the
selection.

Offset Angle is only used if Perform Orientation is enabled.

Offset Angle
Rotate the inspections on an image. Set the angle on a specific feature to match the current
orientation of the part. You can use the Select Angle button to set this value. This feature
saves you from modifying subsequent regions during slight changes that might affect region
placement.

<+ Note: this angle can only be set after you create a template.
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Select Offset Angle

Click the Select Angle button to initiate the selection. Then click in the image where the
orientation should point to. Wait while the system computes and then populates the Offset
Angle parameter. Then click the Select Angle button to complete the selection.

Color to Grayscale

[Only used with color cameras] This feature converts a color image to grayscale for analysis.

This feature can speed up the registration, and may also help the registration to find
features.

Neckring Registration

The Neckring Registration is used in the filling application to locate both sides of the neck ring
on a bottle and then position the following inspections with respect to these points. This
registration always uses a Measure ROI (on page 223) Region. The Neckring registration finds
the edges of the neck ring, then it computes the tilt of the bottle.

Note: Neckring is the new name for Support Ring Registration that was available in version 5.1
software.

¢ Note: Neckring Registration requires a Measure ROl (on page 223) region.

> Before adding a Neckring registration:

Add a Measure ROI (on page 223) Region of Interest to the inspection tree (if you do not
already have one). This region of interest should cover the neckring, a portion of the cap, and
enough of the bottle so that it can accurately determine the tilt of the bottle. It should also be
wide enough to accommodate some part movement in the camera's field of view, but not so
wide that adjacent bottles can be seen in the region of interest.
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e The Measure ROI region of interest should be oriented such that the search direction
(yellow diamond) is pointing towards the cap.
e A sample Measure ROl placement is shown below.

Measure ROI placement for Neckring Registration

1 Measure ROl re-sizing handles. Make sure these are oriented towards the cap and sides.

2 Yellow diamond indicates search direction. Make sure search direction is towards cap.

Next add a Neckring registration.

» To add a Neckring registration:
1. Make sure a Measure ROl region of interest has been added to the inspection tree. A
sample Measure ROI placement is shown above.

2. Right-click on the item you just added.
3. From the Inspection menu, select Add > Registration > Neckring Registration. The
registration is added to the inspection tree. Re-name it to something more meaningful to

you.
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4. The Neckring menus are displayed and the region is shown on the image. (The menus are
described after the procedures) Adjust the placement of the region and parameters as
necessary.

freqgon T

» To set up the Neckring Registration:

1. Inthe Part Search menu, adjust the Edge Polarity, Gradient, Delta, and Size to find the
edge points on the outside edges of the bottle, neckring, and cap. Leave Use Subpixel
un-checked. Edge Thickness should be set so that thin pieces of flash in the region will be
ignored (a value of 5-8 is usually good).

a) To see the effects of these settings, go to the Neckring Registration menu and enable
Show Vectors, Show Search Direction, and Show Edges.

b) Look for green (good) edges at the edges of the bottle, as shown below. To zoom in,
right-click over the image and select a zoom option from the Image Options menu.

~egion |

2. Inthe Neckring Search menu, adjust the number and length of vectors so that they can
locate the underside of the neckring.
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If there are many water droplets or flash hanging down from the neckring, you may want
to disable "Use Common Edge Settings" in the Part Search menu. This will provide
independent edge location settings for the vectors looking for the sides of the bottle and
the vectors that search upwards towards the bottom of the neckring.

If desired, adjust Tilt Limits in the Neckring Registration menu. Normally, this is not used
to reject bottles, so we normally use a wide range for Tilt Limits values.

Scroll through the images to test the registration and make sure that the blue '+' marks
are in the correct places on the bottle (that is, at the edges of the neckring). Adjust the
parameters in the menus as needed. The parameters are described below. An example of
a good neckring search is shown below.

[\'"gil n 1

How the neckring search works

> The registration finds the neckring as follows:

1.

It uses the parameters in the Part Search menu to search from the bottom of the bottle
to the top, looking for edges on the outside of the bottle, as well as the neckring and cap.
It finds edges on the bottle and compares the edges, looking for a large jump in the
direction perpendicular to the bottle (indicating the neckring). It creates "neckring
candidates" when it finds these large jumps. You will see a blue "X" in the candidate
location if you check the Show Candidates box in the Neckring Registration menu. You
will see a red "X" if a candidate was found but did not meet inspection criteria. For
example, this could happen if the system sees a large water droplet.

When a potential neckring candidate is found, the inspection uses the parameters in the
Part Search menu to verify that the candidate is part of the actual neckring and not a
piece of flash or large water droplet.

When the inspection determines the actual neckring points, it places a blue "+" in those
locations.

The parameters in the Neckring Search are used to locate the underside of the neckring
for more accuracy.
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Neckring Registration menu

Use the Neckring Registration menu to locate the neckring. Use the settings recommended by
Pressco support engineers, and adjust as necessary for your part.

| I

Use Linear Hough [ Enabled
Centerline Sensitivity 95

Tilt Limits 0.0° +360.0°/ -360.0°
Show Vectors [ Enabled

Show Neckring Vectors | Enabled

Show Search Direction | Enabled

Show Edges ¥ Enabled

Show Candidates | Enabled

Use Linear Hough
Do not use this feature, as of the date of this publication.

Centerline Sensitivity
Set the orientation sensitivity. The range is from one to 100 with one being the least
sensitive and 100 being the most sensitive. The value of 90 is good sensitivity in almost all
cases.

Tilt Limits
Set the allowed range of tilt of the part within the image.

Nominal
The expected degree of tilt.

R/

*» Note: for the following parameters, you must also Show Graphics. Right-click over the part
image and make sure Show Graphics is checked.

Show Vectors
Show the search lines on the image.

Show Neckring Vectors
Show the gray vectors that are searching for the neckring.

Show Search Direction
Show the search direction of the vectors with an arrow.

Show Edges
Show the found edges on the image.

Show Candidates
Show the potential neckring positions.
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Part Search menu

The settings in this menu determine which edges are used to find the sides of the bottle and
the neckring.

Use Common Edge Settings [V Enabled
Edge Polarity Light-to-Dark
Edge Gradient 16..50
Edge Delta 2

Edge Size 2

Use Subpixel [V Enabled

Use Common Edge Settings
Typically, you would leave this box un-checked. This allows the search for the neckring to
use different settings to ignore flash and other possible flaws. If this box is un-checked, then
you will set the search vectors both in this menu and in the Neckring Search menu.

If this is enabled, then the registration uses common edge location settings for the search
vectors looking for the sides of the bottle (part search), AND the search vectors looking for
the neckring.

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Edge Size
Indicates how many pixels in a row to compare (1to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.
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Neckring Search menu

Use the Neckring Search menu to find the edges along the underside of the neckring and then
locate the outer edges.

Neckring Search

Neckring Vector Length 80

Neckring Vectors 25

Neckring Offset -1

Edge Polarity Light-to-Dark
Edge Gradient 30.75
Edge Delta 2

Edge Size 4

Use Subpixel [v' Enabled

«»» Note: if "Use Common Edge Settings" is enabled on the Part Search menu, then only the
first three parameters are shown in this menu.

Neckring Vector Length
The length, in pixels, of the vectors that search for the neckring.

You can see the neckring vectors when you enable "Show Neckring Vectors" in the Neckring
Registration menu.

1 | Neckring vectors

Neckring Vector
Set the number of vectors to search for the neckring.

Neckring Offset
Set the number of pixels away from the neckring corner that the vectors will begin their
search. If you enter a value, then the offset position is referenced to the centerline of the
part.

If the offset is [-1], then the inspection automatically determines the offset as the average
of edges found on the neckring. The system provides a suggested value to use; look at the
Results window to see that value.
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Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Edge Size
Indicates how many pixels in a row to compare (1to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.

Measure Registration

Measure Registration is used for rectangular or other non-round parts. This registration finds
one edge of a part (vertically, horizontally, or at an angle) and places inspections relative to this
edge. It uses edge search criteria to find the average edge location in a Measurement ROI
region.

Series IV users: This registration is similar to X-Y registration, except that you set up separate regions for
the X and Y searches.

¢ Note: This registration uses a Measure ROl (on page 223) region.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspections 285
© 2013 Pressco Technology Inc. Proprietary



> To add a Measure registration:

1.

Add a Measure ROI (on page 223) region of interest to the inspection tree. Place the
region where the system will consistently see an edge. An example is shown below. If you
want to search both X and Y directions, place one region that will search in the X
direction. You can set up another region and Measure Registration for the Y direction
later. You can even set up a diagonal region to locate a corner, if desired.

2.
3.

Right-click on the item you just added.

From the Inspection menu, select Add > Registration > Measure Registration. The
registration is added to the inspection tree. Re-name it to something more meaningful to
you.

The menu is displayed and the region is shown on the image. (The menu is described
below) Adjust the placement of the region and parameters as necessary. The menu is
described below.

286 Inspections

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)
© 2013 Pressco Technology Inc. Proprietary



Measure Registration menu

Set the registration parameters to locate the edges.

Vector Spacing 1

Max Missed Edges 2
Edge Polarity Dark-to-Light
Edge Gradient 30..255
Edge Size 2
Edge Delta 2
Enhance Vectors V¥ Enabled
Show Edges [V Enabled
Show Vectors [ Enabled
Show Search Direction V¥ Enabled
Show Measurement Positions V¥ Enabled
Average Edge Percentage 0

Vector Spacing
The distance between search vectors.

Max Missed Edges
The number of search vectors that are allowed to fail without causing the inspection to fail.

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Size
Indicates how many pixels in a row to compare (1to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Enhance Vectors
Computes an average pixel value from a neighborhood of 3x3 pixels around each pixel of

the vector.

Show Edges
Show the found edges on the image.

Show Vectors
Show the search lines on the image.

Show Search Direction
Show the search direction of the vectors with an arrow.

Show Measurement Positions
Show the location of the measurement positions (minimum, maximum, and average).
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Average Edge Percentage
Ignore the extreme edges found. If you set a percentage, the inspection will ignore X
percent of the minimum and maximum edges found. This helps determine an average edge

position.

ORIENTATIONS

An orientation compensates for part rotation by finding a grayscale pattern. An analysis which
must rotate with the part must follow an orientation.

«* Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page
216) where you want the Orientation to take place.

Available orientations include Pattern Match (on page 288) and Template Orientation (on
page 290).

«»+» Note: the Centerline (on page 259) and Template Match (see "Template Registration" on
page 269) Registrations also contain an orientation angle that can be used to orient
regions.

Pattern Match

Pattern Match Orientation creates a pattern to be matched. A Pattern Match reference must
be set on one part that you consider to have the desired pattern. The Pattern Match reference
sets the standard to which all other parts inspected must meet. The Pattern Match is based on
percentages; the referenced pattern will be 100%. All other parts will be compared to the
referenced pattern and given a percentage depending on how the two patterns match up. In
other words, a part with an 88% Pattern Match rating is 88% similar to the referenced part. If
the inspected part has too low of a percentage, the part will fail the orientation.

1 Normal orientation

2 Incorrect orientation

¢ Note: Pattern Match only works with a Ring Region (on page 217).

» To add a Pattern Match Orientation:

1. Make sure a Ring Region (on page 217) of Interest has been added to the inspection tree.
Normally the region is a narrow donut- shaped region placed over a repeatable pattern
on the part, such as ridges or other geometry.

2. Right-click on the item you just added.
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3. From the Inspection menu, select Add > Orientation > Pattern Match. The Pattern Match
orientation is added to the inspection tree.

4. The Pattern Match menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

Pattern Match menu

Symmetry Repeat 1
Radial Spacing 1
Select Offset Angle
Offset Angle 0.0°
Set Reference
Show Qrientation Enabled
Part Wiew Display Show Pattern
Show Pattern Match [J Enabled
Region Extraction Read Radially
B Reject Limits
Pattern Match Confidence 30% .. 40%

X3 0 Important

7

%+ Set Reference before adjusting other parameters.

L)

Symmetry Repeat
Divide the donut-shaped region into a number of pie-shaped sections. The system need
only match the gray shade pattern in one of these sections to determine proper orientation.

An example for the use of symmetry is when you are inspecting the base of a bottle that has
five feet - use a symmetry of five. The system uses a gray shade pattern in one-fifth of the
region, and you are assured proper orientation because these gray shade patterns are
identical in the other four sections of the region.

This feature can speed up this orientation. The time required for the orientation is reduced
by 1/symmetry squared. If you have a symmetry of five, this orientation takes 1/25th the
amount of time it would take with a symmetry of one.

Radial Spacing
The number of pixels between search circles. It can be used to increase the speed of this
inspection, especially if the region is large.

Select Offset Angle
Set the Offset Angle (described below). Click the Select Angle button, then click in the image
where you want the orientation to point to.

¢ Note: you can only set Offset Angle if the inspection is passing. You may have to adjust
4 y g P p g y /]
other parameters, or disable other inspections while setting this to get the inspection to
pass.

Offset Angle
Allows you to rotate the inspections on an image. Set the angle on a specific feature to
match the current orientation of the part. This feature saves you from modifying
subsequent regions during slight changes that might affect region placement.
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Set Reference
Click the Set Reference button to set the reference pattern from the
currently displayed image.

Show Orientation
Display the orientation line on the image.

Part View Display
Allows you to look at different results for the part. You must enable 'Show Pattern Match'
to see the information in the unwrapped image.

Show Correlation Plot - Displays a plot to show the correlation between the reference
pattern and the current image in the unwrapped image.

Show Pattern - Displays the extracted grayscale pattern of the current image.

Show Normalized Pattern - Displays the extracted grayscale pattern of the current image;
the values are normalized so that the highest value is one.

Show Pattern Delta - Displays a plot of the differences in the pattern.
Show Pattern Match

Display a graphical plot of the pattern match on the unwrapped image. An example is
shown below.

g A ITE TR A T
[ AR AN I Y A Vi Al

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region. In this inspection, only Read Radially is used. The data
is extracted in a radial direction as shown in the illustration below.

Pattern Match Confidence
Define how closely the pattern must match the original sample. To adjust this value, you

can change the numerical value, or click and drag the red line in the Retro-Spec graph at the
top of the screen.

If you check Show Pattern Match, you can see the red failure limit line in the unwrapped
image move when you change this value.
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Template Orientation

Template Orientation can determine the orientation of a feature that is either irregularly
shaped, or is located in a region with a lot of gray scale variation. However, it can be used on
any part. It is fast and accurate.

‘0

e Note: if you have a part that requires using symmetry, such as the base of a plastic bottle,
or a lugged closure, use Pattern Match (on page 288) to find the orientation.

«*» Note: you must have a registration in the part program prior to the Template Orientation.

The registration will locate the part and allow the Template Orientation to be properly

placed.

> Before adding a Template Orientation:

1. Add a registration that will best locate your part.

2. Add aregion of interest in the area where you want to place the Template Orientation.
An example is shown below. We want to orient the part using the rivet and the
surrounding part geometry.

» To add a Template Orientation:

1. Make sure a region of interest has been added to the inspection tree. A sample Ring
region placement is shown above.
2. Acquire about 100 images to get a good sample population of part images:

=  Put the lane online, long enough to acquire about 100 images. Take the lane offline.
= OR: Use Offline Imaging (on page 158). Right-click the Sensor button to see the Sensor

menu > select Offline Imaging > Immediate Mode Run button. Exit the Offline Imaging
screen after acquiring about 100 images.

3. Right-click on the item you just added.

4. From the Inspection menu, select Add > Orientation > Template Orientation. The
orientation is added to the inspection tree. Re-name it to something more meaningful to
you.

5. The Template Orientation menus are displayed and the region is shown on the image.
(The menus are described below) Adjust the placement of the region and parameters as
necessary.

Next, choose an image and save it as a template as follows:
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» To save a template image:

1.

5.

From the Retro-Spec inspection screen, find an image that represents a regular part - not
the best image, not the worst image, but a typical part image. Use the forward/ backward
arrows to scroll through the acquired images.

If necessary, adjust the region size and placement to cover an area where there is a
repeatable and distinct grayscale pattern.

Go to the Template menu (described below) and click the Save Template button. An on
screen keyboard is displayed.

Name the template image and click the OK buttonaI to save. A Saved Template dialog
box is displayed with the name and location of the saved template image.

Saved Template

Saved to: C:\Pressco\Lane 1
\InspectionTemplates\EZ0O My Template.bmp

@

Click the OK button to close the message. You can set the remaining parameters of the
Template menu at a later time.

Next, set the parameters in the other menus. Use the steps below for quick setup of the
orientation. Depending on your part and application, you may need to make other adjustments
after these steps. The parameters for each of the menus are described below.

> To set up the Template Orientation:

1.
2.

In the Template Region menu, make sure Use Inspection Region is selected.

In the Settings menu, click the Standard Settings button so that the system can adjust to
the image.

In the Settings menu, click the Select Angle button. Click in the image where the
orientation should point to. Wait while the system populates the Offset Angle parameter.
Then click the Select Angle button again to complete the process.

In the Template Orientation menu, adjust Orientation Strength to pass or fail the part.
This can be adjusted using the bars on the graph.

Acquire more images and test the orientation. Make other adjustments as necessary in
the menus, making sure that the orientation is properly found on each part, and that
improperly oriented components make the part fail.
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Below is an example of how a Template Orientation looks on a part.

The menu parameters are described below.

Template Region menu

Make sure that Use Inspection Region is selected. This setting should be used unless otherwise

instructed by Pressco.
Tempiate Region

Template Region Type Use Inspection Region
Settings menu

Use the Standard Settings button and Select Angle button for easy setup in this menu.

If your inspection is not getting consistent results, set the Angular Samples, Downsize Level,
and Offset Angle, using the guidelines described below.

Settings
Standard Settings Standard Setiings
Angular Samples 1024
Downsize Level
Offset Angle 78.43

Select Offset Angle [ Select Angle

Standard Settings

Click the Standard Settings button to automatically set Radial Samples and Angular
Samples based on the current region settings.

Angular Samples

This number is automatically set by clicking the Standard Settings button. This number
divides the region into a number of arcs. See example below.

Example: This example shows a region with three (3) radial samples and eight (8) angular
samples. (Note: these values are not available in the inspection. These examples and
shading are for illustration purposes only.)
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Downsize Level

Using this option depends on the image. For example, if your part image has grain, then use
a Downsize Level of 4 to 1 - this will blur the image enough to almost ignore the grain.
Enabling this option looks at the region differently by grouping pixels. The system will look
at pixels in groups of 4 (Level 1), 16 (Level 2), or 64 (Level 3). Larger values reduce the image
further, speeding up the inspection at the cost of resolution.

For Template Orientation, this can be left disabled for most applications.

Offset Angle

Rotate the inspections on an image. Set the angle on a specific feature to match the current
orientation of the part. You can use the Select Angle button to set this value. This feature
saves you from modifying subsequent regions during slight changes that might affect region
placement.

7

** Note: this angle can only be set after you create a template.

Select Offset Angle

Click the Select Angle button to initiate the selection. Then click in the image where the
orientation should point to. Wait while the system computes and then populates the Offset
Angle parameter. Then click the Select Angle button to complete the selection.

Template Orientation menu

Set the parameters in this menu to pass or fail the part based on orientation.

I

Orientation Strength 1.5

QOrientation Normalization
Orientation Normalization Gain

Orientation Strength

Set the minimum strength, or quality, you require for orientation between the inspected
image and the template image. If the current part falls below this value, the part fails.

Orientation Normalization

Normalization uses template data as a reference and compares it to current part data.
Normally this does not need to be changed from Component Power. If you are getting
inconsistent results, try another technique. Use the technique that works best for your
parts. We recommend trying the techniques in this order:

= Component Power- default, used in most applications.

= Component Magnitude - try this as a second option.

=  Global Power - try only if Component Magnitude or Component Power do not work for
your part.

= Phase Only - not used.

Orientation Normalization Gain

Leave this set at zero.
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Template menu

This menu allows you to save a template image, view the selected template image, and create
a region that is different from the region of interest that the orientation uses.

[rempiate

d Template Generic EZO Panel.bmp
Use Common Template Region IV Enabled
Template Center X 320
Template Center Y 240
Template Region Radius 240
Save Template Image
View Template Image [View Template

Selected Template
Select any saved template from the drop-down menu. If no templates have been created,
no drop-down menu is available.

Use Common Template Region
[only available after more than one template is saved] There are two regions to consider:
the template region and the search region. Using a Common Template Region uses the
same region for both. Using this feature depends on your part. When you have an image
that does not work well with other registrations, such as a rivet on a converted end, an EZO
end, or rectangular bottles, then un-check Common Template Region.

Where possible, use another registration such as Radial Edge or Hough prior to this
inspection, and Use Common Template Region. This allows you to keep the region smaller,
and uses less processing time.

Template Center X and Y
This is not normally used in an orientation. However, it allows you to offset the center of
this region from the center found by the registration that this orientation uses.

Template Region Radius
This is not normally used in an orientation. However, it allows you to adjust a region radius
different from the one set up by the region of interest.

Save Template Image
Save the current image as a template.

View Template Image
To verify that you have selected the correct template image, click the View Template
button. A pop-up window displays the saved template image. An example is shown below.

1

Template Image Viewer

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspections 295
© 2013 Pressco Technology Inc. Proprietary



K/

** Note: displaying the template image does not display it in the Intellispec image area.

ANALYSES

These inspections analyze the part for defects, features, measurements, or gray shades.

7
°

Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page
216) where you want the analysis to take place. We also recommend a Registration (see
"Registrations" on page 249) and an Orientation (see "Orientations"” on page 288)
(depending on the part type) prior to an analysis.

The available types of analyses are:

Ambient (on page 296)

Shape Check (on page 298)

Contrast (on page 301)
Measurement (on page 307)

Fill Height (on page 315)

Fill Height - Segmented (on page 322)
Measure Extract (on page 334)
Distribution (on page 335)

Label Skew Extract (on page 345)
Feature Detect (on page 347)

7
L4

Note: Your system (and this book) may show only those items that apply to your
application.

Ambient

Ambient is a measure of gray levels in a selected region and looks for abnormal gray levels.
There are three ways in which to measure a part’s ambient: Max Amplitude, Peak Percentile,
and Density. You can set the Ambient Analysis Mode to have maximum reject limits, minimum
reject limits, or a combination of maximum and minimum reject limits.

Normal Ambient

Incorrect Ambient
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> To add an Ambient analysis:

1. Make sure a Region of Interest (see "Regions of Interest (ROI)" on page 216) has been
added to the inspection tree. We also recommend a Registration (see "Registrations" on
page 249).

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Ambient. The Ambient analysis is
added to the inspection tree.

4. The Ambient menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

Ambient menu

Ambient Technique Density
Ambient Analysis Mode Min & Max
Region Extraction Read Radially
B A Ambient Limits

Nominal 128

Ambient Technique
This method determines the region’s ambient. Choose the method through the drop-down

menu.

e Max Amplitude looks for the maximum gray level amplitude — the gray level with the
most pixel counts — within the histogram of the search area.

2) Pixels

I
0 255
1) Gray Level
1 Gray level
2 Pixels in the histogram of the image

Peak Percentile locates the gray level value that exceeds the threshold. In the example
below, the system would use the gray level to the right of the line marking 80%.

=  Ambient Threshold defines what percentage of the search area to use.

2) Pixels M'
._- : - v 1 3

"] a0 255
1) Gray Level
1 Gray level - choose a percentage
2 Pixels in the histogram of the image
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e Density computes the average of all the pixel gray levels — total gray level divided by
pixels.

Ambient Analysis Mode
Specify the reject criteria.

Min & Max - The minimum and maximum acceptable ambient gray level values. Any
computed ambient found lower than or greater than these values will cause the inspection
to fail.

Min Only - The minimum acceptable ambient gray level value. Any computed ambient
found lower than this value will cause the inspection to fail.

Max Only - The maximum acceptable ambient gray level value. Any computed ambient
found greater than this value will cause the inspection to fail.

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region.

«»*» Note: some inspections do not use all of these options

The illustration below shows how the information is read by each method. Note that these
shapes are examples only - your region does not have to match the shape.

= i (Y Al EE
/

.r
N

—_—
S \
—
1 2 3 4 5
1 Read Horizontally - Extract the region horizontally - 90 degrees with respect to orientation.
2 Read Vertically - Extract the region vertically - parallel with respect to orientation.
3 Read Circularly - Extract in a circular fashion around the region.
4 Read Radially - Extract region in a radial direction.
5 Read Horizontally and Vertically - Extract the region both horizontally and vertically (with
respect to orientation). This is used in special cases.

Ambient Limits
The minimum and maximum acceptable ambient gray level values. Any computed ambient
found lower than or greater than these values will cause the inspection to fail.

Nominal
The expected gray level value of the region of interest.
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Shape Check

Shape Check looks for a certain shape in the search region and will reject a part if it is out of
tolerance. This feature helps ensure that the custom search region does not get fooled by an
irregularly shaped container.

‘0

» Note: This inspection is only available for Adaptive Regions.

Series IV users: Shape Check is similar to the Shape Adapt region analysis in Series IV.

The example below shows a normal part [item 1], and a part that failed the Shape Check [item

2].

1 2
1 Normal part
2 Part failed Shape Check

» To add a Shape Check inspection:

1. Make sure an Adaptive Region (on page 225) of Interest has been added to the
inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Shape Check. The analysis is added to
the inspection tree. Re-name the inspection to something more meaningful to you.

4. The Shape Check menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.
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Shape Check menu

Select between three different methodologies to determine proper shape (Area Check, Cross

= Area Check
B - Area Range 25000 +5000f -5000
Nominal 25000

" "
Learn Nominal Area ] Learn

= Cross Section Check

Maximum Cross Section Deviation 8.0..10.0

Learn Cross Section .Tearn Distances

=] Vertex Deviation Check

Maximum Deviation Side 1 50. 8.0
Maximum Deviation Side 2 50.80
Area Check

Enable the Area Range portion of the inspection. This computes the area of the region in
pixels to check for proper region size.

Area Range
Define the acceptable deviation (in pixels) from the normal area of the region. You may also
adjust the values on the Retro-Spec graph.

Nominal
The expected area size. This number is populated when you press the Learn button.

Learn Nominal Area
Click the Learn button to automatically learn the area.

Cross Section Check
Enable the Cross Section portion of the inspection. This is only used when an Adaptive
region is added to a Centerline registration. The system ensures that the learned distance
between the two sets of points is within tolerance.

Maximum Cross Section Deviation
First use the Learn Cross Section button to determine the normal values. The distance is in
pixels. Then adjust these values per your specifications.

Learn Cross Section
Click this button to determine the normal values for the Cross Section check.

Vertex Deviation Check
Enable the Vertex Deviation Check portion of the inspection. This is only used when an
Adaptive region is added to a Centerline registration. This check looks at the deviation
between consecutive edge points, and is performed on each side. An example where this
feature might be used is when searching for choked necks on bottles.

The vertex edge points are determined when you use Learn Cross Section.
Maximum Deviation Side 1 and 2

The system computes the distance (in pixels) between consecutive edge points. Adjust the
sensitivity per your specifications.
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Contrast

The Contrast analysis looks for light and dark defects within your desired region. You can set
the Contrast analysis to look for light defects only, dark defects only, or both light and dark
defects. In the example image below, a Contrast analysis found a scratch.

» To add a Contrast analysis:

1. Make sure a Region of Interest (see "Regions of Interest (ROI)" on page 216) has been
added to the inspection tree. We also recommend a Registration (see "Registrations" on
page 249).

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Contrast. The Contrast inspection is
added to the inspection tree. Re-name it to something more meaningful to you.

4. The Contrast menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

Contrast menu

/7

** Note: The symbol [E] indicates that this value is in pixels. Your system may show [mm] for
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be
calibrated using Review Camera Calibration (on page 167) or Image Analysis (on page 158)
for the current sensor.

Bl Contrast Limits 71.48 .. 114.98
Size Filter 21.0@ .. 485.0()
B Acceptable Size 0.0@®
Use Size Weighting ] Enabled
Sizing Total Width
Region Extraction Read Radially
B Advanced Settings
Sample Filter Integration Sampling
Fuzzy Edge Removal Disabled
Defect Type Light and Dark Defects
Optimize Settings
Detection Mode Defect Detect

B Segment Settings

Nurnber of Rings 1
Segment Count 1

Contrast Limits
Set the sensitivity of the inspection. You can also move the red and yellow bars on the

Retro-Spec graph by selecting the arrows to the left of the graph.
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Size Filter
Choose a defect size you want to catch. For example, you may want to pass very small
defects but fail larger ones. For example, if Size Filter is set to 3 -- 80, any defects smaller
than three pixels or larger than 80 pixels would be ignored.

Acceptable Size
This looks at the width of only those peaks that go above the contrast bar. It sums up the
total size of those peaks and puts a limit on how large the total size of the defects can be. In
the Part View graph shown below, there are peaks that go above the contrast bar. However,
Acceptable Size is set to a number greater than the sum of those peaks, and this part
passes. Acceptable Size allows you to pass parts with some anomalies, but reject parts with
too many anomalies.

Part View: Contrast

2000
000 I
& & &

Sgf 6 & 6 & & & & & & ¢ ¢ 4 & & & & &

Use Size Weighting
This feature helps find defects such as wrinkles on metal parts. It is not normally used on
bottles.

= If an area of the part fails, it is weighted. If the area does not fail, it is not weighted.

= The Acceptable Size parameter changes to provide adjustment for weighting.
o The left value is Acceptable Size; see the description for that parameter.
o The right value adjusts the weighted size limit.

Sizing

Choose between Total Width and Total Area for the inspection. The Number of Rings also

affects Sizing.

= Total Width, the default setting, adds the number of units (pixels, millimeters, etc.) of
defective bars at or above the sensitivity level within an inspection region or segment.

= Total Area adds all the defect pixels. Suppose your part had two small defects along the
same radial line. Normally, the width of the predominant defect would be counted. But
with Area enabled, all defect pixels are counted. This results in a larger defect area
counted.

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region.

¢ Note: some inspections do not use all of these options
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The illustration below shows how the information is read by each method. Note that these
shapes are examples only - your region does not have to match the shape.

= il () S BE
L /TN

,,
N

P —
1 2 3 4 5
1 Read Horizontally - Extract the region horizontally - 90 degrees with respect to orientation.
2 Read Vertically - Extract the region vertically - parallel with respect to orientation.
3 Read Circularly - Extract in a circular fashion around the region.
4 Read Radially - Extract region in a radial direction.
5 Read Horizontally and Vertically - Extract the region both horizontally and vertically (with
respect to orientation). This is used in special cases.

Advanced Settings

Sample Filter
Choose how to filter the samples. The default selection is Integration. Leave that selected
for most applications. Concavity is used for detecting and ignoring draw marks in two-piece
beverage cans.

Fuzzy Edge Removal
This is for parts that have normal anomalies at the edges that are fuzzy, but the feature
edges are sharp and clear on the image. The default is disabled. The higher the Filter Level,
the stronger the fuzzy edge removal. Be aware that this filtering increases inspection time.

Defect Type
Search for dark, light, or both types of defects.

Optimize settings
Described below.

Detection Mode
Search for either a defect (default setting) or for a feature (for example, a feature that
should be there and its absence represents a defect).

Segment Settings

Number of Rings
The number of concentric rings the region is divided into (for Read Circularly or Read
Radially Region Extractions only). More rings generally means more sensitive.
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a

a Region with one ring

b Region divided into three rings

The example below shows a Part View graph of the same part's region with one ring [item
1], and that same region divided into several rings [item 2]. Notice that the width of the
peaks do not change, but the amplitude of the peaks change, because the system is

focusing on a smaller region.

Part View: Contrast [
12000
>
100.00
B0 00
B0.00 ‘_ 1
w000
LLLLLIL. ™= ”I .
Sgd & E & & & & 0§ & & & & & £ F F £ £ £ £ £ F F
Part View: Contrast L
14000
12000 I
> -
10000
ED.00 2
w000
000
Sgf & & & £ & & ¢ & & & & & £ F F £ £ £ F & F 5 F
1 Part with region with one ring
2 Same part with region divided into several rings
Number of Segments
The number of angular segments the region is divided into.
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Ring Height

Ring Height is similar to Number of Rings, but applies to a polygon region. This number
refers to a number of pixels wide or high, depending whether you are using Read
Horizontally or Read Vertically for Region Extraction. Ring Height can improve inspection
sensitivity to defects that do not span the width of the inspection region. The default value
for Ring Height is one, which is the most sensitive value. In the example below, suppose
Ring Height in [item 1] is one pixel, and Ring Height in [item 2] is five pixels. In this case, the
part using Ring Height of one [item 1] would be more likely to fail than with a Ring Height of

five [item 2].

1 Smaller Ring Height - more sensitive

2 Larger Ring Height - less sensitive

Using the Optimize feature

The Optimize feature automatically sets the optimum settings for many inspection parameters.
It is processor-intensive and must be done off-line. For this to work correctly, ensure that you
have moved all acceptable images to the left side of the Retro-Spec graph (Set A), and the
defect images to the right side of the graph (Set B). Optimize is available under the Advanced

Settings.

» To use the Optimize feature:

1. Make sure the Retro-Spec graph is in Population view: right-click on the graph to select

Population View.

2. Load aset of good parts into Data Set A using the steps below.

> Toload Data Set A:

1. Look at the Retro-Spec Population View Graph (on page 210).

2. Click the left arrow 0 button on the Retro-Spec graph to view the Select Data Sets

menu.
r

Select Data Sets

Set A (left side)

l:r'- Mothing Selecied
{F Mo Changes (keep current parts)
(" Last 100

{r Latest Delects

@ Image Files
CAPrasscolLane Timages\Sanso 1 v |

Set B (right side)

If-h Hathing Selecied

(_ Mo Changes (ke e clament pans)

@ Last 100

[r Laiest Detecs

Ir'_. Image Files

-

(XX

3. Click the Image Files button for Set A.
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4. Click the disk icon m to browse to the folder where the images were saved. The Select
File menu is displayed.

Select File

Device or Location
C:\Pressco\Lane 1\Images\Sensor 1 v J

No Preview Available

Image File Time Stamp g
1hmp 912612012 11:14:25 AM
10bmp 912612012 11:14:25 AM
T1bmp 912612012 11:14:25 AM
12bmp 912612012 11:14:25 AM
13bmp 912612012 11:14:25 AM
14bmp 912612012 11:14:25 AM
15bmp 912612012 11:14:25 AM
2bmp 912612012 11:14:25 AM
3bmp 91262012 11:14:25 AM
g e gesiSensor 1 Abmp  SZBR012TIAZSAM

| 20

5. Browse to and select the folder that contains the images you want to load.

6. Click the OK button @ in the Select Location and Select Data Sets menus to load all the
bitmap images that were previously saved in the selected folder.

Next load a set of images of bad parts into Data Set B. These parts should have defects in the
current inspection's region of interest.

> Toload images of bad parts:

1. Click the right arrow button n to view the Select Data Sets menu.

2. From the Select Data Sets menu, select Latest Defects, or choose Image Files for Set B. If
you choose Image Files, select images similarly as you did for Set A, except this time
choose defect images.

3. Exit the Select Data Sets menu.

If there are any parts that do not belong in either sample set, try moving or deleting those
samples [refer to the illustration below].

= To move an image:
o Click on the image lock icon [item 1] to allow images to be moved.

o Then click and hold the desired image's peak [item 2] - it displays a small image - and
drag it to the other side of the center.

= To delete an image:
o Click on the image lock [item 1] to allow images to be moved.

o Then click on the desired image's peak [item 2] - it displays a small image - and drag
it to the trash can icon [item 3].

o OR: Click on the desired image's peak [item 2] - and then click the trash can icon
[item 3].
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o The system displays a "Deleted!" message above the trash can icon when it is
deleted.

Lest 100 RetroSpec Population View: Contrast

140.00

Latest Defects

120.00

00004
B> a0

B0.00

40.00

2000

000

2000

Cortrast Limits T1.48 . 114,98 Contrast FAILED

Size Filter 21,00 .. 435,08 Total Size: 532 (0)
B Acceptable Size 0.0

Slzing Total Width

Region Extraction Read Radially

8 Advanced Setlings
Sample Filker neegration Sampling
d Disabled

Light and Cark Defects

Defect Detect

[Optimize Settings] Click to automatically determine the best
contrast parameters to inspect the two data sets.

[o)el~ Ix)

» To finish setting up the Optimize feature:

1. Inthe Contrast menu, choose the Defect Type: light, dark, or both.

Adjust the Acceptable Size parameter to catch the size of defect you want to detect.

3. Click the Optimize button. The system will analyze the part sets and determine the best
settings to pass the good parts while failing the bad parts. Wait till the optimization
process is complete - this may take several seconds.

4. Look at the Retro-Spec graph to determine whether the good parts are still passing and
the bad parts are failing. Most likely, you will see a significant separation of contrast
between good and bad parts.

5. Test the inspection by loading (see "Loading Images" on page 187) more images. You can
make slight adjustments in the Contrast menu if necessary.

N
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Measurement

This analysis measures an inner/outer diameter and/or width of a feature. It can be used in
other types of shapes, but is most often used to measure circular features. It can find
non-round (oval) parts, as well as incorrect widths of circular features.

Series IV users: this inspection is similar to Circle Width Dimension or Retro-Spec Measurement
inspection

» Before you set up the Measurement analysis:

1. Decide which feature you want to measure: inner diameter, outer diameter, width, or all
three.

2. With calipers or other measuring tools, make actual measurements on a good part.
Measure at least one of the features you want to measure (inner diameter, outer
diameter, and/ or width). Make a note of these measurements to input into the analysis
during setup.

¢ Note: if you choose Inspection Calibration [most common] during setup, then you only
need one measurement. If you choose Feature Calibration, you will need the actual
values of all the features you want to measure.

3. Place a Region of Interest (see "Regions of Interest (ROI)" on page 216) over the area you
want to measure, allowing space to find edges.

< Tip: If you want to measure the width of a circular feature, make the region
approximately as wide as the feature on both sides. For example, if the feature is 10
pixels wide, place the region 10 pixels outside of the feature, as well as 10 pixels inside
of the feature as in the example shown below.

1 feature

2 region

> To add a Measurement analysis:

1. Make sure a Region of Interest (see "Regions of Interest (ROI)" on page 216) has been
added to the inspection tree to surround the areas you want to measure. We also
recommend a Registration (see "Registrations" on page 249) before the measurement
region of interest.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Measurement. The Measurement
analysis is added to the inspection tree. Re-name it to something more meaningful to
you.
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4. The Measurement menus are displayed and the region is shown on the image. (The
menus are described below) Adjust the placement of the region and parameters as
necessary.

A

» To set up a basic Measurement analysis:

1. Inthe Measurement menu, pick a Feature Type [see description below].
2. Choose whether to inspect for inner diameter, outer diameter, width, or all three. Under
each of the corresponding menus, enable those measurements.

‘0

s Note: for most applications, you can disable Range and Continuity. Leave these enabled
only if required by your plant.

3. Go to the Contrast menu and adjust the Contrast Limits until you find an edge.

4. Go to the Measurement menu and set most of the parameters [described below].

5. Click the Learn button. This sets the inspection limits for the Inner, Outer, and Width
measurements.

6. Find the actual measurements you made on the part prior to setting up the inspection.
Go to the corresponding menus (example, inner diameter = Inner menu). Enter these
values in the Measured Distance field for each measurement (depending on Calibration
Provider setting in the Calibration menu).

= |f you use Inspection Calibration [most common] for Calibration Provider, then you only
need to enter one value in one of the Inner/ Outer/ or Width menus.

= |f you use Feature Calibration for Calibration Provider, then you must enter values for
all enabled measurements.

= If you use Sensor Calibration for Calibration Provider and the system has already been
calibrated, then skip this step.

7. Change the Units field to match your actual measurement (example, millimeters).

8. Go to the Calibration menu and use the Calibrate on Part [recommended setting] or
Calibrate on Set features to set the scale factor for the analysis.

9. Set other parameters as required by your plant.

Measurement menu

This menu provides settings that will be used in all (Inner, Outer, or Width) measurements. It
also has a Learn feature that automatically sets measurement reject criteria for you.

Learn Settings

Fuzzy Edge Removal Disabled
Feature Type Light Feature
Feature Selection Logic Highest Contrast
Border Sharpness 1.9

Balance 1.0

Balance Side Disabled
Sample Count 36

Allowed Gap Size 0.0

Learn Settings
Click to learn the measurements of the part. This sets the diameter, min/max values, and
average values for you and updates that information in the Inner/ Outer/ Width menus.
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»  Note: if you make significant changes to the parameters in this menu or the other
Measurement menus, click the Learn button again to update the information.

Fuzzy Edge Removal
This is for parts that have normal anomalies at the edges that are fuzzy, but the feature
edges are sharp and clear on the image. The default is disabled. The higher the Filter Level,
the stronger the fuzzy edge removal. Be aware that this filtering increases inspection time.

Feature Type
Determine the type of feature you want the inspection to search for. Use the type that best

finds the region on your part.

1 Light Feature

2 Dark Feature

3 Borders - both dark
4 Borders - both light
5 Borders - dark inner, light outer

6 Borders - light inner, dark outer

Feature Selection Logic
Set this according to your part type and measurement type. Choose the type of edges you
want to find for a type of feature.

¢ Tip: for most applications, leave Border Sharpness, Balance, Balance Side, and Allowed Gap
Size at their default settings.

Border Sharpness
For most cases, leave this set at 1 - 9. This allows you to choose whether to find sharp or
gradual edges. At the default setting, the system finds both types of edges. If you only want
to find sharp edges, set the values closer to one. If you only want to find gradual edges, set
the values closer to nine.
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Balance
For most cases, leave this disabled. This parameter applies mostly to Feature Type =
Feature. If the feature in your image is not the same gray shade across the feature, you
could adjust Balance to compensate for the change in gray shade. Normally, the histogram
across the feature is flat, as in illustration [a]. In the example below, the histogram for the
feature of part [b] shows that the gray scale of the inner diameter is about 50% of the gray
scale of the outer diameter. In this example, we would use a Balance of 0.5, and we would
choose Outer for Balance Side. This allows the system to treat part [b] as though it has
similar gray shades on both sides.

a b

Balance Side
When using Balance, choose which side's contrast needs to be reduced.

Sample Count
Choose how to divide up the circle. For example, if Sample Count is 36, then the system
places a search vector every 10° (360° divided by 36 equals 10°).

Allowed Gap Size
This is used in special cases where you want to ignore a number of segments. Set this to the
number of search vectors you want to ignore. For example, if Sample Count is 36, and the
gap is approximately 40°, then the Allowed Gap Size would be four.

a Allowed gap size
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Inner/Outer/Width menus

There are three menus to provide three different measurements. The parameters in each of
the menus are the same.

Inner Diameter 387.99mm

Min/Max 387.99mm +7.38mm/ -5.83mm
Average 387.99mm +2.62mm/ -3.04mm
Range 9.03mm
= Continuity
Continuity Size B UE
Units pixel
Calibration Factor 0.9999
Measured Distance 388.0mm

Inner diameter/outer diameter/width
Check the box under the appropriate menu to perform this measurement.

‘0

s Tip: When you click the Learn button in the Measurement menu, the values for
Diameter/Width, Min/Max, and Average are set for you. Normally, you do not need to
adjust these further.

Min/Max
Set the minimum and maximum allowable measurement.

Average
Set the average measurement for the part.

‘0

e Tip: for most applications, Range and Continuity are disabled.

Range
Set the acceptable measurement range for the part. This can be used to check for ovality.
The system subtracts the minimum value found from the maximum value found.

Continuity
This feature checks for local changes in edge position between vectors. This allows
detection of defects where the part may be crushed or bent.

Part View: Measurement [Outer Diameter. Continuity]

=

Continuity - Size
Choose the size range of the defects you want to catch, specified in segments.
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Units
Choose your preference in the reporting of the measurements. Choose from millimeters,
inches, pixels, and custom. Custom allows any calibration factor to be used.

Measured Distance
Measure your part with calipers or another tool, then enter the actual value for Measured
Distance. This is used to help calibrate the measurement.

Calibration menu

This menu uses your actual measurements (that you input into the Measured Distance
parameter) to convert the number of pixels into your preferred unit of measurement. This
ensures that the system is making accurate measurements.

Calibration
Calibration Provider Inspection Calibration
Dimension Width
Units millimeter

Calibrate on Part réalibrate on Part
Calibrate on Set A [Calibrate on Set A
Save Calibration u'éave Calibration

Conversion Factor 1.0

Calibration Provider
Specify the source for the display of the calibrated values.

Sensor Calibration -- Calibration can be done through Image Analysis (on page 158), or
through an inspection. When Save Calibration is used within an inspection, that information
can be used in any other inspection (that uses Calibration Provider) for that sensor.

Inspection Calibration -- [most common] use the value from one of your actual
measurements to calibrate the Measurement analysis. Additional Dimension and Units
parameters are available to choose one of your measurements and preferred unit of
measurement. Additionally, Conversion Factor can be adjusted manually to get the best
match between pixels and physical length.

Feature Calibration -- use separate calibration settings for each of the enabled
measurements (inner diameter, outer diameter, or width). You must enter an actual
measured value into each of the appropriate menus.

Dimension
[Available when Calibration Provider = Inspection Calibration] Specify which dimension to
use to calibrate the inspection.

Units
Choose your preference in the reporting of the measurements. Choose from millimeters,
inches, pixels, and custom. Custom allows any calibration factor to be used.

Calibrate on Part
Use the current image to calibrate the Measurement analysis. Use a known good part.

Calibrate on Set A
Use the current set of images in Set A to calibrate the Measurement analysis. The system
takes the average value of the set and uses that number to calibrate the analysis.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspections 313
© 2013 Pressco Technology Inc. Proprietary



Save Calibration
Click the Save Calibration button to save the calibration scale and units to the sensor for
use by other inspections.

Conversion Factor
This indicates the pixel size and is used to convert one pixel into the units selected. The
initial conversion will be controlled by the Learn Calibration results. You can adjust this
value manually if necessary.

Contrast menu

This menu allows you to adjust for sensitivity and defect size for the inspection.

Contrast Limits 113.57 .. 153.88
Size Filter 1.0mm .. 514.0mm

Contrast Limits
Set the sensitivity of the inspection. You can also move the red and yellow bars on the
Retro-Spec graph by selecting the arrows to the left of the graph.

Size Filter
Choose a feature size you want to measure. For example, you may want to ignore very small
features but find larger ones. For example, if Size Filter is set to 3 -- 80, any feature smaller
than three pixels or larger than 80 pixels would be ignored.

Results window

The results displayed for a measurement inspection are different than other inspections. In
addition to the parameters, a measurements table is displayed.

Measurement PASSED b
Metric Values:
Feature Contrast = 87.6

v

Min 432.68 439.84 2.93

Max 439.44 446.73 —
Avg 436.00 443.81 3.91
Range 6.76 6.90 3.08
Continuity Lo -3.00  -2.90  -1.80
Continuity Hi 2.90 270  2.20
Contrast 87.6

You can perform several functions through this results window, including:
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e Go directly to the parameters to adjust a particular measurement. If you click the [6.01] in
the example, the Width menu is displayed and the Min/ Max parameter is highlighted for
you.

e View the corresponding Retro-Spec graph. If you click [6.01] under Width in the example,
the Width Min/ Max graph is displayed at the top of the screen.

More options are available when you right-click over this window to see the Measurement
Results menu. This menu allows you to enable or disable an entire measurement set such as
Inner, Outer, or Width. If you click "Enable/ Disable Measure," then the parameter you

right-clicked to see this menu becomes enabled or disabled.

1 l: Measurement Results

Enable/Disable Measure

@ Enable/Disable Inner
@ Enable/Disable Outer
@ Enable/Disable Width

Light Meter

Light Meter is not used as of this publication.

Fill Height

Fill Height inspection is used for determining the fill level of containers, mainly to find
containers with high fill or low fill. The Fill Height inspection compares the fill level of the liquid
to a standard reference point, which is typically the neckring of a container.

¢ Notes: This inspection requires a Measure ROl (on page 223) Region using two regions.

e If your bottle’s fill level or foam goes into the closure, or way below the fill region, then the
fill height may not be detected. We recommend the Fill Height - Segmented (on page 322)
inspection for these cases.

*

X3

The example below shows a bottle with a normal fill height [item 1], and a bottle with a fill
height that is too low [item 2].

1 Normal fill height
2 Fill height too low
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> Before adding a Fill Height inspection:

Make sure a Measure ROI (on page 223) Region of Interest has been added to the inspection
tree. Suggested settings are as follows:

In the Measure ROl menu, set Region Count to Two Regions.

Place Region One over a distinct reference point, such as the neckring. Set the search
direction (yellow diamond) to search towards the top of the cap.

Place Region Two over a section of the bottle where you expect to see the liquid level. Set
the search direction (yellow diamond) to search towards the bottom of the bottle.

An example is shown below.
Save and close the Measure ROI region menu.

» To add a Fill Height inspection:

1.
2.
3.

4.

Highlight the Measure ROl region name in the inspection tree.

Right-click on the item you just added.

From the Inspection menu, select Add > Analysis > Fill Height. The analysis is added to the
inspection tree. Re-name the inspection to something more meaningful to you.

The Fill Height menus are displayed and the regions are shown on the image. (The menus
are described below) Adjust the placement of the regions and parameters as necessary.

Fill Height menu

7

L X4

*

Note: The symbol [E] indicates that this value is in pixels. Your system may show [mm] for
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be
calibrated using Review Camera Calibration (on page 167) or Image Analysis (on page 158)
for the current sensor.
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Use this menu to set the reject limits for the fill height of the bottle. Note that you may need to
adjust the settings in the Reference or Fill Height menus before setting the Fill Height limits.

:

Fill Mode Top and Bottom

Part Orienation Closure on Left
Reference Region Region 1

Fill Ratio 53

Correct Fill Position V' Enabled

Fill Correction Deviation 59.0®

Fill Height Limits 50.0® +405.92®/-40.0®
Show Fill Height IV Enabled

Keep RetroSpec Statistics 'V Enabled

Fill Mode

Choose whether to measure fill level at the Top Only or at the Top and Bottom
Top Only is generally used for water or other non-carbonated beverages.

Top and Bottom is used mainly for carbonated beverages, or beverages that foam when the
liquid sloshes around in the container as it moves in front of the inspection module. The
inspection can measure the distance from the reference point to the top of the foam, and
also from the reference point to the bottom of the foam.

Part Orientation
Choose the orientation of your part. In many cases, the part image is sideways to optimize
the inspection area on the screen.

Reference Region
Choose a region from the Measure ROI region of interest to set as the reference point (in
our setup example, we picked Region 1). A typical setup uses the neck ring of a bottle as the
reference region. The direction of the search is determined in the region setup (search
towards the diamond). You can change search direction by right-clicking over the image and
using the choices from the Image Options (on page 189) menu.

Regic

Reg

Fill Ratio
[Available when Fill Mode = Top and Bottom] Set the percentage of the distance from the
bottom edge (top of the liquid) to the top edge (top of the foam). The percentage used
depends on the type of liquid in the container. Usually, a value of 25% works well.

Correct Fill Position
Enables edge correction, where the system uses a "moving average" technique to eliminate
outlying edges (example: edges caused by water spots or bubbles in the liquid).
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Fill Correction Deviation
[Available when Correct Fill Position is enabled] This is used to correct stray points that fall
too far away from the moving average edge position. The value is in pixels. Make sure you
use a high enough value, or the inspection will not properly detect sloshing liquid. A
common value to use is 25 or higher.

Fill Height Limits
Define the valid fill height range per your specifications. This value is measured with respect
to your reference point (the neck ring, in our example). You can use the bars on the
Retro-Spec graph to adjust the limits.

Nominal
The ideal fill height value.

Show Fill Height
Show the fill height measurement on the image.

Keep Retro-Spec Statistics
Check this box to keep statistics such as Mean, Standard Deviation, and CPK, from this
inspection. For more information see Retro-Spec Statistics (on page 81).

Reference menu

‘Vector Spacing 1

Max Missed Edges 6

Edge Polarity Light-to-Dark
Edge Gradient 70.. 285
Edge Size 2

Edge Thickness 1

Edge Delta 3

Show Edges Enabled
Show Vectors [] Enabled
Show Search Direction [J Enabled

Set the parameters to find the edges in the reference region.

Vector Spacing
The distance between search vectors.

Max Missed Edges
The number of search vectors that are allowed to fail without causing the inspection to fail.

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Size
Indicates how many pixels in a row to compare (1to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.
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Edge Thickness
The number of consecutive times that the gradient must be met to define an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Show Edges
Show the found edges on the image.

Show Vectors
Show the search lines on the image.

Show Search Direction
Show the search direction of the vectors with an arrow.

Fill Top or Fill Bottom menu

Wector Spacing 1

Search Direction [J Flipped
Max Missed Edges 95

Edge Polarity Light-to-Dark
Edge Gradient 5..45

Edge Size 2

Edge Thickness 1

Edge Delta 1

Show Edges Enabled
Show Vectors [] Enabled
Show Search Direction [l Enabled

Set the parameters to find the edges for the fill level top (Fill Top menu) or the fill level bottom
(Fill Bottom menu).

Vector Spacing
The distance between search vectors. Normally kept at one.

Search Direction
Change the search to the opposite direction.

R/

** Note: If you are using both Fill Top and Fill Bottom menus, then one of the search
directions is usually flipped from the direction indicated in the Measure ROI. You are not
required to flip the search direction, since you can change the Edge Polarity to achieve
the same effect.

Max Missed Edges
The number of search vectors that are allowed to fail without causing the inspection to fail.

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.
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Edge Size
Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Edge Thickness
The number of consecutive times that the gradient must be met to define an edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is

more sensitive because it finds more edges.

Show Edges
Show the found edges on the image.

Show Vectors
Show the search lines on the image.

Show Search Direction
Show the search direction of the vectors with an arrow.

Empty/ Full menu

Emply / Fuil
Empty / Full Check vV Enabled
Ambient Technique Density
Ambient Threshold 80.0
Ambient Analysis Mode Min & Max
B Ambient Limits 128 +127/-128
Reject on Over Fill v

Use this check to determine whether the bottle is empty or full. The system performs an
ambient check in the Fill Height region to determine whether the bottle is empty or full.

Ambient Technique
This method determines the region’s ambient. Choose the method through the drop-down

menu.

e Max Amplitude looks for the maximum gray level amplitude — the gray level with the
most pixel counts — within the histogram of the search area.

2) Pixels

- ]

0 255
1) Gray Level
1 Gray level
2 Pixels in the histogram of the image

Peak Percentile locates the gray level value that exceeds the threshold. In the example
below, the system would use the gray level to the right of the line marking 80%.
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=  Ambient Threshold defines what percentage of the search area to use.

2) Pixels M'

0 80% 255
1) Gray Level

1 Gray level - choose a percentage

2 Pixels in the histogram of the image

e Density computes the average of all the pixel gray levels — total gray level divided by
pixels.

Ambient Analysis Mode
Specify the reject criteria.

Min & Max - The minimum and maximum acceptable ambient gray level values. Any
computed ambient found lower than or greater than these values will cause the inspection
to fail.

Min Only - The minimum acceptable ambient gray level value. Any computed ambient
found lower than this value will cause the inspection to fail.

Max Only - The maximum acceptable ambient gray level value. Any computed ambient
found greater than this value will cause the inspection to fail.

Ambient Limits
The minimum and maximum acceptable ambient gray level values. Any computed ambient
found lower than or greater than these values will cause the inspection to fail.

Nominal
The expected gray level value of the region of interest.

Reject on Over Fill

Check this box to reject bottles that are too full. Un-check the box to pass bottles that are
too full.

Calibration menu

Calibration Mode Inspection Calibration
Units Pixels

Conversion Factor 1.0

Learn Calibration
Save Calibration
Measured Distance -1.08

Measured Fill Level -1.0®

Set the parameters to convert pixel measurement into your preferred measurement unit.
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** Note: The symbol [E] indicates that this value is in pixels. Your system may show [mm] for
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be
calibrated using Review Camera Calibration (on page 167) or Image Analysis (on page 158)
for the current sensor.

Calibration Mode
The system will convert the pixel dimensions into your preferred unit of measurement.

Sensor Calibration -- Use the calibration previously set up for the sensor through Image
Analysis (on page 158) or through another inspection.

Inspection Calibration -- Use the calibration from this inspection only.

Units
Choose your preference in the reporting of the measurements. Choose from millimeters,
inches, pixels, and custom. Custom allows any calibration factor to be used.

Conversion Factor
This indicates the pixel size and is used to convert one pixel into the units selected. The
initial conversion will be controlled by the Learn Calibration results. You can adjust this
value manually if necessary.

Learn Calibration
Click the Learn Calibration button to automatically determine the scale factor, which
converts the value to the desired units.

Save Calibration
Click the Save Calibration button to save the calibration scale and units to the sensor for
use by other inspections.

Measured Distance
Measure your part with calipers or another tool, then enter the actual value for Measured
Distance. This is used to help calibrate the measurement. The measurement should be the
physical length from the neckring to the normal fill height, in your selected unit of
measurement.

Measured Fill Level
Measure your part's normal fill level (with respect to the bottom of the bottle) with calipers
or another tool, then enter the actual value for Measured Fill Level. This is used to help
calibrate the measurement.
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Fill Height - Segmented

Fill Height - Segmented inspection is used for determining the fill level of containers. It can
determine whether containers have high fill, low fill, or no fill. The Fill Height - Segmented
inspection compares the fill level of the liquid to a standard reference point, which is typically
the neckring of a container.

The differences between Fill Height and Fill Height - Segmented inspection are:

e Fill Height - Segmented inspection uses an external reference point, meaning that you can
choose any point of reference on the bottle to measure fill height. Fill Height inspection
uses an internal reference point - one Measure ROI for the reference point, and one
Measure ROI for the measurement.

e Fill Height - Segmented inspection uses ambient analysis to find the fill line. Fill Height
inspection uses edge point analysis to find the fill line.

> A. Before setting up the Fill Height - Segmented inspection:

1. Set up a Neckring Registration (on page 278) that locates the neckring, and allows the
system to place inspections with respect to the neckring location. An example is shown
below.

2. Set up a Measure ROI (on page 223) region of interest for the Fill Height - Segmented
inspection. Suggested settings are as follows:
e Inthe Measure ROl menu, set Region Count to One Region.
e Place the region on the bottle so that:
= The region is high enough on the bottle as possible, but does not overlap the neckring
= The region is far down enough on the bottle to accommodate the normal fill range of
the bottle
= The region is as wide as possible but does not fall outside of the bottle. It should be
narrow enough to fit inside the narrow part of the bottle.
= The search direction goes from the bottom of the bottle towards the top: place the
diamond towards the top of the bottle.
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=  Anexample is shown below.

e Save and close the Measure ROI region menu.
Next add the Fill Height - Segmented inspection.

> B. To add a Fill Height - Segmented inspection:

1. Highlight the Measure ROI region name in the inspection tree.

2. Right-click on the item you just added.
3. From the Inspection menu, select Add > Analysis > Fill Height - Segmented. The analysis is

added to the inspection tree. Re-name the inspection to something more meaningful to

you.
4. The Fill Height - Segmented menus are displayed and the region is shown on the image.

(The menus are described below) Adjust the placement of the region and parameters as
necessary.
First, you will set the reference to the registration that you placed earlier.

> C. To set up the Fill Height - Segmented inspection reference:

1. Go to the Fill Height ROl menu and select One Region for Region Count.
2. Go to the Reference menu and click the Select Inspection button.

Reference
Select Extraction 1 Select Inspection
L& Assigned Inspection Neckring Reg
| Location Provider Type Neckring Registration
Finish Comer Average
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3. Inthe inspection menu, select the Neckring registration that you set up earlier. This tells
the inspection to use data from the registration as a reference.

=l Inspections

-1 ® Neckring Reg ROI [1]
=1 @ Neckring Reg [1]

) =l @ Fill Height ROI

4. Click the Select Inspection button again to complete the selection.
5. From the Finish Corner drop-down menu in the Reference menu, select Average.

Next, set up the product description for the type of bottle you will be inspecting.

» D. To set up the product description:
1. Go to the Segmenting menu.

Segmenﬂr.gl
Carbonated Soft Drink (C...

Vector Spacing 1
Ambient Technique Density
Reject on Over Fill v Enabled

2. Optional: from the Product Description drop-down menu, select the type of product you
are inspecting. At this time, this selection does not affect inspection. It is only a label.

3. If you want the system to reject bottles that are over-filled, check the Reject on Over Fill
box. Otherwise leave it un-checked.

4. Leave the default values for the remaining parameters for now. You can change them
later, if necessary. These are described later in this section.

Next, set up the segments to determine fill height.

» E. To set up the segments:
1. Go to the Fill Height - Segmented menu.

Part Orienation Closure on Left

Dense Foam Fill Ratio 20

Light Foam Fill Ratio 10

Fill Height Limits 50.0@ +40.0@/-40.0®

Show Fill Height 'V Enabled

Show Segment Colors 'V Enabled

Show Segment Highlights V' Enabled :

Keep RetroSpec Statistics | Enabled
Ligu n
®B|v No Liquid Classification
[ Nitrous Dose Classification
[v  Fill Edge Classification
v Dense Foam Classification
[v  Light Foam Classification
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From the Part Orientation drop-down menu, select the appropriate orientation. In our
example, the closure is on the left.

To see the segments as you set them up, check the Show Fill Height box. Also choose
Show Segment Colors [displays solid colors] or the Show Segment Highlights [displays
transparent colors] box. These allow you to see the setup on the screen. You can turn
these off later, if desired.

In the Fill Height - Segmented menu, check all the classifications that pertain to your
bottle. The classification key is shown below. The abbreviations are used in the Results
window next to the inspection menus.

«»* Note: these classifications are color coded. The colors are listed in the information box

when you select Show Segment Colors or Show Segment Highlights in the menu.

Part Orienation Closure on Left

Dense Foam Fill Ratio 20

Light Foam Fill Ratio 10

Fill Height Limits 50.0@ +40.0@/-40.0®
Show Fill Height ¥ Enabled

Show Segment Colors | Enabled

Show Segment Highlights Enabled :

Keep RetroSpec Statistics | Enabled
[v  Liquid Classification
@|v No Liguid Classification

-

[Show Segment Highlights] Sh ne segments color coded to
indicate what they are: Liquid = Green, No Liquid = Red, Nitrous =
Purge = Dark Red, Fill Edge = Yellow, Foam = Dark Yellow and

Next, set up the inspection to learn the ambient values of each classification.

» F. To learn the classifications:

1.

In the Fill Height - Segmented menu, expand the classification you want to learn by
clicking the [+] sign next to the classification. Start with Liquid Classification. More menu
items are displayed. (See also Tips for Setting Classifications below)

Show Segment Colors v Enabled
Show Segment Highlights | Enabled
Keep RetroSpec Statistics [ Enabled
[v Liquid Classification
B Mo Liguid ¢
No Liquid Ambient Range 190 .. 250
No Liquid Variation Range 0.0..25.0

—=
i Leam

Select No Liquid Segments

Select No Liquid Segments E

2. Click the Learn button.

3. Inthe image to the left of the menu, click all the segments that match the classification,
using the crosshair cursor. For example, for liquid classification, click all the segments that
have only liquid showing in the current image. If you inadvertently select an undesired
segment, click it again to de-select it.
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4. Click the Learn button again to complete the selection. A menu is displayed, asking you to
confirm your selections. Click the OK button to accept the selections. The system displays
the ambient values it measured for the selected segments.

SAVE Settings N

- | Do you want to save the settings for the "Liquid®
. classification?

Old AmbientRange=10..70
New AmbientRange=91..129

Old Deviation Range =0..25
NewDeviation Range=2.62..6.51

Do you wish to save the new settings?

| 00

5. Click the OK button to accept and save the new settings.

«» Note: this inspection uses only the displayed image to learn. You may need to use the
Learn More button on additional images to get a good sample population.

6. Click the right arrow button below the image to display a new image. If the new image
does not contain a good example of the classification (light foam, for example), select a
new image.

7. Click the Learn More button. This adds data to the information already learned using the
Learn button.

8. Use the crosshair cursor to select all the segments that match the current classification.

9. Click the Learn More button again to complete the selection.

10. Click OK twice to confirm your selections.

11. Repeat steps 6-10 several more times to get a good sample population. Select different
bottles in the Retro-Spec graph, and make sure that the segments are properly
highlighted for the classification you are setting. Learn more as necessary.

12. Repeat steps 1-11 above for the remaining classifications. Tips are provided below.

Tips for setting classifications:

e You might be able to see the differences between segments better by using Show Segment
Highlights rather than Show Segment Colors. This allows you to see the fill line, and when
the segments change classification.

e Use the unwrapped Region of Interest on the Retro-Spec screen to view the segments
better. This provides a magnified view of the segments.
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Finding the fill level edge:

e For learning fill edge, try to use a segment that has the fill line in the middle of the
segment. You may need to scroll through images, or you may need to adjust the number of
segments to make the fill line fall in the middle of a segment. The system uses only one
segment at a time when learning.

e The system places a large X (green for passing, red for failing) where it determines the fill
level. An example is shown below.

e If the product has foam, the system compensates for it by:

= determining how much and what type of foam is detected, and
= the value you assign to the Dense Foam Fill and Light Foam Fill ratios in the Fill Height -
Segmented menu

1 Bottle passes - fill level was within specifications

2 Bottle fails - fill level was too low

> G. To test the Fill Height - Segmented inspection:

1. Inthe Retro-Spec graph, right-click to see the Retro-Spec Options menu. Select Auto
Select Limits. This sets the pass/fail limits for the inspection based on current settings.

2. Test the inspection by looking at selecting more images on the Retro-Spec graph. Make
sure each bottle passes or fails according to your specifications. You can adjust the bars
on the Retro-Spec graph to make bottles pass or fail.

3. Test several more images to make sure bottles are passing and failing correctly. To
acquire more images, put the lane online and click the [+100] button below the image in
the Retro-Spec screen.

4. If bottles are not passing and failing correctly, then go back to "F. To learn the
classifications" and learn more bottles for the classifications. Or you may need to adjust
other menu parameters. These are listed below for your reference.

Fill Height - Segmented menus

To set up this inspection, follow the procedures A - G above. The following menu descriptions
are for reference.
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Fill Height ROI menu
Set up the Fill Height - Segmented region.

Fill Height RO

Region Count One Region
B Region 1

Center Offset X -9

Center Offset Y 381

Region Width 744

Region Height 288

Region Angle 358.54

Region Count
For this inspection, only use One Region.

Region 1
Usually the region can be set up using the tools on the image. Refer to "A. Before setting up

the Fill Height - Segmented inspection" for tips to set up the region using the Measure ROI
tools.

Reference menu

Select the inspection to which the fill level is referenced. Refer to "C. To set up the Fill Height -
Segmented inspection reference" above to set this menu.

Reference
Select Extraction 1
| Assigned Inspection Neckring Reg
| Location Provider Type Neckring Registration
Finish Corner Average

Select Extraction
These menus allow you to choose an inspection to use as a reference point for the
measurement. Click the Select Inspection button, then choose an inspection from the
inspection tree. Click the Select Inspection button again to set the choice. The Assigned
Inspection and Location Provider Type information is filled in -- you cannot manually change
these.

Finish Corner
If the inspection chosen for the Extraction has multiple reference points, then this
parameter allows you to choose which point to use. For Fill Height - Segmented inspection,
you will usually use Average.
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Segmenting menu

Set up the types of segments needed for your current product. See "D. To set up the product
description."

Segmenting
Product Description Carbonated Soft Drink (C...

ificatior nents

Vector Spacing 1
Ambient Technique Density
Reject on Over Fill v Enabled

Product Description
Choose the type of product you are inspecting. As of this publication, this selection does not
affect inspection. It is used as a label.

Classification Segments
Divide the search region into a number of segments between one and 32. The default is 16
and usually works well. Increasing the number of segments may be more accurate; however
this may increase inspection time and it may be affected by sloshing or decorative features
on the bottle.

Vector Spacing

The distance between search vectors. For this inspection, leave the value at one.
For Fill Height - Segmented inspection, Ambient Technique is usually set to the default Density.
Ambient Technique

This method determines the region’s ambient. Choose the method through the drop-down
menu.

e Max Amplitude looks for the maximum gray level amplitude — the gray level with the
most pixel counts — within the histogram of the search area.

2) Pixels

N
0 255
1) Gray Level
1 Gray level
2 Pixels in the histogram of the image

Peak Percentile locates the gray level value that exceeds the threshold. In the example
below, the system would use the gray level to the right of the line marking 80%.
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=  Ambient Threshold defines what percentage of the search area to use.

2)Pixels M'
._‘ : - v 1 3

0 80 255
1) Gray Level
1 Gray level - choose a percentage
2 Pixels in the histogram of the image

e Density computes the average of all the pixel gray levels — total gray level divided by
pixels.

Reject on Over Fill
If you want the system to reject bottles that are too full, then check this box.

Fill Height - Segmented menu

Program the inspection to learn your product. See "E. To set up the segments."

Part Orienation Closure on Left
Dense Foam Fill Ratio 20
Light Foam Fill Ratio 10
Fill Height Limits 50.0@ +40.0®/-40.0@®
Show Fill Height Vv Enabled
Show Segment Colors vV Enabled
Show Segment Highlights vV Enabled b
Keep RetroSpec Statistics | Enabled
Liquid C cation
[v No Liquid Classification
[ Nitrous Dose Classification

[v  Fill Edge Classification
[v Dense Foam Classification
[v  Light Foam Classification

Part Orientation
Choose the orientation of your part. In many cases, the part image is sideways to optimize
the inspection area on the screen.

Dense Foam and Light Foam Fill Ratio
These are usually used for carbonated soft drink or beer applications. Set the amount of
liquid volume contained in the dense foam and light foam. The default values are 20%
(dense foam) and 10% (light foam).

Fill Height Limits
Define the valid fill height range per your specifications. This value is measured with respect
to your reference point (the neck ring, in our example). You can use the bars on the
Retro-Spec graph to adjust the limits.
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Nominal
The ideal fill height value.

% Note: for the following parameters, you must have Show Graphics enabled. Right-click over
the image and make sure Show Graphics is checked.

Show Fill Height
Show the fill height measurement on the image. A large 'X' is displayed to indicate the
computed fill height.

Show Segment Colors
Show the segments with the color-coding based on classification.

Show Segment Highlights
Show the segments with transparent color-coding based on classification.

% Note: If you have both Show Segment Colors and Show Segment Highlights enabled, only
Show Highlights is displayed.

1 Show Segment Colors

2 Show Segment Highlights

Keep Retro-Spec Statistics
Check this box to keep statistics such as Mean, Standard Deviation, and CPK, from this
inspection. For more information see Retro-Spec Statistics (on page 81).

Classifications
Enable the proper classifications based on the product you are inspecting. The following
parameters are available for each classification.

Ambient Range - This is automatically populated during the learn process.
Variation Range - This is automatically populated during the learn process.

Learn button - Use this button during the first learn process for a classification. Click the
Learn button, then in the image, click all the segments that match that classification. Then
click the Learn button again.

Learn More - Use this button to add data to the learned values. Select a different image

than used for the Learn process, then click the Learn More button, then in the image, click
all the segments that match that classification. Then click the Learn More button again.

‘0

e Note: the system uses only ONE image for the Learn and Learn More processes. We
recommend that you select additional images and use the Learn More button to add
data to the learned population.
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Calibration menu

Use this menu to program the system to translate pixels into your desired units of measure
(mm, for example).

Calibration Mode Inspection Calibration
Units Pixels
Conversion Factor 1.0

Learn Calibration [Leamn Calibration
Save Calibration 'Save Calibration

Measured Distance -1.0®
Distance to Reference -1.0@

<+ Note: The symbol [E] indicates that this value is in pixels. Your system may show [mm] for
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be
calibrated using Review Camera Calibration (on page 167) or Image Analysis (on page 158)
for the current sensor.

Calibration Mode
The system will convert the pixel dimensions into your preferred unit of measurement.

Sensor Calibration -- Use the calibration previously set up for the sensor through Image
Analysis (on page 158) or through another inspection.

Inspection Calibration -- Use the calibration from this inspection only.

Units
Choose your preference in the reporting of the measurements. Choose from millimeters,
inches, pixels, and custom. Custom allows any calibration factor to be used.

Conversion Factor
This indicates the pixel size and is used to convert one pixel into the units selected. The
initial conversion will be controlled by the Learn Calibration results. You can adjust this
value manually if necessary.

Learn Calibration
Click the Learn Calibration button to automatically determine the scale factor, which
converts the value to the desired units.

Save Calibration
Click the Save Calibration button to save the calibration scale and units to the sensor for
use by other inspections.

Measured Distance
Measure your part with calipers or another tool, then enter the actual value for Measured
Distance. This is used to help calibrate the measurement. The measurement should be the
physical length from the neckring to the normal fill height, in your selected unit of
measurement.

Distance to Reference
Measure your part's normal fill level (with respect to the bottom of the bottle) with calipers
or another tool, then enter the actual value for Distance to Reference. This is used to help
calibrate the measurement.
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Measure Extract

This analysis will use edge search criteria to find the minimum, maximum, and average edge
location in a Measurement ROI. You then add a Dimension - Distance (on page 349) inspection
to do the measurement of the found feature position.

» To add a Measure Extract analysis:

1. Make sure a Measure ROI (on page 223) Region of Interest has been added to the
inspection tree. Make sure the region is placed over the feature(s) you want to measure.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Measure Extract. The Measure Extract
analysis is added to the inspection tree. Re-name it to something more meaningful to
you.

4. The Measure Extract menu is displayed and the region is shown on the image. (The menu
is described below) Adjust the placement of the region and parameters as necessary.

Measure Extract menu

‘Vector Spacing 10

Max Missed Edges 18
Edge Polarity Light-to-Dark
Edge Gradient 86.. 139
Edge Size 2
Edge Delta 2
Enhance Vectors [] Enabled
Show Edges Enabled
Show Vectors Enabled
Show Search Direction Enabled
Show Measurement Fositions Enabled

Vector Spacing
The distance between search vectors.

Max Missed Edges
The number of search vectors that are allowed to fail without causing the inspection to fail.

Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.
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Edge Size
Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Enhance Vectors
Computes an average pixel value from a neighborhood of 3x3 pixels around each pixel of
the vector.

Show Edges
Show the found edges on the image.

Show Vectors
Show the search lines on the image.

Show Search Direction
Show the search direction of the vectors with an arrow.

Show Measurement Positions
Show the location of the measurement positions (minimum, maximum, and average).

Distribution

The Distribution inspection looks at color printing on parts, detecting 'tramp cans' or gross
decoration errors on parts. If you are familiar with the Pressco Extractor product, the
Distribution inspection will seem familiar to you.

This inspection can also inspect for proper color of a product. For example, if you are inspecting
blue preforms, it can detect when a preform is not the proper color blue, or if it is an incorrect
color.

The Distribution inspection can inspect for gross decorator defects in gray scale images or color
images. Use Gray Scale mode if your system does not have a color camera, or you want to
focus on a specific range of gray shades. This can help detect scratches or other defects where
the color is missing from an area on the part.

The inspection uses:
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A learned data set to compare to newly inspected parts

Color histograms (see "Distribution Histogram Types" on page 340) that consist of a
number of color bins. Each color in the region of interest is analyzed. The total number of
pixels containing a certain color (or gray scale) are counted and placed in each bin.

» To add a Distribution analysis:
1.
2.
3.

4.

Make sure a Region of Interest has been added to the inspection tree.

Right-click on the item you just added.

From the Inspection menu, select Add > Analysis > Distribution. The analysis is added to
the inspection tree. Re-name the inspection to something more meaningful to you.

The Distribution menu is displayed and the region is shown on the image. (The menu is
described below) Adjust the placement of the region and parameters as necessary.

Load a set of good images into Data Set A

You can use images of the last parts run (up to 100 parts) and learn using this data. However,
you must make sure that all the images in the data set are from good parts. You can look at the
Population View graph and delete the images you do not want. Alternately, you can load a set
of known good images that you have saved previously using the steps below.

> To load Data Set A:
1.

Look at the Retro-Spec Population View Graph (on page 210).
2. Click the left arrow o button on the Retro-Spec graph to view the Select Data Sets
menu.
r -
Select Data Sets
Set A (left side) Set B (right side)
I:f-. Mothing Seleched If-h Hathing Seleciksd
Ird_ Ho Changes (keep current paris) r_ Mo Changes (keep cumen pans)
I:r_. Last 1040 @ Last 100
I:f_ Latesi Defecs r_ Laiest Defecis
@ Image Files rF Image Files
CAPresscolLans 1UmagesSans 1 v |
]

3. Click the Image Files button for Set A.
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4. Click the disk icon m to browse to the folder where the images were saved. The Select
File menu is displayed.
Select File

Device or Location
C:\Pressco\Lane 1\Images\Sensor 1 v J

No Preview Available

Image File Time Stamp g
1hmp 912612012 11:14:25 AM
10bmp 912612012 11:14:25 AM
T1bmp 912612012 11:14:25 AM
12bmp 912612012 11:14:25 AM
13bmp 912612012 11:14:25 AM
14bmp 912612012 11:14:25 AM
15bmp 912612012 11:14:25 AM
2bmp 912612012 11:14:25 AM
3bmp 912612012 11:14:25 AM
g e gesiSensor 1 Abmp  SZBR012TIAZSAM

| 20

5. Browse to and select the folder that contains the images you want to load.

6. Click the OK button @ in the Select Location and Select Data Sets menus to load all the
bitmap images that were previously saved in the selected folder.

Set up the Distribution inspection

» To set up a Distribution inspection:

1. Make sure a good set of images is loaded into Data Set A (see above).

R/

*» Note: descriptions of the parameters mentioned are described under the Distribution
menu section below.

Choose a different Histogram Type if appropriate for your part.
Use the Learn function.

Set the Attenuation if desired.

Use the Learn More function if desired.

vk wnN

‘0

e Note: To use the Learn More function, you will need a set of part images in Data Set A. The
images can be the last 100 parts you have inspected, or images from a file. To load more
images, use the instructions to "Load a set of good images into Data Set A" listed above.
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Distribution menu

Histogram Type New RETRO-SPEC Color Hist...
Gray Scale 0. 285
Bin Count 255
Deviation Limits +20,0/-20.0
Attenuation 0

Learn
Learn More [ Learn More

Region Extraction Read Radially
Color Mode Gray Scale

Histogram Type
Select one of the Distribution Histogram Types (on page 340). This is not used if Color Mode
= Gray Scale.

Gray Scale
Specify the range of gray scales for the distribution inspection. This is not used if Color
Mode = RGB.

Bin Count
This is only used when Color Mode = Gray Scale. Set the number of bins (gray shades) the
histogram is divided into. Note that some constraints may apply, and this number may not
exactly match the number of bins.

Deviation Limits
Set the tolerance level for the colors or gray scale values. Positive values represent too
much of some color. Negative values represent too little of some color. The values
correspond to the largest deviations of some color from its expected amount, which is
determined when learning the data set. Values of zero represent no deviation of color.

Attenuation
Set the minimum number of pixels of a color or gray shade that must be seen before they
are counted. For example, if Attenuation is set at 100, there must be at least 100 pixels of
that color or gray shade, or it will be ignored. Increasing attenuation reduces sensitivity to
small changes. It ensures that only significant color changes cause the product to fail.

Learn
The Distribution inspection needs to learn the colors or gray shades of your product. To
learn, the inspection looks at the samples in Data Set A. Therefore, you will need a set of
images in Data Set A. The data set should contain a good sample of your production line.
Ideally, you should store the images of about 100 good parts in Data Set A. The larger the
sample population, the better the inspection results.

¢ Note: if there are any defective parts in Data Set A, they will be included in the learned
data. Therefore, you might want to look through the data set using the Comparison
View graph, and move defective parts to Data Set B.

7
°

Note: Learn overwrites existing data. It can be used if you are testing the inspection on a
new part, or want to clear the data from a previous learn.
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Learn More
[Only available after you use Learn] - After you have used the Learn function, you can add to
the learned data. Use this to learn new parts where the colors might be slightly different
than your original data set, but are still good parts. This builds a wider tolerance of colors
for your parts. This feature can be used at any time - for example: immediately after the
initial learn, or several weeks later.

7

% Note: We recommend that after running the Learn function on 100 parts, you use the
Learn More button several times to get a good sample population.

Region Extraction
Choose how the Intellispec should read the information from the region. This usually
depends on the shape of your region.

7

+* Note: some inspections do not use all of these options

The illustration below shows how the information is read by each method. Note that these
shapes are examples only - your region does not have to match the shape.

= i () S EE
/

.r
B s kS o

—_—
- \
R —
1 2 3 4 4]
1 Read Horizontally - Extract the region horizontally - 90 degrees with respect to orientation.
2 Read Vertically - Extract the region vertically - parallel with respect to orientation.
3 Read Circularly - Extract in a circular fashion around the region.
4 Read Radially - Extract region in a radial direction.
5 Read Horizontally and Vertically - Extract the region both horizontally and vertically (with
respect to orientation). This is used in special cases.
Color Mode

Choose whether to extract the data in Gray Scale or RGB mode. Note that your system must
have a color camera to use RGB mode.

Information about the graphs in Distribution inspection

The Part View graph view shows the distribution of the color of pixels in the inspection's region
of interest. Each bar on the graph represents a number of pixels in each color bin. The color
bins are shown in the color band at the bottom of the graph. For information about the color
bins, refer to Distribution Histogram Types (on page 340).
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The example below shows a Part View graph with a good part (top) and a defective part
(bottom). The defective part had too many pixels of several different colors in this example -
possibly a 'tramp' part.

Part View: Distribution
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Distribution Histogram Types

In the Distribution (on page 335) inspection, there are several color histograms available. Most
often, you will be using the New Retro-Spec Color Histogram. You will notice the difference
between the histograms in the color bar directly below the Retro-Spec Part View Graph (on
page 214).

P — T T

W - - o
1 New Retro-Spec Color Histogram

2 Special Color Histogram (Chartreuse, Green, Spring Green shown)

3 Classic Extractor Histogram

4 White Level Histogram - not shown

» To see a different histogram:

1. Select a different from the Histogram Type drop-down menu.

2. Switch to Population View on the graph by right-clicking the Retro-Spec graph, then
selecting Population View from the Retro-Spec Options menu.

3. Switch to Part view by right-clicking on the Retro-Spec graph, then selecting Part View
from the Retro-Spec Options menu. The new histogram is displayed below the graph.

340 Inspections System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary




New Retro-Spec Color Histogram

In this histogram, there are 16 bins of gray scale, 48 bins of dark or pastel colors, and 192 bins
of very bright colors. The 48 bins of dark or pastel colors have a wider tolerance, and therefore
you may see most of the colors of your part in those bins. This histogram also has some
overlapping of colors - that is, pixels may be mapped to more than one color bin. This ensures
that slight variations of color do not cause the product to fail.

Special Color Histograms

In special cases, you may use other color histograms. The color bars are viewable under the
Part View graph.

If you are trying to detect off-color parts, such as preforms, use one of the special color
histograms. For example, if your preforms are supposed to be green, use the histogram that
most closely matches the correct color. This provides a large range of green colors to be
detected. When a different color part (blue, for example) goes through your product stream,
that part will be easily detected because it will not fall into the learned green color range.

Classic Extractor Histogram

This histogram is the same as the original Pressco Extractor product. It has 16 gray scale bins
and 240 color bins. This is different from the New Retro-Spec Color Histogram in that it does
not have the middle section of 48 bins of dark or pastel color.

This histogram is only used when an approximate comparison between the original Extractor
product and the Retro-Spec Distribution is required.

White Level Histogram
(As of this printing, the white level histogram is not displayed under the Retro-Spec graph)

This histogram is used for pastel colors, or if you want to differentiate between shades of the
same color. For example, you might need to detect when a yellow color is too light compared
to the normal yellow shade.

Delta E in Retro-Spec Distribution inspection

Delta E is a measurement used to indicate how much a color deviates from an accepted
standard. The Distribution inspection provides Delta E detection by measuring color separation
on a scale of 0 - 100. A value of zero indicates that there is no discernible difference in color
from the reference value. A value of one indicates the minimum human perceptible difference
in color. The colors are measured in an L*a*b*color space.

When using Delta E, the optional Luminance, Chrominance, and Hue features can all be
enabled or disabled separately. You can also set separate sensitivity values for each of these
components.

¢ Tip: set up one Distribution inspection to measure Delta E. Use a separate Distribution
inspection to detect tramp parts or gross decorator defects.

> What you will need:

Your plant's L*a*b* color specifications for the part you are inspecting. You should have values
from a Gold Standard part, as well as measured values from a random sample part. (example: if
your can is painted primarily Blue, Red, and Gold, then obtain L*a*b* values for those three
colors)

> Before adding the Distribution inspection with Delta E:

1. Make sure a Region of Interest has been added to the inspection tree.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspections 341
© 2013 Pressco Technology Inc. Proprietary



A

r

N

7.

Snap several images of parts - if possible, put the lane online for about a minute to
capture several images. Alternately, you may choose to load a set of saved parts after
adding the inspection.

Take the lane offline.

To add the Distribution inspection:

Highlight the region name in the inspection tree.

Right-click in the inspection tree to see the Inspection menu.

From the Inspection menu, select Add > Analysis > Distribution. The analysis is added to
the inspection tree. Re-name the inspection to something more meaningful to you. The
Distribution menu is displayed and the region is shown on the image. For more
information about the Distribution menu, see Distribution (on page 335).

Go to the Delta E menu and check the Delta E box to enable the feature.

If you have already captured several images and want to use them, go to the next step. If
you have a saved set of images that you want the system to learn, load those images into
Data Set A.

Go to the Distribution menu and click the Learn button. You should see a difference in
the population graph.

Next, set the Delta E colors.

Setting Delta E Colors

> To set a Delta E color:

1.
2.

3.

Go to the Delta E menu and highlight the Delta E Limit item in the menu.

Scroll through the available part images to locate one that has a good representation of
the Delta E colors you want to define.

Switch to Part View in the Retro-Spec graph: highlight, then double-click the bar for the
part identified in step 2. You should see peaks on the graph that correspond to the colors
on your part.

¢ Note: the height of the peak is not proportional to the number of pixels in the bin. You

may see a low peak with a large Color Count.

4.

Click on the various peaks on the graph while looking at the Results window. Locate a bin
(peak) that is close to the Delta E color you want to define (colors are displayed below the
graph). Find one that has a high Color Count.
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Part View: Distribution [Delta E Limit]

10.00

Distrioigion |

Delta E v Enabled || Distribution Part Information
| Information for Bin 16:

| Color Count = 4565

Luma Enabled Variance = 5.4
Chroma [ Enabled Leamed On (S | 2cted Bin):
Hue [~ Enabled | Min Count = [ i1
. = S Max Count | 6240
Analysis Mode Use Al Colors
Color Analysis e se All Colors | of Cc | ats = 2636
Add Custom Color Add Custom Color |

(Min < Nor | < Max)
| Delta E Informal
Delta E 1.41

[Delta E Limit] — TBD —

= 1-Select a peak (bin) that is close to the Delta E color you want
= 2 - Results window - look at Color Count

5. When you have located a bin that is close to your Delta E color with a high Color Count,

click the Add Custom Color button. The Add Color menu will be displayed.
r

Add Color
Color Selected #65

Color Name &= 50705

Calibration Standard

L/52.048 al36.084 bl 24.795
Gold Standard
L|52.048 a|36.084 b|24.795

L 20

6. Addthe L*a*b* colors for either the Calibration Standard (from your random sampled
part) and/or Gold Standard row, depending on your plant requirements.

7. Click the OK button to save changes and exit. Once you have added a Custom Color, the
Edit Custom Color and Delete Custom Color buttons become available in the Delta E
menu. The Results window now displays information about the custom colors you have
defined (when you select that color in the graph).
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8. To add another color, select another bin on the graph that is close to the Delta E color
you want to define, and that has a high Color Count (if necessary, scroll through images
to find one that has a good representation of that color).

9. Next, set the sensitivity.

A

»> To set the sensitivity:

1. Make sure the Delta E Limit parameter is highlighted in the Delta E menu.

2. Switch to the Population View graph: Right-click over the Retro-Spec graph and select
Population View from the Retro-Spec Options menu.

3. Move the red sensitivity bar on the graph to determine pass/ fail limits for the inspection.
For example, if your plant allows a Delta E value to be no greater than six (6), then set the
sensitivity bar at six.

The parameters in the Delta E menu are described below.

Delta E menu

Delta E |V Enabled

Luma V¥ Enabled

Luma Limits +9.0/-9.0

Chroma |V Enabled

Chroma Limits +9.0/-9.0

Hue V¥ Enabled

Hue Limit 9.0

Color Analysis Mode Use All Colors

Edit Custom Color [Edit Custom Color

Delete Custom Color Belete Custom Color

Enable measurements for Delta E, Luma (Luminance), Chroma (Chromaticity), and/ or Hue, if
desired. Use these measurements only if required by your plant.

Delta E
Enable the Delta E check.

Delta E Limit
Set the reject limit for the Delta E check. This can be entered manually by selecting this row
and using the pop-up numerical tools, or by sliding the reject line on the Retro-Spec graph.

Luma (Luminance)
The luminous intensity of a surface in a given direction per unit of projected area. [Source:
http://www.merriam-webster.com/dictionary/luminance)

Chroma (Chromaticity)
The aspect of color that includes consideration of its dominant wavelength and purity.
[Source: http://www.thefreedictionary.com/chromaticity]

Hue
The attribute of color that enables an observer to classify it as red, green, blue, purple, etc.,
and excludes white, black, and shades of gray. [Source:
http://www.thefreedictionary.com/hue]

Color Analysis Mode
Choose to evaluate All Colors or Custom Colors for Delta E limits.

All Colors - the system uses all the colors on the part to evaluate Delta E limits.
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Custom Colors - you must first select a bin from the Part View Retro-Spec graph to define a
color. See "Setting Delta E Colors" above for instructions. If you select "Custom Colors,"
then the system will only evaluate parts for the defined custom color(s).

If you select Custom Colors then only the bins that contain pixels for the custom colors are
displayed on the Retro-Spec graph. In the example below, we have two custom colors
defined; therefore only two bins are displayed.

Part View: Distribution [Delta E Limit]

Bin 0 Bin 1

Edit Custom Color
This button is available only after you have defined a custom color, and you have selected
the bin corresponding to the color on the Retro-Spec graph. Click this button to edit the
values for Calibration Standard or Gold Standard.

Delete Custom Color
This button is available only after you have defined a custom color, and you have selected
the bin corresponding to the color on the Retro-Spec graph. Click this button to delete the
current custom color.

Label Skew Extract

Label Skew Extract is similar to Measure Extract (on page 334). Label Skew Extract is
specialized to locate the edge of the label and can be set up for either one or two search
regions. It finds the edges of a label and draws a "best fit" line using those edges. The
inspection's main function is to export this data to a Dimension > Angle inspection. Label Skew
Extract inspection can reject a part if the label is not consistent enough, such as a flagged label.

Label Skew requires a Measure ROI (on page 223) to set up the region(s). The actual skew
inspection is handled by the Angle (on page 354) dimension.

1 Normal label
2 Skewed label
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> To add a Label Skew Extract inspection:

1. Make sure a Measure ROI (on page 223) Region of Interest has been added to the
inspection tree. Set up the Measure ROI for one or two regions.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Label Skew Extract. The analysis is
added to the inspection tree. Re-name the inspection to something more meaningful to
you.

4. The Label Extract and Region menus are displayed and the region is shown on the image.
(The menus are described below) Adjust the placement of the region and parameters as
necessary.

5. After setting up the Label Skew extract, add an Angle (on page 354) dimension.

Label Skew Extract menu

Check Consistency

Label Consistency 5.0

Check Consistency
Enable the consistency check (the label skew check).

Label Consistency
Set up the limits for the position of the found edges. This number indicates the straightness
of a line. A lower number means the points do not deviate much from a straight line and is
therefore more consistent.

Region 1 menu

Set the parameters so that desired label edges are found. Note that search direction and region
position can be set by using the Image Options (on page 189) menu. Right-click over the image
to see the Image Options menu.

Wector Spacing 1

Max Missed Edges 20

Edge Polarity Either

Edge Gradient 15.. 30
Edge Size 2

Edge Delta 2

Edge Thickness 1

Use Subpixel [J Enabled
Enhance Vectors Enabled
Show Edges Enabled
Show Vectors [J Enabled
Show Search Direction Enabled

Vector Spacing
The distance between search vectors.

Max Missed Edges
The number of search vectors that are allowed to fail without causing the inspection to fail.
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Edge Polarity
Choose the type of edge to search for — Light to Dark, Dark to Light, or Either. For example,
if the feature you want to find is very bright, choose Dark to Light.

Edge Gradient
The minimum and maximum difference in gray shades, between two pixels, to be
considered an edge.

Edge Size
Indicates how many pixels in a row to compare (1 to 1, 2 to 2, etc.). The larger the Edge Size,
the stronger the edge will need to be. This parameter acts like a filter that looks at a length
in pixels before and after the edge.

Edge Delta
The distance between pixels being compared when seeking an edge. A higher Delta value is
more sensitive because it finds more edges.

Edge Thickness
The number of consecutive times that the gradient must be met to define an edge.

Use Subpixel
Finds edges based on their subpixel location, rather than rounding off to the nearest pixel.
This gives greater centering accuracy.

Enhance Vectors
Computes an average pixel value from a neighborhood of 3x3 pixels around each pixel of
the vector.

Show Vectors
Show the search lines on the image.

Show Search Direction
Show the search direction of the vectors with an arrow.

Feature Detect

Feature Detect analysis can be used to detect a range of specific gray shades to determine
defects. For example, in a fill height/ cap placement inspection, it can be used on the cap to
determine whether a tamper band is broken.

¢ Note: Feature Detect analysis requires either a Ring Region (on page 217) or Polygon
Region (on page 218) of interest.

Series IV users: Feature detect is similar to Zones Inspection.

> To add a Feature Detect analysis:

1. Make sure a Ring Region (on page 217) or Polygon Region (on page 218) of interest is
already added to the inspection tree. Adjust the region to examine the area of interest
where you will place the Feature Detect inspection.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Analysis > Feature Detect. The analysis is added
to the inspection tree. Re-name it to something more meaningful to you.

4. The Feature Detect menus are displayed and the region is shown on the image. (The
menus are described below) Adjust the placement of the region and parameters as
necessary.
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Feature Detect menu

Use the Feature Detect menu to specify a range of gray shades to find.

Feature Method Use All Data
Feature Gray Scale 30..100

Second Feature Range [ Enabled
Show Features [ Enabled

B|v Check Feature Area
B -1 Allowed Area
Nominal 1000

Learm Nominal Area

[ Check Feature Count

Feature Method
Choose a method to determine the ambient value in a search region.

Use All Data - Analyzes all the pixels in the search region, and counts the total number of
pixels that meet the criteria set in Feature Gray Scale.

Use Qualified Features - Analyzes all the pixels in the search region, but only counts pixels
if:

= The pixels meet the Feature Gray Scale criteria, AND

= The pixels meet the Feature Size criteria.

Feature Gray Scale
Set the range of gray shades of the feature you want to locate.

Second Feature Range
Set a second range of gray shades to locate within the search region.

Second Feature Gray Scale
[Only shown if Second Feature Range is enabled] Set the range of gray shades of the second
feature you want to locate.

Show Features
Highlight the found features on the image.

Check Feature Area
Check the area of the feature to see that it is within the specified tolerance.

Allowed Area
[only available if Check Feature Area is enabled] The tolerance (in pixel area) of the feature
you want to locate.

Nominal
The expected area size. This number is populated when you press the Learn button.

Learn Nominal Area
Click the Learn button to automatically learn the area.

Check Feature Count
Check to see that the correct number of features is found.

The following parameters are available when Feature Method = Qualified Features.
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Feature Size
Set the allowable size of the feature you want to locate.

Show Feature Centers
Show the center points of the found features, marked with an 'X.'
Feature Detect - example FHCP 3X

The example below shows where a Feature Detect inspection could be used within a Fill
Height/ Cap Placement inspection. It could be used to detect a defective tamper band. This
tamper band did not meet tolerance criteria for gray scale range, so it failed inspection.

DIMENSIONS

The dimension inspection type is special in that it connects the results of two other inspections
to do the analysis. For example, a distance inspection can connect two registrations to measure
the distance between centers of two features.

The Dimension inspections include:
e Distance (on page 349)
e Angle (on page 354)

«»*» Note: Your system (and this book) may show only those items that apply to your
application.

Distance

The Distance inspection computes the distance between two points. This is useful if you want
to find features that are out of tolerance or out of place on a part. Distance inspection does
NOT use a region. It obtains information produced in other inspections. The other inspections
can include a Registration (it uses the found registration point), or a Measure Extract
inspection.

Series IV users: this inspection produces the same results of Dimension inspection, but in Series V the
measurement points are found by other inspections.
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Examples of where Distance inspection might be used is for detecting swung gates or high caps
on bottles, turned tabs on converted or EZO ends, or computing finish dimensions. The
example below shows a gate position computed with respect to the center of the base.

Full image with swung gate

Enlarged image of good part

Enlarged image of bad part showing incorrect position of gate

Distance can be computed with respect to the center of the screen, if desired.

X

> To add a Distance measurement:

1.

Make sure at least one Registration (see "Registrations" on page 249) or Measure
Extract (on page 334) inspection is placed in the inspection tree. To find the distance
between two points, place the registrations or Measure Extract inspections for each
point.

Right-click on the item you just added.

From the Inspection menu, select Add > Dimension > Distance. The dimension is added to
the inspection tree. Re-name it to something more meaningful to you.

The Distance menus are displayed and the region is shown on the image. (The menus are
described below) Adjust the parameters as necessary.

» To set up a basic Distance measurement:

1.
2.
3.

Choose a Distance Component from the Distance menu.

Go to the Extraction 1 menu and click the Select Inspection button.

Select the first reference point (in the inspection tree) you want to use for the Distance
measurement. Click the Select Inspection button again to complete the selection.

Go to the Extraction 2 menu and click the Select Inspection button.

Select the second reference point (in the inspection tree) you want to use for the
Distance measurement. Click the Select Inspection button again to complete the
selection.

Go back to the Distance menu and set the Distance Limits.

Adjust other parameters as necessary.
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Distance menu

% Note: The symbol [E}] indicates that this value is in pixels. Your system may show [mm] for
millimeters, ["] for inches, or [ ] blank for custom units. It indicates that this value can be
calibrated using Review Camera Calibration (on page 167) or Image Analysis (on page 158)
for the current sensor.

l

Distance Component Point to Point

Use Orientation From Extraction 1

& B Distance Limits *-20.0@*-10.0® 10.0@® 20.0...
Nominal 100.0®

Keep RetroSpec Statistics | Enabled

Distance Component
Point to Point -- [most common] Find the distance between two reference points.
Perpendicular to Orientation and Parallel to Orientation -- These two modes are good for

measuring distance across a bottle finish. You would set this mode depending on the part
orientation.

1 2

1 Part oriented upright - use Perpendicular to Orientation

N

Part oriented sideways - use Parallel to Orientation

7
°o

Note: If you use Finish Location or Centerline registrations for either of the extractions,
note that these registrations produce an orientation. The distance measured will
reference the orientation produced by the Finish Location or Centerline registrations. If
using other inspections, zero degrees or ninety degrees is used as a reference.

Use Orientation From
Select which measurement from which to use orientation information.

Distance Limits
Specify the minimum and maximum distance between the two reference points.

Nominal
The ideal distance.

Keep Retro-Spec Statistics
Check this box to keep statistics such as Mean, Standard Deviation, and CPK, from this
inspection. For more information see Retro-Spec Statistics (on page 81).

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspections 351
© 2013 Pressco Technology Inc. Proprietary



Extraction 1 and Extraction 2 menus

«*» Note: when only one inspection is used for Extraction, the second reference point used is the
center of the screen.

Extraction f|
Select Extraction 1 Select Inspection

L Assigned Inspection UNDEFINED
| Location Provider Type No Measurements

Select Extraction
These menus allow you to choose an inspection to use as a reference point for the
measurement. Click the Select Inspection button, then choose an inspection from the
inspection tree. Click the Select Inspection button again to set the choice. The Assigned
Inspection and Location Provider Type information is filled in -- you cannot manually change
these.

In this example, we chose Hough as Extraction 1 and Feature as Extraction 2 from the
inspection tree. Those inspections become highlighted when Distance is selected in the
inspection tree and/or is being edited.
= Inspections
+ @ Polygon [1]
-1@ Ring
a@Heuan st — 1
-1@® Ring
e Reaue Lt — 2
-@ Ring
% Contrast
-l@ Ring
# Contrast
# Ambient

Reference Point
(Available when you use the Measure Extract inspection) Choose which edges to use when
computing Distance.

Extraction I‘
Selecting ... 1 Select Inspection
| Assigned Inspection Measure Extract
. Location Provider Type Measurement

Reference Point

Maxirnurm Pe

Average Position

Minimum Position -- The system will use the minimum distance of the search region, and
reject parts if the measurement is out of limits.

Maximum Position -- The system will report the maximum distance of the search region,
and reject parts if the measurement is out of limits.

Average Position -- The system will report the average distance of the search region, and
reject parts if the measurement is out of limits.

352

Inspections System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary



Suppose the illustration below indicates a search region, in which the system is searching
from right to left, seeking a light to dark transition. Position 1 is the Maximum Position.

Position 2 is the Average Position. Position 3 is the Minimum Position found in the search
region.

Finish Corner

(Available when you use Finish Location as the extraction for Distance) Choose which corner
to use as a reference when computing Distance.

Extraction 7‘
Select Extraction 1
L Assigned Inspection Finish Location
| Location Provider Type Finish Registration
Finish Corner Corner 1

Calibration menu

Use this menu to program the system to translate pixels into your desired units of measure

(mm, for example).
Caﬁbra!‘kx}|

Calibration Mode Inspection Calibration
Units

Conversion Factor 1.0

Learn Calibration
Learn Calibration
Measured Distance -1.0

Calibration Mode
The system will convert the pixel dimensions into your preferred unit of measurement.

Sensor Calibration -- Use the calibration previously set up for the sensor through Image
Analysis (on page 158) or through another inspection.

Inspection Calibration -- Use the calibration from this inspection only.
Units

Choose your preference in the reporting of the measurements. Choose from millimeters,
inches, pixels, and custom. Custom allows any calibration factor to be used.

Conversion Factor

This indicates the pixel size and is used to convert one pixel into the units selected. The

initial conversion will be controlled by the Learn Calibration results. You can adjust this
value manually if necessary.
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Learn Calibration
Click the Learn Calibration button to automatically determine the scale factor, which
converts the value to the desired units.

‘0

»  Note: you must first enter the Measured Distance before learning calibration.

Save Calibration
Click the Save Calibration button to save the calibration scale and units to the sensor for
use by other inspections.

Measured Distance
Measure your part with calipers or another tool, then enter the actual value for Measured
Distance. This is used to help calibrate the measurement.

Angle

Angle computes the difference in angles between two orientations or registrations. Angle does
NOT use a region by itself. It uses information obtained in previous registrations or
orientations. To measure an angle, use at least one registration or orientation - anything that
produces an orientation. Examples where Angle could be used are to find skewed labels, or
turned tabs on converted ends or EZO ends.

Inspections that produce an orientation, that can be used to compute an angle include:
Centerline (on page 259)

Finish Location (on page 264)

Template Registration (on page 269)

Pattern Match (on page 288)

Template Orientation (on page 290)

Label Skew Extract (on page 345)

In the example below, a label angle is computed with respect to the centerline of the part.

.
r——
- A
1 2
1 Good part
2 Bad part - label angle is out of tolerance
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You can measure the angle with respect to zero degrees on the image, if desired.

00

X

>

To add an Angle dimension:

Make sure at least one inspection that produces an orientation has been added to the
inspection tree. [see list above]

Right-click on the item you just added.

From the Inspection menu, select Add > Dimension > Angle. The Angle dimension is
added to the inspection tree. Re-name the inspection to something more meaningful to
you.

The Angle menu (along with two Orientation menus) is displayed and the region is shown
on the image. (The menu is described below) Adjust the placement of the region and
parameters as necessary.

> To set up Angle dimension:

1.
2.
3.

Select the Orientation 1 menu.

Click the Select Inspection button.

From the inspection tree on the left side of the screen, choose an inspection to reference
one angle. The inspection you choose must be one that produces an orientation. See list
at the beginning of this topic.

Click the Select Inspection button again to complete the selection.

If you have another inspection to reference, use the Select Inspection button in the
Orientation 2 menu. If you do not have another inspection to reference, the system uses
zero degrees on the image as a reference.

Go to the Angle menu and set the Angle Limits to pass or fail parts based on your quality
control criteria. For example, a part may be rejected if the angle of the label is too large
compared to the centerline of a bottle.

Adjust other parameters as necessary to pass or fail parts per your criteria.

Angle menu

| Orientation |Orientation |

B 1 Angle Limits 0.0° +{-245,9°
Nominal 0.0
Angle Mode Largest Angle
Flip Angle 180 [J Enabled
Angle Limits

Set the valid range of measured angles per your specifications.

Nominal

The ideal angle measured.
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Angle Mode
Use the Smallest or Largest Angle. An example: the system could measure an angle at 2° or
358° depending which direction it is measuring. Choose whether to use the smallest or
largest angle found.

Flip Angle 180
Use this option if your angles are pointing in opposite directions and you want them aligned
in the same direction. Sometimes this depends on how a ribbon was drawn, for example.

Orientation menu (1 or 2)

Pick the reference point(s) to measure the angle.

«*» Note: when only one inspection is used for Extraction, the reference angle used is zero
degrees, so the inspection would measure the angle with respect to zero degrees.

Orientation 4
Select Extraction 1 Select Inspection

Ll Assigned Inspection Centerline

| Location Provider Type 'Centerline Registration

Angle Selection

Centerline
Side 1

Side 2

Select Extraction
These menus allow you to choose an inspection to use as a reference point for the
measurement. Click the Select Inspection button, then choose an inspection from the
inspection tree. Click the Select Inspection button again to set the choice. The Assigned
Inspection and Location Provider Type information is filled in -- you cannot manually change
these.

In this example, we chose Finish Location as Extraction 1 and Centerline as Extraction 2 from
the inspection tree. Those inspections become highlighted when Angle is selected in the
inspection tree and/or is being edited.

- Inspections
- @ Ribbon

... @FinishLocation 4 _——

# Measure Extract

(WX 151111 — iy

- Distance

Angle Selection
This parameter is available when the inspection selected for the extraction contains more
than one data point to reference. Examples include Finish Location or Centerline. Select the
data point to which you want to reference the angle.
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CORRELATION

The Correlation inspections identify which machine part was used during manufacturing of
each product. For example, body makers and spray guns are identified, allowing you to monitor
trends or trace potential manufacturing problems.

‘0

e Note: you must first place a Region of Interest (see "Regions of Interest (ROI)" on page
216) where you want the correlation inspection to take place. We also recommend a
Registration (see "Registrations” on page 249) and an Orientation (see "Orientations” on
page 288) (depending on the part type) prior to the inspection.

The available types of correlation inspections are:
e Body-Maker ID (on page 357)
e Color Dot (on page 370)

** Note: Your system (and this book) may show only those items that apply to your
application.

Body-Maker ID

This inspection identifies the markings from Body-Makers on cans, and correlates the can to
the machine part where it was made. This information helps to identify trends in defects from
a particular machine part, to help in troubleshooting and improved processes.

If a part fails this inspection, it would be because the ID mark cannot be read or is unknown.

You will need cans with Body-Maker ID marks on them running through the inspection system.
Make sure your camera and lighting setup provides the best image possible of the ID marks.
You will run several hundred cans through the system, identify them yourself, sort them into
the proper ID category, then program the inspection to do the same.

/7

** Note: Initial setup may take 30 minutes or longer, depending on the number of cans and
Body-Makers you identify.
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> Before adding a Body-Maker ID inspection:

1. Make sure that your system has a Body-Maker configured in the Machine Part
Correlation (on page 117) menu. Set the number of machine parts to the number of body
makers plus one. For example, if your body-makers are numbered 21-26, you have six
body makers: set the number of machine parts to seven. Always leave the offset at zero.

Machine Part Correlation (8-Channel Part Tracker) R

Number of Machine Parts: |2

Iv[nfeed

4] 2 D
L o D
Name [Spray Gun (MP2) [OutFeed
number (€3 BERE- ] 2 D
orrset (DI ) ] o )

(4) ShowCorrelation Values in Imag

(XX

2. Use aregion and registration to find the center of the part. For example, place a Ring
Region (on page 217) and Hough (on page 254) registration to determine the center of
the part. An example is shown below.
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3. Add another Ring Region (on page 217) to cover the area where the Body-Maker ID will
be found. An inner radius of one, and an outer radius of ~127 works well. The outer
radius will depend on the size of the Body-Maker ID marks on your parts.

Next, add a Body-Maker ID inspection.

» To add a Body-Maker ID inspection:

1. Make sure a Ring Region has been added to the inspection tree to surround the
body-maker ID mark you want to find.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add > Correlation > Body Maker ID. Re-name it to
something more meaningful to you. The inspection is added to the inspection tree. A
message stating "You need to run the 'Create Body Maker' operation for the best results"
is displayed. You will set that up in the following procedures. Click OK to continue.

The Body Maker ID menus are displayed and the region is shown on the image. (The menus are
described below) The steps to setting the inspection should be followed in the order shown
below.

1. Set the Machine Part

To correlate the can to the proper Body Maker, go to the BMID menu and set Selected
Machine Part to Body Maker. Note: your machine parts may be named differently, depending
on system setup. Other parts of this menu are explained in the following procedures.

BMID = Body-Maker Identification.

Selected Machine Part Body Maker

Categorization Method Orientation Only

Extract Bounding Region | Enabled

Selected Body Maker 22

View Body Maker Bod

Load Sorted Images

Sort Images Centered ¥ Enabled

Collect Images

Mirror Sort Images V' Enabled

Sort Images

Learn lterations 20

Create Body Maker [Create Body Maker
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2. Acquire images to learn the ID marks

You will acquire images, sort them, then program the inspection to identify the proper ID
marks.

» To acquire the sample images:

1.

7.

From the BMID menu, click the Collect Images button. The Image Auto-Save menu is
displayed. Set the parameters as follows, or as recommended by a Pressco Service
Engineer. Most of the parameters are set by default to properly to acquire body maker
images. For additional information about this menu, see Saving Images Automatically
(on page 175).

Image Auto-Save

Selocted Sensor BMID 7| _ _
S 00600
" = (4 ]5]6]-

Quantity |1 (1.. 1000 Parts)
g Skip N Parts Between Saves |0 .

g By Inspection — Any Inspection — ¥
Part Status  Passing or Failing ¥ I
Registration Centered v I Status

Q Use Correlation
[1
-
- [1 I

3
Start Auto-Save

@

For Selected Sensor, select the proper sensor from which you will collect body maker
images.

For File Name, type the root name of the images that will be saved. BMID is the default
name, so that when images are saved, they are named "BMID_0001.bmp" etc. If you
have previously saved images with the same name, those images will be overwritten, so
you may need to change the name to avoid overwriting the images.

Set Quantity to the desired number of images to capture. The more images you capture,
the better the identification. You will need ideally 100 images per ID mark. The default
quantity of images to capture is 500. Note: setting this number does not guarantee an
equal number of images per Body-Maker, but it provides a good sample population.
Leave the other settings at their default values.

Put the lane online, and click the Start Auto-Save button to acquire the images. The
status is displayed, and the auto-save process will stop when completed. The images are
saved to C:\Pressco\Lane_n\sensor_name\part_program\BMID_xxxx.bmp.

Click the OK button to return to the BMID menu.

Next, you will visually sort the images by body maker ID marks.
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3. Sort the images

This is a critical step in which you tell the Intellispec system which image came from which
body maker. The system uses the images to create an average template image for each body
maker.

> To sort the images:
1. Click the Sort Images button in the BMID menu. The image sorter is displayed.

r B

Sort Body Maker Images
soimages 1]
fpge Labe

@ Display Mirror Image

3 @ @ I
BMID_0001.bmp (1 of 500 for ID *?')
0 0 0 0 0 0

2. If your system is set up so that the images appear backwards in the image, then check the
Display Mirror Image box.
3. Look at the current image on the screen.

@

= |f you have a numbered bin below the image that matches the body maker number,
then click that button. In our example, the image shows "23." We would click the 23
button below the image.

= If you do not already have the numbered bins below the image, then click the Create
New ID button. Type the new ID number or name on the keyboard provided. A button
with the new ID is displayed below the image.

= [fanimage is difficult to read, poorly marked, or defective, then click the Delete Image
button to remove it from the sample set. If you cannot read the ID number, then the
system cannot either.

4. Sort all the remaining images into the proper ID bins as in step 3. As you sort images, the
system places the image files into separate folders on the Intellispec hard drive. The
images are removed from the default unsorted list. The image folders are located under
C:\Pressco\Lane_n\sensor_name\part_program\folder. These images can be used in other
jobs or testing.

= The number of remaining images to sort is displayed below the image (example: "1 of
259" changes to "1 of 258" when you sort an image).
= The number of images in each bin is displayed below each ID button (this number
changes each time you place an image in the bin).
=  You will be able to review images later to make sure the proper images are in the
proper bins
When all images have been sorted, the image screen will be blank. After you have sorted all

the images, review each bin to verify proper images and assign seed images. These are
described next.
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> To review images:
1. Select Review Images from the drop-down menu in the upper right of the menu. More
buttons are enabled, and the images for the first bin are displayed on the screen.

Sort Body Maker Images

P
Create New ID Review Images "
[ Change Label ;

-
Disable ID

o Rem L

rUnASorl Image
=
Assign as Seed
=
Delete All

@ Display Mirror Image

BMID_0011.bmp (1 0of 83 for 1D "217)
n
77 7 80 0

63 86 96 8

(.

2. To review the images for each ID, click one of the buttons at the bottom of the menu, and
scroll through all the images. If you find any un-readable images, or images that were
assigned incorrectly, use the Un-Sort Image or Delete All buttons. Use the remaining
functions as described below:

Create New ID
Create a new body maker ID label. A button is created and placed below the image.

Change Label
Select an ID button below the image, then click the Change Label button. A keyboard is
presented to allow you to change the ID of the button.

Disable ID/ Enable ID
Select an ID button below the image, then click the Disable ID button. That ID button is
disabled. An 'X' is displayed below the button. You will not be able to save any images to
that ID. To re-enable the button, click the Enable ID button (the button toggles between
Disable and Enable).

Remove ID
Select an ID button below the image, then click the Remove ID button. That ID button is
removed from the screen. You will not be able to save nor review any images assigned to
that ID. You will not be able to remove the ID if you have any images assigned to it. You can
use the Delete All button to remove all images assigned to the ID.

Un-Sort Image
As you review images, you can use the Un-Sort Image button to remove an image assigned
to an ID. This is helpful if the image was improperly assigned, or if the image is difficult to

read. You can re-assign unsorted images, using the Sort Images drop-down menu at the top
right of the screen.

Assign as Seed
The system uses the "Seed" image as the first image when creating an average image for
the ID. For best results, choose the best possible image for the ID, and click the Assign as
Seed button. Click the other ID buttons at the bottom of the screen and assign the best
image from each ID as a seed image.
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Delete All

To remove all images from an ID bin, select that ID button and click the Delete All button.

All those images are removed from the system.

After you have reviewed the images and assigned seed images, review the seed images.

» Toreview seed images:

1. Select Review Seeds from the drop-down menu in the upper right of the menu. Some
different buttons are displayed. The buttons on the right of the screen are described

above.

Sort Body Maker Images

—
Create New ID
-
Change Label
=
Enable ID
=

@ Display Mirror Image

(cla
Dooooo
62 76 86 93 87 80

L

Review Seeds Y

&

2. Select an ID button at the bottom of the screen to display the seed image.

= If the image looks good, then no further action is necessary.

= [f desired, you can use the buttons directly below the image to rotate it so that it looks
upright and straight. The outer buttons rotate the image 30 degrees at a time, and the
inner buttons rotate the image one degree at a time. This does not affect inspection; it

is available for you to read the image easier.

3. If you want to change the seed image, select the Review Images drop-down menu and

scroll through the available images, then assign a different seed image.

<> 0 Important: You should have 100-200 images per ID. A minimum of 100 images has

been proven to work well.

e If you do not have the minimum images for an ID, you can disable that ID by selecting it,
then clicking the Disable ID button in the sort menu. OR:

e You can acquire more images by the procedures described above, and sorting enough

images into the ID bin to have at least 100 images.

e If you have previously learned sets of images and disabled ID numbers or acquired more
images, you will need to relearn the IDs, as described below.

Next, set the parameters before learning the image. Click the OK button to save changes and

exit the sort images menu.

4. Set the Parameters

You may set other parameters before using the learn process, but as a minimum, set the

following.
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» To set the parameters:

1. Inthe Settings menu, click the Standard Settings button. This allows the system to set the
best values for the angular and radial samples parameters based on your configured
region.

Standard Settings

Standard Settings

Downsize Level Disabled

Grain Reduction Technique Moving Average

Grain Reduction Level 15

Contrast Compression Technique Moving Average

Contrast Compression Level 20

View Filtered Region
Polar Inner Radius 8

Polar Outer Radius 100.0

2. Make sure Grain Reduction Technique and Contrast Compression Level are both set to
Moving Average. These filters are critical to the learn process.

3. Inthe BMID menu, set the number of Learn Iterations. The default setting is 20, which
usually works well. A higher setting may improve the results slightly, but takes more time.

Next, have the system learn the images.

5. Learn the images

The system learns the images by analyzing each image in each bin, determines the
distinguishing characteristics, and creates an average (combined) image from all the samples in
each bin.

» To learn the images:

1. Make sure you have acquired images as described above in sections 2 and 3.
2. Inthe BMID menu, click the Create Body Maker button. The system displays a progress
bar as it learns the images.

Leam Body Makers 9of 29

HRNEENR |

7
0.0

Note: this process may take several minutes, depending on the number of images and
the number of Learn iterations.

3. When the learn process is complete, the progress bar is removed from the screen. The
inspection should be ready to use.

4. View the template image for each body maker by making a selection for Selected Body
Maker, and clicking the View Body Maker button.

= [fthe image looks good for each body maker, no further adjustments are necessary.

= [fthe image is not clear and sharp, you may need to collect more images or adjust
parameters, and re-learn.
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5. Test the inspection by scrolling through the images in the Retro-Spec interface and
comparing the image to the results. The image should match the ID. Remember that your
images may be reversed in the image area because of hardware setup. The example
below shows the correct ID for the selected image.

Last 100 Parts RETRO-SPEC Population View: Body Maker ID [Selected Body Maker] .

(=)

Body Maker

v

Fin

Selected Machine Part
Categorization Method
Extract Bounding Region
Selected Body Maker

Body Maker ID PASSED

Body Maker: 25

Previous Center = (355, 230)

(Center = (355, 230)

Orientation Angle = 24 617
Storage Size = 256x256

Downsize Level = Disabled

Separation Ratio: 38.02 (10)

wrunages Centered ¥ Enabled Registration Strength: 100 {0)
Colect Images Orientation Strength: 0 (0)
Mimor Sort Images [ Enabled

Create Body Maker [Create Body Maker

[Sort Images] Sort the collected body maker images into the
appropriate body maker directories. This is used to leamn the body
makers.

r (d f ;\
=] 9000
You may find that the inspection matches the images to the correct ID, but perhaps not all the

time. You may need to adjust some parameters for best results. The section below explains the
main parameters to adjust.

R/

«» Note: After the system learns the images, it saves the average image (template) in a
"results" folder for each body maker at
C:\Pressco\Lane_n\sensor_name\part_program\folder\results.

6. Adjust the parameters

‘0

e Note: If additional adjustments are necessary, such as changing grain settings or contrast
compression level, you must perform another learn process. A new average image will be
created using the new parameters.

» To adjust the parameters:
1. Adjust the following parameters for best results:

=  Grain Reduction Technique - [Settings menu] the inspection works best with this filter
disabled.

= Registration Normalization - [Body Maker ID menu] the inspection works best with
Phase Only, but you may try another setting for your body maker images.

= Orientation Normalization - [Body Maker ID menu] the inspection works best with
Component Magnitude, but you may try another setting for your body maker images.
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= Categorization Method - [BMID menu] the inspection works best with Orientation
Only, but you may try another setting for your body maker images. If you are only
checking the orientation, then the Registration Normalization is not being used.

2. If you have made any changes, click the Create Body Maker button. A progress bar is
displayed to show progress.

When the learn process is complete, the progress bar is removed from the screen. The
inspection should be ready to use.
Body-Maker ID menus

This topic contains the parameter explanations for the Body-Maker ID inspection, for your
reference. To set up the inspection, refer to Body-Maker ID (on page 357).

Body Maker ID menu

Body Maker 1

Radial Samples 128
Angular Samples 256
Advanced Orientation | Enabled
Orientation Strength 0.0
Orientation Normalization Global Power
Orientation Normalization Gain 0.0

B @Limits
Separation Ratio 10.0

B Registration Strength
Registration Strength 0.0
Registration Normalization Component Magnitude
Registration Normalization Gain 0.0

[ Check Scale

Radial Samples
This number divides the region into a number of rings. See example under Angular Samples
below.

It is best to use the Standard Settings button in the Settings menu to set Radial Samples
and Angular Samples.

Angular Samples
This number divides the region into a number of arcs. See example below.

Example: This example shows a region with three (3) radial samples and eight (8) angular
samples. (Note: these values are not available in the inspection. These examples and
shading are for illustration purposes only.)

.
|||l |"I{ i ‘ A \"|_'|
IlI I'-__‘ . N n ’_.'I II||

"l“'-,./\\"--.__ _____.,.-X__..r
G

Advanced Orientation
Not used.
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Orientation Strength
Set the minimum strength, or quality, you require for orientation between the inspected
image and the template image. If the current part falls below this value, the part fails. This
parameter is ignored if Registration Only is selected for Categorization Method in the BMID
menu.

Orientation Normalization
Normalization uses template data as a reference and compares it to current part data.
Normally this does not need to be changed from Component Magnitude. If you are getting
inconsistent results, try another technique. Use the technique that works best for your
parts. We recommend trying the techniques in this order:

= Component Power- try this as a second option.

=  Component Magnitude - default, used in most applications.

=  Global Power - try only if Component Magnitude or Component Power do not work for
your part.

=  Phase Only - not used.

Orientation Normalization Gain
Leave this set at zero.

Limits
Separation Ratio
This is a measure of how good the body maker ID is, compared to the next strongest body

maker template. The higher the number the better. A value of 2 would mean twice as
strong (such as strength 20 versus 40).

Registration Strength
Set the minimum strength, or quality, you require for registration between the inspected
image and the template image. This sets the pass/ fail limits. You can set this using the
horizontal bar on the Retro-Spec graph (after you select this parameter in the menu). This
parameter is ignored if Orientation Only is selected for Categorization Method in the BMID
menu.

Registration Normalization
Normalization uses template data as a reference and compares it to current part data.
Normally this does not need to be changed from Component Magnitude. If you are getting
inconsistent results, try another technique. Use the technique that works best for your
parts. We recommend trying the techniques in this order:
= Component Magnitude - default, used in most applications.
= Component Power - try this as a second option.
= Global Power - try only if Component Magnitude or Component Power do not work for

your part.

= Phase Only - not used.

Registration Normalization Gain
Leave this set at zero.

Check Scale
We recommend that you leave this box un-checked. Scale refers to a magnification factor in
the event of a change in optics or part movement. It can be used as a reject limit for part
size.
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Settings menu

Standard Settings [Standard Settings
Downsize Level Disabled

Grain Reduction Technique Moving Average

Grain Reduction Level 15

Contrast Compression Technique Moving Average

Contrast Compression Level 20

View Filtered Region
Polar Inner Radius 8

Polar Outer Radius 100.0

Standard Settings
Click the Standard Settings button to automatically set Radial Samples and Angular
Samples based on the current region settings.

Downsize Level
Using this option depends on the image. For example, if your part image has grain, then use
a Downsize Level of 4 to 1 - this will blur the image enough to almost ignore the grain.

Enabling this option looks at the region differently by grouping pixels. The system will look
at pixels in groups of 4 (Level 1), 16 (Level 2), or 64 (Level 3). Larger values reduce the image
further, speeding up the inspection at the cost of resolution. For cans, this is normally
disabled. If you want to improve inspection time, try a setting of 4, but the inspection will
probably not work well with a setting of 16 or 64.

Grain Reduction Technique
This is an optional filter. Enable this feature only if your part has grain and is causing
inspection problems. This filter will help block grain from the image. Use the technique that
works best on your part. For cans, the default is enabled, and the Grain Reduction Level is
set at 15.

Grain Reduction Level
The size of the grain reduction filter. A larger value results in more reduction of the grain.

Contrast Compression Technique
This is an optional filter. Enable this feature only if your part has low-frequency changes
such as shadows that are causing inspection problems. Use the technique that works best
on your part. For this inspection, the default is enabled, set at Moving Average, and the
Contrast Compression Level is set at 20.

Contrast Compression Level
The size of the compression filter. A larger value results in more contrast compression.

View Filtered Region
[Only applicable if the Grain Reduction or Contrast Compression techniques are being used]
This displays the image area using the filters.

Polar Inner and Outer Radius
This is only used when both Orientation and Registration are selected for Categorization
Method in the BMID menu. The defaults are 8 for inner radius, and 100 for outer radius,
and probably do not need to be adjusted. These values are used when computing the polar
extraction data.
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BMID menu

Selected Machine Part Body Maker
Categorization Method Orientation Only

Extract Bounding Region | Enabled

Selected Body Maker 22

View Body Maker Bod

Load Sorted Images
Sort Images Centered [v Enabled

Collect Images
Mirror Sort Images [v Enabled

Sort Images
Leamn lterations 20

Create Body Maker [Create Body Maker

Selected Machine Part
Select the machine part to which you want to correlate the body maker ID. The items in the
drop-down menu must be configured during system setup. See Machine Part Correlation
(on page 117).

Categorization Method
This allows the system to determine the body maker by using registration strength,
orientation strength, or both. This inspection works best with Orientation Only.

Extract Bounding Region
This is not used. Leave it un-checked. If this is enabled, the system reads a rectangle of data
instead of just a circle of data.

Selected Body Maker
Select which body maker you want to see in the body maker found graph, and also for
viewing the body maker template.

View Body Maker
First, select a body maker from the parameter above, then click the View Body Maker
button to see the template image. If the image is not a good, sharp image, then you may
need to re-learn the template and/or collect and sort more images.

Load Sorted Images
Load all the images you have sorted for the Selected Body Maker. The image bars are
represented on the right side of the Retro-Spec graph. This feature allows you to see how
well the inspection is working.

Sort Images Centered
This should be left at the default value of enabled. It allows the sorted images to be
centered by the registration.

Collect Images
This opens the Image Auto-Save menu to allow you to collect images. For instructions on
using this feature, see "2. Acquire images to learn the ID marks" in the Body-Maker ID (on
page 357) section.

Mirror Sort Images
This causes the images in the Sort Manager to be reversed on screen. This helps if your
images are normally reversed because of hardware setup.
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Sort Images

This brings up the image sort manager. For instructions on using this feature, see "3. Sort
the images" in the Body-Maker ID (on page 357) section.

Learn Iterations
The learn process will run through the data this number of times. NOTE: this takes a long
time if you have hundreds of images. A value of 3 is a minimal setting, but we recommend a
setting of 20 for best results.

Create Body Maker
This creates the templates for all body makers using the sorted images. For instructions on
using this feature, see "5. Learn the images" in the Body-Maker ID (on page 357) section.

Color Dot

This inspection correlates cans to the spray gun that the can passed by during manufacturing.
The inspection could pass or fail parts based on the size and number of color dots sprayed on
the can.

Color Dot Correlation uses a color image of the bottom of a can to detect the color of the spray
dot that is made from the different spray guns. A color enhancement is used to classify that
color as a certain grayscale range, and then the Color Dot inspection finds only the pixels that
fall into that range. Currently, this inspection is only used for detecting spray dots on beverage
cans.

¢ Note: setup is similar to Feature Registration and Feature Detect Analysis.

«»*» Note: We recommend that one Color Dot inspection be set up for each different color dot.
Also add a separate Color Distance Enhancement prior to each Color Dot inspection.

AN

» Before setting up Color Dot Correlation:

1. Set up an appropriate registration (usually a Hough (on page 254) or Radial Edge (on
page 257)) to find the center of the bottom of the can.
2. Add a Ring Region (on page 217) to include the area where the dot will be found. Size the
Ring Region so that it covers the whole circle formed by the bottom of the can.
3. Add a Color Distance (on page 238) Enhancement to specify the range of colors
acceptable for the color dot. This will allow the inspection to ignore all other color dots.
= |n the Color Distance menu, click the Color Picker button, then click on the color dot in
the image area. Make sure you click the center of the dot, and not the edges. Click the
Color Picker button again to complete the selection.
= This assigns the selected color to the enhancement. The enhancement will make all
pixels of the selected color black, and all others a lighter gray shade value.
= Re-name the Color Distance enhancement to note the color of the dot.
= Add another Color Distance enhancement for each color dot in your process. You may

need to turn off the graphics to see the color dots (right-click over the image, and
un-check Show Graphics from the menu).
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= An example of a menu with several Color Distance enhancements is shown below.

Enhancemaws‘

alv Color Distance - orange
Distance Technique RGB
Proximity Distance from Color
Color Picker
Color B 138, 100, 49

B|v Color Distance - teal -
Distance Technique RGB
Proximity Distance from Color
Color Picker
Color W ss.02.73

B|v Color Distance - red
Distance Technique RGB
Proximity Distance from Color
Color Picker
Color B 121,60, 49

Next, set up Color Dot Correlation.

> To add a Color Dot Correlation:

1. Highlight the Color Distance Enhancement name in the inspection tree.

2. Right-click on the item you just added.

3. From the Inspection menu, select Add* > Correlation > Color Dot. *If you have already
added several Color Distance Enhancements, then use Insert > Correlation > Color Dot
after each Color Distance enhancement. You may need to drag and drop the Color Dot
inspection to the correct place in the inspection menu.

4. The inspection is added to the inspection tree. Re-name the inspection to something
more meaningful to you. The inspection tree should look something like the one shown
below.

CInspections
-1 ® Ring [3]
- @ Hough [2]
-l @ Ring [4]

% Color Distance - Orange
* Orange
% Color Distance - Red
* Red
% Color Distance - Blue
* Blue
% Color Distance - Green

* Green
5. Adjust the Color Dot parameters as necessary.

» To set up the Color Dot Correlation:

1. Open the Retro-Spec interface for the Color Dot inspection by double-clicking the name in
the inspection menu.
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2. Use the Selected Machine Part drop-down menu to select a machine part to correlate the
color dot. This is usually named spray gun, spray dot, or color dot.

3. For Color Dot Value, select the value for the color dot you are currently finding. For
example, if you are searching for an orange color dot from Spray Gun #1, then select "1."

4. For Color Dot Grayscale, select the range of gray shades you are searching for. If you have
used a Color Distance enhancement, this range will be very low (example: 0 - 20). You will
know you have selected the correct range when you see peaks on the Retro-Spec graph
only for those images that have the color dot you are looking for. In the example below,
when we click each of the green peaks on the graph, the corresponding image has an
orange dot. There are no peaks for the wrong-colored dots.

Last 100 Parte RETRO-SPEC Population View: Color Dot [Color Dot Area] Labodd Dotvcte
260 (H
’ \ -
g ‘
< 400
z
>3

-159

b By BHE D
(i

x K2 ® ° ® L4 L3 ® ° ® & & &

G
‘o

° ® & & & &

Rir

Selected Machine Part Body Maker |Color Dot PASSED

|Color Dot Area: 322 (71 ... 800)
Color Dot Value 1 {
'Color Dot Count: 1 (1 1)
{Color Dot Found

Color Dot Grayscale

Color Dot Valid Area 50 .. 800

Color Dot Area 71..800
Color Dot Count 1.1
Show Features [ Enabled

[Color Dot Grayscale] This Is the threshold for what is considered
a color dot in terms of grayscale values. Typically the color dot will
be converted to white for easy detection.

@ a N\
0O BEm (oM@l Ix)
5. If the system is not consistently finding the correct color dots, you may need to adjust

Color Dot Area and Color Dot Count. These are described below.
6. Repeat steps 1-5 above for each of the other color dots in your process.

Color Dot menu

2d Machine Part Spray Gun

Color Dot Value 1
Color Dot Grayscale 0..20
Color Dot Valid Area 50 .. 800

Color Dot Area 71..800
Color Dot Count 1..1
Show Features |_ Enabled
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Selected Machine Part
Select the machine part to which you want to correlate the color dots. The items in the
drop-down menu must be configured during system setup. See Machine Part Correlation
(on page 117).

Color Dot Value
Assign a number to correlate the color dot to the machine part. Example: orange dot comes
from Spray Gun number 1.

Color Dot Grayscale
Define the grayscale range that could be considered the color dot. All other grayscale values
are ignored. [Using a Color Distance Enhancement prior to the Color Dot inspection
converts the color pixels to grayscale]

Color Dot Valid Area
When the system counts the number of color dots, if a found dot is larger or smaller than
these values, it is ignored.

Color Dot Area
When the system finds color dots, this parameter puts an upper and lower limit on the size
of the dot.

Color Dot Count
Set the number of acceptable dots. This is normally set at one.

If you have two small dots and you want to pick out one dot of a specific color, then set
Color Dot Area to accommodate the small dot size, and set Color Dot Count to [1...2] as a
range. This allows the system to choose pixels that have more than one dot's worth of data.

Show Features
Highlight the found features on the image.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Inspections 373
© 2013 Pressco Technology Inc. Proprietary






Chapter 14
SYSTEM HARDWARE INFORMATION

This section shows wiring diagrams and pinouts, and lists signals of various Intellispec system
components.

7

** Note: some sections are only included in books pertaining to specific applications. This book
may not contain all of the sections below.

Related sections include:

e Cluster Box

e Inspection Module Adjustments (see "Inspection Modules" on page 389)
e Extended I/O (on page 425)

e Maintenance Frequency - BNS

e Maintenance Frequency (on page 437) - Integrated Tunnels

POWER UP

Intellispec Series V systems have multiple power switches. Make sure the power switches are
turned on for the user interface, each camera module, and cluster box (if applicable). See the
illustrations below for power switch locations.

The power connections for the user interface are found on the right side of the cabinet.

— ==
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1 PC (computer) power connector

2 Monitor power connector

3 User interface power switch

Each integrated camera module (for example the CPV series of inspection tunnels) has its own
power on/off switch.

ol |1
i
) ®
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Teleleole
Je80e0s
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O

In system configurations that have a cluster box:

e if the cluster box has a UPS, open the cluster box door and switch on the UPS, then
e turn the external on/off switch to power all camera modules connected to the cluster box.

el elleal] @
CICICICH
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e &[] @[]

® o § Vo \_/
® 000 O

POWER DOWN

To completely power down all components of the Intellispec, make sure the following power
switches are turned off:

e User interface

e Integrated inspection modules (if applicable)

e Cluster box (if applicable)

e UPSinside the Cluster box (if applicable). Open the Cluster box door to switch off the UPS.

The user interface, inspection modules, and cluster box are all independent of each other.
Therefore, if you need to service any of the above modules, any one can be turned off by itself.

0 Important
If you re-start the computer, turn off the User Interface power and leave it off for about 40
seconds before turning it back on. This allows the electronic components to correctly reset.
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To see the locations of the power switches, refer to Powering on the system (see "Power Up"
on page 375).

SERVICING THE USER INTERFACE

&e—23 Warning
Potential hazardous voltage from the UPS. Use caution when servicing.

WIRING DIAGRAMS

Pressco PC outlet wiring

A Warning
The Pressco PC outlet is only to be used to provide power to the Intellispec PC. Any other use is
prohibited.

The power connections for the user interface are found on the right side of the cabinet.

e T —

LI,

3

— —
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1 PC (computer) power connector

2 Monitor power connector

3 User interface power switch

Wiring details:
4

e 3 g | HHH%

M_
Il
o
LN

GND

SECTION "A-A"

Output: 230VAC, 500W

Outlet mating connector: Harting: insert 09200042611, hood 09200031440
Use wire type UL1015 or equivalent, 16awg (1.44mm2) min.

Wiring chart

Pin number, 5-pin Wire color Pin number, 3-pin Description
connector
1 black L L1
2 white N L2
GND green GND PE
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User Interface external connections

*»* Note: the connectors not called out in the diagram have no connection

\ J
10 11 12 13 14 15 16 17
For more information, refer to Wiring diagram user interface/ PC (on page 381).
1 Monitor connector panel
2 Convenience USB port
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PC [inside the cabinet]

Monitor connector panel connectors

Auxiliary USB connector

DVl input

AC power connector

N|[fo|lu ]| b~

Touch screen USB connector

PC connectors

8

2 pin power connector for camera ethernet switch

9

2 pin power connector for PDN ethernet switch

10

Convenience USB port connector

11

Monitor auxiliary USB connector

12

Monitor touch screen USB connector

13

Trackball USB connector

14

Biometric device USB connector

15

DVI connector

16

Ethernet connector for camera ethernet switch (blue cable)

17

Ethernet connector for PDN ethernet switch (green cable)

18

Optional plant network connection

19

Optional remote user interface connection
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Wiring diagram user interface/ PC

The following diagram shows the wire connections between the monitor, user interface, and

PC.
A\
! |
! |
! |
! |
4 N | |
e e |
= |
4 N | = |
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1 Monitor auxiliary USB cable
2 Convenience USB port cable
3 DVI cable (included with monitor). (Remove DVI-VGA adapter if present)
4 AC power in for monitor
5 Touchscreen USB cable (for optional touchscreen monitor)
System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) System Hardware Information 381

© 2013 Pressco Technology Inc. Proprietary



6 Optional Biometric device -USB cable

0 Do not plug in until application software is installed

7 Trackball USB cable

0 Do not plug in the PS/2 connector

8 View of monitor connector panel

9 PC. Connectors are inside cabinet.

10 Side cable entry locations

11 Cable entry. Route cables behind the PC mounting panel, through the cable

entry at the back of the PC.

Wiring diagram ethernet switches

6-YEL/12VDC
5-BLK/COM

@
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“Al) W:
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[\ |
(@) i O=s oo
12 Ethernet switch for cameras [on left]
13 Ethernet switch for Pressco Device Network (PDN) [on right]
14 Blue ethernet cable
15 Green ethernet cable
16 Quad ethernet card
17 Two pin power connectors. Cables are included with PC.
18 Two pin power cable
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19 Two pin power cable

20 PC

21 Detail "A" Ethernet switch power connection

*» Note: the Cat-6 ethernet cabling is divided into two groups. The green cabling goes to/from
the cameras and lighting circuitry. The blue cabling goes to/from the part tracking circuitry.

Wiring diagram trackball
TRACKBALL SWITCH CONNECTIONS

| — TRACKBALL

o |
TRACKBALL |

|
|
|
\ SWITCHES ( i)
/
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REBOOTING THE INTELLISPEC SYSTEM

You may need to reboot the entire system if power or communication has been lost between
the Vision Processor and the Cluster Box.

Symptoms may include that the inspection module light has stopped flashing, and the system is
no longer taking pictures. Rebooting the system will reconnect the Vision Processor with the

Part Tracker in the cluster box.
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«*» Note: if the power to both the Vision Processor UPS and the Cluster box is interrupted for
more than two minutes, the software will automatically shut itself down and then shut
down the Vision Processor PC. The software will restart. You will just need to log in and put
the system back online.

It may not be necessary to completely reboot the system each time the power to cluster box is
interrupted. Try restarting the application.

Restarting the Application

You must have proper user permissions to exit the software. This prevents unauthorized
system shutdowns. Contact your system administrator if you need user permissions.

» To exit Intellispec software:

Login.

Click the Home button n

Click the Tools button to display the Tools menu.
Click the Exit System option.
A drop-down menu allows you to choose an option:

ukhw N PR

= Shut down the Intellispec software only
=  Shut down the Intellispec software and computer
= Shut down the Intellispec software and restart the computer

SHUT-DOWN SYSTEM

Intellispec Only v
Intellispec Only J

Shut Down Intellispec and Computer
\Shut Down Intellispec and Restart Computer

20

L
6. Choose the desired option from the menu and click the OK @ button. The Intellispec
software and/or computer shuts down (and restarts if applicable).
7. Connect the Mechanical keyboard (MKB) (on page 38).
8. Press Ctrl + Alt + Delete on the mechanical keyboard.
9. Use the Log Off option to log off of Intellispec.

10. At the Windows Login Prompt, enter “pvpass” as the password for the Intellispec user
account. Once login is complete the Series V application software will be launched.

Rebooting the entire system

If restarting the application does not clear the errors, try rebooting the entire system. This
involves shutting down the software, the processor cabinet, and the cluster box (if applicable).

¢ Note: The system reboot takes several minutes to complete.

Processor Cabinet Shutdown

You must have proper user permissions to exit the software. This prevents unauthorized
system shutdowns. Contact your system administrator if you need user permissions.
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> To exit Intellispec software:
Login.
Click the Home button a

Click the Tools button to display the Tools menu.
Click the Exit System option.
A drop-down menu allows you to choose an option:

vk w N e

=  Shut down the Intellispec software only
= Shut down the Intellispec software and computer
=  Shut down the Intellispec software and restart the computer

SHUT-DOWN SYSTEM

Intellispec Only v
Intellispec Only J

Shut Down Intellispec and Computer
\Shut Down Intellispec and Restart Computer

00O

6. Choose the desired option from the menu and click the OK & button. The Intellispec
software and/or computer shuts down (and restarts if applicable).

» To shut down the Processor Cabinet:

Connect the Mechanical keyboard (MKB) (on page 38).

Press Ctrl + Alt + Delete on the mechanical keyboard.

Use the Shutdown option to shut down the PC.

Once the PC has shut down, turn off the Processor Cabinet ON/OFF switch. For location,
see Power Up (on page 375).

PwwnNeE

¢ Note: The Processor Cabinet ON/OFF switch must be off for approximately 40 seconds
before turning it back on for proper restart.

Cluster Box Shutdown
1. Shut off the cluster box external rotary power switch. For location of the power switch,
see the illustration of the cluster box in the Power Up (on page 375) section.
2. If you have a UPS inside the cluster box, open the cluster box and shut off the UPS.
Shutting off the UPS will conserve battery power.
3. Wait at least one minute for all Pressco Devices to fully power down.

Cluster Box Power Up
1. If you have a UPS inside the cluster box, open the cluster box to turn ON the UPS.
2. Turn ON the cluster box external rotary power switch.
3. Verify the 12VDC, 24VDC, and 48VDC power status indicators of the cluster box turn ON.
4. Wait at least one minute for all Pressco Devices to fully power up.

Processor Cabinet Power Up

1. Turn ON the Processor Cabinet ON/OFF switch. The system will launch the Intellispec
software.
2. Loginto the system and begin using the system.
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Notes

e If power to the cluster box is interrupted on a cluster box that does not come equipped
with a UPS, the following prompt will be displayed.

"Part Tracker Exception: the Part Tracker has closed its communication port on Lane n.
Reset the Part Tracker and restart the application."

e This message is an indication that the Part Tracker and the Application software
communication link has been broken for an extended period of time.

LIGHT TREE

The optional light tree may be mounted on or near an inspection module, or near a cluster box
(if applicable). The optional horn, mounted with the light tree provides an audible warning.

For more information, refer to Light tree status (on page 386).
Light Tree (optional)
Red (Alarm)
Amber (Warning)
Green (Online)

Blue (Power)

i

Light tree status

The lights on the optional light tree will turn on, off, or blink depending on status of certain
hardware. Each lane has its own light tree. The table below lists the different states for each
light.

Light color Condition What it means

Red On - steady Alarm condition

Red On - blinking Part tracker board lost communication with the host
PC or has an error and needs to initiate an alarm

Red Off No alarm (OK)

Amber On Warning alarm condition

Amber Off No warning (OK)

Green On Lane is online

Green off Lane is offline

Blue On Part tracker board has power (OK)
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Light color

Condition

What it means

Blue

Off

Part tracker board has no power
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Chapter 15
INSPECTION MODULES

This section covers camera adjustments that may be required to keep the inspection modules
working properly. Adjustments include the camera position, aperture, and camera focus.

The focus adjustment controls the clarity of the image; the aperture adjustment controls the
amount of light admitted by the shutter. Normally the inspection modules do not require
further adjustment after initial system setup. Circumstances that might require additional
adjustments are camera replacement, strobe replacement, or a substantial change in part size
or color.

Danger
The inspection modules are mounted near moving machinery. Use extreme caution to avoid
contact with moving machinery when servicing inspection modules as serious personal injury
could result. Ensure machinery is in an emergency stop state before servicing inspection
modules.

OBSERVE PART IMAGE

When adjusting the focus, aperture, or height for any inspection module, it is helpful to use
Offline Imaging (on page 158) so that you can immediately see the effect of an adjustment on
the image quality. Use the Run feature in Immediate Mode.

-

Offline Imaging

Triggered Made

Sangla |

Immadiate Modae

Image Updana Iniarsal

17

20
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> To use Run in Immediate Mode:

1.

vk wnN

Make sure the lane is offline.

Penny .
Click the desired Sensor button j";“: to view Sensor Overview mode.
Right-click the Sensor button to see the Sensor menu.
Select Offline Imaging from the menu.
Click the Run button under Immediate Mode. The camera will snap pictures continuously
without the need for a part present signal.

While the system is in this mode, you will be able to make adjustments to focus, aperture, or
camera height.

EXTENDED I/0O IN INSPECTION MODULES

The Extended I/0 (see "Extended I/0 board" on page 425) kit (optional) is installed within
Chromapulse inspection modules as shown below.

1 power cap
2 Extended 1/0O kit
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CP/E SERIES MODULES

The CP/E series of inspection modules is a group of modules with similar components. The
module's appearance and adjustments are similar between models. The difference between

model numbers lies in the specific lighting and optics for inspection of different types of parts.
To see your model number, look at the label on the outside of the module.

An Extended 1/0 (on page 425) kit is available for the CP/ E series inspection modules.
This section covers CP/E models including:
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e CP500E

e CP750E
e CP1200E
e CP1500E

The basic components of the CP/EV module are shown below.

1 Power assembly

2 Second driver and light control module (models CP1200E and CP1500E only)

Part Tracker assembly

Driver and light control module

Fill light module with beam splitter

Ethernet switch (mounted on inside wall - not shown)

Camera

0 I Nl | b~ w

8-port I/0 box: CP/ EV inspection module 1/0 connectors (see "Chromapulse
module external connections" on page 400)
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Adjusting the CP/ E Series modules
Module Height Adjustment

The height of the module is easily adjusted. Refer to the illustration below. Loosen the
adjustment knob [item 4] and use the handle [item 3] to move the module up or down. You
can move the module with one hand while viewing the image on the monitor. Tighten the knob
when desired height is achieved.

_ ¥ Caution
Loosen only one knob [2 or 4] at a time. Otherwise, the weight of the module may not be
supported.

Adjust for different part size
e Move the module up or down to increase or decrease the size of the part image —
Observe Part Image - SV (see "Observe Part Image" on page 389) while adjusting module.

e Use camera position adjustment to adjust for small change in part size - Camera Position
Adjustment (on page 395)

e The adjustable stops [items 1 and 5] can be used to mark where the module is supposed to
rest. For example, the bottom stop [item 5] can be placed at the module’s lowest
inspection height. You can easily raise the module to clean or clear jams, then lower the
module back down to the stop.

e The top stop [item 1] can be used to mark the module’s highest inspection height — for
your largest inspected part.

» To adjust module height (or to raise the module for cleaning or clearing jams):
1. Loosen the adjustment knob [item 4].

¢ Note: if you need a greater range of movement [example: you are changing from
inspecting a shorter part to a much taller part], then loosen knob 2 first. Move the
module using the handle, then tighten knob 2. Then use knob 4 for smaller adjustments.

2. Use handle [item 3] to move the module up or down.
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3. Tighten the knob [item 4].

3]

1 Adjustable stop - highest inspection position

2 Range Knob - locks the pivot position in place. Loosen only if you
need to increase the range of movement of the module, move the
module using the handle, then tighten the knob.

3 Handle - use to move the module up or down

4 Adjustment Knob - loosen to move the module, then tighten to
secure the module in place

5 Adjustable stop - lowest inspection position

Switch sides

The CP/E series modules are designed for maximum flexibility to fit into your production line.
During installation, the module can be changed so that the height adjustment brackets can be
placed on the other side of the module.

Likewise, the doors of the module may be removed and their hinges attached to the other side,
for the door to swing oppositely.

Camera Adjustments

If your inspection module has the optional motorized focus and aperture feature, you can
adjust the focus and aperture through the software: Camera Focus and Aperture (on page
156).
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Focus Adjustment
Look at the part image to observe the adjustments: Observe Part Image - SV (see "Observe
Part Image" on page 389)

To adjust focus, carefully remove or open the inspection module cover. Turn the focus adjust
ring while observing the part image on the monitor. Adjust the focus for the sharpest image. If
needed, adjust the aperture, then reinstall the cover.

Aperture Adjustment

The aperture controls the amount of light that passes through the lens. The programmable
light source provides the range of light intensity required for most applications. However, you
can manually adjust the aperture if necessary by turning the aperture adjust ring on the
camera lens. Reinstall the cover.

Camera Position Adjustment

«»» Note: Normally, you do not need to adjust camera position. Adjust only if you are initially
installing, or have replaced the inspection module.

The cameras can be adjusted for image size and position. Carefully remove the side panel cover
of the inspection module. Adjust cameras as necessary while observing image on Intellispec
monitor. After making all camera adjustments, replace module cover.

1 Note camera position on scale when adjusting for your part

2,3 Additional camera position adjustments - horizontal or vertical on
Intellispec image

4 Camera position - adjust for image size
5 Focus adjustment (or aperture adjustment depending on lens)
6 Aperture adjustment (or focus adjustment depending on lens)
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Replacing Camera
On rare occasion, you may need to replace a camera in a CP/E inspection module.

P

> To replace camera:

Remove the two screws [items 1 and 2].

Remove camera from mounting plate and attach new camera.

Tighten two screws [items 1 and 2].

If necessary, adjust the screws attached to camera bracket [items 3, 4, 5] to square the
image on screen.

PwnNPE

Lighting Adjustments

To adjust the lighting, use the software adjustments.
To see the image on the screen:

Observe Part Image (on page 389)

Adjust lighting through either:

e Basic adjust lighting (on page 163), or

e Advanced adjust lighting (on page 165)

Most often, you will use Basic Adjust Lighting.

Lighting zones CP500E/ CP750E

These modules use one camera and several lighting zones (see below). The camera and lighting
zone configuration for CP500E and CP750E are the same; however, the angle of the lighting
array of the CP500E is different than that of the CP750E. The illustration below shows the zone
grouping for these modules.
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These zones are programmed at Pressco and should not be changed. You may view the setup

in Advanced adjust lighting (on page 165).

Fill Light
Module w/
Beam Splitter

T

CP500E/ CP750E Lighting Zones

— Ring light

(optional)
L. ]

CP500E/ CP750E lighting zones
Fill light with beam Main array Ring light (optional)
splitter (optional)
4 zones: 9 zones: 1 zone:

1red zone *  3redzones 1red zone

1 green zone *  2greenzones

1 blue zone * 2 blue zones

1IR zone - 2 IR zones

CP1200E/ CP1500E

These modules use one camera and several lighting zones (see below). The zone configuration
is similar between these modules, except that the CP1500E has an additional Lower Light array.
The illustration below summarizes the grouping of the light zones for the CP1200E and

CP1500E inspection modules.
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These zones are programmed at Pressco and should not be changed. You may view the setup
in Advanced adjust lighting (on page 165).

Fill Light

CP1200E/ CP1500E Lighting Zones Lower Light
ghting “— \ (CP1500E

- only)

| =3 "gzl Ring light

CP1200E lighting zones
Fill light Upper light Middle light Ring light (optional)
(optional)
4 zones: 9 zones: 8 zones: 4 zones: OR:
1red zone *  3redzones *  2redzones *  1redzone *  2redzones
1 green *  2green *  2green *  1lgreen * 2blue
zone zones zones zone zones
1 blue zone *  2blue *  2blue *  1bluezone | OR:
1 IR zone zones zones *  1IRzone *  4red zones
2 IR zones . 2 IR zones OR:
1red zone
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CP1500E

Fill light Upper light Middle light Lower light Ring light (optional)
(optional)
4 zones: 9 zones: 8 zones: 8 zones: 4 zones: OR:
* 1red *  3red * 2red * 2red * 1red 2red
zone zones zones zones zone zones
*  lgreen *  2green *  2green *  2green * 1lgreen 2 blue
zone zones zones zones zone zones
1 blue 2 blue 2 blue 2 blue 1 blue OR:
zone zones zones zones zone 4red
1IR 2 IR 2 IR 2 IR 1IR zones
zone zones zones zones zone OR:
1red
zone
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Chromapulse module external connections

«» Note: this inspection module is not used in all systems. The configuration of your inspection
module may vary.

— |® ® B
o0
0: 3 BLUE CAMERA 1
®: @ <
[ —]
o { [@> GREEN PON o 2
QU e g

@ PRESSEQ ‘
s

8-PORT 1/0O BOX-MB1

|
\_r
Kiiiji
@ 38-4 PockeT pETECT (T |l|-l- T — J 8

J7 > () Wcumerers wal B
J5 »tmaer [ Socreowmme g

J3 pmen ) SescrcowmRu na
J1 > eeresc s

S
&

J6-4 MACHINE PART 2 W |l|-l-- J 6

o

O
ool

C:

et () e J4

pet—————seeen [ rTenroe J2

RC1 REJ2

4o

REJ1

E
E

MB1

8 port 1/0 Box MB1
1 Blue cable - Camera
2 Green cable - PDN (Pressco Device Network)
3 Encoder. 8 pin panel connector.
J1 PD Part detect
J2 REJ1 Reject 1
3 RC1 Reject Confirm 1
14 REJ2 Reject 2
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8 port 1/0 Box MB1

J5 RC2 Reject Confirm 2
J6 MP2 Machine Part 2
17 MP3 Machine Part 3
J8 PKT Pocket Detect

CP/E inspection module internal connections

This drawing shows the internal wiring typical of inspection modules CP500, CP750, CP1200,
and CP1500.

POWER PANEL CAMERAL GIGE
66582
57824 a = 58202 1 S)
CAMERA2
(IF PRESENT 66582 GIGE
( 57824 @ D 58202 S)
" ETHERNET SWITCH PDN
— o860 66582
g FHLL 5 1
LIGHT TREE 58317 67740 2 £)
(OPTIONAL) 67744 3
4 4 59860
EXTENDED 10 66765 €
(OPTIONAL) C
&
8-PORT 110 BOX 57783 E GATEWAY
N 66533 =) (OPTIONAL-SEE PG 4)
0 Lty
A E] - E
65330 é
ENCODER 65331 H ] E] EI
65332 Ju@ O o
B .
S/
ETHERNET SWITCH POWER TERMINATION-12VDC
SEE BELOW
\_57795
CP500, CP750, CP1200, CP1500
\ - LED CTRL1/DRVR1 IS INSTALLED ON THE SIDE PANEL
LED CTRL1/DRVR1
(ON SIDE PANEL)
CP1200, CP1500-LED CTRL2/DRVR2
LED CTRL2/DRVR2 IS INSTALLED ON THE TOP PANEL
57794
-

57795

Ji1

\ 32

LED CTRL1/DRVR1 LED CTRL2/DRVR2
(ON SIDE PANEL) (ON TOP PANEL)

ETHERNET SWITCH POWER TERMINATION-12VDC
TWIST THE BLACK AND RED WIRES TOGETHER

6-RED/1BAWG

T — T e e

g
0
o
S
S

—~c o= dd

| m— 1))

6-PIN CONNECTOR
INCLUDED WITH SWITCH

«*» Note: on Part Tracker assembly, switch RSW1 must be set to '0' for proper operation
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CP500E light array connections
CP500-LIGHT ARRAY CONNECTIONS

16985

LED CTRL1/DRVR1
(ON SIDE PANEL)

58601 Y

CABLE 58691
UPPER ARRAY

16985

RINGLIGHT

(OPTIONAL)

CABLE 58691
FILL LIGHT

FILL LIGHT ASSY @ @
(OPTIONAL)

LIGHT ARRAY ASSY
(MAIN PLATE)

CPZ750E light array connections
CP750-LIGHT ARRAY CONNECTIONS

N
~

2

3

[=3

LED CTRL1/DRVR1
(ON SIDE PANEL)
58691 Y,
e
CABLE 58691
@ UPPER ARRAY
2
Q
@ @
0 e e []
o
RINGLIGHT NS
(OPTIONAL)
CABLE 58691 o
FILL LIGHT
FILL LIGHT ASSY tomm—ol}
(OPTIONAL) LIGHT ARRAY ASSY
(MAIN PLATE)
402 Inspection Modules System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary



CP1200E light array connections
CP1200-LIGHT ARRAY CONNECTIONS

N
N
o
3
2
LED CTRL1/DRVR1 LED CTRL2/DRVR2
(ON SIDE PANEL) (ON TOP PANEL)
58691 )
CABLE 58692
CABLE 58691 MIDDLE ARRAY
- UPPER ARRAY
8
3
IS
58692 Y,

o
°e

RINGLIGHT E
(OPTIONAL) g
CABLE 58691 °
FILL LIGHT
0 e -]
FILL LIGHT ASSY © ©

(OPTIONAL)

LIGHT ARRAY ASSY
(MAIN PLATE)

CP1500E light array connections
CP1500-LIGHT ARRAY CONNECTIONS

N\ 0\
N &
3
o N
3
& g
i
LED CTRL1/DRVR1 LED CTRL2/DRVR2 =
(ON SIDE PANEL) (ON TOP PANEL)
58691 Y ey,
CABLE 58711
LOWER ARRAY CABLE 58692
MIDDLE ARRAY
58692
e ¢ CABLE 58691
. UPPER ARRAY
RINGLIGHT E
(OPTIONAL) 3
CABLE 58691 °
FILL LIGHT
-] <]
FILL LIGHT ASSY ol ®©
(OPTIONAL) 58711 Y
LIGHT ARRAY ASSY
(MAIN PLATE)

CABLE 58711
| OWFR ARRAY
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CP/E Power Panel connections

CONNECT TO
90-240VAC PART TRACKER J1
50/60HZ
BLK-16AW FAN
N LED 66527
WHTISANG ~N INDICATORS
58558
UINE [ :
POWER ENTRY — =I=| cp1 = D a
MODULE ViEw TIT| 10A °
= 0
LINEFILTER — rermacview LOAD ] |9
MODULE CONNECTOR IEC320-C14 o e gl &
1 gl g 8
MATING CONNECTOR IEC320-C13 af = ; : :; POWER DIST PCB
i Bl 65966
2
K —\ 66528 J6 —D -
[} S
z 66532
H J7
g p 66529 . 8 H]
S CONNECT TO LED
""" e CTRL1/DRVR1 J3
GROUND STUD
SEE GROUND DETAIL 5
%_\
Q L]
Bl USK2
SK1 12vbe Loy [eEED o 3
N—WHL L7 3 NEUT Ty 3| &
] N—2BLK L 1LNE 4RET
H : e [—i] o
2 S
g = 2 b
K g &
ot RS
g
H e ° CNs
[ 2 8
& 3
8 8
o Q PS3
ps2 48VDC
n 24vDC 3
T ] 1-NEUT 424V |io YEL CN1
TERMINATE TO TAB N—BLC L] s 1inNE I,
INSTALLED ON COVER. LRET b wh
B
R
-] Q Q Ggl o
j EJ
EE
(. 66529
GROUND STUD POWER ENTRY
\ exnuT MODULE
STAR WASHER
\ — EARTH GROUND
CAMERA MODULE
EARTH GROUND CIRCUIT
PANEL COVER \ 1 BREAKER
t — FLAT WASHER
/ — HEXNUT
STAR WASHER / — EARTH GROUND FROM
\ POWER ENTRY MODULE
STAR WASHER \ ]
DETAIL "A"
GROUND DETAIL APPLY ITEM 35 LABEL TO TOP OF
FASTEN GROIIND | 1IGS AS SHOWN COVFR AT AC POWFR ENTRY POINT
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CP/ E Motorized focus connections (optional)

The following wiring diagram shows the wiring between the motors and controllers for
inspection modules that have the motorized focus option.
MOTORIZED FOCUS CONNECTIONS

(OPTIONAL)
58702
( N\
58702
° 5 5 ° 58703
4
MOTOR 'X' e} O MOTOR'Y" g 57744
58702 58702 & GATEWAY PCB
o o o o E30000000

58472 ?
[y __seros =i B
GEAR'X' J j] D —[
UPPER =R iE ‘ ‘
oo sy D )
@ = D D
GATEWAY POWER B [ .
CONNECT TO PART ‘,‘:] o D :] )
TRACKER MOTHERBOARD J20
LIMIT SWITCH PCB
58485 LIMIT SWITCH PCB
58485 LIM 'Y* CONNECTOR
LIM X' CONNECTOR 58556
CAMERA ASSEMBLY
LIM X' CONNECTOR
LIM "Y' CONNECTOR
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CP4422EV INSPECTION MODULE

The CP4422E inspection module provides comprehensive inside of can inspection. The module

can be configured with up to four cameras to inspect the flange, neck, and body of the can. The
main components of the CP4422E are shown below. Note that your system may not contain all

components shown.

‘0

e Note: if this module is used with an Intellispec Series V CSL system, there is a limit of two
cameras.

The color of the arrays and filters on the cameras dictates what color the camera sees. The
Neck camera sees only red light. The Body camera sees only blue light. The Flange camera sees
only green light.

An Extended 1/0 (on page 425) kit is available for the CP4422E.

1 Flange camera with Green Pass filter installed
2 Neck camera with Red Pass filter installed
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Ethernet switch

Body camera with Blue Pass filter installed

Plate or space for Auxiliary module

Beam splitter/ mirror assembly

First surface mirror

Periscope assembly for body camera

O | 0[N |0V || W

Window - neck and flange cameras look through

10 Body, flange, and neck arrays inside

11 Ellipsoidal mirror inside

An auxiliary module may be installed to provide additional inspection (the area inspection
depends on your application). It is installed in place of the plate [item 5]. An example auxiliary
module is shown below.

Adjusting the CP4422EV module
Camera Adjustments

If your inspection module has the optional motorized focus and aperture feature, you can
adjust the focus and aperture through the software: Camera Focus and Aperture (on page
156).

Focus Adjustment

Look at the part image to observe the adjustments: Observe Part Image - SV (see "Observe
Part Image" on page 389)

To adjust focus, carefully remove or open the inspection module cover. Turn the focus adjust
ring while observing the part image on the monitor. Adjust the focus for the sharpest image. If

needed, adjust the aperture, then reinstall the cover.
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Lighting Adjustments

To adjust the lighting, use the software adjustments.
To see the image on the screen:

Observe Part Image (on page 389)

Adjust lighting through either:

e Basic adjust lighting (on page 163), or

e Advanced adjust lighting (on page 165)

Most often, you will use Basic Adjust Lighting.

Lighting Zones CP4422F

The illustrations and table below show the lighting zone grouping for the CP4422E inspection
module. The illustration shows a module with three cameras installed.

7

*» Note: These zones are programmed at Pressco and should not be changed. You may view
the setup in Advanced adjust lighting (on page 165).

Sidewall/ Sidewall/
Dome (Body) | Flangel Dome (Body)

Q RN /4/\

0 N

CP4422E Lighting Zones

Body Neck Flange

(upper array type) (lower array type) (ring array type)

10 blue zones 1red zone 3 green zones
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CP4422E module external connections

«» Note: this inspection module is not used in all systems. The configuration of your inspection

module may vary.

e

AW N R

8-PORT 1/0 BOX-MB1

J7-4

J7 P ) MecHnerarTs

®

el
b

J5-4

POCKET DETECT WW |l||-l-- J 8

J5 --l-|l| [ REECT CONFIRM?

J3 --l-lll ) REECTConFIRML

O
©
©)

Pl
Q
~
=
3
N

J3-4

MACHINE PART2 W |l||-|-- J6
REJECT2 (I |l||-|--. J4

©
®

Jl --|-|l| [ 2aRroetect

Ji-4 J2-2
@Jl J2©

9
£

REJECT1 Wm |l||-|-- J2

8 port 1/0 Box MB1

1 Green cable - PDN (Pressco Device Network)
2 Blue cable - Camera

3 Light tree cable

4 Encoder. 8 pin panel connector.
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8 port 1/0 Box MB1

J1 PD Part detect

)2 REJ1 Reject 1

3 RC1 Reject Confirm 1
Ja REJ2 Reject 2

J5 RC2 Reject Confirm 2
J6 MP2 Machine Part 2
17 MP3 Machine Part 3
18 PKT Pocket Detect

410
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66923

66923

CP4422EV internal connections page 1

F1291W page 1 of 3
LED

PART

BLK-16AWG
INDICATORS 66527 TRACKER s N
58558 322 WHT-16AWG N
g ili f
® -
& LINE [[&0]a0
= 0 CB1
LOAD (=] |“]
A
S N © 2
3 8 2
8 ©
[-) Py © ©
PS1 ~
12vDC 1RED =
WHT - o NEUT 1-12v s N <
BLK | 3NEY 4-RET |[HBLK u
[(—BLE | 1-LiNE - N -
1”1 ’:_> %
\ °
° ° POWER DIST PCB 2§
re) by 50
I . 65966 O w
23 8 o 9[]ET[]° g u
° PS2 ° ° g 1 ?
© s 8 F g
\__J33| H
J1 24vDC 13 D]EF - i <
WHT . H S
—Br | LNEUT 4-2av |H—YEL_ Rl | | 8
[—E5Et| 3-LINE I GRN 1 o1
1-RET |+t ~ 35 T
o oo
A 0
° ° : : 2
o ° E]“ EI(’ g
|
° LY S o
PS3 CN5 8 o z
- CN1 48vDC 148y [A-ORG 9 &
M o
(WB-LINE S.RET I BLU £ SEE NOTE 1
[—WHT 1 J3-NEUT : N 66924 ) \ H
B NOTES:
[ o
_ 66925 Y, 1) TERMINATE TO GROUND TAB INSTALLED ON COVER.
o
N
S
2
8
. 66923 J
—_— = = = = = — — 5 _— = - = = — — - — = = - - — —
7/ GROUND STUD N
90-240VAC | | STAR WASHER — HEX NUT |
| 50/60Hz | x — EARTH GROUND |
CAMERA MODULE
| o | EARTH GROUND
- . | | PANEL COVER X |
| 9 — FLAT WASHER
| | /— HEX NUT
| STAR WASHER — EARTH GROUND FROM
POWER ENTRY MODULE
| POWER ENTRY | | STAR WASHER % |
MODULE | | |
| LINE FILTER § {
EXTERNAL VIEW | | |
MODULE CONNECTOR IEC320-C14
| MATING CONNECTOR IEC320-C13 | \ GROUND DETAIL )
N - FASTEN GROUND LUGS AS SHOWN _
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CP4422EV internal connections page 2

F1291W page 2 of 3
POWER 66926 59861
W ( |
N — .
o 66922 U:P 18
s J19 66914
ﬁ}] ; LIGHT TREE
EiP O ‘ )
@ J— [—
L= v
Ei}:] o o
.
66919 J4 T_Df—’P o e o o
a ’ ]
- & 3 PART TRACKER PCB ASSY
- - K 66458
o o
™ N
™ [e2]
0 (G}
© (e}
— g ENCODER  MB1
Q 28 B ‘
N
N
DIST BD1 2
59130 ©
PDN SWITCH
(GREEN CABLES)
T
[ ’ o
L] 3 2
(2]
L] 4 B
L]
|12 PDN
[:] 6
el PART TRACKER J
8 59861  HOSTPC —
=
66582 FERRITE/
H ” ” ” H 6-PIN CONNECTOR
90009 ? INCLUDED WITH SWITCH
o [ SEE DETAIL "A" below
@ |o
= |
Bk
Gl

.0

* Note: on Part Tracker assembly, switch RSW1 must be set to 'F' for proper operation
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Detail "A"
DETAIL "A"

6-RED/18AWG

=3 -
I ] M TS C X T B6922-XX [ XX T > ]
===\ ETHERNET SWITCH POWER TERMINATION-12VDC
e |3 PIN 6 - 12V(RED) TWIST THE BLACK AND RED WIRES TOGETHER
—mYp) PIN 5 - COM(BLK)
=D 1
6-PIN CONNECTOR
INCLUDED WITH SWITCH
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CP4422EYV internal connections page 3
F1291W page 3 of 3

PDN SWITCH
(GREEN CABLES)

a1l Pl ol |
No g A WN R

LED CTRLR1 59862
GROUND SWITCHES FLANGE (CAMERA3)
ETFERRET
TO PANEL - D @
SEE DETAIL "B" L
CAMERA SWITCH
(BLUE CABLES) NECK (CAMERA2)
s e
alll e
{ 3
{ 4
5 FLANGE (CAMERA3) J BODY (CAMERAL
CAMERAS % 6 NECK (CAMERA2) Em;(uw )
7 BODY (CAMERAL)
59847 HOST PC ; D ,@
v &
66582 FERRITE %
6-PIN CONNECTOR }l (U) EU) ! l H PDN SWITCH pgg‘p;gg
INCLUDED WITH SWITCH [ il POWER CONNECTOR [ i
2 'E) ’E‘A 2l
& J

INSTALL JUMPER WIRES FOR
POWER FROM PDN SWITCH
PIN 6 - 12V(RED)

PIN 5 - COM(BLK) 66582
FLANGE CAMERA ]
I
66582
NECK CAMERA e
[
66582
BODY CAMERA —
L1
g 59862
w
2
3 J1
<|Q o|¢ o o CONNECT TO
I —[L & LIGHT ARRAY
|z = o4
M i
HE 66917 u2| |5 66913
s
[a]
2 [ J5
o 5@3 o
AN| O] | WO
T 10000
% 66919 J1 o °
‘ LED CTRL1/DRVR1
66459
DIST BD1
59130
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Detail "B"

GRN/YEL-16AWG

DETAIL "B"

ETHERNET SWITCH GROUND
TRIM WIRES TO FIT

CP4422EV auxiliary module internal connections

PDN SWITCH
(GREEN CABLES)
aliiEs
2
Al
o114
3 5 LED CTRLR2 59860
alliE
|17
i
CAMERA SWITCH
(BLUE CABLES)
al 1 J1 ©] °|
)
] g AUX (CAMERA4) L[4
] 66582 H
7!
e : AUX (CAMERA4) D @ 1 AUX CAMERA 66709 J12 f B El
[ e | J5
% 6 E
4 )
L) '1 H@@@
66919 Jl
p
LED CTRL2/DRVR2
DIST BD2 66459
59130
0
i
[EF ° ) o [{33 ©
2 -l
3 TP
© = r
[{j o - CONNECT TO
i — O g | o [ LIGHT ARRAY
. [—
— [ O0g o=
TP __ o (C —
LT ]
P o b—=rllo |

PART TRACKER PCB ASSY

66458
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CP500 INSPECTION MODULE

The CP500 inspection module is in a smaller package for confined spaces. It inspects mostly
smaller crowns and closures.

The CP500 is shown below.

CP500 outside view CP500 inside view with covers removed

1-Camera

Adjusting the CP500/ V module
Camera Adjustments

If your inspection module has the optional motorized focus and aperture feature, you can
adjust the focus and aperture through the software: Camera Focus and Aperture (on page
156).

Lighting Adjustments

To adjust the lighting, use the software adjustments.
To see the image on the screen:

Observe Part Image (on page 389)

Adjust lighting through either:
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e Basic adjust lighting (on page 163), or
e Advanced adjust lighting (on page 165)
Most often, you will use Basic Adjust Lighting.

Lighting zones CP500
The lighting zones are the same as the CP500E inspection module. See Lighting zones CP500E/
CP750E (on page 396).

CP500 inspection module internal connections
ASSEMBLIES W/O MOTORIZED FOCUS

CAMERA CAMERA

66582 — 66582
58283 59286
i el
‘1
.

o 0 o
5n0
66583 66687 J1 | mgm%m&‘iﬂ]
o OO O Q.0
m@ o foo[ﬂ[ﬂ Jo
DIST PCB
59130

ASSEMBLIES W/ MOTORIZED FOCUS

159860
L \
CAMERA
66582 ETHERNET 66582
—1 58283 B 59286 GATEWAY PCB
o PWR/O 57744
i

66583 :
ﬁ_z 66687 J1g

3118 ] o

0 %8 59260 = L
DIST PCB
59130
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CP500 Motorized focus connections (optional)
The following wiring diagram shows the wiring between the motors and controllers for

inspection modules that have the motorized focus option.
ASSEMBLIES W/ MOTORIZED FOCUS

58468

.
58468
° ° ° ° 58477
[2])
MOTOR X' MOTOR 'Y* 2 x 57744
@) @) ol o
58468 58468 o z| 2 GATEWAY PCB
ol > D g
o1 © N B
Rz=sles =
[ <| COMM 58471 112 |
= Il |
GEAR X' 0
UPPER —
o il
=== nafd -
8] ). o©
58472 B Y B
S I o W B

LIMIT SWITCH PCB
3
L7

58485 LIMIT SWITCH PCB

58485
LIM X' CONNECTOR

LIM'Y' CONNECTOR
58556

\ LIM
sf

LIM 'X' CONNECTOR

LIM'Y' CONNECTOR

BC2D15 STEPPER
MOTOR CONTROLLER.
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CPX INSPECTION MODULE

The CPX module contains the lighting and optics to inspect the decoration on the outside of
cans to detect mixed labels and gross decorator defects. The basic components of the
inspection module are shown below.

CPX front view (with door removed)

1 Light control board

2 Camera 1

Camera 2

Signal distribution board

LED light source (quantity 4)

First surface mirror for optics (one on each side of module)

First surface mirror for optics (one on each side of module)

0 I N|o|lu ]| b~ w

Glass shield
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CPX back view

4

o

D g
2

1 Blue cable - Camera 2 connector

2 Blue cable - Camera 1 connector

3 Green cable - PDN (Pressco Device Network)
4 Photoelectric sensor "Smarteye"

5 Part detector cable

6 Part detector cable

Adjusting the CPX camera

This section covers camera adjustments that may be required to keep the inspection modules
working properly. Adjustments include the camera position, aperture, and camera focus.

The focus adjustment controls the clarity of the image; the aperture adjustment controls the
amount of light admitted by the shutter. Normally the inspection modules do not require
further adjustment after initial system setup. Circumstances that might require additional
adjustments are camera replacement, strobe replacement, or a substantial change in part size
or color.
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\ Danger
The inspection modules are mounted near moving machinery. Use extreme caution to avoid
contact with moving machinery when servicing inspection modules as serious personal injury
could result. Ensure machinery is in an emergency stop state before servicing inspection
modules.

The camera can be moved up or down for fine tuning the image. The focus and aperture can be
adjusted manually if necessary.

7

** Note: The camera inspects the top five inches of a can, or the whole length of a 12 ounce
can. This adjustment is not for large adjustments.

Q Q Ul
(o) I—
33—
@)
1 Camera adjust to fine tune the image area
2 Aperture adjust
3 Focus adjust

Camera Adjustments

If your inspection module has the optional motorized focus and aperture feature, you can
adjust the focus and aperture through the software: Camera Focus and Aperture (on page
156).
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Lighting Adjustments

To adjust the lighting, use the software adjustments.
To see the image on the screen:

Observe Part Image (on page 389)

Adjust lighting through either:

e Basic adjust lighting (on page 163), or

e Advanced adjust lighting (on page 165)

Most often, you will use Basic Adjust Lighting.

Lighting zones CPX

The lighting zones for the CPX module consist of the right side and the left side. Lighting
adjustments make either side brighter or darker.
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CPX internal connections

LJ))® ot L=
EN ©
— — = = ©
S
«© o
° o (15
< 0 © ©
— g
CAMERA 1 (% O 0 CAMERA 2
2
PWR+I/O 0 0 E PWR+I/O
ETHERNET |0 3 = | ETHERNET
[ 0 Q
N — CAT 6
U o = 0
=
N
© © © 0 n
9 ° °
N
T
F1348C I_T_T_l
58624C
s /Q\ o
S ’ A
J\'/ >>/
=P
[=5]p
O
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Chapter 16
EXTENDED 1/0

This section contains information about the optional Extended 1/0O board.

7

** Note: In some systems, such as FHCP 3X inspection systems, the Extended I/0O board is
always included (not optional).

EXTENDED I/0 BOARD

This optional module provides additional input and output ports for communicating with the
Intellispec Series V system. The board may be installed within a cluster box or within an
inspection module (see "Extended 1/0 in inspection modules" on page 390). The board is
connected to the lane's Part Tracker board via a ribbon cable.

«»*» Note: Each Extended I/0O board handles only one lane.
% Note: Extended I/0 is not available with an Embedded Cluster Box.

Some signals must be enabled in the software through the Extended I/0 Configuration (on
page 432).
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Below is the basic layout for the Extended 1/0 module.

( ~
B ©
PREFORM ALARM g @

CLEAR STATS Sl 5
CLEAR ALARMS | [l | | -
PRINT STATISTICS SH nJ
PART AT REJECT H Sl 8%

PARTBAD S I B

PART PRESENT | S| H gz

PART GOOD g” g s

SYSTEM STATE| S|l | il o

g\\ g ‘”7
24V _®_1—®-
S| Sk
1 B \\7
EiLE
> »&
>9 g” N
'_|-|'| ®H >O
\%2 @H § 28
e gH @”‘Q/Z o
8 | H:‘/H
/’% N \\%
24v Q| S|
_®J_®
/—® /®ﬁ7/
sl s
o)
© g” sl =
IR off 2
[ @ )
=9 §
S St
RS-232 po§T4T\é -%- J_g RS-232 PORT RCV
OUTPUT PORT STROBE |1S)|| (SHNPYT PORT STROBE
1818 25
o LE
\E% ||| ! H ;g‘
=3 Q| gH %O
=
Q g‘ di N
2 0 Dl M0
YR
24V gﬁ I+

[
[

\- J

Extended I/0 signals

The Series V Extended 1/0 signals are listed in the table below. For the location on the
Extended I/O board, refer to the Extended I/0 terminal block reference (on page 430).

7
0.0

Note: some signals are not currently used
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All Extended 1/0 inputs are PNP. Outputs are selectable to be either open collector or open
emitter. However, that selection applies to ALL output signals.

The input and power LEDs are visual indicators. The output LEDs illuminate if the current
reaches 40mA or higher, which is approaching maximum current. The maximum current output
is 50mA. See also information about Extended 1/0O circuits (on page 430).

*The signals marked with an asterisk must be enabled through Extended I/O Configuration (on
page 432) in the software.

Signal 1/0 Connector Indicator LED | Comments/ Reference

Clear Stats* I 14-23 D2 Clears the lane statistics

Clear Alarms* I 14-22 D3 Clears the lane alarms

Print Statistics* | 14-21 D4 Prints the lane statistics to currently

configured printer or file

Schedule Reports (on page 109)

Preform Alarm | 14-24 D1 Used only in special applications.
Activated by the Preform Material
Handling system.

System State* o J4-16 D11 Indicates whether the lane is online or
offline. Online = active. Offline = inactive.

Part Present (Part 0] J4-18 D9 Pulses for 12 ms when the part present

Detect)* sensor detects a part

Part Good* 0 14-17 D7 Pulses for 12 ms for each part declared

(Group A) good by the inspection

Part Bad* (Group A) 0] 14-19 D5 Pulses for 12 ms for each part declared
bad by the inspection

Part at Reject* (Group 0] 14-20 D13 Pulses for 12 ms for each part that

A) crosses the reject point (online mode
only)

Group 0 (0] J2-3 D17 Pulses for 12 ms when an inspection fails
inth _defi I

Group 1 o 12-4 D75 in the user-defined group (online mode
only)

Group 2 (¢ J2-5 D33 Walk By Setup (on page 64)

Group 3 O J2-6 D41

Group 4 O 12-7 D15

Group 5 (6] J2-8 D23

Group 6 (6] J2-9 D31

Group 7 (6] J2-10 D39

Group 8 (6] J2-15 D21

Group 9 (6] J2-16 D29

Group 10 (6] J2-17 D37

Group 11 (6] J2-18 D45

Group 12 (6] J2-19 D19
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Signal 1/0 Connector Indicator LED | Comments/ Reference
Group 13 0] J2-20 D27
Group 14 0] J2-21 D35
Group 15 0] 12-22 D43
Part Not Processed: (0] 14-3 D109
(Rejector 0)
Part Not Processed: (0] 14-4 D113
(Rejector 1) Pulses for 12 ms when a part is not
processed due to a system malfunction
Part Not Processed: (0] J4-5 D117 (online mode only)
(Rejector 2)
Part Not Processed: (0] J4-6 D121
(Rejector 3)
Reject Confirm 0 14-7 D107 Output signal when reject is confirmed
Reject Confirm 1 14-8 D111 (F168 and later DPT firmware)
Reject Confirm Sensor J4-9 D115 Reject confirm sensor signal pulse width
blocked exceeding programmed limit
(F168 and later DPT firmware)
Host communication (6] J4-10 D119 Output signal when communication
lost to/from host is disrupted
(F168 and later DPT firmware)
Inspection Alarm 0 0] J3-3 D59 Pulses when the associated alarm
TseEe A & 0 13-4 D67 condit?on occurs and stays active until the
alarm is cleared
Inspection Alarm 2 0 13-5 D75 Lane Alarm Configuration (on page 96)
Inspection Alarm 3 0 J3-6 D83 and
Inspection Alarm 4 0} 13-7 D57 igg;orAlarm Configuration (on page
Inspection Alarm 5 0 13-8 D65 *)3-22 Inspection Alarm 15 supported
Inspection Alarm 6 0 13-9 D73 with F168 and later DPT firmware. In
earlier firmware versions, this signal is
Inspection Alarm 7 (0] J3-10 D81 "Host Communication Lost"
Inspection Alarm 8 (0] J3-15 D63
Inspection Alarm 9 0 J3-16 D71
Inspection Alarm 10 0] 13-17 D79
Inspection Alarm 11 0] J3-18 D87
Inspection Alarm 12 0] J3-19 D61
Inspection Alarm 13 0] J3-20 D69
Inspection Alarm 14 0] J3-21 D77
Inspection Alarm 15* 0] 13-22 D85
Generic Input Port 0 | J1-3 D48
Generic Input Port 1 | 11-4 D50 Reserved for Asynchronous Correlation
Generic Input Port 2 | J1-5 D51

428 Extended /O
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Signal 1/0 Connector Indicator LED | Comments/ Reference
Generic Input Port 3 | J1-6 D52
Generic Input Port 4 | J1-7 D55
Generic Input Port 5 | J1-8 D56
Generic Input Port 6 | J1-9 D47
Generic Input Port 7 | J1-10 D49
Input Port Strobe | J1-11 D53 Reserved for Asynchronous Correlation
Generic Output Port 0 0 J1-15 D91
Generic Output Port 1 0 J1-16 D95
Reserved for Asynchronous Correlation
Generic Output Port 2 0 J1-17 D101
Generic Output Port 3 0 J1-18 D105
Generic Output Port 4 0] J1-19 D89 Encoder Z pulse output
Generic Output Port 5 0] J1-20 D93 Part at Reject (Group B)
Generic Output Port 6 0] J1-21 D99 Part Bad (Group B)
Generic Output Port 7 0] J1-22 D103 Part Good (Group B)
Output Port Strobe 0] J1-23 D97 Reserved for future use
RS-232 Port TR 0] J1-24 D202 Reserved for future use
RS-232 Port RCV | J1-12 D200 Reserved for future use

All Connectors

Function Pin
Isolated ground 1,2
24V (isolated) 13,14
Test Points

Function Test Point
24V 2

24V Gnd 3

3.3V 1

3.3V Gnd. 4
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Extended I/0 terminal block reference

(0]

TP1

[o] [o]

TP3

P4

14-P24
Ja-P23
14-P22
Ja-P21
14-P20
34-P19
14-P18
34-P17
J4-P16
Ja-P15
14-P14
34-P13
J3-P24
J3-P23
13-P22
J3-P21
13-P20
J3-P19
J3-P18
13-P17
J3-P16
J3-P15
J3-P14
J3-P13
J2-P24
J2-P23
J2-P22
J2-P21
J2-P20
J2-P19
J2-P18
J2-P17
J2-P16
J2-P15
J2-P14
J2-P13
J1-P24
J1-P23
J1-P22
J1-P21
J1-P20
J1-P19
J1-P18
J1-P17
J1-P16
J1-P15
J1-P14
J1-P13

[0]

TP2

Extended I/0O circuits

The following illustrations show typical input and output circuits you can use to communicate
with your plant's PLC, or to connect external LEDs or light trees.

(©) 2010 Pressco Technology Inc.

J4-p12

J4-P11

J4-P10

14-P9

586866
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14-P7
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=

14-P6

34-P5

14-P4

14-P3

14-P2

34-P1

J3-P12

J3-P11

J3-P10

J3-P9

8668685 6666

J3-P8

J3-P7
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[
w

J3-P6
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J3-P4
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J3-P1

J2-P12

J2-P11

J2-P10

J2-P9

6869 6666

J2-P8
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J2-P5

32-P4
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J2-P2

J2-P1
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J1-P12

Ji-P11

J1-P10

J1-P9
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J1-P8

J1-P7
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=

J1-P6

J1-P5
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> Specifications:
e  Minimum dwell time of the input device is 1.1 ms
e Maximum output load is 50 mA

e Default value of output pulse is 12ms. Some output signals, such as alarms, must be
cleared on the Intellispec before they turn off.

Default timing of pulsed output

On
Off ‘ 12ms

The following illustration shows a typical circuit that can be used to clear alarms.

CLEAR ALARMS - INPUT

Terminal Block TB4

+24V 1SOL
A +3.3V

.
2
X
20 DPT
GND_ISOL Input
GND

The following illustration shows a typical circuit that can be used for a group output.

GROUP 1 - OUTPUT
+24V_1SOL

DPT

Output Terminal
J Block TB2

5—o04

7

GND GND —o° 1
ISOL
GND_ISOL
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EXTENDED I/0 IN INSPECTION MODULES

The Extended I/0 (see "Extended I/0 board" on page 425) kit (optional) is installed within
Chromapulse inspection modules as shown below.

1 power cap

2 Extended I/0O kit

EXTENDED I/0O CONFIGURATION

Through this menu you can enable input or output signals to either perform a function on the
Intellispec system or allow you to monitor the production lane in your plant. These settings
must be done for each Extended 1/O board for each lane.

See also the sections about Extended I/0 (see "Extended 1/0 board" on page 425) and
Extended 1/0 Signals (on page 426).

NS

> To get to this screen:

From the Lane or Sensor Overview screen, click the Tools button to see the Tools Menu,
then select Hardware Setup, then select Extended 1/0 Configuration.

This screen displays some of the inputs and outputs on the optional extended I/0 board.
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If one of the extended I/O ports is used it must be enabled here in the software, and the
hardware must be connected appropriately.

Extended I/0O Configuration

Input Interrupts Part Detect Mask Part Good / Part Bad / Part at Reject
Glear Alarms Intemupt @ PartDetect SetA SetB
Clear Statistics Intemupt Input Event 1 @ Reject 1 @ Reject 1
;‘J @ Input Event 2 (/_ (_

Output Input Event 3 @ @

O System State @ o s ‘& @

Input Interrupts

These signals produce an input pulse to the Intellispec processor to perform the following
functions.

Clear Alarms Interrupt
Clears the lane alarms.

Clear Statistics Interrupt
Clears the lane statistics.

Print Statistics Interrupt
Prints the lane statistics to the currently configured printer or file. See also Schedule
Reports (on page 109).

Output

System State
Produces an output pulse to notify your plant whether the lane is online or offline. Online =
active. Offline = inactive.

Part Detect Mask

Choose which Part Detect or other input events to trigger the Part Present output on the
Extended I/O board. This is an OR function. Any enabled Part Detect signal or Input Event that
goes active will activate the Extended 1/O Part Present output.

Part Detect
The signal goes active when the sensor detects a part.

Input Event N

The Part Tracker board accepts up to five* input events (Part detectors or other sensors).
Part tracking is always controlled by the Part Detect signal (Input Event 0). You might use
other input events (1 - 4) in your system to trigger the Part Present output signal.

*Only if your system has an 8-channel Part Tracker board. If your system has a 2-channel

Part Tracker board, then only one Part Detect signal is used. The other input events are not
available.
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Part Good/ Part Bad/ Part at Reject

Choose which rejector signal to activate the Part Good, Part Bad, and Part at Reject signals on
the Extended I/O board. After a part is inspected, the system determines whether the part is
good or bad. As the part passes by Rejector 1, 2, 3, or 4, the Part Good/ Part Bad/ and Part at
Reject signals are activated on the Extended I/O board. There are two groups of Part Good/
Part Bad/ and Part at Reject signals - Group A and Group B. You choose which rejector is
associated with Group A and/or Group B. You can have both groups associated with the same
rejector, if desired. See Extended I/0 signals (on page 426).

7

* Note: If your system has a 2-channel Part Tracker board, then the lane has up to two
rejectors. If your system has an 8-channel Part Tracker board, then the lane has up to four
rejectors.

Example 1 below: Group A is triggered when the part passes Rejector 2, and Group B is
triggered when the part passes Rejector 4. The illustration below shows a basic block diagram
with a conveyor with four rejectors. Those rejectors output a signal to the Extended I/O board,
based on the Extended I/0O configuration.

OO00O0 OO O O
R1 R2 R3 R4
/ !
_7 _7
/’__ "
/ /
]
P
|m| |F)G'B |
| | | |
| PB-A | | PB-B | Extended
| | | | /0O board
| PaR - A : IPaR-B:
lF lF

Extended I/O Configuration

Input Interrupts Part Detect Mask Part Good / Part Bad / Part at Reject
Clnar Atarm inte _— PartDetect Set A SotB
@ Clear Sitistics inemapt a gt Evesn 1 (
Reject 2
=) @ gt Event 2 @
Output @ [ —
F)e= @ rowerene ( @ race

R Rejector
PG Part Good signal, Group A and Group B
PB Part Bad signal, Group A and Group B
434 Extended /O System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary



PaR

Part at Reject signal, Group A and Group B

Example 2 below: Group A is triggered when the part passes Rejector 2, and Group B is also
triggered when the part passes Rejector 2.

>

OO00O0 O O O O
| R1 R2[  |R3[ " |R4
]
_____,.."I
,” 1
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P
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Output
System Suase

Extended I/O Configuration

Part Detect Mask

Part Good / Part Bad / Part at Reject
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Chapter 17
MAINTENANCE FREQUENCY

Follow the guidelines for cleaning and maintenance of the Intellispec system and the inspection

modules.

Intellispec Processor Cabinet and General Components

Item Description Once per Once per
day or shift | month
Observe Proper Verify that defective parts are being rejected by inserting a X
inspection known defective part through inspection
Observe Proper Verify that no stray parts are stuck in or near the inspection X
inspection module or reject station
Observe Proper Verify that no buildup of dirt or contaminants has occurred X
inspection on inspection module, part detector, or conveyor. Clean if
necessary.
Observe Proper Verify that each sensor image is properly centered, X
inspection focused, and properly lit. Adjust if necessary.
Vision Processor | Rinse in clean water; use mild soap and water solution if X
filter oily. Cleaning the Vision Processor filter (on page 438)
Cluster Box filters | Rinse in clean water; use mild soap and water solution if X
(if applicable) oily. Cleaning the Cluster Box filters
Inspection Modules Chromapulse
Item Description Once per Once per
day or shift | month
Part Detect Sensor Clean with soft, clean, oil-free cloth dampened with Once per
and Reflector mild soap and water solution. Wipe dry. week
Cleaning the Part Detector (on page 442)
Camera lens Clean only with lens tissue and lens cleaner. Be careful X
not to alter focus or aperture.
Cleaning the Camera Lens (on page 441)
Glass surfaces: Clean with soft, clean, oil-free cloth dampened with lens X
Beam Splitter and cleaning solution.
Secondary lens Cleaning the Chromapulse Beam Splitter (on page 440)
Ellipsoidal mirror Normally does not need cleaning. If dirty, blow off dust Only if dirt
with compressed air, and follow instructions. appears on
Cleaning the Ellipsoidal Mirror (on page 442) image
Plastic surfaces: Clean with soft, clean, oil-free cloth dampened with X
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Dome light or Ring mild soap and water solution. Wipe dry.
light diffusers

Fan filters CP4422EV | Rinse in clean water; use mild soap and water solution if X
oily. Cleaning the Chromapulse Fan Filters (see
"Replacing/ Cleaning the Chromapulse CP4422EV Fan
Filters" on page 439)

Filter/ Regulator Replace filters Oil removal filter - replace
Replacing Filter/ Regulator Filters (on page 444) every 2000 hours

Oil vapor removal filter -
replace every 12 months

CLEANING THE VISION PROCESSOR FILTER

The filter for the vision processor should be cleaned once a month for best results. The filter is
located underneath the user interface cabinet. Replace with a new filter when necessary.

*»*» Note: You may need to clean the filters weekly depending on plant conditions

» To clean the filter:
1. With your fingers, pull down the front of the grate [item 2]. The grate is hinged, and
opens wide enough to remove the filter.
2. Remove the filter [item 1] and clean it.
= [f the filter contains dry dust and dirt, rinse it in plain water
= |f the filter contains oily dust and dirt, clean it in soapy water, then rinse in clear water

3. Dry the filter completely, then place it back underneath the user interface cabinet.
4. Push the grate closed.
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1 Part number 66621 - filter for vision processor

2 Grate to hold filter in place

REPLACING/ CLEANING THE CHROMAPULSE
CP4422EV FAN FILTERS

We recommend that you replace the filters once a month, using the part number listed below.

If you do not have replacement filters, clean them once per month. Remove the covers to
access the filters.

= [f the filter contains only dry dust and dirt, rinse it in plain water

= [fit contains oily dust and dirt, clean it in soapy water

CHROMAPULSE)

e
\J
To replace a filter, use the part number listed below:
Part Number Description
1 66446 Replacement filter element (same part number is

used in both locations)

CLEANING OPTICAL SURFACES

0 Important

Debris and contamination could build up on both the glass and plastic surfaces. This dirt could
appear in the inspection windows, causing false rejects of parts, or it could degrade lighting.
Clean glass and plastic surfaces often to avoid false rejects.
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To maintain proper image quality and system performance, the clear glass and plastic surfaces
on the Inspection Modules must be cleaned on a regular basis. Dirt and debris that appear in
the image can cause false rejects. An oily film on optical surfaces can cause false rejects or
missed defects.

CLEANING GLASS SURFACES

Glass surfaces that may require cleaning are:
e CameraLens

e Beam Splitter (if present)

e Secondary lens (if present)

e Secondary mirror (if present)

» To clean glass surfaces:

e Blow off dust with canned, compressed air

e Use a clean non-abrasive cloth dampened with lens cleaning solution

e Use lens tissue and lens cleaning solution on camera lenses

e If surface has compound on it, first clean with alcohol, then with lens cleaning solution

** Note: Cleaning frequency will depend on plant and process conditions.

CLEANING THE CHROMAPULSE BEAM SPLITTER

You must remove the Beam Splitter (on some Chromapulse models) to access the bottom side
for cleaning. The method for removing the beam splitter depends on your inspection module.

In the illustration below, item A is used in preform sidewall endcap (PSE) modules. Item B is
used in seal surface modules and some Chromapulse modules (example: CP750EV, CP1200EV,
and more).

1 Beam Splitter
2 Screws
3 Retaining plates
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> To clean beam splitter:

1. Raise the camera (see "Cleaning the Camera Lens" on page 441) if necessary. Be sure to
note the camera position before moving it.
2. Loosen the screws [item 2] and carefully remove the beam splitter.

= [tem A has four screws. Slide the retaining plates [item 3] to the sides and remove the
beam splitter.
= [tem B has two screws. Loosen the screws to remove the beam splitter.
3. Clean the beam splitter [item 1].
= Blow off dust from beam splitter with canned, compressed air.
= Clean the glass (see "Cleaning Glass Surfaces" on page 440) on the beam splitter.
4. Replace the beam splitter assembly.

= [tem A - Replace the beam splitter with the reflective side to the outside. Slide the
retaining plates back in plates and tighten the screws.

= [tem B - Replace the beam splitter with glass to the inside. Tighten the screws.

CLEANING THE CAMERA LENS

L_—— Caution
Do not touch the lens with fingers or oily cloths.

» To clean the camera lens:

1. Raise the camera to access the lens by loosening the height adjustment screw. The
clamping bracket should remain in place.

2. Clean all camera lenses with lens tissue and lens cleaning fluid. Be careful not to alter the
focus or aperture of the cameras.

3. Slide the camera back into position as marked by the clamping bracket.

4. Tighten the height adjustment screw

5. Re-adjust aperture and focus if needed.

1 [ Camera height adjustment screw

2 | Clamping bracket - camera height reference
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CLEANING PLASTIC SURFACES

Plastic surfaces that may require cleaning are:
e Dome Light Diffuser

e Ring Light Diffuser

e Light Shield (if present)

e Beam Splitter Diffuser (if present)

«*» Note: Cleaning frequency will depend on plant and process conditions.

» To clean plastic surfaces:

Do Do Not

Use canned compressed air to blow away dust Do not wipe away dirt as plastic coating may be
scratched

Use a clean, non-abrasive cloth dampened with mild Do not use paper towels or paper napkins — these may

soap and water solution. Saturate surface completely scratch surfaces
to let particles wash away.

Dry the surface with clean, compressed air

CLEANING THE ELLIPSOIDAL MIRROR

This mirror provides the enhanced neck image for optimal inspection of the neck of a can.

£L__—_\ Warning
The special surface of the mirror can be easily scratched. Take special precautions and do not
touch the surface of the mirror.

«» Note: This mirror does not require periodic cleaning. Contact Pressco Service if the mirror
has dirt or marks that cannot be blown off with clean, compressed air.

In most systems, the mirror has a built-in air cleaning system. Air is blown through the module
to keep dust and debris off the mirror and out of the module. There are no bottom shields on
these modules. You do not have to clean the mirror in these modules.

CLEANING THE PART DETECTOR

Your system will be equipped with either a part detector or proximity sensor, depending on
your application. The proximity sensor does not use a reflector. However, the cleaning
procedure for either of these types of sensors is similar.

The part detect sensor and reflector surfaces of the part detector must remain clean to
properly detect parts. Clean these surfaces regularly to prevent dirt and oil build-up.
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> Toclean the part detector:

e C(Clean the part detector surfaces with a soft, clean, lint-free cloth dampened with a mild
soap and water solution.

e C(Clean the sensors on both sides of the conveyor.

e Do not use a glass cleaning solution or strong solvent on the plastic surfaces as they might
be damaged.

7

** Note: The frequency of cleaning will depend on plant and process conditions.

CLEANING THE PART DETECTOR AND REFLECTOR

The part detect sensor and reflector surfaces of the part detector must remain clean to
properly detect parts. Clean these surfaces regularly to prevent dirt and oil build-up.

Clean the part detector surfaces with a soft, clean, lint-free cloth dampened with a mild soap
and water solution. Do not use a glass cleaning solution or strong solvent on the plastic
surfaces as they might be damaged.

The frequency of cleaning will depend on plant and process conditions.

S—
o]

AR
(¢

1 | Part detect reflector

2 | Part detect sensor
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REPLACING FILTER/ REGULATOR FILTERS

The filter/ regulator assembly shown below is installed with CP4422EV inspection modules.

1 66290

1 Filter/ regulator. No filter change necessary.
2 Filter oil coalescing
3 Filter oil vapor

Use the following part numbers and replace as indicated:

Pressco part Description Use in item Replacement frequency
number number (above)

67620 Filter element oil removal 2 Every 2000 hours

67621 Filter element oil vapor removal 3 Every 12 months

67622 Kit (contains one each of 67620 and 67621)

You may find it easier to replace both
of these filters at the same time
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Chapter 18
DEFECT DATABASE TOOL (OPTION)

**» Note: the Defect Database tool is an optional feature. To purchase this feature, please
contact your Pressco Sales Manager. Additional hardware may be required, depending on
your system. How to Contact Pressco (on page 481).

The Series V Intellispec system is capable of archiving data associated with defective parts. The
archiving of this data may be enabled or disabled. The defect data collected includes
information related to the part program, lanes, inspections, sensors and correlated machine
parts. The information can be from any type of sensor - camera, x-ray, mass, etc. The Defect
Database tool allows you to search, view, and report defect information.

This information is valid as of 5.0.491/ 5.2.022/ 5.3.004 software.

What is the Defect Database?

The Defect Database is a tool within the Intellispec system that uses a separate hard drive used
to archive information associated with rejected parts. This tool has two components:

e The Defect Data File that contains images of parts that have been rejected, and

e The Defect Database that stores defect information for each part that has been rejected.

Defect Database Specifications and Limitations
e The Defect Database is an option and therefore has to be part of the original install, or
purchased as an upgrade.
e Aseparate hard drive is installed to support this database. A minimum 500GB hard drive is
recommended.
= |f your system has a part number 70315 or higher, then it is hardware-ready. This
means that the system has the hardware capable of running the Defect Database.
= |f your system has a part number below 70315, then additional hardware (hard drive
and possibly memory) may be required. Contact Pressco.
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e The Defect Database is maintenance-free.

e Aseparate database is created for each lane. You must enable the Defect Database
individually for each lane.

e The Defect Database supports up to 500,000 records for each lane.

e The number of images available depends on the size of the Defect DB hard drive installed.
You can see this information on the Intellispec screen on your system. (see example below)
This total number of images is shared between all lanes. As defect images are written
first-come first-served, more images are stored for a lane with a higher number of defects.

e There may be more records for all lanes than available image space. Therefore the oldest
records may have no valid image associated.

e We cannot guarantee that all records and all images are saved because of memory
constraints and available time for writing images to a hard drive.

e The Defect Database is designed to limit interference with the inspection system. This
means that under high system load data may not be recorded as the database has to yield
to the inspection system.

e The Defect Database file size is fixed. The entire hard drive space is allocated upon initial
setup. When the database reaches its maximum number of records or images, it overwrites
the oldest information.

e Example file size and number of images available:

Defect Recording Configuration

Enable Defect Recording
Ready

Space available in data file: 442.34 GB
Max number of 640x480 images: 1545312.
Max number of 1360x1024 images: 341009.

Enable Defect Database (Lane)

20

Note the following about the Defect Database

The information below refers to content you can find by using the Defect Database Viewer (on

page 453).

o Defect images can be accessed from the Defect Database by looking at details of a search
result record.

e You can create defect rate reports over a time span for any or all part programs.
e You can search the database by criteria including:
= Part program
= Sensor
= Inspection (your name for the inspection, such as "Find Center")
= Inspection type (Intellispec inspection type, such as "Contrast")
= Sets of machine parts (such as "Cavity 3 through 10" or "Spindle 1 through 100")
= Time span of calendar dates and clock times
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PREPARING THE DATABASE

«»*» Note: the Pressco installer will configure your database upon installation if you have
purchased this option with your system. However, if you purchase this option as an
upgrade, you may need to configure the database as described below.

N

» What you need:

e A dongle with the Defect Database feature enabled (provided with the purchase of the
feature).

e Ahard drive labeled “Defect DB” The size of the hard drive determines the number of
images that can be stored. (At least 500 GB of storage is recommended, more if you are
using cameras of resolutions higher than 640x480). Name the hard drive "Defect DB" using
the Computer or Windows Explorer on the Intellispec system. The drive letter does not
matter. Make sure to use the exact capitalization and spacing as shown.

4 8 Computer
& Main (C:)
ca Backup (E)
» __a Defect DB (G:)

Enabling Defect Recording versus Defect Database

Enabling Defect Recording will start saving images to the Defect Data File, which can be
accessed by using the Defect Data (Images) Viewer (on page 452). You can disable Defect
Recording (recording of images and data of non-image type sensors) for each lane individually.
However, in order to enable the Defect Database that stores defect information for each part
that has been rejected, Defect Recording must be enabled. Enabling the searchable Defect
Database is described next.

> To see whether the Defect Database is already enabled:

1. From Lane Overview or Sensor Overview mode, click the Tools button to see the tools
menu.

2. Select Lane Setup > Defect Recording Configuration. The configuration menu is displayed.
(This menu is only available when you have the configured dongle and hard drive as
described above)

Defect Recording Configuration
Enable Defect Recording

Ready

Space available in data file: 442.34 GB
Max number of 640x480 images: 1545312.
Max number of 1360x1024 images: 341009.

Enable Defect Database (Lane)

20
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= |f "Preparation Required” is displayed, then you need to set up the Defect Database; see
below. Otherwise, if any box is unchecked you can enable the option by checking it. You
can only check “Enable Defect Database (Lane)” if “Enable Defect Recording” is
already checked.

= If both boxes are checked, then the Defect Database is ready to use.

First, prepare the hard drive for defect recording.

» To prepare the hard drive:

¥ Warning
When you complete these steps, all information from the Defect DB hard drive is deleted. This
action cannot be undone.

1. From the Intellispec application, go to Lane Overview or Sensor Overview mode and click
the Tools button to see the tools menu.

2. Select Lane Setup > Defect Recording Configuration. The configuration menu is displayed.
It should indicate that preparation is required.

Defect Recording Configuration

O Enable Defect Recording

Preparation Required

J

Defect Recording Required

20

3. Check the Enable Defect Recording box. A message will explain that the Intellispec
system will delete everything from the hard drive that it recognizes as "Defect DB."

Prepare Defect Data Recording

The system needs to delete all existing data on the

defect database drive. This action can't be undone.

You will be asked for confirmation before any action
will be taken.

Pre})are Hard Drive

(X

)
4. Click the Prepare Hard Drive button. As a safety precaution, the system asks you to type
the word "DELETE" before it prepares the hard drive.
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5. If you are sure that you want all information deleted from the "Defect DB" hard drive,
type DELETE in all capital letters on the displayed keyboard, then click the OK button.

Prepare Hard Drive N

Please type DELETE to confirm deleting all data on drive G:\

20

6. The hard drive is prepared. A message indicating the space available on your hard drive is
displayed. Click the OK button to continue.

Intellispec

, 0’ Drive G:\was prepared for use with the defect
database.
Space available in data file: 442.34 GB
Max numberof640x480 images: 1545312
Max numberof 1360x1024 images: 341009

9

The configuration menu is displayed, showing that Defect Recording has been enabled.

Defect Recording Configuration

Enable Defect Recording
Ready

Space available in data file: 442.34 GB

Max number of 640x480 images: 1545312.

Max number of 1360x1024 images: 341009.
G Enable Defect Database (Lane)
Preparation Required

20
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> To enable the Defect Database:

. ¥ Warning
If you are upgrading from a system with software earlier than 5.0.480 that was already using
the Defect Database, then the entire old database will be erased. This action cannot be
undone.

1. If you are not already viewing the Defect Recording Configuration menu, go to Lane
Overview or Sensor Overview mode, then click the Tools button, then select Lane Setup >
Defect Recording Configuration.

2. Inthe Defect Recording Configuration menu, check the Enable Defect Database (Lane)
box. Your system may be configured with more than one lane. You must enable the
Defect Database for each lane separately. The system displays a message stating that it
will prepare the database for the lane.

Prepare Defect Database

The system needs to delete the old defect database
for all lanes. This action can’t be undone. You will be
asked for confirmation before any action will be
taken.

(X

- |

3. Click the Start button to continue. As a safety precaution, the system asks you to type the
word "DELETE" before it prepares the hard drive.

4. If you are sure that you want all information deleted from the "Defect DB" hard drive,
type DELETE in all capital letters on the displayed keyboard, then click the OK button. The
system prepares the hard drive.

Prepare Hard Drive
Please type DELETE to confirm deleting all data on drive G:\

20
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5. The Defect Recording Configuration menu is displayed, showing that the Defect Database
is enabled. Click the OK button to exit.

Defect Recording Configuration

Enable Defect Recording
Ready

Space available in data file: 442.34 GB
Max number of 640x480 images: 1545312.
Max number of 1360x1024 images: 341009.

Enable Defect Database (Lane)

20

The Defect Database is ready to use on the lane on which it was enabled. The database will
record defects and images each time you put the lane online.

> To enable the Defect Database on additional lanes:

1. Navigate to the other lane for which you want to enable the defect database.

2. Click the Tools button to see the tools menu and select Lane Setup > Defect Recording
Configuration. The configuration menu is displayed, showing whether the defect
database is enabled for the lane.

3. To enable Defect Recording (the recording of images and non-image sensor data), click
the Enabled Defect Recording box. The system will show that the hard drive is ready and
display the amount of space available.

«»» Note: once the hard drive is prepared initially, you do not need to prepare it again for
additional lanes.

4. Click the Enable Defect Database (Lane) box. The database is enabled for the current
lane. No further hard drive preparation is necessary.
5. Click the OK button to save changes and exit.

SAVING ITEMS TO THE DATABASE

To save items to the database, the database must first be enabled. See Preparing the
Database (on page 447).

Each time you put a lane online, the Intellispec saves defect information and images to the
database. The defect database for each lane has a fixed number of 500,000 records, and once
this number is reached the oldest records will be overwritten with the newest ones.

¢ Note: when the database is prepared, the entire hard drive space is used, so the "Defect
DB" hard drive will appear full. The Defect Database Tool places images and defect
information into the database, using allocated placeholders in the database. You will not be
able to tell whether the database is full by looking at hard drive space.
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DEFECT DATA (IMAGES) VIEWER

The defect data viewer is an auxiliary tool that allows access to the contents of the Defect Data
File, which is a very large file containing image data and data of non-image sensors, such as
Mass. This tool is not part of the defect database but provided for your convenience.

> To open the Defect Data Viewer:

From Lane Overview or Sensor Overview mode, click the Tools button , and select
Reporting > Defect Data Viewer. The Defect Data File Viewer and Extractor screen is displayed.

Defect Data File Viewer and Extractor

Filter

Lane  Rectangular (1) I

Sensor Camera 1 'J

Part Program Master Rec Food Can \j J

From: |2/12/2013 [11:41

To: |2/12/2013 [11:44

Step 89 of 89

‘2/12/2013 11:44:34 AM
Grayscale Camera 640 x 480

Extractto Files

Number of Files ‘89
Available ltems 89

LatestFirst yJ

C:\Pressco\DataExportimages v J .

C:\Pressco\DataE xport\imag TWM: Rec Food Can @

If the lane was online when you opened the viewer, the database will continue to collect defect
data and images. However, the information in the viewer reflects only the data as of the time
you opened the viewer. To see more recent data, you must close and re-open the Defect Data
Viewer.

Filtering images

In the upper part of the menu, you can filter the images you want from the database. Choose
from lane, sensor, part program, and date range. This affects the list of images available to
view on the right of the menu, as well as the images you may export from the lower part of the
menu.

Viewing defect images

Images are displayed on the right side of the viewer. Use the buttons below the image to scroll
through the available images.

Extracting images

In the lower part of the menu, you can extract images from the database for use in another
location or during part program setup. The images available for extracting are determined by
the filter settings in the upper menu.
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» To extract images:

1. Enter the Number of Files if you want to save a different number of images than the
available items.

2. Click the disk icon l]] to change the location to which to extract the images, and browse
to the desired location.
3. Click the Extract button to save the selected images.

DEFECT DATABASE VIEWER

This tool allows you to:

e Search the defect database

e Examine and export images of defects

e Export search results, and

e Create and export defect rate reports from the database.

> To open the Defect Database Viewer:

From Lane Overview or Sensor Overview mode, click the Tools button and select
Reporting > Defect Database. The Defect Database Viewer is displayed.

In the upper right corner, a Snapshot time is displayed. This is the time when you entered this
menu. If the lane is online, the Intellispec keeps saving defect data and images, but any data
collected while this window is open will not be available for searching. You can close and
re-open the menu for the most recent data.

The name of the Lane (Rectangular, in our example) is the name of the Lane selected.

Reports

The Reports tab allows you to view reports by minute, hour, or day. You can choose from all or
a single part program. A date/time range picker is provided to limit the report to a specific
period. The Quick Select drop-down menu allows you to choose a time period of the last 24
hours, today's data (until the snapshot time), or all available data.

Rectangular Defect Database Viewer

(o [ oo JNCoomorenne )

Snapshot Time:6/17/2013 9:58.22 AM

Time Step  Hour Y
[Part Program Al v

me:.Thursda)f. June 13, 2013 118

To: |Friday, June 14, 2013 =

Q Whale Day Quick Select v
IF View Report

@

Click the View Report button to see the report from the selected criteria.
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The example below shows a report with a time step of one minute. Use the buttons on the

right side of the window to page through the reports.
r
Defect Report

Defect Report

Lane= Circular Cans; Part Program= All

250

200
.\il
150
]
o
100 \
50
) /
0 1
214 1128 1129 1130 1131 1132 1133 113 1135 1136 1137
1127 AM AM AM AM AM AM AM AM AM AM
AM

2.00

0.00

214 1128 1129 1130 1131 1132 1133 1134 1135 1136 1137
1127 AM AM AM AM AM AM AM AM AM AM
AM

Lane= Circular Cans; Parnt Program= All

Date

2/14/2013 Thursday

21417013 Thursdaw
‘

11:27:00 AM 99 26 26.26
11-28-00 AM 203 41 7020
M

File does notexist.

| Export

Report.pt
C:\Pressco\DataExporf\

()

Printing the report

Click the Preview button to enable the print function. A print preview is displayed. Use the
Print button to print the report to the configured printer. (For more information, see Setting

up a printer (on page 144))
Saving the report to file

If you have not yet saved any reports, then a message stating "File Does Not Exist" is displayed

below the disk icon.

» Tosave a new report:

1.
2.

Click the disk icon . The Select File window is displayed.

If desired, use the disk icon in the Select File window to browse to a different location on
the hard drive, or a USB drive. Browse to the desired location and click the OK button to
continue.

Click the New button in the Select File menu to create a new report file name. The
onscreen keyboard is displayed.
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4. Type the report name, and click the OK button to continue. A file is created at
C:\Pressco\DataExport (or another location that you selected in step 2) but no data is

saved yet.

5. Click the Export button from the Defect Report window. The report is saved as a text
(.txt) file and the file name contains lane, time interval, and time stamp information. You
can use this data in your own spreadsheets or other databases to chart your plant's

defect data.

» Tosave new data to an existing report name:

You can use an existing report name to save more data to a new file. The last used report name

is displayed under the Export button.

Click the Export button to save new data. The report is saved as a new text (.txt) file. The file
name contains lane, time interval, and time stamp information. You can use this data in your
own spreadsheets or other databases to chart your plant's defect data.

Exported Report Example

The file below is an example of a text file exported from the Defect Database. The file is
tab-separated, and you can import it into your preferred reporting software. The header
describes the contents in detail. The header text and all number and time formatting depend

on the currently chosen language.

File Edit Format View Help

Number of defects found in processed parts during the record’'s time interval and while using t

The start of the record's time interval, given in number of seconds since 1/1/2012 12:00:00 AM.

e sel

# Number of Comment Lines=23

# Separator=Tab

#

# Column Descriptions -

# Row The running number of the record. : i

# weekday The weekday of the start of the record's time interval.

# Date The date part of the start of the record’'s time interval.

# Time The time part of the start of the record’'s time interval. X "

# Part zrogram Each part program that was loaded and reported defects during the record's time interval.
# seconds

# Pa;ts Number of parts processed during the record’s time interval and while using the selected part ﬁrogra
# pefects

# pefect % The ratio of defects to parts, in percent.

#

# parameters

#p Lane Lane 1

#p Part Program All

#p From: Friday, June 21, 2013 12:00:00 Am

#p To: Saturday, June 22, 2013 12:00:00 AM
#p Snapshot Time Friday, June 21, 2013 4:16:53 PM
#p Time Step one Minute

#p Report Creation Time Friday, June 21, 2013 4:17:31 PM

#

Row weekday Date Time Part Program

1 “Friday" 6/21/2013 10:49:00 "FHCP3X Master”

2 "Friday"” 6/21/2013 10:50:00 "FHCP3X Master"”

3 "Friday" 6/21/2013 15:11:00 "FHCP3X Master"”

4 "Friday" 6/21/2013 15:12:00 "FHCP3X Master”

5 "Friday" 6/21/2013 15:13:00 "FHCP3X Master”

6 "Friday"” 6/21/2013 16:14:00 "FHCP3X Master”

7 "Friday” 6/21/2013 16:15:00 "FHCP3X 5.2 testing”

8 "Friday"” 6/21/2013 16:15:00 "FHCP3X 5.2 testing - enhancements”

9 "Friday"” 6/21/2013 16:16:00 "FHCP3X 5.2 testing - enhancements”
10 "Friday” 6/21/2013 16:16:00 "FHCP3X Master”

Seconds parts Defects Defect ¥
46435740 1 1 100.00
46435800 44 4 9.09
46451460 170 23 13.53
46451520 428 63 14.72
46451580 141 23 16.31
46455240 32 6 18.75
46455300 126 110 87.30
46455300 119 119 100.00
46455360 9 9 100.00
46455360 271 39 14.39
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Search

The Search tab allows you to search the database by part program, sensor, inspection,

inspection type, date, time, and machine part.

Lane 1 Defect Database Viewer

Search r_Search Results

Snapshot Time:8/21/2013 3:11:55 PM

PariProgram  FHCP3X Masier 'l

Machine Parts

Sensor Al ¥ l FILLERVALVE Use Filter T (3-10)
Inspection ANl 7|
CAPPERHEAD Al v
ekl

From: Thursday, June 20, 2013 [ 15:12:11

To: | Friday, June 21, 2013 | 151211

Q Whale Day Quick Select Y
@

©

> To start the search:

1. Choose the desired filters from the available options.
2. Click the Search button. The search may take a few seconds depending on the search
criterion and the size of the database. Afterwards, the Search Results tab is automatically

selected.

If your system uses machine parts, you have the option of searching for defects by machine

part.

» To search by Machine Part:

1. Check the box next to "Machine Parts" to enable the search filters.
2. If you want to search by all machine parts, leave the drop-down menu at "All."

Use Filter Y (7-9,14,31)
All
Use Filter

\ Edit Filter ... /
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3. To select specific machine parts, select "Use Filter" in the drop-down menu. The Select
Machine Parts screen is displayed.

Select Machine Parts

Available Selected

@~ O vk W R =

(Empty)

20

4. Select a machine part number in the "Available" column. Click the right arrow button to
move that machine part number to the "Selected" column.

a) To select additional machine parts, select each machine part, then click the right arrow
button to move each into the "Selected" column.

b) To select contiguously listed machine parts, select the first desired machine part, then
click the Mark Range button. Select the last listed machine part you want to search for.
The system selects all machine parts between the first and last machine part you
selected. Click the right arrow button to move all those machine parts to the "Selected"
column.

5. To de-select any machine part, highlight it in the "Selected" column, then click the left
arrow button to move it to the "Available" column. Use the Mark Range feature to select
a group of contiguously listed machine parts.

6. All selected machine parts are listed below the "Selected" column. Click the OK button to
save changes and exit. The selected machine parts are also displayed in the Defect
Database Viewer Search screen.

7. Inthe Defect Database Viewer Search tab, an "Edit Filter" option is added to the
drop-down menu. You can change the list of machine parts to search using the "Edit
Filter" option.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Defect Database Tool (option) 457
© 2013 Pressco Technology Inc. Proprietary



Search Results

After performing a search, the Search Results tab is automatically selected. Defect data
returned as search results is presented within the grid. Each row represents an inspection
associated with a defective part based on the search criteria. Each column represents specific
information about the inspection (for example, part program, inspection name, sensor, status,
time stamp, etc.). Use the scroll bars to see data from a specific time period.

Lane 1 Defect Database Viewer
F F f
)
Snapshot Time:6/18/2013 3:31:12 PM
-
6182013 104123 A FHCP3XMaster  Color 1 Cap HeightRight  Distance 132 24 = ﬂ
BME2013 10:41:23 AM  FHCPIX Master Color 1 Cap Height Left Distance 132 24
GAR2012 10:41:23 AM - FHCP3X Master Color 1 Cap Height Right Distance: 134 26
6182013 104124 AM  FHCP3XMaster  Cokr1  CapHeightRight  Distance 138 2
GR2013 10:41:24 AM FHCPIX Master Color 1 Cap Height Left Distance 135 27 “
6182013104125 A FHCP3XMaster  Main  CapHelightRight  Distance 142 34
BME2013 10:41:27 AM FHCPIX Master Main Fill Height Fill Height - Segmented 16 18 =l
682013 104127 AM  FHOP3X Master  Main  Fill Height Fil Hoight - Segmented 16 18 i
BN82013 10:41:27 AM - FHCP3X Master Color 1 Cap Height Left Distance 18 18 g
GAR2013 10:41:27 AM FHCPIX Master Color 1 Cap Height Right Distance 18 18
BI82013 10:41:27T AM  FHCP3X Master  Color 1 Tamperband Feature Detect 18 18
BME2013 10:41:27 AM FHCPIX Master Color 1 Tamperband Feature Detect 18 18
GAS2012 10:41:30 AM - FHCP3X Master Color 2 Cap Height Left Distance: 34 34
682013 10:41:30 AM - FHCP3X Master Color 2 Cap Height Right Distance 39 3
GMR2013 10:41:30 AM  FHCPIX Master Color 2 Cap Height Left Distance as a
BBE012 104131 AM  FHOP3X Master  Color | Cap Helght Fight  Distance 40 4 =
" —

o ®

Elapsed Time [seconds]: 0.428

Scrolling through the data

Click the scroll bar to the immediate right of the grid to scroll to a specific record. Labels
appear indicating the time stamps that will be scrolled to when moving the button next to the
label. Note that the labels are spaced by records not by time.

Lane 1 Defect Database Viewer

= =
| Reports | || | Search Results
| Snapshot Time:6/18/2013 3:54:54 PM
s

BAB2013 11:28:26 AM  FHCP3X Master  Color2  Cap Helght Left Distance 7o 34 6/18/2013 9:24:54
EN82013 112026 AM  FHCP3X Master Cokw2  Tamperband Feature Detect 70 34
6182013 112826 AM  FHCP3X Master  Color2  Tamperband Feature Detect 7o 34
BM1B2013 11:20:26 AM  FHCP3X Master  Color 1 Cap Height Left Distance T3 1
E82013 11:20:26 AM  FHCPIX Master Color 1 Cap Height Right Distance 73 1
1

PIX Master Color 1 Tamperband Feature Detect T3

E182013 112026 AM FHY

PIXMaster  Colr 1 Cap Height Right  Distance 85 23

BN82013 112020 AM FHCP3X Master  Color 1 Cap Height Left Distance a5 23
82013 11:28:20 AM FHCP3aX Master  Main Fill Height Fill Height - Segmented 86 24
BAB2013 112820 AM - FHOP3X Master  Maln Fill Helght Fil Hedght - Segmented 96 24
E82013 112020 AM FHCP3X Master Cokw 2  Cap Height Right Distance ar 25
G82013 112829 AM  FHCP3X Master  Color2  Cap Height Left Distance 7 25
GN82013 11:20:30 AM - FHCP3X Master  Colr2  Cap Height Right Distance 102 30
182013 11:28:30 AM FHCP3aX Master  Cokr 2 Cap Height Left Distance 102 a0

G182013 11:25:31 AM  FHCP3X Master  Color 1 Cap Height Right  Distance o7 35

i
:
o ®

Elapsed Time [seconds]: 0.561
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For larger data sets (more than about 160 records) a second scrollbar “Data Zoom” appears to
the right of the first scroll bar. This allows narrowing in on the time of interest. While moving
the Data Zoom scroll bar two thick lines appear in the first scroll bar, which indicate the time
span to which scrolling will be restricted. Labels indicate the times of the first and last record of
the search result; the first and last record of the current scroll restriction selected by Data
Zoom and of one currently displayed record. Use the first scroll bar to get closer to the desired

time and repeat the process as needed.

Lane 1 Defect Database Viewer

Snapshot Time:6/18/2013 3:54:54 PM

[Coeror JJ[ soner ]| osmona

BAB2013 11:28:26 AM  FHCP3X Master  Color2  Cap Helght Left Distance T
6182013 11:20:26 AM  FHCP3X Master  Color 2 Tamperband Feature Detect 70
GAS201311:28:26 AM FHCP3X Master  Color 2 Tamperband Feature Detect 70
GN82013 112026 AM FHCP3X Master  Color 1 Cap Height Left Distance 73
E82013 11:20:26 AM  FHCPIX Master Color 1 Cap Height Right Distance 73

F3X Master

Tamperband Feature Detect

E/182013 11:20:26 AM —— S——r
0 Color 1 Cap Height Right

— w— HCP3X Master Distance a5
BN82013 112020 AM FHCP3X Master  Color 1 Cap Height Left Distance a5
BNB2013 11:28:20 AM  FHCPAX Master  Main Fill Height Fill Height - Segmented 86
G182013 112929 MM FHCPIX Master  Main Fill Height Fil Hedght - Segmented 96
GB2013 11:20:20 AM  FHCP3X Master  Color 2 Cap Height Right Distance ar
BA82013 11:28:20 AM  FHCP3X Master  Color 2 Cap Height Left Distance a7
GNB2013 112030 AM - FHCP3X Master  Color 2 Cap Height Right Distance 102
EN82013 11:28:30 AM  FHCP3X Master  Color 2 Caap Height Left Distance 102
GNB2013 11:26:31 AM - FHOP3X Master  Color 1 Cap Height Right  Distance: o7

34 GI182013 S:24:54

34
34
1
1
1

BIEZ013 11:10:28 AM

BITEZ013 11:20:26 AM

23
23
24
24
25
25
30
a0

35

EI1E2013 11:48:20 AM

woog eeg

r Details M Export

Elapsed Time [seconds]: 0.561

@

Viewing result details

Click the Details button for a highlighted item to view the Record Details. This window displays
the associated image and inspection information. It also allows you to export the image. The
Full Size button brings up a viewer showing the unscaled image in full resolution (screen
resolution may restrict this for images of very high resolution).

Record Details

Time Stamp 6/18/2013 9:42:52 AM Time Stamp
Sensor Color 2 Sensor
PantProgram FHCP3X Master Part Program
Inspection Cap Height Right Inspection

Record Details

TN7/2013 4:02:18 PM
352345
XRAY_1

Compare

Color Camera 640 x 480
Distance Too Large

i Full Size

CAPressco\DataE [ Seve Image

C:\Pressco\DataExporimages

@

or

550

M Full Size
APressco\Datal fx @
e e e " Save Sensor Data

C:\Pressco\DataExporimages

Tap Tone Sensor

Q Diagnastic Details

@

¢ Note: The details viewer will not always show a specific text such as “Distance too Large.”
This depends on the type of inspection and the specific type of defect.
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Exporting the results

» To export the results:

1. Click the Export button at the bottom of the Defect Database Viewer Search Results
screen. The Export Search Results window is displayed.

Export Search Results

Ci\Pressco\DataExport w |

More Search Results. txt
Search Results txt

= txt
XX

2. If desired, use the disk icon to browse to a different location on the hard drive or a USB
drive. Browse to the desired location and click the OK button to continue.

3. Select an existing file from the displayed box, or click the New button to create a new
report file name.

4. (If creating a new file) In the on-screen keyboard type a file name, and click the OK button
to continue. A file is created at the location displayed in the drop-down but no data is
saved yet. Highlight the new file as in step 3.

5. Click the OK button. The search results are saved as a text (.txt) file. You can use this data
in your own spreadsheets or other databases to chart your plant's defect data. Exported
Search Results Example (on page 461).
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Exported Search Results Example

The file below is an example of a text file exported from the Defect Database after using the
Search feature. The file is tab-separated, and you can import it into your preferred reporting
software. The header describes the contents in detail. The header text and all number and
time formatting depend on the currently chosen language.

Home Insert Page Layout Formulas Data Review View Acrobat

A B c D E F G
1 |# Number of Comment Lines=21 I
2 #Separator=Tab
3 %
4 #Column Descriptions
5 #Time Stamp The time at which the part was inspected.
6 #Part Program The part program that was running while the part was inspected.
7 #Sensor The sensor for which the defect was recorded.
3 #Inspection The name of the inspection that failed.
9 #Inspection Type The type of the inspection that failed.
10 #FILLER VALVE Machine Part 1
11 # CAPPER HEAD Machine Part 2
12 #
13 # Parameters
14 #p From: Thursday, June 13, 2013 11:18:36 AM
15 #p To: Monday, June 24, 2013 12:00:56 PM
16 #p Snapshot Time Monday, June 24, 2013 1:53:13 PM
17 #p Lane Lane 1
12 #p Part Programs FHCP3X Master
19 #p Inspections All
20 #p Inspection Types all
21 #
22 Time Stamp Part Program Sensor  Inspection Inspection Type FILLER VALVE CAPPER HEAD
23 6/17/2013 13:22 FHCP3X Master Colorl  Tamperband Feature Detect 84 12
24 6/17/2013 13:22 FHCP3X Master Colorl  Tamperband Feature Detect 84 12
25 6/17/2013 13:22 FHCP3X Master Colorl CapHeight Left Distance 84 12
26 6/17/2013 13:22 FHCP3X Master Colorl CapHeight Right Distance B84 12
27 6/17/2013 13:22 FHCP3X Master Color2 CapHeight Left Distance 97 25
28 6/17/2013 13:22 FHCP3X Master Color2  Cap Height Right Distance 97 25
29 6/17/2013 13:22 FHCP3X Master Color2 CapHeight Left Distance 102 30
30 6/17/2013 13:22 FHCP3X Master Color2  Cap Height Right Distance 102 30
31 6/17/2013 13:22 FHCP3X Master Colorl CapHeight Left Distance 106 34
32 6/17/2013 13:22 FHCP3X Master Colorl CapHeight Right Distance 106 34
33 6/17/2013 13:22 FHCP3X Master Main Cap Height Right Distance 108 EL
34 6/17/2013 13:22 FHCP3X Master Colorl CapHeight Left Distance 118 10
35 6/17/2013 13:22 FHCP3X Master Colorl  CapHeight Right Distance 118 10
36 6/17/2013 13:22 FHCP3X Master Main Fill Height Fill Height - Segmented 126 18
7 6/17/2013 13:22 FHCP3X Master Main Fill Height Fill Height - Segmented 126 18
38 6/17/2013 13:22 FHCP3X Master Colorl CapReg Finish Location 1 1
39 6/17/2013 13:22 FHCP3X Master Main Fill Height Fill Height - Segmented 10 10
40 6/17/2013 13:22 FHCP3X Master Main Fill Height Fill Height - Segmented 10 10
41 6/17/2013 13:22 FHCP3X Master Colorl CapHeight Left Distance 11 11
42 6/17/2013 13:22 FHCP3X Master Colorl  CapHeight Right Distance 11 11
W 4 + W| Results June 24 04 70 o | m
Ready

Abnormal Results

Sometimes you may see results in the database that do not show defect data. These are rare
situations, but can be caused by high part rates, high defect rates, or a heavy processor load on
the system. You may also have less space for images in the defect data file than the total
number of defect database records over all lanes, so images in the defect data file may already
have been overwritten for the oldest records in the defect database.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01) Defect Database Tool (option) 461
© 2013 Pressco Technology Inc. Proprietary



Stale Data

This happens when the real time processor was busy for too long while the image was pending
a write to the hard drive. This condition may happen when there is a high defect rate and a
high load on the system. In this case the record exists in the database but the image is not valid
because it was never written in the first place.

Record Details
Stale Data

Time Stamp 7118/2013 4:05:37 PM
Sensor Main

PantProgram FHCP3X 5.2 testing - enhancements

Inspection Fill Height - Segmented

Grayscale Camera 1228 x 924

@@

Recycled Data
This happens for the oldest records in the defect database when their images in the defect
data file have been overwritten.

Record Details

S Data not Availab

(may be recycled)

Time Stamp TINTI2013 3:24:15PM

Sensor Main

ParntProgram  FHCP3X 5.2 testing - enhancements

Inspection Fill Height - Segmented

Sensor Data not Avallable (may be re

@@

Spilled Record

This happens when the defect record (not image) cannot be written to the hard drive. This may
occur if the system is too busy writing images to the hard drive. The screen will indicate how
many defect records were spilled during which time interval.
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Chapter 19
ABOUT OPC

OPC (OLE {Object Linking and Embedding} for Process Control) is a data communication
standard developed by leading manufacturing equipment and software vendors, in conjunction
with Microsoft. Its purpose is to promote interoperability between a wide variety of data
sources and the consumers of that data, eliminating the need for diverse and incompatible
“drivers” for each separate device or program.

The OPC specifications are developed and administered by the OPC Foundation:
http://www.OPCFoundation.org http://www.OPCFoundation.org

Pressco has been an OPC Foundation Member since Spring of 2004, and participated in their
Interoperability Workshop of April 2005.

THE INTELLISPEC OPC SERVER

The Pressco OPC Server for Intellispec systems supports the OPC Foundation “Data Access”
specification. It is compatible with all versions of the specification in widespread use today
(1.0a, 2.05 and 3.00). The OPC Server does not support other OPC specifications (including

Alarms & Events, Historical Data or XML Data or Unified Architecture).

The Intellispec OPC Server is an optional feature - contact (see "How to Contact Pressco" on
page 481) your Pressco sales manager for details.

Sampling rate

Sampling of data is based on an ‘update rate,” which is specific to a group of OPC data items.
There may be several groups of items, each having an update rate appropriate for the items in
that group. The maximum update rate supported by the OPC Server is 100 milliseconds (i.e. 10
updates / second); this may be less depending on the system configuration, part programs and
part rates. Note that OPC does NOT support event-driven data updates; example, every 10,000
parts inspected or every rotation of a machine part.

Defect statistics

The data items available from the Intellispec OPC Server include most inspection defect
statistics produced by the system. In particular, the following five items will be found:
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http://www.opcfoundation.org/

e TotalNumberlnspected: the number of parts inspected since last reset.
o TotalNumberDefects: the number of defective parts identified since last reset.

e TotalPercentDefects: the defective part rate expressed as a percentage of total number
inspected, since statistics were last reset.

e RecentNumberDefects: the number of defective parts over the last “N” number of parts
inspected, where “N” is a configurable system parameter.

e RecentPercentDefects: the defective part rate expressed as a percentage of the last “N”
parts inspected, where “N” is a configurable system parameter.

These data items appear repeatedly within a hierarchical (“multi-level”) structuring of the data

items and represent a variety of different subsets of the parts inspected. More specifically,

they are maintained for every lane in the system (top level), every camera or sensor within

each lane (second level) and every individual inspection within each camera (third level). Some

values are also available for correlated machine parts when the system is so configured.

The exact names of the levels containing these data items are automatically derived from the

names given to the lanes, cameras and inspections programmed into the Intellispec system.

This makes “browsing the tree” of available data items extremely intuitive and eliminates the

tedious and time-consuming process of OPC server configuration.

OPC CONFIGURATION

The OPC Configuration screen provides access and settings to the OPC server.
To access OPC Configuration:

1. Login.

2. Click the B button.
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3. Click the Tools button to see the Tools menu > select OPC Configuration. The OPC

Configuration menu opens. Please see the information about each section below.
Vs )|
OPC Configuration

Counter Setup

Use Counter Rollover Use Private Counters

@ 10000 (\ 100000 rReset Private Counters

Show 'Generic’ Node

Show 'Measurements’ Items

Show '‘Parameters’ Items

@1 x]

Refresh Interval
Not used.

Counter Setup
See Counter Rollover (on page 475) or Using the OPC Private Counters option (on page 472).

Options
"Show Alarms Node" and "Show Groups Node" are not used. "Force Upper Case" is only used
for compatibility with a specific OPC client - in most cases it is not used.

Show 'Generic' Mode
Use this to view items when inspection names or other parameters have been re-named
using non-ASCII characters. Note that everything is named generically, including sensors,
lanes, and inspections.

‘0

e Tip: This can be used by Pressco Service Engineers to view data that is not in English.

Show 'Measurements' Items
See Measurement data items (on page 470).

Show 'Parameters' Items
See Parameter data items (on page 471).
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Permissions
Reserved for Pressco Technicians only.

OPC Test Client button

Click this button to open The Intellispec OPC test client (on page 466).

THE INTELLISPEC OPC TEST CLIENT

USER LEVEL: ADMINISTRATOR

The Intellispec provides test client software to make sure that the OPC server is properly
working. It is not a fully functional software client - it is only intended to be used to verify the
functionality of the server. This is only available if your system has been configured for OPC.

> To use the OPC test client:
1. Llogin.
2. Click the a button.

3. Click the Tools button to see the Tools menu > select OPC Configuration. The OPC

Configuration menu opens.

4. Click the OPC Test Client button. The Softing OPC Toolbox Demo Client opens.
5. Click Open on the program's toolbar. The File Open dialog box is displayed.

F b
B3] Open Iﬁ
Lookin: [ J, OPC ~| e B~
= Name : Date modified Type
gy
Rme‘;ﬁaces 5 aace 9/4/20122:52PM  Softing OI
L& Ispecsystem.soc 3 10/26/2012 208 PM _ Softing Ol
| e 9/5/201211:21 AM  Softing Ol
Desktop
e
Libraries
Computer
@
Network
4 m ¢
File name: |ISpecSy51em S0C j Open
Files of type: | Softing OPC Ciient Fies (*.soc) | Cancel
A

6. Click the IspecSystem.soc file >> click Open.

466 About OPC

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary



The left pane of the demo client window should now display ‘Data Access’ at the very

top, with ‘Pressco Intellispec OPC Data Server’ below that, a group below that, and a list
of data items (all beginning with Lane.’) below the group. Each of these items (except
‘Data Access’) should have a solid green circle containing a black dot to the left of it.

rg Softing OPC Toolbox Demo Client
File Edit Session View
(B [~ =] =

X
Hew Open Save | Propeites | Delete

Stap

N FSEY =)

Connect  Start

—
T

Lanel.Main.RejecterEnabled
Lanel.Main InspectionCount
Lanel.Main. TotalNumbernspected
Lanel.Main. TotalNumberDefects
Lanel.Main.TotalPercentDefects
Lanel.Main.Recenthlumberinspected
Lanel.Main.RecenthumberDefects
Lanel.Main RecentPercentDefects
Lanel.Main MissedPartPresents
Lanel.Colorl RejecterEnabled
Lanel.Color InspectionCount
Lanel.Colorl TotalNumberlnspected
Lanel .Colorl. TotalNumberDefects
Lanel.Colorl. TotalPercentDefects
Lanel.Colorl.RecentNumberinspected
Lanel.Colorl RecentNumberDefects
Lanel.Colorl.RecentPercentDefects
Lanel.Colorl MissedPartPresents
Lanel.Color2. RejecterEnabled
Lanel.Color2.InspectionCount
Lanel.Color2. TotalMumberinspected
Lanel.Color2. TotalNumberDefects

IEIP TR N T .

192 CERERRRORRRIIORRRREER®

Ready

n

- Data Access * |[# 8 Loca
E-@ Pressco Intellispec OPC Data Server 51k Remoe
=@ Group Bt Manudl
o

OFC Servers | DA Browss | DA ltems | AE Browss | AE Events | AE Condbions | Emors

7. Click the DA Items tab at the bottom of the window. Note that there are columns for

Item, Value, Quality, and Time Stamp for each of the items in the left window frame.

B Softing OPC Toolbox Demo Client N [E=EE
File Edit Session View
(B [~ =] = *
Mew Open Save | Propetes | Delete Stop  Conmect  Stat [Cwiite_]

" ® Lanel Capp | Calor2N Def < M iem [ Vae | Quaity [ TimeStamp [ Resut =~

~@ Lanel.CapperHiead.Color2PercentDefects @ Lanel CapperHead T [0.35](0,0... GOOD 33630625

—@® Lanel.Cappertead. TotalNumberDefects ® Lanel CapperHead T [035][0.0... GOOD 093630625
& Lanel.CapperHead.TotalPercentDefects & Lanel TolaMumbsdn.. 0 GOOD 09:36:30 625
& Lanel.TotalNumberinspected @ Lanel TataMumbeD .. 0 GOOD 019:36:30 625
@ Lanel.TotalNumberDefects @ Lanel TotaPercentD... 0 GOOD 093630625
@ Lanel.TotalPercentDefects @ Lanel RecentMumbe... 0 GOOD 09:36:30.625
@ Lanel RecentNumberdnspected @ Lanel ReceniNumbe . 0 GOOD 09,3630 625
& Lanel RecentMumberDefects & Lanel RecentPercen.. 0 GOOD 9:36:30 625
& Lanel RecentPercentDefects ® Lanel CameraCourt 3 GOoD 09:36:30.625
@ Lanel.CameraCount ® Lanel MachinePaiC.. 2 600D 093630625
@ Lol MachinePanCount ® Lone] TimeLasiFleset 093042 GOOD 093630625
® Lanel TimeLastReset @ Lanel Encodeifiequ.. 0 GOOD 093630625
@ Lanel EncoderFrequency ® Lme].P‘?llﬂae o GOOD 09:36:30.625

@ Lanel Partfate @ Lanel MissedResuls 0 GOOD 09:36:30 625

& Lanel. CurentPart FHCF Master  GOOD 9:36:30 625

@ Lanel MissedResults @ Lanel Annuncistovte . 0 00D 033630625

—@ Lanel CurrentPart @ Lanel Oriine 0 00D 093630625
® Lanel AnnuncistorActive ® System Appicabortla. Intelispec S GOOD 09:36:30 625
@ Lanel.Online & System Varsion 51022 (wi. GOOD 09:36:30625 L
& System.ApplicationMame @ Spstem LaneCount 1 GOOD 03,3630 625 b
& System.Version £ || ® Svstem Relreshinterval 60 GOOD 09:36:30 625
& System.LaneCount & Spstem RecentSampl.. 1000 GOOD 9:36:30 625
@ System.Refreshinterval @ System Cument zer Administrator  GOOD 09:36:30.625
@ System RecentSampleSize @ System CumentTime  10.44:45 600D 10:44:45 054 =
@ System.CurrentUser ‘ m b
® OFC Servers | DA Browss DA ltems | AE Browss | AE Events | AE Condbions | Emors

- ems
Ready

8. Verify that all data items have a solid green circle next to them.

9. Verify that all data items have GOOD status in the Quality column.

10. Verify that data item "System.Current.Time" is being updated once per second.
11. In the left window frame, select Pressco Intellispec OPC Data Server.

12. At the bottom of the right window frame, select the DA Browse tab.
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13. At the top of the right window frame, click the '+' to the left of the blue diamond. There
should be one blue square for each lane configured on the Intellispec, plus a blue square
named System. Each blue square is a container for whatever data items are available for
each group, and additional nested containers if appropriate.

B Softing OPC Toolbox Demo Client 5 [E=EE
File Edit Session View
0 = =] = L3 @
Mew Open Save | Propeites Stop  Cormect  Stat [
54 Data Access * |[E-® Pressco Intelispec DFT Diata Server -
E-@ Pressco Intellispec OPC Data Server =-[E Lansl
2@ Group = B Main
System.CurrentUser =-[E Colort
% Lanel.Main RejecterEnabled B Coloi2
@ Lanel.MainInspectionCount E =B Filedabee
o . # B CoppesHead
@& Lanel.Main.TotalMumberlnspected o [ 1
& Lanel.Main. TotalMumberDefects © TotaNumbeDefects
& Lanel.Main.TotalPercentDefects =@ TotaPercerDefecls
@® Lanel.Main.Recenthumberinspected @ Recentiumbernspected -
@ Lanel.Main RecenthumberDefects @ RecentMumberDeiects 1
@ Lanel.Main.RecentPercentDefects # @ RecentPecentDeiects
® Lanel Main MissedPartPresents & ComesaCount
@ Lanel.Colorl RejecterEnabled ® MachinePaiCount
p @ TmelasReset
@ Lanel.Colorl InspectionCount
N @ Encoderfrequency
@ Lanel.Colorl. TotalNumberlnspected @ PalRals
Lanel .Colord. TotalNumberDefects @ MizsedFesuts
Lanel.Colorl. TotalPercentDefects @ CuneriPart
Lanel.Colorl.RecentMumberinspected @ ChuteFul
@ Lanel.Colorl.RecentNumberDefects @ Dooillpen
@ Lanel.Colorl.RecentPercentDefects @ Alaméclive
@ Lanel Colorl MissedPartPresents @ :”""9““:2‘1
@& Lanel.Color2.RejecterEnabled g D:.:::I&U e
@& Lanel.Color2InspectionCount 5B System

@ Lanel Color2. TotalNumbernspected & ArclicalionName -
@ Lanel.Color2. TotalNumberDefects

= | OPCServers DA Browse |DAlhams] AE Brnwse] AE Everts | AE Cmdtunsl Errarz |

Ready

Interpreting the Data
The data items in the OPC test client correspond to the statistics on the Intellispec screen.

> To see the individual data items:

1. Click the 'DA Browse' tab on the lower right screen.

2. Click on the '+' next to the blue square for a lane. This will display a nested blue square
for each camera and machine part configured on that lane, plus several more blue circles
for the data items summarizing that lane, including: TotalNumberInspected,
TotalNumberDefects, TotalPercentDefects and TimelLastReset.
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3. Click on the '+' next to the blue square for a camera. This will display a nested blue square
for each inspection currently programmed for that camera, plus several blue circles for
the data items summarizing that camera. These items correspond to the statistics on the
screen, as shown below.

Defects
1083
Defect %
100.000

‘Suppon Ring Registration
Cap Height Left
Cap Helght Right

More Lane Infi

wrmatio

0 0.000
pr7 ar7o0

7T 47.700 -]

Machine Parts
[ statistics
=

Reject Images

~
Trend Graphs
~

—
Trend Graphs

—
Reject Images

Neckring Reg 1 0 o.000 B
?E?;-fecls Cap Reg 1 &0 5.000 -
Detect | (S I o :iﬂﬁl fillac Vabca
014 Cap Helght Left 1 8 0.800 o
e ——— | fecli [ Defect s I Last |
Ne: Re: 1008 o 0.0 o 0.000 [ -
Defects Cim : “ 10rs 20 1.465 19 1.900 Cappet.Hipad
41 Tamparhand 109 1w 0.9p7 9 0.900
LTS8 | cap Helght Left 10frs 21 1.8 19 1.800
3.782 Cap Height Ng}a 1049 1 1.09 10 1.000
B Softing OPC Toollx Demo Clignt
File Edit Session || View
D = = tH P LS q‘ |
New Open Save | Hropptiel: elete Stop  Connect Star it
g #-[=] Main -
@[ Colorl
=+-[E Color2
. #-[E NeckingRegROI
== MNeckringFeg
#-[® CapRegROI
L 5] CapReg
@-[& TamperbandA0l
= 5] Tampetband
= CapHeightLeft
- CapHeightRight
© RejecterEnabled
@ InspectionCount =
@ TotalMumbernspected
@ TotaNumberD efects s
© TotalPercentDefects
@ RecentNumberinspected
®
| [H-@ RecentPercentD afects se—
L@ MissedPantPresents
- Fille/alve
#-[E CapperHead
—2 TotalNumberlnspected
== TotalNumberDefects
=2 TotalPercentDefects
@ RecentMumbernspected
@ RecentNumberDefects

- @ RecentPercentDefects

4. Click on the ‘+’ next to the blue square for an inspection (example, Tamperband). This will
display several more blue circles for the data items summarizing that inspection,
including: Enabled, TotalNumberDefects, TotalPercentDefects, RecentNumberDefects

and RecentPercentDefects.
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Click the ‘+’ next to the blue square for a machine part (if any) (example, CapperHead).
This will display a blue circle for each camera in the lane, named
‘<CameraName>NumberDefects’, '<CameraName>PercentDefects,' plus
‘TotalNumberDefects’ and 'TotalPercentDefects.' Note that each of these data items is an
array containing defect counts for the machine part correlation feature.

Adding data items to those being monitored

Double-click a data item (blue circle) in the ‘DA Browse’ tab to add that data item to the list of
those which are being monitored in the ‘DA Items’ tab.

B Softing OPC Toolbox Demo Client 5 B
File Edit Session View
D & MW = X ® @ [
Hew Open Save  Fropebes  Delels Stop  Cornect Stait [

® Lenel CapperHead TotelNumber « |[=78 Presaco Intelspec DFC Dofa Server

® Lanel .CapperHead. TotalPercentl =-[E Lanel

# Lanel.TotalNumbernspected # [ Main

@ Lanel TotalNumberDefects = Colorl

® Lanel TotalPercentDefects B Coloi2

® Lanel.RecentMumberinspected =B Iiile(\«'ahe

® Lanel RecenthumberDefects T E #;c:::rchzlmpscled

& Lanel RecentPercentDefects © TotaNumbe:Detects

@ Lanel.CameraCount =-@ TotdPerceniDelect:

® Lanel.MachinePartCount @ FAecentlumbernzpecied

® Lanel TimelastReset @ RecentNumberD efects

® Lanel EncoderFrequency #-@ RecentPercentDefects

® Lanel PartRate @ CameraCount

® Lanel MissedResults ® MachinePaiCount

® Lanel CurrentPart ° Tm&La;‘EHesEt

@ Encoderfrequency

® Lanel.AnnuncistorActive @ PalRals

@ System.ApplicationMame @ MizzedFlesuts

& System.Version @ CueriPart

& System.LaneCount @ ChuteFul

& System.Refreshinterval @ Doailpen

& System.RecentSampleSize @ ‘\L:Ilﬂ\ﬁcll\’!‘.

@ System.CurrentUser & Waringholive

c - @ Arouncizioehclive

® System.CurrentTime % Orine

: Land.Capoer;sjd_.EciIEEEbmbd_— % B System
4 m » oFc Saw@m Itame ] AE Browse ] AE Everts | AE Cmdmns]’ Enarz I
Ready

Measurement data items

Additional inspection data is presented for some inspections.

To see measurement data items, check the Show 'Measurements' Items box in the OPC
Configuration (on page 464) screen.

A number of inspections include data items providing measurements, including:

Measurement inspection: the measurements “Inner,” “Outer,” and “Width” are available
(see note 1 below)

Distance inspection: the measurement “Distance” is available
Angle inspection: the measurement “Angle” is available
Mass inspection: the measurement “Value” is available (see note 2 below)

.0

%

Note 1: some of the measurements for the “Measurement” inspection may not be active,
depending on the specific configuration of the inspection.

Note 2: if machine part correlation is available on the system, the single “Value”
measurement will instead be named “AllCavities” and the per-cavity measurements
“Cavityl,” “Cavity2,” Cavity3,” ... “Cavity(N)” where (N) is the total number of cavities
configured will also be available.
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For each available measurement, the data items “Average,” “StdDev,” Minimum,” and
“Maximum” are presented, based upon a running sample of the last 100 good parts inspected
while online. The following example shows the items for a Measurement inspection.

B Softing OPC Toolbox Demo Client

File Edit Session View

[ & =] )
MNew Open Save Properties

P LS @

Delete Stop  Connect Start

@ Data Access
El-@® Pressco Intellispec OPC Dat:
B @ System
System.Applicationh
System.Version
System.SerialNumbe
System.LaneCount
System.Refreshinten
System.RecentSamp
System.CurrentUser
System.CurrentTime

POOOOOO® @

== Rivet

[E CoarseRegistrationR 0l
w-[E CoarseRegistration
#-[E FineRegistrationR 0l
[= FineRegistration
- RiveiEdgeROI

+-[E RivetEdgelnspection
#-[& RivetDimensionROI
= W1 RivetDimensinn

----- © Average
@ StdDev
A& Minimum
@ Maximum
- CAMHIAC:-;e

Outer
width
Enaoea
TotalNumberlhspected

|—|..E
==
<
- TotalNumberDefects
(<]
(<]
(<]
(<]

4|

] TotalPercentDefects

- RecentNumberDefects
RecentPercentDefects
RejecterEnabled
RejecterMumber

. @ MeasurementCount
w-[E OuterRivetROI

+-M® OuterRivetinsoection

m

< | I | » | OPCServers [A Browse IDAIten‘rs] AE Bruwse] AE Events] AE Conditium] Errors ]

Ready

Parameter data items

Additional inspection data is presented for some inspections.

To see parameter data items, check the Show 'Parameters’ Items box in the OPC Configuration

(on page 464) screen.

System Guide Series V (5.2) Integrated Tunnel INTELLISPEC™ (71838 Rev. 01)

© 2013 Pressco Technology Inc. Proprietary

About OPC 471



Contrast inspection includes parameter values (user settings affecting the performance of the
inspection), including: “MaxContrast," “MinFeatureSize," “MaxFeatureSize,” and
“MaxTotalSize” are presented. An example of a Contrast inspection is shown below.

F ™
B Softing OPC Toolbox Demo Client L] B

File Edit Session View

O & = &= LS @ [

MNew Open Save Properties Stop Connect Start

@ Data Access =-[= Panel A

[ @ Pressco Intellispec OPC Dati - @-[E CulRegistrationR0l
)@ System - =-[E CulRegistration
@ System.Applicationh | i Cesiin
o System.Version =R
| @ Enabled

e TotalMumbernspected
© TotalNumberDefects
@ TotalPercentDefects
@ RecentNumberDefects
& RecentPercentDefects
& RejecterEnabled
& FRejecteMumber
©
@
©
©

m

System.SerialNumbe

® 4

X

System.LaneCount
System.Refreshinten,

) (®) (0

System.RecentSamp

®

System.CurrentUser
System.CurrentTime

®

MeasurementCount
MaxContrast
MinFeatureSize
MaxFeatureSize

MaxTotalSize

= R D L= RS LR L L)

[E CuilDimension

[E SeamingbreaR0l

[E Seamingdrealnspection
B ChuckwalR0I

[E ChuckWwallnspection

[E ChuckwalRegistrationR 0|
[E ChuckwallRegistration
[E PanelT abOrientationR 0|
=1 PanelT abOrientation

P T » OPC Servers DA Browse [ D& Items] AE Bruwse] AE Events] AE Conditions ] Errars ]

Ready

Checking for Errors

At the bottom of the right window frame, click the Errors tab. Verify that no errors have been
reported.

Exiting the Test Client

Click the ‘X’ in the upper right corner of the Softing OPC Toolbox Demo Client window to close
the program. If you are prompted to save changes (probably due to changing the list of data
items being monitored), click No.

Using the OPC Private Counters option

A separate set of OPC counters is available for long-term statistics tracking. When this feature
is enabled, OPC counters are unaffected when the system statistics are reset either manually
or automatically. When this feature is not enabled, the OPC counters are reset the same as the
system statistics you see on the Intellispec screen.

When the Private Counters option is enabled, the OPC Counters will only reset when:
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e A new part program is loaded, or:
e You use the Reset Private Counters button

> To enable the OPC Private Counters:
1. Login as Administrator.
2. Click the a button.

3. Click the Tools button to see the Tools menu > select OPC Configuration from the
menu. The OPC Configuration (on page 464) menu is displayed.

4. Check the Use Private Counters box.

Click the OK button to save changes and exit.

6. The Intellispec must re-start for changes to take effect. Click the OK button (check mark)
to acknowledge the message.

System Restart Needed

Youmustrestart the system before yourchanges will

! take effect.
M) @

7. Click the Tools button to see the Tools menu > select Exit System from the menu.
8. Select "Shut Down Intellispec and Restart Computer" from the drop-down menu. The
Intellispec system shuts down and restarts. The Private Counters are enabled.

v

To see the difference between the statistics on the Intellispec screen and the OPC Private
Counters, use The Intellispec OPC test client (on page 466).

To view only items such as parts inspected, number of defects, etc., see how to View only
defect data (on page 475).
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The example below shows what happens when Private Counters is used.

B Softing OPC Toolbox Demo Client

© EZO Ends

File Edit Session View
D ® & & x X 3

O Total Parts New Open Save Plopérties Ddéte Stop Connect Start
-9 Data Access Item | Value | Quality
E-@ Pressco Intellispec OPC Dati || @ System.ApplicationNa... Intelispec 5... GOOD
B-@® System @ System Version 50473 (wi.. GOOD
@ System.Applicationh || @& System. SerialNumber GOOD
@ System.Version @ System LaneCount 1 GOOD
& System.SerialNumbe || @ System Refreshinterval 60 GOOD
@ Wstemn.LaneCount || ® System.RecentSampl.. 1000 GOOD
@ Syster™RRg @ System.Currentl ser New Userd.. GOOD
@® System.Rece - QlurentTin =L GOOD
@® System.CurrentUse@ - 51 GOOD
@ System.CurrentTime [® EZOEnds.TotalNumb... 26 GOOD
@ : . 50.9803921.. GOOD
A8
®

Defects
0

Defect %

\ J 0.000

0 TotaloPag |
(\

A Normal condition. Intellispec and OPC statistics are the same.
B Private counters enabled. The Intellispec statistics are reset, but the OPC statistics do not get
reset.

Reset Private Counters
When you use the OPC Private Counters option, you may need to manually reset the OPC data.

> To reset the OPC Private Counters:

Take the Intellispec system offline.
Log in.

Click the ﬂ button.

Click the Tools button to see the Tools menu > select OPC Configuration. The OPC
Configuration menu opens.

N

5. Click the Reset Private Counters button. A confirmation box appears to notify you that
the counters will be reset on the OPC server.
6. Click OK. The OPC counters are reset.
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Counter Rollover

Counter Rollover is an advanced option for the OPC server. It allows the OPC server to behave
like PLC counters if the digits are limited. For example, you may use a PLC where the data rolls
over after 9,999. In this example, set the Counter Rollover value to 10,000. This would make
the OPC data roll over after 9,999 to be compatible with your PLC.

7

** Note: if your plant is not limited in the number of digits for your OPC counter, make sure the
Use Counter Rollover box is un-checked.

If you have a PLC that has limited digits, set the Counter Rollover to a number equal to one
greater than your PLC's highest number.

e If your PLC rolls over after 9,999, set Counter Rollover to 10,000
e If your PLC rolls over after 99,999, set Counter Rollover to 100,000

A

> To set Counter Rollover:

Take the Intellispec system offline.
Login.

Click the B button.

Click the Tools button to see the Tools menu > select OPC Configuration. The OPC
Configuration (on page 464) menu opens.

Check the Use Counter Rollover button.

Click either the 10,000 or 100,000 button.

7. Click the OK button to save changes and exit. The Intellispec needs to re-start for the
changes to take effect.

8. Click the a button.

9. Click the Tools button to see the Tools menu > select Exit System.

10. Select Shut Down Intellispec and Restart the Computer from the drop-down menu. The
Intellispec software shuts down and restarts.

11. Log in after the software restarts, and continue operation.

el

o w

View only defect data

To see the effects of Private Counters, set up the OPC test client to show only the defect items
such as parts inspected and number of defects.

Open the The Intellispec OPC test client (on page 466).

Next, set up the data items to display only defect information.

» To see the defect items:

1. Remove the items that you do not want to see by clicking each item, then clicking the
Delete button at the top of the menu.
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‘0

e Note: do not click the "System" item in the left pane. If you remove that item, then none
of the statistics items will be available to view.

._S softing OPC Toolbox Dema Client
File Edit Session “iew
O = = A

Mew Open Save

b
Fropertkes De[,\ée

* @

Stop Connect Start

=8 Data Access
-] Pressco Inkel;

- 2

OPCDatas |

+-e Ma
System, CurrentTime
System, ChuteFull
System, Dooropen
System, PowerFail
System, LowBattery
Swstem, OverTemperat
System, Blarmbckive
Swstem, WarningActive
System, Annunciatar
System. Online

fOR R R RCRCE R ORCE

< wll

== | {Dele

]
nual

OFC Servers | D, BrowseJ D4, Ilems] AR Browse] AR EventsJ AE Eonditinns] Errars J

Deletes the ohject and all objects in the subtrees

2. Click the DA Browse tab at the bottom of the window. The "Pressco Intellispec OPC Data

Server" item is disp

layed in the right pane.

3. Click the '+' next to the Data Server item to expand the tree.

b

Click the '+' next to a Lane name to expand the Lane tree.

5. Choose the items from the right pane that you do want to view by double-clicking each

item.

B softing OPC Toolbox Demo Client
File Edit Session View
(B = = 5]

Hew Open Save | Propeites

k.3

Stop  Cormect  Stait

[E=ET 5]

[

E-@ Data Access
E-@ Pressco Intellispec OPC Data Server
=@ Group

Lanel.TotalNumberDefects

& Lanel.RecentNumberDefects.

Ready

% Lanel.TotalNumberinspected

=@ Pressco Intellspec OPC Data Server
= & Larel
& Man
=8 Colort
- Colos2
=[5 Fileahe

@ Lanel.TotalPercentDefects:
| i
@ Lanel RecEmNumher[nspe:;E‘“x QI i z
Q\a TotalNumbesDefects

@& Lanel.RecentPercentDefects w TotalPerceriDefects
\‘_) Fecenttumbernspected

H‘“\f RecentlumbeiDefects
52 FRecentPricentDefects
@ CameraCount
@ MachinePariCount
@ TimelasResst
@ Encodefrequency

@ PanRale
@ MizzedResuts
@ CunentPait
@ ChuteFul
@ Doolpen
@ Alamdctive
@ ‘Waringhciive
@ Asnuncistorhclive
@ Onlne

# [ System

OFC Servers DA Browse | DA ltems | AE Browse | AE Events | AE Condiions | Enors

6. Continue choosing all the items you want to see. Expand the individual camera trees and
choose the defect statistics for each camera, if desired.

7. Once you have all the items you want to see in the left pane, click the DA Items tab at the
bottom of the window. Your selected items appear in the right pane.

Next, test the Private Counters: Put the Intellispec system online. Observe the defect data on
screen and in the OPC test client. Notice that the numbers are essentially the same. Due to
different update rates, the numbers may be slightly off at times.
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LIST OF DATA ITEMS

The following list contains the common data item IDs that are available on the Intellispec OPC
Server. Note that the names of the data items depend on your system configuration.

TotalNumberinspected
Total number of parts inspected since statistics were last reset. Present for each lane,
camera and inspection.

TotalNumberDefects
Total number of defective parts found since statistics were last reset. Present for each
lane, camera and inspection, and also for each machine part when machine part correlation
is in effect (in which case this item is a one-dimensional array with each array element
representing the defect count for one occurrence of the machine part).

TotalPercentDefects
Percentage of defective parts per the total number of parts inspected since statistics were
last reset. Present for each lane, camera and inspection, and also for each machine part
when machine part correlation is in effect (in which case this item is a one-dimensional
array with each array element representing the defect percentage for one occurrence of the
machine part).

RecentNumberDefects
The number of defective parts found in the last “N” number of parts inspected, where “N” is
a configurable parameter. Present for each lane, camera and inspection.

RecentPercentDefects
Percentage of defective parts found per the last “N” number of parts inspected, where “N”
is a configurable parameter. Present for each lane, camera and inspection.

RecentSampleSize
Gives the value of the configurable parameter “N” mentioned in the preceding “Recent...”
data items. Present for System.

Enabled
True if the inspection is currently enabled or False if it is disabled. Present for each
inspection.

RejecterEnabled
True if the rejecter for this camera or inspection is currently enabled or False if it is disabled.
Present for each camera and inspection.

RejecterNumber
Gives the rejecter number assigned to this camera in lanes configured to have multiple
rejectors. Present for each camera.

TimeLastReset
Gives the date and time statistics were last reset to zero. Present for each lane.

CurrentPart
Name of the currently selected part program. Present for each lane.

ChuteFull
True if the defective part container for this lane is currently full or False if it is not. Present
for each lane.
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MissedResults
The number of parts that reached the reject point on the conveyor before the system was
able to determine if the part was defective or not. Present for each lane.

PartRate
The number of parts to be inspected being encountered per minute. Present for each lane.

EncoderFrequency
The number of encoder pulses being produced per second (which is proportional to the
conveyor speed). Present for each lane.

AlarmActive
True if the red light on the light tree is currently illuminated or False if it is not. Present for
each lane.

WarningActive
True if the yellow light on the light tree is currently illuminated or False if it is not. Present
for each lane.

AnnunciatorActive
True if the horn or buzzer on the light tree is currently sounding or False if it is not. Present
for each lane.

Online
True if parts are currently being inspected with defective parts being rejected or False if
they are not. Present for each lane.

MissedPartPresents
Total number of parts for which a usable image was not received from the camera. Present
for each camera.

Average
Arithmetic mean of measurement. Present for each inspection measurement.

StdDev
Standard deviation of measurement. Present for each inspection measurement.

Minimum
Lowest value of measurement. Present for each inspection measurement.

Maximum
Highest value of measurement. Present for each inspection measurement.

Version
String giving the major, minor and build numbers of the software currently running on the
Intellispec system. Present for System.

SerialNumber
String giving the system serial number. Present for System.

CurrentUser
String giving the name of the user currently logged onto the system, or empty string if no
user is currently logged on. Present for System.

CurrentTime
Current date and time as given by system clock. Present for System.
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REFERENCES

To learn more about OPC, visit these links:

OPC Foundation
(http://www.opcfoundation.org/Default.aspx/01_about/01_whatis.asp?MID=AboutOPC)
OLE for process control (http://en.wikipedia.org/wiki/OLE_for_process_control)

Or perform a search on the Internet, using "OLE for process control" as the search criteria.
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Chapter 20
HOW TO CONTACT PRESSCO

24/ 7 Customer Support:
+1 440-498-2000

E-mail:

dispatch@pressco.com (mailto:dispatch@pressco.com) or techsupport@pressco.com
(mailto:techsupport@pressco.com)

Customer Service Fax:
+1 440-498-4761

Mailing Address:
Pressco Technology Inc. 29200 Aurora Rd. Cleveland, OH USA 44139-1847

Main Phone:
+1 440-498-2600

Web Site:

www.pressco.com (http://www.pressco.com)

Business Hours:
Monday - Friday, 8:00am - 5:00pm Eastern Standard Time
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